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Preface: Getting help

Welcome to the FileMaker Pro application from Claris Corporation. 
FileMaker Pro is designed to help you manage information easily and 
effectively. 

If you’re new to the Mac OS You need to learn about using the mouse, 
working with disks, and other Mac OS conventions. See the 
documentation that came with your computer.

Important If you are using a system prior to Mac OS 7.5, or if you are using 
Mac OS 8, what you see on your screen might not match the illustrations in 
the documentation.

Customer support and registration
Please take the time to complete and mail the product registration card 
that is included in this package. Refer to our Web site at
http://www.claris.com for information about customer support.

U.S. and Canadian retail customers can also refer to the Claris Service 
Directory included with the software. For customers outside of the U.S. 
or Canada, refer to the Technical Support brochure included with the 
software.

Using Help and the user’s guide together
Throughout this guide you see Help icons in the margin, along with 
instructions, that tell you what keywords to use to find a related Help 
topic. A keyword is like a term in an index. In some cases, Help gives 
you additional information about a subject. For more information about 
using Help keywords, see “Using the Help index” on page XIV.

Use the FileMaker Pro Quick Reference on the back cover of this user’s 
guide to get at-a-glance information about using the FileMaker Pro tools 
and status area controls.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Help, using
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Glossary terms are available in the Help Reference section, as well as 
underlined with a dotted line in Help topics.

Note The examples in this documentation show dates and numbers in 
U.S. formats such as November 30, 1998, and $1,234.50.

Using FileMaker Pro Help
FileMaker Pro Help is available whenever FileMaker Pro is running. It 
contains some information not in the printed documentation, like 
troubleshooting tips. As you get comfortable with FileMaker Pro, you’ll 
be able to find all the information you need in FileMaker Pro Help.

Opening FileMaker Pro Help
To open Help when FileMaker Pro is running, choose a command from 
the  or Help menu:

Whenever you open FileMaker Pro Help, you start the QuickHelp 4.0 
application, which runs independently of FileMaker Pro.

Managing FileMaker Pro Help
Here are some ways to manage FileMaker Pro Help and the windows on 
your screen:

Choose To see

About Balloon Help Directions for using Apple Balloon Help.

Show Balloons Brief descriptions of FileMaker Pro tools, icons, and menus. 
(To turn off Balloon Help, choose Hide Balloons.) 

FileMaker Help A context-sensitive Help topic.

FileMaker Help Topics Topic titles in a table of contents.

FileMaker Help Index An alphabetical list of index entries (keywords).

To Do this

Work in FileMaker Pro 
while FileMaker Pro Help 
is running

Start FileMaker Pro, click a FileMaker Pro window, or choose 
FileMaker Pro from the application menu (at the right of the 
menu bar).

Move a window Drag the window’s title bar.



Getting help XIII
Using the Help contents
When you open FileMaker Pro Help, you see a list of Help topics, like 
the table of contents in a book. You can click topic titles to see any 
subtopics, and then click a topic to move to the information you need.

Arrange windows for easy 
access

On a small screen, move the FileMaker Pro document window 
and the Help window so the corners overlap. Then you can click 
a corner to bring a window into view.

On a larger screen, arrange the windows side by side.

Switch between the Help 
window and a 
FileMaker Pro file window

Click the window you want to work with.

Close FileMaker Pro Help 
and leave it running

Click the close box in the upper-left corner of the window. 
Claris Help Viewer continues to run in the background. To 
show Help again, click a FileMaker Pro window, and then press 
2-?.

Hide FileMaker Pro Help 
and leave it running

Click a Help window, and then choose Hide QuickHelp 4.0 from the 
application menu (at the right of the menu bar). To show Help 
again, choose Show All from the application menu.

Quit FileMaker Pro Help 
and the QuickHelp 4.0 
application

Click the Help window to make it active, and then choose Quit 
from the File menu.

To Do this
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Using the Help window
To navigate in the Help system, you click buttons and underlined text in 
the Help window.

Click solid underlined text to jump to a topic related to the current topic.

 

To return to any topic you viewed during a help session, choose History 
Window from the Options menu, and then double-click the topic title.

Using the Help index
FileMaker Pro Help comes with a list of index entries, which are 
significant words and phrases (called keywords), to help you find the 
topics containing the information you want. Each index entry is 
associated with one or more topics.

This user’s guide gives you keywords throughout the documentation to 
help you find related topics by their index entries in Help.

Displays the title of the
current topic

Drag the note icon 
into a topic and type 
your own notes

Click to see the index

Type a word 
you want to 
find in the 
Index and 
press Return

Click to move to 
the next or 
previous topic

Click to return to the last topic viewed

Click to return to the
Help contents

Click solid
underlined text to

jump to a topic
related to the
current topic

Click dotted
underlined text to

see a definition
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To use the Help index:

1. If you aren’t in Help, choose FileMaker Help Index from the  or Help 
menu. 

2. In the Index window, type all or part of the keyword to find.

  

You see the topics associated with the keyword in the list. 

3. Double-click the topic you want.

To browse the index, scroll
through the alphabetical list or
type the first few letters of the

entry you’re looking for
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Using Find
You can search for specific words in FileMaker Pro Help:

1. Click the Find tab.

2. If you want, choose options from the two pop-up menus. Then type 
the word that you’re looking for.

3. Click Search.

4. Click a topic in the scrolling list, then click Display.

Getting additional help
To get context-sensitive help for dialog boxes and menu items, press the 
Help key (on an extended keyboard) or press 2-?. 

Use Help to get information on these additional tasks:

For information on

Choose FileMaker Help 
Index from the  or Help 
menu, and then type

Printing a Help topic Help, printing

Adding your own notes or instructions to a topic 
(annotations)

Help, customizing

Creating bookmarks to quickly access topics you use 
often

Help, customizing

Copying all or part of a topic to an application that 
supports text, to compile help information you use often

Help, using

Setting Help preferences to customize the way you use 
Help

Help, customizing

Choose options from the
pop-up menus if you want Type the word you 

want to find

Select a topic from 
the list
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Using the FileMaker Pro documentation
This guide and the other documentation in the set give you all the 
information you need to know about installing and using FileMaker Pro.

Start by reading chapter 1, “FileMaker Pro basics,” for an overview of 
FileMaker Pro, and for information about managing files and 
performing common tasks. Then read chapter 2, “Creating a database 
file,” for information about designing FileMaker Pro database files. You 
can then move to the chapters you need for doing your work, such as 
using layouts, or entering, finding, and sorting information.

Use the following additional tools to help you with FileMaker Pro. 

Use To

FileMaker Pro 
Installation and New 
Features Guide

Install FileMaker Pro on your hard disk. If you’ve used 
previous versions of FileMaker Pro, you can read about 
features new to this version.

FileMaker Pro Tutorial
(an onscreen tutorial)

To get an overview of how to use and design a FileMaker Pro 
database. You can complete the tutorial in one session, or one 
segment at a time. To use the tutorial, double-click the Tutorial 
file in the Tutorial folder.

FileMaker Pro template 
files

See and work with database files created with FileMaker Pro. 
You can use the templates for your business or personal work— 
as they are, or change them to suit your needs. (See “Creating 
and opening files” on page 1-9.)

FileMaker Pro Help Get complete, onscreen, step-by-step instructions and reference 
information for using FileMaker Pro as you work. (See “Using 
FileMaker Pro Help” on page XII.)

 Balloon Help See brief descriptions of FileMaker Pro tools, icons, and 
menus. (Choose Show Balloons from the  or Help menu. To 
turn off Balloon Help, choose Hide Balloons.) Choose About 
Balloon Help from the  or Help menu to see directions for using 
Apple Balloon Help.

CDML Developer’s Guide Get information on publishing custom Web database solutions. 
Open the CDML Reference file in the Web Tools folder, in the 
FileMaker Pro 4.0 folder.

Web browser Help Get help while working with a database in a browser. Available 
by clicking the ? icon in the Instant Web Publishing interface.

Sample custom HTML 
pages and databases

Use as models for creating your own custom Web databases. 
Available in the Web folder, in the FileMaker Pro 4.0 folder.



Chapter 1:  FileMaker Pro basics

You’re using FileMaker Pro software because you have information to 
manage, or information you would like to publish on the World Wide 
Web. This information could be just about anything: accounts, 
inventories, suppliers, sales contacts, employees, or products. The 
power, flexibility, and ease of use of FileMaker Pro help you manage 
that information, so you can:

1 find information quickly

1 update and maintain information

1 print documents like invoices, form letters, and mailing labels

1 analyze information using onscreen and printed reports

Important Before you read this chapter, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.”

Understanding FileMaker Pro
Before you begin to work with FileMaker Pro, you should be familiar 
with the basics of FileMaker Pro. If you’re new to databases, start with 
the next section, “What’s a database?” If you’re familiar with databases 
but new to FileMaker Pro, start with “What’s a FileMaker Pro database 
file?” on page 1-3.

What’s a database?
A database is a collection of information, or data, that you can organize, 
update, sort, search through, and print as needed. A database doesn’t just 
hold information—you use a database to organize and analyze 
information so that you understand its significance.

A database can be one file, such as Clients, which might hold the names, 
addresses, and phone and fax numbers of all your clients. 

A database can also be many files that, together, contain all the 
information about a particular topic, or related topics (sometimes called 
a database system). For example, a database for a travel agency can 
include files that hold information about clients, tours, invoices, and 
accounting. 
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Using the relational capabilities of FileMaker Pro, you can join 
information between files to create a relational database. For example, 
one file can show you which clients went on a particular tour and a 
related file can show how much they paid. (For more information about 
relational databases, see chapter 10, “Using data from related files.”) 

A database file contains one or more records. Each record holds all the 
information about one subject (like one person or one identification 
number). For example, each record in a Clients file would contain the 
name and address of one client.

Trip file
Clients file

Invoice file
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Each piece of information in a record—like name, address, and 
telephone number—is stored in a field. You create the fields for each 
database file.

What’s a FileMaker Pro database file?
Each FileMaker Pro database file contains information about the file’s 
structure, like fields and their definitions, access privileges and 
passwords, calculations, layouts, and scripts. A FileMaker Pro database 
file also contains the data you enter and work with.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E FileMaker Pro

Records in a Clients file

Fields in a record
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Fields and field definitions
Fields are the basis of a database file. Fields store, calculate, and display 
the data you have entered or calculated. For example, you might create 
a field named Tour Name to hold a descriptive name for each tour you 
add to a Tours database file.

The information you put into a field—by typing, copying, looking up, or 
importing—is its value. Field values in a FileMaker Pro file can be:

1 text

1 a number

1 a date

1 a time

1 a graphic, sound, or movie

1 the result of a formula that calculates the field’s value

1 a summary of the values in the field for a group of records

Each field has a set of characteristics that defines how it will store, 
display, and interpret data, and whether the value is typed or entered into 
the field or is the result of a calculation. These characteristics are the 
field definition. You create a field in a file and define it to suit your 
needs. For example, the type of data in the field and whether to calculate 
the field’s value are both part of the field definition.

This field is designed to hold 
only numbers

This field is designed to calculate 
a value based on other values in 
the record
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Records
To enter data in a database file, you create a record and then enter data 
into the fields. After you have records in a file, you can work with them 
in various ways, such as sorting them, finding a group of records that 
contains particular data, or importing and exporting records.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E records, overview

One record contains
all the information

about a single activity,
individual, or subject
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Access privileges and passwords
Access privileges and passwords promote file security by controlling 
who can use a file and particular fields and layouts, and which tasks they 
can do. In the FileMaker Pro Web Companion, a password controls who 
can browse and edit a file on the World Wide Web.

A file doesn’t require access privileges and passwords; you can create or change them as 
needed. For more information see chapter 7, “Networking and access 
privileges” and chapter 11, “Publishing files on the Web.” 

Using relationships in a database
Whether you create a database with one file (sometimes called a flat-file 
database) or many files (a relational database), you can use data from 
other files as if the data were in the current file. A file that contains data 
used in another file is a related file.

1 To copy data from a related file and store it in the current file, define 
a lookup (see “Looking up and displaying data from other files” on 
page 10-1).

1 To view and work with data from different files in the current file 
without storing that data in the current file, create a relational 
database (see “Working with relational databases” on page 10-14).

To learn more about these differences, see “Lookups and relational 
databases: a comparison” on page 10-8.

You can publish both flat-file and relational databases on the World 
Wide Web using FileMaker Pro Web Companion. For more 
information, see chapter 11, “Publishing files on the Web.”

 Choose FileMaker Help Index from the  or Help menu, and then type:

E access privileges
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Working with modes
You work in FileMaker Pro in four modes. You switch between modes 
by choosing a menu command for the mode you want. 

In this mode You do this

Browse Work with the data in a file. You can view, add, change, sort, omit, and 
delete records. Browse mode is where you’ll do much of your work. For 
more information, see chapter 4, “Working with information in records.”

Layout Determine how information is presented on your screen or in printed 
reports, labels, and forms. You design layouts for specific tasks, like data 
entry or printing invoices or envelopes. For more information, see 
chapter 3, “Laying out and arranging information.”

Find Search for particular records that match a set of criteria. You can then 
work with these records, called the found set. After you find a group of 
records, FileMaker Pro returns to Browse mode so you can begin working 
with them. For more information, see “Finding information” on page 
4-19.

Preview See on your screen how data in records, forms, or reports will look before 
you print on paper. For more information, see chapter 6, “Previewing and 
printing information.”
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Note Some FileMaker Pro tasks, like defining fields and relationships 
and using ScriptMaker, can be performed in any mode.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E modes

Browse mode

Find mode

Layout mode

Preview mode
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Managing files
The following sections tell you how to work with FileMaker Pro files.

Creating and opening files
You can create a file when you start FileMaker Pro or after 
FileMaker Pro is already running.

Create a file from a copy of a template—a predefined file that you use 
as is, or modify to suit your particular needs. Or create a file from 
scratch, without using a template. (If you didn’t install templates and 
want to use them, see the FileMaker Pro Installation and New Features 
Guide.)

After you name a new file, you see the Define Fields dialog box, where 
you create the database fields and define their characteristics. (See 
chapter 2, “Creating a database file.”)

The following table describes the ways to create or open a file in 
FileMaker Pro. If FileMaker Pro isn’t already running, start it by 
double-clicking the application icon. When you start FileMaker Pro, 
you see the New Database dialog box, and you can skip the first (Choose 
New...) step in the following directions.

To Do this

Create a file using a 
template file 

In FileMaker Pro, choose New from the File menu. In the New 
Database dialog box, select Create a new file using a template, choose 
a template category from the pop-up menu, and then double-click 
the name of a template file in the list. In the Create New File dialog 
box, type a name for the file (choose a different folder, if needed), 
and then click Save.

Create a file without 
using a template file

In FileMaker Pro, choose New from the File menu. In the New 
Database dialog box, select Create a new empty file, and then click 
OK. In the Create New File dialog box, type a name for the file 
(choose a different folder, if needed), and then click Save.
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Keep these points in mind:

1 To keep FileMaker Pro from displaying the New Database dialog 
box, select No longer show this dialog in the New Database dialog box. 
You can redisplay the dialog box by setting a preference in the 
General area of the Application Preferences dialog box. (See “Setting 
general application preferences” on page 9-2.)

Open an existing file If FileMaker Pro isn’t running, in the folder containing your 
FileMaker Pro files, double-click the name of the file to open. Or 
drag the file onto the FileMaker Pro application icon.

You can also double-click the FileMaker Pro application icon. In 
the New Database dialog box, select Open an existing file, and then 
click OK. In the Open dialog box, double-click the name of the file 
to open. If you’re asked for a password, type the password, and 
then click OK.

If FileMaker Pro is running, choose Open from the File menu, and 
then double-click the name of the file to open. If you’re asked for 
a password, type the password, and then click OK.

If you have opened the file recently, you can also choose the 
filename from the listing in the File menu if you have selected this 
option in application preferences. For more information, see 
chapter 9, “Customizing FileMaker Pro.”

To Do this

Create a file

Select to stop showing
this dialog box

Choose a 
category of 
templates
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1 When you open a file created with FileMaker Pro versions 2.0 and 
2.1, you see a message telling you the file must be converted to 
FileMaker Pro 4.0 format. To rename the original file, keep the 
Rename old file as checkbox selected and type a name (or use the 
FileMaker Pro default). The new file is converted to the current 
FileMaker Pro file format. The original file has a new name, but the 
contents don’t change. (For more information about converting files 
from previous versions of FileMaker Pro, see the FileMaker Pro 
Installation and New Features Guide.)

1 When you open a file saved with internal default formats different 
from the system formats set on your computer, you might see an alert 
message. For information about this situation, see appendix B, 
“Working with international files.”

1 You can open a file created in another application, like Lotus 1-2-3, 
Microsoft Excel, or ClarisWorks software, in FileMaker Pro and 
convert it to FileMaker Pro format. See “Importing data into a new 
file” on page 8-9.

Closing files
FileMaker Pro saves changes you make to a file as you work and 
whenever you close a file or leave the application.

To close a file, be sure the file’s window is active, and then do one of 
these:

1 Click the close box (in the upper-left corner of the file’s window).

1 Choose Close from the File menu.

Saving a copy of a file
Although FileMaker Pro saves changes to a file as you work, you can 
save a copy of a file for various purposes.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E creating
E opening files

 Choose FileMaker Help Index from the  or Help menu, and then type:

E closing database files
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Important Always save a copy before you make extensive changes. You 
can’t restore data after you delete a field from the Define Fields dialog 
box or remove records using the Delete Record or Delete All commands.

1. Make the file you want to save the active file, and choose Save a Copy 
As from the File menu.

2. In the Save a Copy dialog box, for Type, choose an option from the 
pop-up menu.   

3. To rename the file, for Create a copy named, type a name. 

 

4. Click Save.

Choose To

Copy of current file Duplicate the entire file, including the field definitions, 
layouts, scripts, page setup options, and data. Copying a 
file is useful before you make extensive changes. 

Compressed copy (smaller) Compress the entire file into less disk space by 
reclaiming unused space in the file. Compressing a file 
may take time, so it’s a good idea to compress a file only 
when you’re archiving it. 

Clone (no records) Make a copy that contains all the field definitions, 
layouts, scripts, and page setup options, but no data. 
Make a clone when you want a template of the file. 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E saving files

Options for saving a copy

Name of the new file
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Leaving FileMaker Pro
When you’re finished working in FileMaker Pro, choose Quit from the 
File menu. 

Important Always quit FileMaker Pro before you turn off your 
computer. 

Checking your spelling
You can use the installed spelling dictionaries to check the spelling in a 
file, all at once or as you type. FileMaker Pro compares your text with 
its main dictionary (which contains almost 100,000 words) and a user 
dictionary, in which you can store up to 32,000 unique terms. Each file 
can have its own user dictionary. This is useful when, for example, you 
have files that contain unique terms (like medical or legal terms).

You can check the spelling of a selected word or passage, all words in 
the current record or layout, or all words in the records most recently 
found (the current found set) or browsed in Browse mode.

When FileMaker Pro finds a word it doesn’t recognize, you can correct 
it, skip it, or add it to your user dictionary.

Note Before you begin, be sure the dictionaries currently selected are the 
ones you want to use. See “Working with spelling dictionaries” on page 
1-16.

Checking your spelling in a file
1. Display the layout or record, find the set of records, or select the text 

to check.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E closing database files
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2. Choose Spelling from the Edit menu, and then:

3. In the Spelling dialog box, make any changes.

  

To check the spelling of Choose

A selected word or passage Check Selection

Text in the current record Check Record

Field names and text on the current layout (you 
must be in Layout mode) 

Check Layout

The set of records most recently found or browsed Check All 

To Do this when you see a questionable word

Replace a misspelled 
word with one in the 
dictionary

Select a word from the list of suggestions, and then click 
Replace. (You can’t change a misspelled word in a restricted or 
password-protected file or field. In that case, click Next.) 

Revise a misspelled 
word that’s not in the 
dictionaries by typing in 
your own

For Word, retype the word. (Or use standard text-editing 
methods to replace only the portion to change.) Then click 
Check. When the word is spelled as you want, click Replace. 
(You can’t change a misspelled word in a restricted or 
password-protected file or field. In that case, click Next.)

Skip a word Click Skip. (FileMaker Pro skips every occurrence of the 
word.) 

Add a word to the user 
dictionary

Click Learn. (To add, remove, and change words in your user 
dictionary, see “Editing a spelling dictionary” on page 1-17.)

Suggestions for
replacement

Revise the word if the correct 
word isn’t in the list

Click to see the questionable
word in context

Word with questionable
spelling
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4. When all questionable words are resolved, click Done.

Checking your spelling as you type
As you type, FileMaker Pro can alert you to errors with either a flash in 
the menu bar, or a beep. 

Checking your spelling as you type is much slower than checking the 
entire file at one time. 

1. Choose Preferences from the Edit menu, and then choose Document.

2. In the Document Preferences dialog box, choose Spelling from the 
pop-up menu. Select how you want to be alerted and where you want 
the Spelling dialog box to appear.

  

3. Click Done.

When you’re alerted to a spelling error, you can do one of these:

1 Correct the last word typed. 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E checking spelling

Select how you want to be
alerted as you type

Have the Spelling dialog box
appear where you place it

Choose Spelling
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1 Choose Spelling from the Edit menu, and then choose Correct Word, before 
you press Tab or Enter. Use the Spelling dialog box to correct the word. 
(See “Checking your spelling” on page 1-13.)

Working with spelling dictionaries
When you check spelling, you can use the main dictionary and the user 
dictionary installed with FileMaker Pro, or you can use a user dictionary you 
created. 

The main dictionary is associated with all your FileMaker Pro files. User 
dictionaries work with specific files. After you select a user dictionary for a 
file, FileMaker Pro uses that dictionary until you select a different one.

Selecting a spelling dictionary
Before you can check spelling, select the spelling dictionaries to use. (If the 
dictionaries you want to use are already selected, you don’t need to reselect 
them.)

Select dictionaries when:

1 your spelling dictionaries are in a place other than the FileMaker Pro 
folder, the Claris folder, or the System Folder 

1 you want to make more than one spell-checking pass through a file using 
different dictionaries (for example, dictionaries of different languages)

1 you want to switch to a different dictionary (like one that contains special 
terms) after checking with the dictionary currently selected

 Choose FileMaker Help Index from the  or Help menu, and then type:

E checking spelling
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To select, ignore, or create a spelling dictionary:

1. Choose Spelling from the Edit menu, and then choose Select 
Dictionaries.

2. In the Select Dictionaries dialog box, choose an option.

  

Making changes to a user dictionary
You can edit, import text to, and export text from a user dictionary. 

Editing a spelling dictionary
Before you begin, be sure the dictionary to edit is selected. (See 
“Selecting a spelling dictionary” on page 1-16.)

1. Choose Spelling from the Edit menu, and then choose Edit User 
Dictionary.

To Do this

Select or switch a 
dictionary

For Select Dictionary Type, choose Main Dictionary or User Dictionary. If 
needed, locate the correct folder. Then select the dictionary name 
and click Select. 

Ignore your user 
dictionary

For Select Dictionary Type, choose User Dictionary, and then click None.

Create a user 
dictionary

For Select Dictionary Type, choose User Dictionary, and then click New. 
Type a unique, distinguishing name for the new user dictionary, and 
then click Save. 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E creating

Select the type of 
dictionary to use
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2. In the User Dictionary dialog box, make any changes, and then click 
OK.

  

Importing or exporting a spelling dictionary
Before you begin, make sure the currently installed dictionary is the one 
you want to import into or export from.

1. Choose Spelling from the Edit menu, and then choose Edit User 
Dictionary.

2. In the User Dictionary dialog box, click the Text File triangle, and then:

To Do this

Add a word For Entry, type the word, and then click Add.

Remove a word from the list Select the word, and then click Remove.

Change a word Remove the word from the list, type a replacement, and 
then click Add.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E editing

To Do this

Import a text file Click Import. (If necessary, locate the correct folder.) Then 
double-click the name of the file to import. (To cancel importing, 
press Command-period.)

Export a text file Click Export. (If necessary, choose a different folder.) Type a name 
for the file to export to, and then click Save. 

Words in dictionary

Currently installed 
user dictionary
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3. When importing or exporting is complete, click OK, and then click OK 
again.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E exporting, dictionaries
E importing data



Chapter 2:  Creating a database file

This chapter tells you how to design a database file:

1 to use by itself

1 to use as part of a relational database

This chapter also explains some limitations on options available when 
designing a file to use with FileMaker Pro Web Companion.

For information about creating a relational database, which includes 
more than one database file, see chapter 10, “Using data from related 
files.”

Important Before you read this chapter, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.”

Planning a database file
Plan a database before you create it to save time and effort later on. 
Although you can change the design later, the more you plan ahead, the 
fewer changes you’ll need to make. Whether you plan to publish your 
database on the World Wide Web or not, the concepts are the same.

Follow these general steps when you plan a database:

1. Decide which categories of information you work with, and plan a 
separate database file for each major category.

For example, for a small business, you might need one database file 
for products, one for customers, and another for employees.

2. Analyze your current information management system to determine 
the tasks you perform.

For example, do you print mailing labels and invoices? What reports 
do you produce? Are there new tasks you want to do?

3. Decide what data you want the file to contain, and plan the fields to 
hold the data.

For example, to print invoices, you need fields for a billing address, 
shipping address, quantity, product code, and so on, and calculated 
fields for subtotal, sales tax, shipping charge, and invoice total.

4. Determine relationships between your file and other files whose data 
you can use.
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For example, if data you want already exists in another file, you can 
use it in the current file by defining a relationship to the other file and 
then defining lookups or adding fields from that file on a layout of the 
current file.

5. Decide what layouts you need, and plan a separate layout for each 
task.

For example, plan layouts for data entry, order entry, printing mailing 
labels, printing form letters, and for each type of report you produce.

6. If others will use your database, think about who can use the file and 
which tasks they can perform.

If security is important to your data, you can restrict who can do 
which tasks by assigning passwords and access privileges to the file.

7. Put your ideas on paper, listing the files you need and the fields for 
each file. Also list the forms and reports you will generate from each 
file.
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After you have all the basic parts in place, you can begin creating your 
database, as described in the next section, “Defining database fields.” 
Start with a simple design and use it for a while. You can change it as 
needed.

Keep these points in mind as you plan database fields:

1 Use separate fields for first name and last name so you can search or 
sort records based on either.

1 Use separate fields for city, state, and postal code. If you combine 
them, you can’t sort records based on the individual fields.

1 Make a separate field for titles (to hold values like Dr., Mr., and Ms.).

Defining database fields
When you create a file, you begin by defining the database fields. To 
define a new field, give it a name, and then select options that determine 
how the field interprets, enters, calculates, stores, and displays data. All 
these characteristics make up the field definition. After you define fields, 
you can add, change, or delete field definitions as needed.

1. Create a file, or, in Browse or Layout mode, choose Define from the 
File menu and then choose Fields.

2. In the Define Fields dialog box, for Field Name, type a unique name 
for the field.

Don’t use the following symbols or words: , (comma), +, –, *, /, ̂ , &, 
=, ≠, >, <, ≤, ≥, (, ), ", :, ::, AND, OR, XOR, NOT, or a FileMaker Pro 
function name.   Don’t begin a field name to be used in a calculation 
formula with a period (.) or a number.

3. For Type, select a field type, and then click Create.

See “Assigning a field type” on page 2-5.
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4. Define options for the field.

5. Define the fields you want for the file, and then click Done.

When the file is new, you see the fields in Browse mode. Otherwise, you return to where you 
were before you defined fields.

If the field type is Do this

Text, number, date, 
time, or container

In the field definitions list, double-click the field name (or select 
the field, and then click Options), and then set entry options for 
the field. See “Choosing data entry options” on page 2-6.

Calculation In the Specify Calculation dialog box, define a formula for the 
field. See “Understanding formulas” on page 2-13.

Summary In the Options for Summary Field dialog box, select summary 
options. See “Defining summary fields” on page 2-23.

Global In the Global Field Options dialog box, select global options. 
See “Defining global fields” on page 2-9.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E adding new fields

Field names and definitions

Type a name for a new field

Select a field type

After you 
type a field 
name and 
select a field 
type, click 
Create

Choose the 
way fields are 
listed in the 
dialog box
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Assigning a field type
When you define a field, you must decide the kind of data it will contain 
and then select the appropriate field type. FileMaker Pro uses the field 
type to interpret the data when sorting and performing calculations. The 
following table explains each field type.

Select this 
field type If the field’s data will be

Text Up to 64,000 characters of letters, symbols, and numbers used as text. 
You can sort records based on a text field and use a text field in formulas 
for calculations and summary fields. Text fields are usually sorted 
alphabetically (from first character to last character in the alphabet, or last 
to first), starting with the first character in the field. For more 
information, see “Sorting records” on page 4-30.

Number Up to 255 characters of numbers or other characters, of which only the 
numbers are treated as numeric. You can sort records based on a number 
field and use number fields in formulas for calculations and summary 
fields. Number fields are sorted numerically (lowest to highest or highest 
to lowest), based on the numeric part of the data.

Date Dates only. A date field must include at least the day and month portion 
(dd and mm) of a date. If you enter no year, and have not typed a separator 
character for a year, FileMaker Pro enters the current year for you. You 
can sort records based on a date field and use date fields in formulas for 
calculation and summary fields. Date fields are sorted chronologically 
(from earliest to latest or latest to earliest).

Time Times only. A time field can contain only the hours, minutes, or seconds 
portion (hh, mm, and ss) of a time. You can sort records based on a time 
field and use time fields in formulas for calculation and summary fields. 
Time fields are sorted chronologically (from earliest to latest or latest to 
earliest).

Container A graphic, sound, or QuickTime movie. You enter data in a container 
field in different ways, depending on the type of data. Container fields 
can be used in calculation fields and summary fields. See “Working with 
container fields” on page 4-6.

Calculation The result of a calculation formula that uses field values from the current 
record or related records. The formula can use values of all field types. 
The result can be text, a number, date, time, or container. See 
“Understanding formulas” on page 2-13.

Summary A value that’s produced by summarizing field values from more than one 
record in the same file. See “Defining summary fields” on page 2-23.

Global One value to be used in all records of the file. A global field can be text, 
number, date, time, or container. Use the value of a global field in 
calculations and scripts. You can’t use a global field to find records. See 
“Defining global fields” on page 2-9.
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Keep these points in mind:

1 Because they often include non-numeric characters like hyphens or 
parentheses, define postal codes and telephone numbers as text fields, 
not number fields.

1 You can’t search or sort records based on container fields, but you 
can define text fields to describe or identify them. Then search and 
sort based on the description or identifying number of the field’s 
value.

1 You can change the way data is displayed in text, number, date, and 
time fields. See “Defining display formats for fields” on page 3-59.

1 The characters displayed for the decimal separator and thousands 
separator in number fields, and the part separators in date and time 
fields, and the order in which date and time parts appear depend on 
the system formats set for the file and the display format for the field. 
See appendix B, “Working with international files,” and “Defining 
display formats for fields” on page 3-59.

Choosing data entry options
For each text, number, date, time, and container field, you can set or 
change options to make entering data fast and accurate. You can have 
default data entered in the field and have the data checked against 
validation requirements set for the field.

1. Create a file, or choose Define from the File menu and then choose 
Fields.

2. In the Define Fields dialog box, double-click a field you want to set 
data entry options for.

3. In the Entry Options dialog box, choose the type of entry options to 
set from the pop-up menu (at the top of the dialog box). 

1 To have a default value automatically entered in the selected field 
for each record, choose Auto Enter.  

1 To have data in the field checked against validation requirements 
you set for the field in each record, choose Validation.

4. Define repetitions and storage options.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields, defining
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1 To make the field a repeating field, select Repeating field with a 
maximum of n repetitions, and then type the number of repetitions. 
(See “Defining repeating fields” on page 2-11.) To set options for 
indexing the field’s values, click Storage Options, and then select 
indexing options. You can also choose a language for indexing and 
sorting text fields. (See “Indexing fields” on page 2-12.)

5. Select options for automatically entering and validating data.

For To Do this 

Auto Enter Turn off automatically entered data Select Nothing.

Enter the date, time, or user name 
when the record was last created or 
changed

Choose an option from the pop-up 
menu.

Assign a unique, sequential number 
to the field in each record

Select Serial number, and then type a 
starting value (for example, 1001) 
and the number to increment by.

Enter the value from the previously 
accessed record

Select Value from previous record.

Enter data you specify Select Data, and then type the data 
you want, up to 255 characters.

Enter the result of a calculation in 
the field

Select Calculated value, and then 
define the formula. (See the note at 
the end of this section and 
“Understanding formulas” on page 
2-13.) 

Enter a value that’s copied from a 
field in the same or a different file

Select Looked-up value, and then 
define the lookup. (See “Defining 
lookups between files” on page 
10-11.)

Prevent users from changing an 
automatically entered value

Select Prohibit modification of value.

Validation Check that the data is a number, 
date, or time

Select Of type and then choose a type 
from the pop-up menu.

Check that the field is not empty, or 
that the value is unique or already 
existing in the file

Select Not empty, Unique, or Existing.

Check that the value is in the value 
list you specify

Select Member of value list, and then 
choose a value list from the pop-up 
menu, or define a value list. (See 
“Defining value lists” on page 3-75.)

Check that the value falls within the 
range you specify

Select In range, and then type a 
starting value and ending value for 
the range.
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Check that the value matches the 
result of a calculation

Select Validation by calculation, click 
Specify, and then define a formula. 
The result must be Boolean—“true” 
or “false,” “yes” or “no,” and so on. 
(See “Understanding formulas” on 
page 2-13.) The result is false when 
the result is 0 or null (empty); 
otherwise the result is true.

Prevent users from entering invalid 
data

Select Strict: Do not allow user to 
override validation.

Display a message you specify when 
the data doesn’t meet the validation 
requirements

Select Display custom message if 
validation fails, and then type a 
message (up to 255 characters).

For To Do this 

Set entry options for entering
default data in the field

Choose Auto Enter to 
have default data 
entered in the field

Set validation options
for the current field

Choose Validation to set 
validation options for the 
current field
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6. Click OK, and then click Done.

Keep these points in mind:

1 You can’t set FileMaker Pro to enter data automatically for 
calculation, summary, and global fields.

1 If you create or edit records using FileMaker Pro Web Companion, 
auto-entered data appears only after the record has been submitted 
from the browser software.

1 Select Calculated value to calculate a value only when a record is first 
created or when a value in a field the calculation refers to changes (as 
long as the field with the calculation doesn’t already contain a value). 
If necessary, you can enter a different value in the field (when Prohibit 
modification of field isn’t selected). However, when you want a 
calculated value that’s always up to date and which you can’t change 
by entering data in the field, define the field as a calculation field. See 
“Defining database fields” on page 2-3 and “Understanding 
formulas” on page 2-13.

1 When the data in a validated field doesn’t meet the validation 
requirements, users see a warning message when they try to move out 
of the current record. If Strict: Do not allow user to override validation is 
set for the field, users must correct the data before moving out of the 
record. You can use Display custom message if validation fails to give 
users the data requirements.

1 To save time during data entry and to validate fields, define value 
lists. Value lists aren’t attached to any field definition. You can 
format value lists to display in a pop-up list or menu, or as 
checkboxes or radio buttons. See “Defining value lists” on page 3-75.

Defining global fields
A global field contains one value that’s used for all records in a file. Use 
the value of a global field:

1 to declare variables in If, Else, End If, Loop, End Loop, and Exit 
Loop If script steps

 Choose FileMaker Help Index from the  or Help menu, and then type:

E data entry options



2-10 FileMaker Pro User’s Guide
1 for fields that rarely need to be updated. For example, use a global 
field to put your company logo (a graphic) and address (text fields) 
on several layouts. You can quickly update the field if needed without 
having to update each layout.

1 as a fixed value to be used in calculations in all records in a file

You can also use a global field in layouts and calculations and as 
repeating fields. You can’t use a global field for finding data.

1. Create a new file, or choose Define from the File menu and then 
choose Fields.

2. In the Define Fields dialog box, for Field Name, type a name for the 
field.

3. For Type, select Global, and then click Create.

4. In the Global Field Options dialog box, select options.

5. Click OK, and then click Done.

      

Note If you’re working with global fields in a shared file, see “Working 
with shared files” on page 7-6.

To Do this

Choose a data type for 
the field

For Data type, choose a type from the pop-up menu. (See 
“Assigning a field type” on page 2-5.)

Make the field 
repeating and set the 
number of repetitions

Select Repeating field with a maximum of n repetitions, and then 
type the number of repetitions. (See “Defining repeating fields” 
on page 2-11.)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E global fields

Choose a data type for the field
Click to make this a repeating field
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Defining repeating fields
A repeating field holds more than one value (up to 1000), each in a 
separate repetition (row) of a field of any type except summary. For 
example, use a repeating field to show all available tours for a cruise 
line.

You can use repeating fields for calculating values and finding and 
sorting records. FileMaker Pro includes all values in a repeating field for 
calculations, summaries, and find requests, even those that aren’t visible 
in the current layout. For sorting, FileMaker Pro uses only the first value 
in a repeating field.

You can make a calculated field repeating when you define a 
calculation. (See “Writing formulas for calculation fields” on page 
2-20.) You can make a global field repeating when you choose global 
field options. (See “Defining global fields” on page 2-9.)

To define a text, number, date, time, or container field to be repeating:

1. Create a file, or, in Browse or Layout mode, choose Define from the 
File menu and then choose Fields.

2. In the Define Fields dialog box, double-click the name of the field to 
be repeating.

3. In the Entry Options dialog box, select Repeating field with a maximum 
of n repetitions, and then type the number of repetitions you want.

4. Click OK, and then click Done.

To change the number of repetitions visible on a layout, see 
“Formatting repeating fields” on page 3-72.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E repeating fields

Each value in a repeating field 
is a single, separate value
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Indexing fields
FileMaker Pro indexes each value in fields used for these tasks (unless 
you deselect the automatic index option):

1 validating fields with unique or existing validation criteria

1 matching fields in a related or lookup file

1 matching fields in a master file (to find data in a field based on the 
relationship)

You can index all field types (except container, summary, or global) to 
improve performance for tasks like finding data. Indexing uses 
additional disk space and can slow performance of some operations, 
especially in large files.

1. Create a new file, or, in Browse or Layout mode, choose Define from 
the File menu and then choose Fields.

2. In the Define Fields dialog box, double-click the name of the field to 
index.

3. In the Entry Options dialog box, click Storage Options.

4. In the Storage Options dialog box, for Indexing, click On. If you are 
working with a text field, choose a language from the pop-up menu.

In most cases, keep Automatically turn indexing on if needed selected. 
Otherwise, tasks like finding take much longer on unindexed fields.

 

Choose the 
language to index 
and sort values by

Index each value in
the current field

Select this to speed up
finding on unindexed fields
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5. Click OK twice, and then click Done.

Keep these points in mind:

1 You can set indexing options for a calculated field when you define 
the calculation. (See “Writing formulas for calculation fields” on 
page 2-20.)

1 To use the index for data entry, see “Working with the index” on page 
4-10.

Understanding formulas
You write a formula (a specific operation on one or more values in the 
database) for a calculation or summary field. For example, suppose your 
file contains two number fields—Unit Price and Quantity—and one 
calculation field, Subtotal. You want to calculate a value for Subtotal in 
each record, so you write the calculation formula:

Unit Price * Quantity

for the Subtotal field. Then, each time you type values in Unit Price and 
Quantity, the formula multiplies those values and displays the result in 
Subtotal.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E index

Contains a formula that multiplies the value in 
Unit Price by the value in Quantity

Contains a formula that multiplies the value in 
Tax Rate by the value in Subtotal and adds 
the result to Subtotal



2-14 FileMaker Pro User’s Guide
Use a calculation field to calculate a result from values in other fields in 
the current record (or from other related records, using a relationship). 
Use a summary field to produce a result using values in more than one 
record in the database.

The values you calculate can come from all field types. You can produce 
different values in a summary field, depending on whether you’re 
browsing all or some of the records, whether records have been sorted, 
and where you place the summary field on the layout.

The formula’s result can be text, number, date, time, or container. The 
result of a calculation depends on the field type of the values it calculates 
and whether the field type is calculation or summary.

A formula contains one or more parts arranged in a particular order 
(called syntax) that determines the values to use and the operations to 
perform to produce the result you want. The following sections explain 
each formula part and its syntax.

Important In the United States, commas act as list separators in 
functions, formulas, and calculations. In other countries, semicolons 
might be used as list separators. The separator that is used depends on 
the operating system your computer uses, as well as the one used when 
the file was created.

Calculation fields Summary fields
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Expressions
An expression is a value or any computation that produces a value. 
Expressions can be combined to produce other expressions.

Constants
A constant is a fixed value that’s part of the formula and doesn’t change 
from record to record. A constant can be text, or a number, date, or time, 
like the text value “Europe” or the numeric value 0.05.

FileMaker Pro interprets the type of data of a constant value according 
to the way you type the constant in a formula. Be sure to type each 
constant in a consistent format. (Quotation marks indicate a text 
expression.) 

Type of expression Example

Text constant "London"

Number constant 2.15

Field reference TaxRate

Function Length(ShipToAddress)

Combination of expressions ((Total–Discount)*TaxRate)/100

For this 
type of 
data Do this when you type a constant Examples

Text Enclose the text in quotation marks (") "Montréal"

"514 555 1212"

Number Don’t include thousand separators or currency 
symbols

123

1234.56

Date Use the value as a parameter of the Date function 
or TextToDate function. See appendix C, 
“Summary of functions.”

Date(2,1,1998)

TextToDate("03/04/199
8")

Time Use the value as a parameter of the Time 
function or TextToTime function. See appendix 
C, “Summary of functions.”

Time(4,14,32)

TextToTime("02:47:35"
)
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Field references
A field reference is a field name that acts as a placeholder for the field’s value. 
When FileMaker Pro evaluates the formula in the current record, the value in 
the field represented by the field reference is used in the calculation. 
(Quotation marks indicate a text expression.)

Operators
You combine expressions using operators, symbols that determine which 
operation to perform on the expressions. You place operators between the 
expressions you want to perform the operation on, as in:

Subtotal + Tax

Each operator has a precedence, which determines the order in which 
calculations are performed in a formula containing more than one operator. 
FileMaker Pro evaluates operators from left to right and performs 
multiplication and division before addition and subtraction. You can change 
the precedence by enclosing the expression you want calculated first in 
parentheses.

This expression Returns

Invoice Total*0.075 7.5 when the value in the Invoice Total field is 
100.

First Name & " " & Last Name "John Jones" when the value in the First Name 
field is “John” and the value in the Last Name field 
is “Jones”.

Relationship Name::Invoice 
Total*0.075

7.5 when the value in the Invoice Total field is 
100. The Invoice Total field is located in a related 
database.

The syntax is Relationship name::Field name

This expression Returns

2+3*2 8

(2+3)*2 10

 Choose FileMaker Help Index from the  or Help menu, and then type:

E operators
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Mathematical operators

Use the following mathematical operators with numeric expressions.

Comparison operators 

Comparison operators compare two expressions and return either true 
or false (sometimes called a Boolean expression). Arithmetically, a 
result of true equals 1 and a result of false equals 0.

Symbol Name Definition Examples

+ Addition Adds two values 2+2

Subtotal+Sales Tax

– Subtraction or
Negation

Subtracts the second 
value from the first, or 
changes the sign to + or 
–

2–2

InvoiceTotal–Discount

–2

* Multiplication Multiplies each value Subtotal*Sales Tax

DaysLate*.01*LeasePayment

/ Division Divides the first value 
by the second

Kilometers Driven/Liters

Inches/12

^ Power of, or 
Exponentiation

Raises the first value to 
the power of the second 
value

A^2+B^2 returns (A2 + B2)

Radius^3 returns (Radius3)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E mathematical operators

Symbol Name Definition Examples

= Equal to True when both items 
are equal

38=39 returns false

38=38 returns true

≠ or <> Not equal to True when the items are 
not equal

38≠39 returns true

38≠38 returns false

> Greater than True when the value on 
the left exceeds the 
value on the right

5>6 returns false

19>1 returns true

< Less than True when the value on 
the left is less than the 
value on the right

5<6 returns true

19<1 returns false
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Logical operators
When you want FileMaker Pro to perform a calculation based on two or 
more conditions, use logical operators to describe such conditions.

≥ or >= Greater than or 
equal to

True when the value on 
the left is greater than or 
equal to the value on the 
right

5≥6 returns false

5≥5 returns true

≤ or <= Less than or 
equal to

True when the value on 
the left is less than or 
equal to the value on the 
right

5≤6 returns true

19≤18 returns false

 Choose FileMaker Help Index from the  or Help menu, and then type:

E comparison operators

Operator Definition Example

AND True only when both of two values are 
true. The result is:

1 true when true AND true 
1 false when false AND true 
1 false when false AND false 

InvoiceTotal<100 AND 
SalesTax<6

OR True when either of two values is true. The 
result is:

1 true when true OR true
1 true when true OR false 
1 false when false OR false 

InvoiceTotal<100 OR
SalesTax<6

XOR True when either, but not both, of two 
values is true. The result is:

1 false when true AND true 
1 true when false AND true 
1 false when false AND false 

InvoiceTotal<100 XOR 
SalesTax<6

NOT Changes a value within parentheses from 
false to true or from true to false. The 
result is:

1 false when NOT(true)
1 true when NOT(false)

NOT InvoiceTotal>1000

Symbol Name Definition Examples
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Use AND, OR, or XOR to combine two expressions; use NOT with only 
one expression.

Text operators

Use the following text operators with text expressions. (Double quotation marks indicate a 
text expression.)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E logical operators

Symbol Name Definition Examples

& Concatenation Appends the text string on the 
right to the end of the text string 
on the left

"XXX" & "ZZZZZ" returns 
"XXXZZZZZ"

" " Text constant Marks the beginning and the 
end of a text constant. Quotation 
marks without text between 
them indicate a blank space. If 
you enter text into a formula 
without using quotation marks, 
FileMaker Pro interprets the 
text as a field name or function 
name. To put a quotation mark 
in a text constant, precede it 
with another quotation mark.

"Sydney, NSW" returns 
Sydney, NSW

"" returns an empty (null) 
value

"The report said 
""Confidential"" on 
the top" returns The report 
said "Confidential" on the top

¶ Return marker Inserts a paragraph return in a 
text constant

"M.T.N.Trek¶Sporting¶
Equipment" returns

M.T.N. Trek
Sporting
Equipment

(The ¶ symbol must be 
enclosed within the quotation 
marks of the text constant)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text operators
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Stored and unstored calculation results
You can have FileMaker Pro:

1 perform a calculation whenever the data that the calculation is based 
on changes, and store the result in the calculated field (a stored result)

1 perform a calculation and display the result only when you need to 
use the data—for example, to browse or print records—(an unstored, 
or virtual, result) 

In most cases, FileMaker Pro makes a field stored when you define the 
field. You can change the storage type to unstored. 

Keep these points in mind:

1 FileMaker Pro makes a calculated field unstored when its formula 
refers to a global field, an unstored calculated field, a related field, or 
a calculation that includes a summary field.

1 Stored results use more disk space. Unstored results take more time 
to calculate.

Functions
A function is a predefined, named formula that performs a specific 
calculation and returns a single, specific value. You type only the 
function, and FileMaker Pro performs the calculation it represents. You 
can use functions by themselves or combine them with other functions 
or expressions. For information about specific functions in 
FileMaker Pro, see appendix C, “Summary of functions.” 

Writing formulas for calculation fields
1. Create a file, or choose Define from the File menu and then choose 

Fields.

2. In the Define Fields dialog box, for Field Name, type a name for the 
field.

3. For Type, select Calculation, and then click Create.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E calculation fields

 Choose FileMaker Help Index from the  or Help menu, and then type:

E functions, using
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4. In the Specify Calculation dialog box, define the formula. 

To Do this

Add a field 
reference

In the formula box, click where you want the field reference to 
appear. In the list of field names, double-click a field name.

Add a 
mathematical or 
text operator

In the formula box, click where you want the operator to appear. In 
the keypad, click an operator. (Quotation marks and parentheses 
are copied to the formula as a pair, with the insertion point blinking 
in the middle).

Add a comparison 
or logical operator

In the formula box, click where you want the operator to appear. 
For Operators, choose an operator from the list.

Add a constant 
value

In the formula box, type the value. (See “Constants” on page 2-15.)

Add a function In the formula box, click where you want the function to appear. 
From the functions list, double-click a function. (To see a category 
of functions, for View, choose a category.) In the formula box, 
replace the placeholder parameter with the value or expression you 
want.

Calculate only if at least one
field in the formula has a value

Choose field references

Formula box
Select 
operators

Select 
functions

Choose a formula result type

Choose 
indexing and 
result storage 
options 

Make a field repeating

Relationship pop-up menu
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5. Select calculation options for the field.

6. To select indexing and storage type options for the field, click Storage 
Options, select options, and then click OK.

7. Click OK, and then click Done. 

To Do this

Make the calculated 
field repeating

Click Repeating field with a maximum of n values, and then type the 
maximum number (up to 1000) of repetitions you want.

Set the field type of the 
result

For Calculation result is <value>, choose a field type for the result. 
Be sure to choose the correct type for the result you want.

See fields from a 
different file

Choose a filename from the relationship pop-up menu. (For 
more information about relationships, see “Understanding 
relationships” on page 10-9.)

Have FileMaker Pro 
perform a calculation 
even when all 
referenced fields have 
no value (are empty)

Deselect Do not evaluate if all referenced fields are empty. (Do this 
when you always want FileMaker Pro to calculate a result, even 
if the field is empty or has never been modified.) Select this 
option when you don’t want FileMaker Pro to evaluate the 
calculation until one of the referenced fields has a value (so you 
don’t display zero as a result).

To Do this

Make the calculation 
result unstored

Select Do not store calculation results—calculate only when needed. 
To store the result in the field, deselect the option.

Index the result For Indexing, select On. To remove indexing, select Off. (See 
“Indexing fields” on page 2-12.)

Specify the language 
for finding and sorting 
indexed values

Choose the language from the pop-up menu. (See “Indexing 
fields” on page 2-12.)

Select this when you
want an unstored result
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Keep these points in mind:

1 When you type values, expressions, functions, and parameters, the 
letters can be uppercase or lowercase. FileMaker Pro doesn’t 
consider case for calculation purposes.

1 When you use a repeating field in a calculation, the other parts of the 
formula must be compatible with that field.

Defining summary fields
Important  The value in a summary field depends on the layout part in 
which you place the summary field, so you must know about parts and 
summary parts to get the results you want. Before you define a summary 
field, see “Working with layout parts” on page 3-24 and “About 
summary layout parts” on page 3-29.

1. Create a new file, or choose Define from the File menu and then 
choose Fields.

2. In the Define Fields dialog box, for Field Name, type a name for the 
field.

3. For Type, select Summary, and then click Create.

4. In the Options for Summary Field dialog box, select the type of 
summary to perform, and then select the name of the field that 
contains the values to summarize.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E calculation fields

To summarize values in a field in the found set 
of records by Select 

Calculating the total of values in the field Total of

Calculating the average of values in the field Average of

Counting the number of records that contain a value for the field Count of

Finding the lowest number, or the earliest date or time, for a field Minimum

Finding the highest number, or the latest date or time, for a field Maximum

Calculating the standard deviation from the mean of the values in 
a field. (The formula is n-1 weighted, following the normal 
standard deviation. For population standard deviation, see step 5.)

Standard Deviation of

Calculating the ratio of the value in the field to the total of all the 
values in that field. (For example, find what fraction of total sales 
can be attributed to each individual sales person.)

Fraction of Total of
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5. If you want, select a summary option, if applicable to the summary 
type.

  

6. Click OK, and then click Done.

For this summary 
type To Select

Total of Show the cumulative total for the 
current and all previous records

Running total

Average of Determine the average in one field 
based on a value in another field that’s 
used as a weight factor

Weighted average. In the 
list of fields that 
appears, select a field 
name for the averaged 
values.

Count of Show the cumulative count of the 
current and all previous records

Running count

Standard Deviation 
of

Calculate population standard 
deviation, where the formula is 
n-weighted

By population

Fraction of Total of Define a subset of the group to sort by Subtotaled. In the list of 
fields that appears, 
select a field name for 
the subtotaled values.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E summary fields

Choose a formula Choose a field 
for the formula 
to operate on

Set an option for
the formula type



Creating a database file 2-25
Changing field definitions
Important Keep the following in mind:

1 Deleting a field from a file in the Define Fields dialog box 
permanently and irretrievably deletes the field definition and all the 
data in that field in all your records. Before you delete a field from a 
file, be sure you don’t need any data the field contains. To delete a 
field from only a layout, see “Deleting a field from a layout” on page 
3-59.

1 When you change the definition of a field that contains data, the data 
in that field could be affected. In addition, changing the field type to 
container, calculation, summary, or global erases data permanently 
and irretrievably.

1. Open the file you want to change, and choose Define from the File 
menu and then choose Fields.

2. In the Define Fields dialog box, make your changes.

To Do this

Change a field 
name

In the field definitions list, select the field to change. For Field Name, 
type or paste the new name, and then click Save. FileMaker Pro also 
changes the field name in layouts and field references in formulas.

Duplicate a field 
definition

In the field definitions list, select the field to duplicate, and then 
click Duplicate. The new field appears at the end of the list with copy 
added to the name. You can change the field name.

Change the field 
type

In the field definitions list, select the field, select a field type, and 
then click Save. (See “Assigning a field type” on page 2-5.)

Change data entry 
options

In the field definitions list, double-click the field, and then make 
your changes. (See “Choosing data entry options” on page 2-6.)

Change a formula In the field definitions list, double-click the field, and then make 
your changes. Once you exit the Define Fields dialog box, 
FileMaker Pro recalculates the value for every record in the 
database.

Reorder field 
definitions

For View by, choose an option from the pop-up menu. To define a 
custom order, use the double-arrow pointer to the left of a field 
definition to drag an item to another location on the list. 
(FileMaker Pro uses the order for all dialog boxes and when it 
creates Standard and Single-page form layouts.) Reordering field 
definitions does not affect existing layouts.

Delete a field from 
the file (and from 
all layouts that 
contain the field)

In the field definitions list, click the field, click Delete, and then click 
Delete again.
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3. Click Done.

Note You can’t delete a field that’s used in a formula. You must delete 
the calculation field or remove the field reference in the formula before 
you delete the field. You also can’t delete a field used in a calculation 
within a script or a field used in a relationship definition.

If a field is placed on a layout in a related database, and that field is later 
deleted, a placeholder for the deleted field remains in the related 
database. The placeholder contains the text ::<Field Missing>.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E field definitions



Chapter 3:  Laying out and arranging information

This chapter tells you how to create, edit, arrange, and format layouts to 
bring together information and graphic elements for display or printing. 
Layouts can be displayed on one computer or on a network of 
computers.

Important Before you read this chapter, you need to know how to design 
a database file, as explained in chapter 2, “Creating a database file.” In 
addition, be sure you know how to use FileMaker Pro Help, as explained 
in the preface, “Getting help.”

Understanding layouts
A FileMaker Pro layout presents data contained in a database. Layouts 
determine the appearance of data and organize it for viewing, reporting, 
finding, or data entry. A layout does not store data.

Use a layout to selectively display fields in a file. You can have more 
than one layout for a file (for example, design separate layouts for 
entering data, summary reporting, printing mailing labels, or publishing 
a database on the Web using FileMaker Pro Web Companion). You can 
have as many layouts for each file as disk space or maximum file size 
allows. You can change a layout’s design without affecting the data or 
other layouts for the file. When you change data in a field on a layout, 
the changes are reflected in the same field on other layouts for the 
database.
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In a layout you: 

1 add, arrange, and format the fields you want to use

1 create summaries of data you want summarized (like a grand total)

1 specify how to print records 

1 add graphics and text, to add emphasis and interest

Mailing labels layoutList report layout

Form letter layoutData entry form layout
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Note Layouts used with FileMaker Pro Web Companion Instant Web 
Publishing do not display graphics or text objects when viewed on the 
Web. You can create custom HTML pages that include graphics and text 
objects when you use FileMaker Pro Web Companion Custom Web 
Publishing. For more information, see chapter 11, “Publishing files on 
the Web.”

 

Graphic objects: Use lines, rectangles, rounded
rectangles, ovals, and graphics anywhere
on a layout to add interest and emphasis

Parts: Use headers, footers,
the body, and summaries to

divide a layout into special
purpose areas

Text: Use for titles,
column headings, field

labels, instructions,
and form letters

Fields: Use for entering
and displaying data

The page: The chosen printer, current
page setup, and layout type determine

how information looks on the printed page
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You make changes to a layout by using the tools available in Layout 
mode.

 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layouts, managing

Layout pop-up menu

Book

Status area
Zoom controls

Status area control

Part label control

Tools

Mode pop-up menu

Fill, pen, and line
width controls
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Working with predefined layout types
FileMaker Pro creates the first layout, a Standard layout, when you 
finish defining fields for a new file. A Standard layout contains all the 
fields in the database file. It appears in Browse mode, ready for you to 
enter data.

  

In addition to this layout, FileMaker Pro includes other predefined 
layout types. Use them for other purposes, like displaying and printing 
data as a columnar report or on mailing labels. You can use the 
predefined layout types as they are, or change them to suit your needs.

Field labels

Fields you defined, in the order they
appear in the Define Fields dialog box
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To use a predefined layout type, choose New Layout from the Mode 
menu, and then select a layout type. To change the layout, use the tools 
and commands in Layout mode to tailor the layout for your needs.

FileMaker Pro considers the printer and page setup information when it 
displays boundaries and measurements on the layout. When you need to 
fit something on the page in a certain way, such as a layout to print data 
on preprinted forms, first use the Chooser to choose your printer. Then 
select options in the Page Setup dialog box.

Use this layout type To display

Standard All the fields in the database file, with field labels, on separate 
lines in the viewing order set in the Define Fields dialog box. 
You see one record per screen. The layout includes a body and 
a blank header and footer.

Columnar report The fields you want, in columns from left to right, with a 
header that includes field labels as column headings. If all 
fields don’t fit across the body, FileMaker Pro wraps them to 
the next line. You see many records per screen. This layout 
includes a blank footer.

Extended columnar The fields you want (in columns, with a header that includes 
field labels) without wrapping fields to the next line. You can 
adjust the field size to see a record on a single line. You see 
many records per screen. This layout includes a blank footer.

Single-page form All the fields in the database file, with field labels, on separate 
lines in the viewing order set in the Define Fields dialog box. 
It’s like a Standard layout, but without a header or footer.

Labels The fields you want, in the arrangement you choose to print on 
mailing label stock.

Envelope The fields you want, in the arrangement you choose to print on 
a standard business envelope.

Blank The fields you want. A blank layout includes a blank header, 
body, and footer.
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Keep these points in mind:

1 To see how a layout displays information on the screen, choose 
Browse from the Mode menu. To see how a layout will print, choose 
Preview from the Mode menu.

1 You can display a specified layout every time you open a document. 
See “Setting document preferences” on page 9-7.

Using Standard, Single-page form, and Blank layouts 
Standard, Single-page form, and Blank layouts are good for browsing 
and data entry. You can view or add records one by one, with or without 
headers and footers. With a Blank layout, you build a custom browse or 
entry screen.

The Standard layout is a good choice for use with FileMaker Pro Web 
Companion Instant Web Publishing. Text styles and graphics do not 
display when you publish a database using Instant Web Publishing, so a 
basic layout – such as Standard, Single-page form, with headers and 
footers deleted if you like – is all that is necessary. For more information 
see chapter 11, “Publishing files on the Web.”

 Choose FileMaker Help Index from the  or Help menu, and then type:

E predefined layouts
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A Standard layout contains all the database fields in the body of the 
layout, in the viewing order set in the Define Fields dialog box. You see 
the field names as field labels to the left of the fields, and a blank header 
and footer. A Single-page form layout looks like a Standard layout, but 
it doesn’t have a header and a footer, and it’s vertically the size of one 
page (although you can resize it if you like). A Blank layout contains a 
blank header, body, and footer. You add the fields for a Blank layout. 

  

 Creating Standard, Single-page form, and Blank layouts
1. In Layout mode, choose New Layout from the Mode menu. 

2. In the New Layout dialog box, for Type, select Standard, Single-page 
form, or Blank. 

Standard layout

Single-page form layout

Blank layout
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3. Select other options, and then click OK.

 

4. To enhance or modify the layout, see the appropriate sections later in 
this chapter.

Using Columnar report and Extended columnar layouts
Use the Columnar report and Extended columnar layouts for reporting, 
printing, and viewing more than one record at a time in Browse mode.

A Columnar report layout displays and prints fields in columns. Fields 
are displayed from left to right across the body, in the order you specify. 
Fields that don’t fit wrap to multiple lines. Field names appear in the 
header as column headings. If the fields wrap to more than one line, 
column headings are stacked. The footer is blank. 

To Do this

Give the layout a 
different name

For Layout Name, type a name.

Include or exclude 
the layout in the 
layout pop-up 
menu

To include the layout, select Include in layouts menu. To exclude the 
layout, deselect this option. (For example, you might exclude 
layouts when you want to give users access only to a particular 
layout.)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E blank layout
E single-page form layout
E standard layout

You can rename the layout

Select the type of layout to
create

Include the layout in the
layout pop-up menu
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An Extended columnar layout displays all fields on one line across the 
page. You see each record in one row across the layout, with no 
wrapping fields or stacked headings. Use an Extended columnar layout 
for browsing; any objects that extend beyond the right edge of the page 
won’t print. You can also use this layout if the selected fields don’t fit 
across the page and you intend to make some fields smaller to fit the data 
on the page.

   

Creating Columnar report and Extended columnar layouts
1. In Layout mode, choose New Layout from the Mode menu. 

2. In the New Layout dialog box, for Type, select Columnar report or 
Extended columnar.

3. Select other options, and then click OK.

To Do this

Give the layout a 
different name

For Layout Name, type a name.

Include or exclude 
the layout in the 
layout pop-up 
menu

To include the layout, select Include in layouts menu. To exclude the 
layout, deselect this option. (For example, you might exclude 
layouts when you want to give users access only to a particular 
layout.)

Columnar 
report layout

Extended 
columnar 
layout
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4. In the Specify Field Order dialog box, choose fields for the layout, 
and then click OK.

   

5.    To enhance or modify the layout, see the appropriate sections later 
in this chapter.

Using Labels layouts
To set up a Labels layout, you can:

1 choose from many preset label sizes. Match the number on your label 
stock with an option in the label measurements list in the Label Setup 
dialog box. When you choose a label type, FileMaker Pro prepares a 
layout based on the preset dimensions.

1 specify your own label dimensions. Measure your labels and match 
them to the dimensions of a preset label type. If you use label stock 
that doesn’t match a label type, set custom measurements for your 
labels.

Important Use a Labels layout only to arrange and print data in a format 
suitable for labels. Labels layouts do not use fields, they use a special 
format of text surrounded by angle brackets (<< >>). Because of this, 
you can’t add data to a database file using a Labels layout. To add data, 
use a different layout type.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E columnar report layout
E extended columnar layout

Click to remove all 
fields from the list

Double-click the fields you
want in the layout, in the order

you want them to appear

Double-click a field 
name to remove it
Click to include all 
fields

Drag the double arrows 
to reorder fields

Click to move a 
selected field

Relationship pop-up menu
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For all labels layouts, you specify the data to print on each label. For a 
custom labels layout, specify the number of labels across the page and 
the label dimensions. FileMaker Pro then divides the body of the layout 
into the number of labels across the page. The leftmost label is a sample 
of a single label on a layout, and the rest of the labels across the page are 
dimmed.

   

Setting up to print on labels
Before you set up a Labels layout, select a printer and set up the page for 
the size of your label stock.

1 If you print on a laser or ink jet printer, set the paper size to match 
your sheet of labels.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E labels layout

The sample label contains
the fields you specify in the

Specify Layout Contents
dialog box

The dotted vertical line shows where 
the next label across starts
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1 If you use continuous-feed stock (like tractor-feed labels) and a dot 
matrix printer, create a custom paper size equal to the height of one 
label. Use a custom paper size to minimize the back-and-forth 
movement of the platen and save label paper.

Keep these points in mind:

1 Depending on the printer and version of the system software you use, 
the Page Setup dialog box might contain different options. See your 
printer manual.

1 To make sure the printer uses the full paper height for each label when 
you’re using a dot-matrix printer, select No Gaps Between Pages. 

1 If you change the dimensions of a standard page size in the Page 
Setup dialog box and you’re using a dot-matrix printer, change the 
name to recognize the dimensions as custom. To restore the preset 
size, click Restore.

Creating a Labels layout
1. In Layout mode, choose New Layout from the Mode menu. 

2. In the New Layout dialog box, for Type, select Labels.

3. Select other options, and then click OK.

To Do this

Select the printer Choose Chooser from the Apple menu, and then select a printer.

Set a paper size for 
a laser or ink jet 
printer

Choose Page Setup from the File menu. Select the size of the 
mailing label sheets you plan to use (usually US Letter in the U.S. 
and A4 elsewhere), and then click OK.

Create a custom 
size for a dot-matrix 
printer

Choose Page Setup from the File menu. Select a Paper option you 
rarely use. At the Edit Paper Sizes options, for Name, type a name, 
type values for Width (the width of a sheet of labels) and Height (the 
height of one label, up to 36 inches), and then click Save. Select No 
Gaps Between Pages, and then click OK.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E printing, labels

To Do this

Give the layout a 
different name

For Layout Name, type a name.
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4. In the Label Setup dialog box, select options, and then click OK.

5. In the Specify Layout Contents dialog box, select and arrange fields 
for the labels, and then click OK.

Include or exclude 
the layout in the 
layout pop-up 
menu

To include the layout, select Include in layouts menu. To exclude the 
layout, deselect this option. (For example, you might exclude 
layouts when you want to give users access only to a particular 
layout.)

To Select

Use preset label 
dimensions

Use label measurements for and then choose a label option.

Create custom 
measurements

Use custom measurements, and then type values for Labels across the 
page, Width, and Height. See “Creating custom labels” on page 3-16.

To Do this

Select fields for the labels In the fields list, double-click the fields you want, in the 
order you want them to appear.

Place a field on a new line Press Return at the end of the previous line.

Display a punctuation mark 
(like a comma) between field 
values

For Layout contents, set the insertion point before or after 
the << or >> characters around a field name, and then 
click a punctuation button.

Display a space between field 
values

For Layout contents, click between field names where 
you want a space, and then press the Space bar.

To Do this

Width is the distance from
the left edge of one label to

the left edge of the next label

Height is the distance
from the top edge of the
first label to the top edge

of the next label

Select preset labels or
custom measurements
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6. In the layout, adjust or delete the header, if necessary.

See “Resizing parts” and “Deleting layout parts” on page 3-36.

7. Adjust the margins, if necessary. 

See “Setting margins for labels” on page 3-16.

8. To enhance or modify the layout, see the appropriate sections later in 
this chapter.

Note Depending on the labels you choose, the layout may contain a 

Remove a field name from the 
layout contents

For Layout contents, select the field name and << and >> 
characters, and then press Delete.

Remove all field names and 
characters from the layout 
contents

Click Clear All.

If you’re using Do this

A laser or ink jet printer Set the header to the top of the first row of labels. The 
layout header compensates for the nonprintable area.

If the labels are small, try setting the header to the top of 
the second row of labels. FileMaker Pro won’t print on 
the first row of labels, but it prints in the correct position 
on subsequent labels.

A dot matrix printer Delete the header, if there is one. Click the part label, and 
then press Delete.

To Do this

Click to add 
punctuation 
characters

Relationship pop-up menu

Fields list

Field names arranged in a label
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blank header. If the first label starts at the top edge of the paper, set the header 
height to the height of the label so that printing starts on the second row of 
labels on the page.

Creating custom labels
If you don’t see the size of your labels in the pop-up menu in the Label Setup 
dialog box, try to match your label dimensions with a preset type. To do this, 
add the space between labels to the label width and height to determine the 
horizontal and vertical pitch (the width of the left edge of a label to the left 
edge of the next, and the length of the top of one label to the top of the next).

Setting margins for labels
You can set margins that reflect the width of labels you’re printing on. If you 
set a top margin, you don’t also need a header on your layout.

1. In Layout mode, choose Layout Setup from the Mode menu.

2. In the Layout Setup dialog box, select Fixed page margins, and then type 
values for each margin.

3. Click OK.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E labels layout

 Choose FileMaker Help Index from the  or Help menu, and then type:

E labels layout

Side margin

Top margin

Label width

Horizontal pitch

Label height

Vertical pitch
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Turn page margins on to see how your page will print.  For more 
information about setting margins and printing, see “Setting margins” 
on page 6-4.

Printing labels
Before printing on label stock, practice printing on regular paper. If 
you’re having trouble with alignment, try adjusting the header size, 
margins, or paper size. 

You can also try the following tips for specific printer problems.

For more information about printing, see “Previewing before printing” 
on page 6-11 and “Printing” on page 6-12.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E printing, labels

For this printer Select

Laser or ink jet printer Larger Print Area after clicking Options in the Page Setup dialog box. 
See “Printing” on page 6-12.

Dot matrix printer Enable Print Spooling in the Print dialog box to minimize the rollback 
of the platen.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E printing, labels
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Using Envelope layouts
The Envelope layout arranges fields for printing on standard business 
envelopes. It includes a header.

   

Important Use an Envelope layout only to arrange and print data in a 
format suitable for envelopes. You can’t add data to a database file using 
an Envelope layout. To add data, use a different layout type.

Setting up to print on envelopes
Before you create an envelope layout, do the following:

1 Choose the printer (see “Setting up to print on labels” on page 3-12).

1 In the Page Setup dialog box, select US Letter (for U.S., or A4 for 
elsewhere). Don’t choose an Envelope paper size. 

1 If you feed the envelopes into the printer short-side first, choose a 
landscape (horizontal) paper orientation. If you feed the envelopes 
into the printer long-side first, choose a portrait (vertical) orientation.

Creating an Envelope layout
1. In Layout mode, choose New Layout from the Mode menu.

2. In the New Layout dialog box, for Type, select Envelope.
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3. Select other options, and then click OK.

4. In the Specify Layout Contents dialog box, select and arrange fields 
for the envelopes, and then click OK.

 

To Do this

Give the layout a different name For Layout Name, type a name.

Include or exclude the layout in 
the layout pop-up menu

To include the layout, select Include in layouts menu. To 
exclude the layout, deselect this option. (For example, 
you might exclude layouts when you want to give 
users access only to a particular layout.)

To Do this

Select fields for the envelopes In the fields list, double-click the fields you want, in the 
order you want them to appear.

Place a field on a new line Press Return at the end of the previous line.

Display a character (like a 
comma) between field values

For Layout contents, set the insertion point before or after 
the << or >> characters around a field name, and then 
click a character button.

Display a space between field 
values

For Layout contents, click between field names where 
you want a space, and then press the Space bar.

Remove a field name from the 
layout contents

For Layout contents, select the field name and << and >> 
characters, and then press Delete.

Remove all field names and 
characters from the layout 
contents

Click Clear All.

Fields list

Relationship pop-up menu

Field names arranged
in an envelope

Click to add 
punctuation 
characters 
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5.   To enhance or modify the layout, see the appropriate sections later in 
this chapter.

Note  Depending on the printer you use, you might not need the header. 

Arranging records in columns
Instead of using a Columnar report or Extended columnar layout, you 
can set columns for a layout. For example, print phone directories with 
the records in several columns. Print records:

1 down the page (column by column), for reports like directories, 
where you read from top to bottom, column by column

1 across the page (row by row), for reports like mailing labels, to use 
the fewest number of rows and conserve label stock

If you Do this

Manually feed envelopes into a 
center-feed printer

Keep the header and adjust it, as necessary, to 
match the printing to the envelope size.

Manually feed envelopes into a right 
edge-feed printer

Keep the header and adjust it, as necessary, to 
match the printing to the envelope size. (A good 
rule of thumb for the header size is to subtract the 
envelope height from 8.5 inches.)

Manually feed envelopes into a left 
edge-feed printer

Delete the header, and insert a footer. Adjust the 
footer, as necessary, to match the printing to the 
envelope size.

Use a laser or ink jet printer that 
automatically feeds envelopes

Choose Page Setup from the File menu, and then 
select No. 10 Envelope paper size. Customize the 
Envelope layout, and then delete the header.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E envelope layout

Each block is a record

Down first

Across first
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It’s easiest to start with a Blank layout or a layout with no objects in the 
body. Before you set up columns, choose the printer to use and set the 
page setup options you want. 

To set columns in a layout:

1. In Layout mode, choose the layout name from the layout pop-up 
menu.

2. Choose Layout Setup from the Mode menu.

3. In the Layout Setup dialog box, click Print in <value> columns.

4. Select options, and then click OK.

To Do this

Set the number of columns For Print in <value> columns, type a number 
from 1 to 99.

Arrange records row by row (left to right 
and top to bottom)

Select Across first.

Arrange records column by column (top 
to bottom and left to right)

Select Down first.

Include or exclude the layout in the layout 
pop-up menu

To include the layout, select Include in layouts 
menu. To exclude the layout, deselect this 
option.

Set margins Select Fixed margins and type values for Top, 
Bottom, Left, and Right.

Print facing pages Select Facing pages.

Set margin options

Select to print 
facing pages

Select column options
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Keep these points in mind:

1 You only see columns when you preview or print data; you don’t see 
columns in Browse mode.

1 In the sample (leftmost) column in the layout, make adjustments to 
keep the fields within the column, and arrange the information that 
prints for each record.

 

1 When you print records in columns down the page, FileMaker Pro 
prints subsummary parts the width of the column. If the subsummary 
part controls a page break, FileMaker Pro starts a new column (not a 
new page). When you print records in columns across the page, 
FileMaker Pro prints subsummary parts across the width of the page, 
and then starts a new page if the part controls a page break. (See “About 
summary layout parts” on page 3-29.)

To Do this

See data in fields that extend 
beyond the first column into the 
gray area of the second column 

Select the fields to slide, choose Sliding/Printing from the 
Format menu, and then select options. See “Sliding 
objects and parts” on page 6-7.

Adjust the size of all the 
columns at once

Drag the vertical dashed line immediately to the left of 
the gray area to change the column width.

To see how wide the column is Choose Size from the Show menu. Position the pointer 
over the vertical dashed line and hold down the mouse 
button (be careful not to change the column width). You 
see the column width in the Size palette.

See how the records will print 
in columns

Choose Preview from the Mode menu.
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1 To change the placement of records (across first or down first) and the 
number of columns, choose the layout from the layout pop-up menu, 
and then choose Layout Setup from the Mode menu. Change the 
options, and then click OK. (To remove the column setup, deselect 
Print in columns.)

Managing layouts
In Layout mode, you can change layouts without changing the 
information in the associated database file.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E records, in columns

To Do this

Switch layouts Choose a different layout from the layout pop-up menu.

Duplicate a layout, 
to design a new one 

From the layout pop-up menu, choose the layout to duplicate, and then 
choose Duplicate Layout from the Mode menu. A duplicate of the layout 
appears last in the layout pop-up menu, with Copy appended to the 
name. (Depending on the layout, you may want to duplicate it before 
making changes.)

Delete a layout From the layout pop-up menu, choose the layout to delete. Choose 
Delete Layout from the Mode menu, and then click Delete in the alert 
message. A database must have at least one layout at any time, so you 
can delete all layouts except the last remaining one. You can’t undo 
deleting a layout.

Rename a layout From the layout pop-up menu, choose the layout to rename, and then 
choose Layout Setup from the Mode menu. For Name, type a new name, 
and then click OK.

Reorder layouts in 
the layout pop-up 
menu

Choose Set Layout Order from the Mode menu. Drag the layout name to 
the position you want, and then click OK.

In a multiuser database, only the host can reorder layouts, and only 
when the database isn’t being shared.

Include or exclude 
the layout in the 
layout pop-up 
menu

Choose Set Layout Order from the Mode menu, and then choose a 
layout. To include the layout, select Include in layouts menu. To exclude 
the layout, deselect this option. You see a checkmark next to the name 
of a layout that’s included in the layout pop-up menu.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layouts, managing
E layout pop-up menu
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Working with layout parts
FileMaker Pro layouts are divided into parts, which are areas in a layout 
that tell FileMaker Pro how to display and print data and text within each 
part. For example, by using parts, you can tell FileMaker Pro to print 
data:

1 once for each record

1 only at the top of each page

1 only before or after groups of sorted records

1 only once on the first page of a report

Trailing grand summary

Body

A subsummary below the 
body summarizes data for 
each group of records 
sorted on the break field 
(Department)

Footer

Header

Subsummary

Trailing Grand
Summary

Footer
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Each layout must have at least one part. Choose from eight different 
layout parts, as described in the following table.

Every predefined layout type includes the body part. Most layouts, 
including the Standard layout, also have a header part and footer part. A 
layout can have only one header, body, and footer. 

Layout part Description

Header Use for column headings, titles, graphics, and other information that will 
appear only at the top of every page. For example, include a header for a 
directory. FileMaker Pro displays the header in Browse mode and prints it 
on every page, except the first page if you add a title header. Fields added 
to a header are printed on every page, using data from the first record on 
that page. You can delete the header from any layout.

Body Put everything you want to appear in each record, including fields, text, 
lines, and graphics, in the body. The contents of the body are printed for 
each record in the current found set. When you print records, 
FileMaker Pro prints the body for as many records as can fit on the page 
with the other parts. You can change the size of the body to change the 
amount of space used for each record. The body is the only part used with 
FileMaker Pro Web Companion Instant Web Publishing.

Subsummary Prints a summary of information for each group of records sorted on the 
break field. You can add one or more subsummaries above or below the 
body. See “About summary layout parts” on page 3-29.

Leading grand 
summary 

Use to summarize all records being browsed above the data in individual 
records. You can use only one leading grand summary. See “About 
summary layout parts” on page 3-29.

Trailing grand 
summary

Use to summarize all records being browsed below the data in individual 
records. You can use only one trailing grand summary. See “About 
summary layout parts” on page 3-29.

Footer Use for page numbers, dates, graphics, or any other information you want 
to appear only at the bottom of every page. FileMaker Pro displays the 
footer in Browse mode and prints it on every page, except the first page if 
you add a title footer. Fields added to a footer are printed on every page, 
using data from the last record on that page. You can delete the footer from 
any layout.

Title header Use for printed reports. The title header replaces the regular header on the 
first page only. For example, put a report title in the title header. Use the 
regular header on the other pages of the report for information like a 
chapter name.

Title footer Use for printed reports. The title footer replaces the regular footer on the 
first page only. For example, put the author and date in the title footer. Use 
the regular footer on the other pages of the report for information like page 
numbers.
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You can put fields, graphic objects, and text in any layout part. For 
example, put your company logo as a graphic object in the header and 
place a horizontal dividing line at the bottom of the body.

  

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layout parts, using

FileMaker Pro prints the title 
header and title footer on 
the first page in place of the 
regular header and footer

Title
header

Title
footer

Page 1

Title footer
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Adding layout parts
You can add a new part to a layout or replace one you deleted. First add 
the part, and then specify the kind of information to appear in it.

A dotted line defines the bottom of a layout part, and the part label to the 
left of the line identifies the part.

  

Part tool

A part includes the area between the 
dotted lines that separate parts

Part label
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To add a layout part:

1. In Layout mode, choose Part Setup from the Mode menu.

2. In the Part Setup dialog box, click Create.

  

3. In the Part Definition dialog box, select options.

   

4. Click OK, and then click Done.

Keep these points in mind:

1 To set options for parts and to add subsummary and grand summary 
parts to layouts, see “Changing part types and options” on page 3-36 
and “Adding a summary part” on page 3-31.

1 To resize layout parts, change what they contain, or remove all but 
one of them, see “Changing layout parts” on page 3-35.

List of parts in the
current layout

Select the type of
part to create

For subsummaries, select the 
field the records will sort by 
(break field)

Select options for page
numbering and breaks
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1 To print a cover page for a report, make the title header large enough 
to cover a page. You can then add a regular header, a regular footer, 
and any other layout parts you want to appear on subsequent pages.

Adding objects to a layout part
You can add fields of any type, graphic objects (like lines, rectangles, 
ovals, and pictures), and text in all layout parts. (To add objects to a part, 
see “Working with all object types” on page 3-37.)

Important  FileMaker Pro considers an object to be in a part when the top 
of the object is in or just touching the part. For example, to print a box 
only when the header prints, put at least the top of the box in the header. 
Or if the top of a field touches the bottom of a header, the field becomes 
part of the header, and its contents won’t print or display after the first 
record.

About summary layout parts
Use summary parts to view and display information from one or more 
records. You place a summary field in a summary part to perform the 
summary. (To define summary fields, see “Defining summary fields” on 
page 2-23.)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layout parts, defining

 Choose FileMaker Help Index from the  or Help menu, and then type:

E objects, creating

Summary part Description

Leading grand summary At the beginning of a report, summarizes all the values in a 
summary field for all records being browsed. You can have only 
one leading grand summary in each layout. If you put 
nonsummary fields in a leading grand summary, FileMaker Pro 
prints the data in that field for the first record being browsed.

Leading subsummary Before the body of a report, summarizes the values in a summary 
field for a group of records. You sort the records according to the 
break field for that part to create groups that have the same value 
for that field. If you put nonsummary fields in a leading 
subsummary, FileMaker Pro prints the data in that field for the 
first record of the group being summarized.
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You can start a new page for any subsummary part. See “Paginating a 
layout” on page 3-32.

  

Trailing subsummary Same as leading subsummary, except it displays the subsummary 
after the body of the report and prints the data for the last record of 
the group being summarized for any nonsummary fields in the 
part.

Trailing grand summary Same as leading grand summary, except it displays the grand 
summary at the end of a report and prints or displays the data for 
the last record being browsed in any nonsummary fields in the 
part. You can have only one trailing grand summary in each 
layout.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E parts, layout

Summary part Description

Use a grand summary to view the total 
number of employees in the company

Place a subsummary part,
containing only the Department

field, above the body to place
the department name ahead of

that group of records

Place a subsummary part,
which totals the employees

for each Department,
below the body
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Adding a summary part
1. Add a summary part.

See “Adding layout parts” on page 3-27.

2. In the Part Definition dialog box, select a summary type.

If you click Sub-summary when sorted by, also select the field to sort 
by (the break field). To define a summary field, see “Defining 
summary fields” on page 2-23.

3. Select page numbering and page break options, click OK, and then 
click Done.

For information on the options, see “Paginating a layout” on page 
3-32.   

4. In the layout, drag the summary field into the summary part. 

See “Adding fields to a layout” on page 3-56.

5. If you added a subsummary part, sort the records according to the 
break field (specified when you created the part).

See “Sorting records” on page 4-30.

Keep these points in mind:

1 The break field groups the records. Each time a group starts or 
finishes printing, the leading or trailing subsummary is displayed.

1 When you view records as a list in Browse mode, subsummary parts 
aren’t displayed. To see subsummary parts in a View as List layout, 
print the file, or switch to Preview mode.

1 If you add a summary part to a layout that doesn’t include a body part, 
FileMaker Pro lets you specify whether you want the summary above 
or below any body part you might add later on.

1 To see summaries for groups of sorted records, move the summary 
fields into a subsummary part. To see summaries that total all records 
in the found set, move the summary fields into a Leading grand 
summary or Trailing grand summary part.
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1 FileMaker Pro previews and prints correct subsummary values only 
after you sort the records. Sorting groups the records by the value in 
the specified field (break field), so the subsummary totals all records 
with the same value in that field. You can sort by more than one field 
to add another level of grouping to your data.

Paginating a layout
You can set and change page break and numbering options for layout 
parts in the Part Definition dialog box.

1. Add a layout part, or select a part in the Part Setup dialog box and 
click Change.

See “Adding layout parts” on page 3-27.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layout parts, defining

Records are 
grouped by the 
value for 
Department, with
subsummary 
totals for each 
group
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2. In the Part Definition dialog box, select an option.

3. Click OK, and then click Done.

Keep these points in mind:

1 If you set column options to print records down the page and specify 
a page break for a subsummary part, FileMaker Pro starts a new 
column, and not a new page, when you preview or print records. If 
you print records in columns across the page, FileMaker Pro starts a 
new page if the subsummary part includes a page break. 

1 If the body or a summary part is too large to fit on a page between the 
header and the footer, you see a dashed line on the layout to show 
where the part will be divided. (This can change if you set sliding 
options. See “Sliding objects and parts” on page 6-7.) 

To Select With these layout parts

Start a new page before 
printing the contents of the 
part (for example, print a 
trailing grand summary on a 
new page)

Page break before each 
occurrence

Subsummary when sorted by
Body
Trailing subsummary
Trailing grand summary

Start a new page after printing 
the contents of the specified 
occurrences of the part (for 
example, print five records in 
the body, and then start a new 
page)

Page break after every 
<value> occurrences

Leading grand summary
Subsummary when sorted by
Body
Trailing grand summary

Start page numbering from 
the beginning after printing 
the part (for example, start 
page numbering after the title 
header if you want it to serve 
as a cover page)

Restart page numbers after 
each occurrence

Title header
Header
Leading grand summary
Subsummary when sorted by
Body
Footer

Print the entire contents of the 
part even if it doesn’t fit on 
one page (for example, divide 
and print the body across two 
pages when it doesn’t fit on a 
single page with the other 
parts)

Allow part to break across 
page boundaries

Leading grand summary
Subsummary when sorted by
Body
Trailing grand summary

Print as much of the contents 
of a part as fits on the page but 
not finish printing it on the 
next page (for example, print 
the information in a Notes 
field to the bottom of the page 
and truncate the rest)

Discard remainder of part 
before new page (available 
only if you select Allow 
part to break across page 
boundaries) 

Leading grand summary
Subsummary when sorted by
Body
Trailing grand summary
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1 If the whole body of another record won’t fit at the bottom of a page, 
FileMaker Pro prints it on the next page, unless you set the option to 
break parts across pages or the body can’t fit on a single page.

   

 Choose FileMaker Help Index from the  or Help menu, and then type:

E page numbering

The amount of extra
space above and below
the objects in the body
determines the spacing

between displayed or
printed records
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Changing layout parts
Change layout parts as described in the following sections.

Reordering parts
You can change the order of the body and subsummary parts only. For 
example, move a subsummary above the body to see subtotals first. 
FileMaker Pro moves all the objects in the reordered part and maintains 
its proportions.

1. In Layout mode, choose Part Setup from the Mode menu. 

2. Use the double-arrow pointer to drag the part to the new position.

3. Click Done. 

 

Keep these points in mind:

1  In Layout mode, you can click the part label control at the bottom of 
the screen to move the part labels to a vertical position (for more 
room on the layout). To read vertically displayed part labels more 
easily, temporarily flip down the labels by holding down the mouse 
button when the pointer is over the label. 

1 You can have only one leading and one trailing subsummary part 
based on the same field. You can’t move a subsummary based on a 
field to where another subsummary based on that same field exists.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layout parts, managing

This symbol indicates a locked
part—you can’t change it

Use the double-arrow
pointer to drag a part

Part label control
(at bottom of window)
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Resizing parts
When you resize a layout part, FileMaker Pro always maintains the size 
of the other parts. For example, changing the size of the header won't 
change the size of the body.

In Layout mode, use the pointer to drag the part label (or the dotted line 
below the part) until the part is the size you want. 

Changing part types and options
You can change a layout part's type and options, including the break 
field, numbering, and page break settings in the Part Definition dialog 
box.

To display the Part Definition dialog box, double-click the part label in 
the layout or see “Adding layout parts” on page 3-27.  

Deleting layout parts
You can delete all but the last part that remains on a layout. Deleting a 
part doesn’t affect your data. Before you delete a layout part, you can 
drag any objects you want to keep to another part on the same layout.

1. In Layout mode, choose Part Setup from the Mode menu.

2. In the Part Setup dialog box, select the part to delete, and then click 
Delete.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layout parts, managing

To change Do this

Part types Select a different part type. Changes you can make depend on the part’s 
location and function.

Break field In the fields list, select a different field name. (Change the break field 
to change the focus of a report using different fields in subsummary 
parts).

Page breaks and 
numbering

See “Paginating a layout” on page 3-32.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layout parts, managing
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3. If the part contains objects, click Delete in the alert message.

4. Click Done.

Working with all object types
An object is a separate element—text, a field, or a graphic object (such 
as an oval or an imported picture)—that you can draw, select, move, 
resize, delete, copy, and otherwise change. You place objects in a layout 
to design how the layout looks and works. For example, add the title 
Invoice, or emphasize a group of fields by enclosing them in a shaded or 
colored rectangle.

   

Note Another type of object is a portal, which displays related records. 
For more information, see “Creating a portal to hold related fields” on 
page 10-23.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E layout parts, managing
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Working with the drawing tools
For each type of object you work with, you use the various tools in the 
status area of the Layout window.

No tools visible? Choose Layout from the Mode menu, and then click the 
status area control at the bottom of the screen.

Use the following techniques to work with the tools:

To Do this

Use a tool once Click a tool to select it. (The tool becomes gray.) 

Keep a tool selected Double-click a tool. (The tool becomes black to 
indicate it remains selected until you select a different 
tool.) To set an option to keep layout tools selected, 
see “Setting layout preferences” on page 9-3.

Switch between the tool last used 
and the pointer 

Press Enter.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E tool panel

Tool panel

Part tool

Pen controls
Line width palette

Field tool

Fill controls

Button tool Portal tool

Status area control
(at the bottom of the window)
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Selecting objects
Whenever you want to work with an object, you must select it first. You 
see handles, small black squares along the boundaries of a selected 
object.

To select an object, use the pointer tool or choose Select All from the Edit 
menu.

To select Do this

One object With the arrow pointer, click the object. (If the object has no fill, click 
its border.)

Several objects at 
once

Drag the arrow pointer to make a selection box that completely 
surrounds the objects. Or hold down Shift and click the objects. Or 
choose Select All from the Edit menu.

All objects of the 
same type

Click the tool for the type of object to select, and then choose Select All 
from the Edit menu.

All fields With the arrow pointer, click a field, hold down Option, and then 
choose Select All from the Edit menu.

Deselect selected 
objects

Click a blank area of the layout or any tool in the tool panel. Or hold 
down Shift and click the selected object.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E objects, changing
E objects, selecting

Handles surround 
a selected object

Pointer tool
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Positioning and sizing objects
Use the text ruler, graphic rulers, ruler lines, T-square, AutoGrid, and 
Size palette to size, position, and align objects.

    

Guide Description

Text ruler A horizontal ruler to help align and format text.

Graphic rulers Horizontal and vertical rulers to help measure and position objects.

Ruler lines A network of intersecting horizontal and vertical lines that correspond 
to the current ruler settings, to help measure and position objects. 
(Ruler lines are different from the AutoGrid.)

T-Square Intersecting horizontal and vertical lines to help align objects that are 
far from each other in the layout. You can move the T-square to the 
objects to position. The ends of the T-square extend into the rulers, so 
you can position an object precisely.

AutoGrid An invisible, snap-to grid. When the AutoGrid is turned on, newly 
added objects are aligned to the nearest grid coordinate. Objects being 
moved or resized are moved or resized in grid increments.

Size palette Type size and distance measurements in the Size palette to position 
objects precisely. Or verify an object’s position using the Size palette.

Graphic rulers

T-square Ruler lines

Text ruler
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The following information tells you how to use each guide.

1 To show or hide the rulers, ruler lines, or T-square, choose Text Ruler, 
Graphic Rulers, Ruler Lines, or T-Squares from the Show menu. For 
information about the text ruler, see “Formatting text paragraphs” on 
page 3-84.

1 To switch the Auto Grid on or off, choose Auto Grid from the Arrange 
menu. To temporarily disable the AutoGrid, hold down Command 
while dragging an object. 

1 To adjust the T-square, place the pointer on the horizontal or vertical 
line. When the pointer is a double arrow, drag the line. (To see the 
position of the T-square in the Size palette, choose Size from the 
Show menu, position the pointer over the T-square, and then hold 
down the mouse button.)

1 To position an object using the Size palette, select the object, and then 
choose Size from the Show menu. Type the measurements for the 
position you want, and then press Return or Enter. (The unit of 
measure is that set for the graphic rulers.) You can close the palette 
or leave it open.

  

1 To position an object precisely by dragging it, choose Size from the 
Show menu. Drag the object until you see the position you want in the 
Size palette.

1 To set the unit of measure—inches, centimeters, or pixels (dots that 
make up the graphic on a computer screen)—for rulers and ruler 
lines, click the box where the graphic rulers intersect. When the Size 
palette is open, click the units label. 

On this ruler Each increment measures

Inch (in) 1/8 inch

Centimeter (cm) .25 centimeters

Pixel (px) 10 pixels

Type the distance from the
left edge of the page to the

left edge of the object

Type the distance from the top of the page to the 
top edge of the object

FileMaker Pro updates measurements for right 
and bottom edges based on the object’s width 
and height
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1 To change the unit of measure for the graphic rulers and the AutoGrid, 
choose Set Rulers from the Mode menu. Make your selections and 
click OK. (You can choose different units of measure for the rulers and 
the AutoGrid. If you change units for the AutoGrid, you change the 
increments by which objects are snapped “to” the grid.)

 

Note To align objects to each other, see “Aligning objects to each other” 
on page 3-48.

Editing objects and data quickly using the context menu
You can quickly edit an object or data by choosing editing commands 
directly from the context menu. You can display the context menu for all 
objects in Layout mode and for fields and selected text in Browse mode.

In Layout mode, hold down Control, and then click and hold down the 
mouse button while the pointer is on an object to edit. In Browse mode, 
hold down Control, and then click and hold down the mouse button 
while the pointer is on a field or data to edit.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E objects, positioning
E text ruler

Choose a unit of
measure for the rulers

Type the number of units for
the AutoGrid, and choose a

unit of measure
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The commands in the context menu depend on the type of object 
selected. For example, when a text object is selected in Browse mode, 
you see text formatting commands like Font, Size, and Style. When the 
object is selected in Layout mode, you see additional commands like 
Specify Field and Field Borders.

 

Showing button, text, and field boundaries
FileMaker Pro displays boundaries only in Layout mode. Use 
boundaries only for positioning objects on the layout.

Note For more information on working with buttons, see “Using buttons 
with scripts” on page 5-20.

To show Choose this from the Show menu

A 2-pixel gray border around 
buttons you’ve created

Buttons. To hide the borders, choose the command again.

Boundaries around text objects Text Boundaries. To hide text boundaries, choose the 
command again.

Boundaries around fields Field Boundaries. To hide field boundaries, choose the 
command again.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E showing

Editing a text field in Browse modeEditing a text field in Layout mode
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Arranging objects
The following sections explain how to arrange graphic objects, fields, 
and text on a layout. 

For information on using the AutoGrid, rulers, T-square, and other 
alignment guides, see “Positioning and sizing objects” on page 3-40.

Moving objects

Keep these points in mind:

1 You can quickly and easily move one or more objects to a different 
location in the current file or to a different file or application by using 
drag and drop. See “Using drag and drop to move information” on 
page 4-13.

1 If you drag a handle by mistake and resize the object, choose Undo 
from the Edit menu before you do anything else in FileMaker Pro.

To move Do this

One object Select the object, and then drag it to the position you want. (To 
constrain the movements to horizontal or vertical directions, hold 
down Shift as you drag the object.)

Several objects at once Select the objects, and then drag them to the position you want. 
(To constrain the movements to horizontal or vertical directions, 
hold down Shift as you drag the objects.) 

An object to a different 
layout

Select the object, and then choose Cut from the Edit menu. Move 
to the other layout and choose Paste from the Edit menu. Then drag 
the object to the position you want.

You can use drag and drop to move objects to different layouts in 
other files. See “Using drag and drop to move information” on 
page 4-13.

An object to a different 
application or desk 
accessory 

Select the object, and then choose Cut or Copy from the Edit menu. 
Open the other application or desk accessory, bring it to the front, 
and then choose Paste from the Edit menu.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E objects, positioning
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Cutting, copying, and pasting objects

Keep these points in mind:

1 To restore an object that you deleted, choose Undo from the Edit 
menu before you do anything else in FileMaker Pro.

1 An object you cut or copied stays on the Clipboard until the next time 
you cut or copy objects or information (in FileMaker Pro or another 
application), or turn off your computer.

1 To edit text in a text object, see “Working with text” on page 3-79.

To Select the object, and then do this

Make one copy of 
(duplicate) an object

Choose Duplicate from the Edit menu (or hold down Option and 
drag the object). Then move the object to the position you want.

Remove an object to 
paste it elsewhere

Choose Cut from the Edit menu. To paste the object elsewhere, 
click where you want to insert it, and then choose Paste from the 
Edit menu.

Paste a copy of an object 
elsewhere

Choose Copy from the Edit menu. Click where you want to insert 
the object, and then choose Paste from the Edit menu.

Paste a cut or copied 
object onto a different 
layout

Choose Cut or Copy from the Edit menu. Switch to the other 
layout, and then choose Paste from the Edit menu.

Delete an object 
permanently

Choose Clear from the Edit menu (or press Delete). FileMaker Pro 
doesn’t place your selection on the Clipboard, and you can’t paste 
it anywhere.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E objects, changing
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Stacking objects and changing the stacking order
You can create a design in which you stack objects by creating or 
dragging them on top of each other. Objects are preset to stack in the 
order you create them—the first object created is on the bottom, and the 
last one is on top. You can change the order in which objects are stacked.

1. In Layout mode, select the object to move in the stack.

Bring to front

Send to back

Send backward

Bring forward

Before

After
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2. Choose a command from the Arrange menu.

Grouping and ungrouping objects
You can combine several objects into one by grouping them. You can 
then work with the group the way you work with a single object. A 
group can include individual objects and other groups.

1 To group objects, select the objects, and then choose Group from the 
Arrange menu. 

1 To ungroup grouped objects, select the group, and then choose 
Ungroup from the Arrange menu.

Keep these points in mind:

1 When you ungroup a group that contains other groups, the subgroups 
stay grouped until you ungroup them.

1 You can edit a text object that’s part of a group without ungrouping 
it first.

To move the object Choose

To the top of the stack Bring to Front

One layer forward Bring Forward

Behind all other objects Send to Back

One layer back Send Backward

 Choose FileMaker Help Index from the  or Help menu, and then type:

E bring forward/to front
E send backward/to back

 Choose FileMaker Help Index from the  or Help menu, and then type:

E grouping objects
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Aligning objects to each other
You can align (line up) objects by their tops, bottoms, or sides. For 
example, align a field label with its field so that the label is centered 
between the field’s top and bottom border. 

When you align a group of objects, they align with the object farthest in 
the chosen direction. When you align center points, the objects align 
along an invisible vertical or horizontal line in the center of the objects.

You can also distribute the space evenly between objects by dividing the 
space that separates the two outermost objects between all selected 
objects.

1. In Layout mode, select the objects to align, and then choose Set 
Alignment from the Arrange menu.

2. In the Alignment dialog box, select the alignment or distribution, and 
then click OK.

To Do this

Set the vertical alignment 
or even distribution of 
space

For Top to Bottom, select one option.

Set the horizontal 
alignment or even 
distribution of space

For Left to Right, select one option.

Objects before distributing space Objects after distributing space 
vertically and aligning left sides
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You can select from both columns.

    

Keep these points in mind:

1 To align new objects according to the current settings, select the 
objects to align, and then choose Align from the Arrange menu. (If the 
settings are both None, the command is unavailable.)

1 To align two objects without moving one of them, select one object, 
and then choose Lock from the Arrange menu. Next, select both 
objects, and then choose Align from the Arrange menu. (For 
information on locking objects, see “Protecting objects from change” 
on page 3-52.)

Rotating objects
You can rotate fields, text objects, and graphic objects in 90-degree 
increments.

1 To rotate a field, text object, or graphic object, select the object, and 
then choose Rotate from the Arrange menu.

1 Continue selecting Rotate from the Arrange menu until the object is 
rotated as you wish.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E aligning objects

Select the way you want
objects aligned vertically

See the results of your choices

Select the way you 
want objects aligned 
horizontally
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Keep these points in mind:

1 For easy editing, a rotated field temporarily reverts to 0 degrees 
rotation when it is selected in Browse mode. The field assumes its 
previous rotation when it is deselected.

1 Portals cannot be rotated.

Changing the appearance of objects
You can change the appearance of a field or a text or graphic object, for 
example by changing its size, border width, or fill pattern.

Resizing objects

Keep these points in mind:

1 Resizing the first repetition of a repeating field resizes all repetitions.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E rotating objects

To resize Do this

An object, using 
the handles

Select the object and drag a handle until the object is the size you want. 
To limit the change to only vertical or horizontal, hold down Shift as 
you drag a handle. (Do this to make fields longer without changing 
their height.)

An object, using 
the Size palette

Choose Size from the Show menu. Select the object to resize. Type the 
width and height in the lower two boxes, and then press Return.

A circle or square Select the object. Hold down Option and drag a handle until the object 
is the size you want.

Several objects at 
once

Select the objects and drag a handle of one object until all objects are 
resized.

Distance from top of object to 
top edge of paper
Distance from bottom of 
object to top edge of paper

Height of object

Distance from left side of
object to left edge of paper
Distance from right side of
object to left edge of paper

Width of object
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1 Resizing a grouped object resizes all the objects in the group. See 
“Grouping and ungrouping objects” on page 3-47.

Changing an object's shape

Note If the AutoGrid is on, you reshape objects in increments defined by 
the grid settings. To reshape objects in finer increments, choose AutoGrid 
from the Arrange menu to turn the grid off. See “Positioning and sizing 
objects” on page 3-40.

Changing lines, colors, and patterns
To set or change preset fill color or pattern, pen color or pattern, or line 
or border width, start with no objects selected. Then choose attributes 
from the palettes.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E resize objects

To Do this

Reshape one object Select the object, and then drag a handle until the 
object is the shape you want. (To change only the 
height or width, hold down Shift as you drag.)

Reshape several objects at once Select the objects, and then drag a handle of one 
object until the objects are reshaped.

Change a rectangle into a square or an 
oval into a circle

Select the object. Hold down Option and drag a 
handle to the shape you want.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E reshape objects

Fill sample

Fill color palette

Fill pattern palette

Pen sample 

Pen color palette

Pen pattern palette

Current line width

Line width palette
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Keep these points in mind:

1 To remove a fill pattern or pen pattern from an object, select the 
object, and then choose the transparent pattern.

1 To use the attributes of an existing object to set the preset attributes, hold 
down Command and click the object. 

1 Attributes you set in the Field Borders dialog box for pattern, color, 
and width replace attributes set with the pen and width controls in the 
status area, and vice versa. See “Adding borders, fill, and baselines to 
fields” on page 3-73.

Protecting objects from change
Lock objects so you can’t move them, change their size, or remove them 
from the layout. 

To lock objects, in Layout mode, select the objects, and then choose Lock 
from the Arrange menu. To unlock objects, select the objects, and then 
choose Unlock from the Arrange menu.

When you copy or duplicate a locked object, the copy isn’t locked. 
When you group objects that include a locked object, the entire group is 
locked.

Note You can change the stacking order of locked objects. (See 
“Stacking objects and changing the stacking order” on page 3-46.)

Working with graphic objects
Draw graphic objects—lines, rectangles, squares, rounded rectangles, 
ovals, and circles—anywhere on a layout. You can also import 
QuickTime movies (in Browse mode) and bring in graphics created in 
other applications. 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E graphic tools

 Choose FileMaker Help Index from the  or Help menu, and then type:

E locking objects
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All objects have a border. (The border of a line is the line itself.) All 
objects except lines have a fill, the area within the border. You can 
change the border’s width, color, and pattern, and the fill’s color and 
pattern before or after you draw an object.

Drawing objects in a layout
Before you draw an object, you select the appropriate drawing tool in the 
tool panel. FileMaker Pro uses the preset line width, pen color, and 
pattern, and it fills the object with the current fill pattern and color (for 
all objects except lines). You can change these attributes before or after 
you draw the object. (See “Changing the appearance of objects” on page 
3-50.)

No tools visible? If you don’t see the status area with the tool panel on the 
left of the window, choose Layout from the Mode menu, and then click 
the status area control at the bottom of the screen.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E objects, creating

To draw a Do this

Line, or 
straight horizontal, 
vertical, or 
diagonal line

Select the line tool, and then position the center of the crosshair pointer 
at the line’s starting point. Drag the pointer until the line is the length 
you want. For a straight horizontal, vertical, or diagonal line, hold 
down Shift and drag the pointer until the line is the length you want.

Rectangle or
square

Select the rectangle tool. Position the center of the crosshair pointer 
where you want any corner of the rectangle or square to start. 

For a rectangle, drag the pointer diagonally until the rectangle is the 
size you want. For a square, hold down Option and drag the pointer 
diagonally until the square is the size you want.

Rounded rectangle Select the rounded rectangle tool. Position the center of the crosshair 
pointer where you want any corner of the rounded rectangle to start. 
Drag the pointer diagonally until the rectangle is the size you want.

Oval or
circle

Select the oval tool. Position the center of the crosshair pointer where 
you want the oval or circle to start.

For an oval, drag the pointer in any direction until the oval is the size 
you want. For a circle, hold down Option and drag the pointer in any 
direction until the circle is the size you want. 

Status area control
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An object is selected when you finish drawing it. To deselect an object, 
click a blank area of the layout or any tool in the tool panel.

Adding graphics in a layout
You can add graphics anywhere on a layout. Use a graphic in a layout 
instead of a container field whenever you want the same image (like a 
company logo) on every record or report. 

1. Copy the graphic from the application it was created in.

2. In the FileMaker Pro layout, choose Paste from the Edit menu.

3. Position and resize the graphic as needed in the layout. 

See “Positioning and sizing objects” on page 3-40 and “Resizing 
objects” on page 3-50. You resize the display of a graphic without 
changing its original size.

Keep these points in mind:

1 You can import a graphic by choosing Import/Export from the File 
menu, and then choosing Import Picture. See “Working with container 
fields” on page 4-6.

1 To display a different graphic, sound, or movie in each record, add a 
container field. See “Formatting graphics in individual container 
fields” on page 3-67.

1 You can also import a graphic onto a layout. When you import a 
graphic, you can choose to store the graphic in the database file or 
externally. If you move or delete a graphic file that’s stored 
externally, FileMaker Pro can’t display the graphic on the layout. See 
“Importing graphics” on page 4-6.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E drawing

 Choose FileMaker Help Index from the  or Help menu, and then type:

E graphics
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Working with fields in a layout
When you first define fields for a new database file, FileMaker Pro adds 
them to the Standard layout, with field labels for each field. Later, you 
can add fields from the database file to the current layout, delete fields 
you don’t want displayed or printed from the current layout, and 
determine the format in which you want data displayed in fields when 
the current layout is used. (To prevent fields that you define later from 
being added to the current layout, see “Setting layout preferences” on 
page 9-3.) A field that doesn’t appear on a layout still exists in the 
database file, and its data can still be used in calculations and 
summaries. 

Fields on a layout are objects, which you can select, move, resize, and 
reshape, just like other objects. Each field displays its field name, 
formatted with the preset attributes for font, size, style, alignment, line 
spacing, and color, so you can easily identify it. Fields of all types 
(except container fields that don’t hold text) display baselines to indicate 
where the data appears when you add or edit records.

Fields display field names

Field tool

Field baseline



3-56 FileMaker Pro User’s Guide
Adding fields to a layout
You can add a field to a layout at any time. A field can be added 
anywhere on any layout, as many times as you want. You can get 
different results by placing the same field in different locations on the 
layout. For example:

1 Add the same summary field to a subsummary part to calculate totals 
for each group of sorted records, and to a grand summary part to get 
totals for all the records in the file.

1 Add a field to the header or footer parts to repeat data from the first 
record or the last record on the page as a header or footer. (You might 
add a Last Name field to the header in a telephone directory.)

To add a field to a layout:

1. In Layout mode, hold down the Field tool and drag the field to the 
layout part in which you want the field to be.

2. In the Specify Field dialog box, select options for the new field.

  

3.    Click OK.

Select the field to add

Select to use the field
name as the field label

Choose from the
relationship pop-up
menu, if necessary
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After you add fields to a layout, you can work with them in the following 
ways:

Keep these points in mind:

1 To define a new field for the database file, which you can then add to 
a layout, see “Defining database fields” on page 2-3.

1 When you copy fields (and field types) from a layout in one file to a 
layout in another, be sure the field names match. When you move 
fields from one layout to a layout in another file, you copy the field 
characteristics for that layout (including dimensions and text styles) 
but not the definition.

To Do this

Redefine a field Double-click the field. In the Specify Field dialog box, 
double-click a different field name. To include a field label, 
first delete the original label on the layout. Then, in the 
Specify Field dialog box, select Create field label.

Display sample data from the 
current record (when the file 
contains data), instead of field 
names, in fields in the layout

Choose Sample Data from the Show menu.

Choose the preset values for 
font, size, style, line spacing, 
alignment, text color, and fill 
color of text entered in a field

See “Working with text” on page 3-79.

Add distinctive borders and 
baselines

See “Adding borders, fill, and baselines to fields” on page 
3-73.

Change the display formats of 
text, numbers, dates, and times 
in fields

See “Defining display formats for fields” on page 3-59.

Format a field as repeating, or 
format its values as 
checkboxes, radio buttons, a 
pop-up menu or a pop-up list

See “Formatting repeating fields” on page 3-72 and 
“Defining value lists” on page 3-75.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields, placing
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Adding merge fields
You can add a merge field (a placeholder for a field’s value) to a layout 
to display or print a field’s data when you browse and print records. Use 
merge fields for documents like letters, envelopes, contracts, and so 
forth. For example, when you add the merge field <<First Name>> to the 
right of the text Dear, FileMaker Pro displays Dear Leon, when the First 
Name field contains “Leon”. 

FileMaker Pro collapses unused lines, such as an empty <<Address 2>> 
field.

1. In Layout mode, click where you want the merge field to appear.

2. Choose Paste Special from the Edit menu, and then choose Merge Field.

3. In the Specify Field dialog box, double-click the name of a field to 
use as a merge field.

  

Keep these points in mind:

1 You can also add a merge field by typing the field name surrounded 
by angle brackets (<< >>) on the layout. (Be sure that the field name 
exists in the database and that you type it correctly.)

1 If you use a text field as a merge field, the merge field picks up the 
text attributes (like style, color, and size) set for the data in Browse 
mode.

1 Add symbols, like commas, and spaces where needed among merge 
fields on the layout.

Select a field to use
as a merge field

Choose from the 
relationship pop-up menu, 
if necessary
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1 Merge fields display as much text as fits in the boundary of the 
defined field. You can adjust the size of the field to display as much 
data as you want.

1 You format merge fields the same way you format other 
FileMaker Pro fields. To assign formats to values in a merge field, 
select the merge field and the << and >> symbols, and then select 
formatting options. See “Defining display formats for fields” below 
and “Changing the appearance of text” on page 3-88.

Deleting a field from a layout
To delete a field from a layout, in Layout mode, click the field and press 
Backspace or Delete. When you delete a field from a layout, the field 
and its data remain in the database file. (To delete a field from a database 
file, see “Changing field definitions” on page 2-25.)

Defining display formats for fields
Display formats make data in fields look consistent when the data is 
displayed or printed. The formats don’t change the data as stored in the 
file. For example, a number field can be formatted to display three 
decimal places. You can do the following:

1 Set no formats in FileMaker Pro. When you set no formats, 
FileMaker Pro displays numbers, dates, and times according to the 
system formats set in the Numbers and Date & Time control panels 
at the time the file was created. (See appendix B, “Working with 
international files” and the documentation that came with your 
computer.) 

1 Set default display formats in FileMaker Pro for all text, number, 
date, time, and container fields you plan to define (see “Setting 
default display formats,” below).

1 Define data formats individually in FileMaker Pro for existing text, 
number, date, time, and container fields (see the sections beginning 
on page 3-60).

 Choose FileMaker Help Index from the  or Help menu, and then type:

E merge fields

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields, deleting
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On a field by field basis, each layout can have a different set of formats. 
For example, suppose you format number fields to display a currency 
symbol, thousands separators, and two decimal places. If the currency 
symbol is a dollar sign ($), the thousands separator is a comma (,), and 
the decimal separator is a period (.), the value 5000 displays as 
$5,000.00. However, only the value 5000 is stored in the file.

Setting default display formats
Set default display formats for newly created fields. Default formats set 
in FileMaker Pro override formats set in the Numbers and Date & Time 
control panels and affect only FileMaker Pro files. Default formats 
apply to newly defined fields added to the current and new layouts.

1. With no fields selected in Layout mode, choose Text, Number, Date, 
Time, or Graphic from the Format menu.

2. In the Default Format dialog box, select options, and then click OK.

You can also set a default display format if you have just added a new 
field to a layout.

1. Drag a new field to a layout. Before deselecting that field, choose 
Text, Number, Date, Time, or Graphic from the Format menu.

2. In the Format dialog box, select options, and then click OK.

See the following sections for information on data formatting options 
for each field type.

You can also set display formats for individually selected fields, which 
replace the current default settings. See the following sections.

Formatting text attributes in individual fields
You can format the text attributes (such as the font, size, and style) for 
data in all field types that contain characters. All the characters in one 
field (including all repetitions of repeating fields) share the text 
attributes. You can also format text objects in the layout.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E formatting fields

 Choose FileMaker Help Index from the  or Help menu, and then type:

E formatting fields
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1. In Layout mode, select a field or text object, and then choose Text 
from the Format menu.

To format more than one field at a time, Shift-click each field to 
format, and then choose Text from the Format menu.

2. In the Text Format dialog box, select options, and then click OK.

  

Keep these points in mind:

1 You can hold down Option as you double-click a field to display the 
format dialog box for that field type. 

1 To set text attributes individually, choose Font, Size, Style, Align Text, 
Line Spacing, or Text Color from the Format menu, and then choose a 
formatting command.

1 To specify a custom size or line spacing, choose Size or Line Spacing 
from the Format menu, and then choose Custom.

1 You can change the font, size, or style of text fields in a record by 
selecting data and setting these attributes in Browse mode. The data 
appears with those text attributes wherever the data is displayed.

1 Text attributes do not appear when data is viewed with Web browser 
software using FileMaker Pro Web Companion.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text, formatting

Choose the
attributes you want

Select one or 
more styles
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Formatting numerical values in individual fields 
Format numbers for number fields, or calculation, summary, or global 
fields that have a numeric result. You can format a field as a decimal 
number or a Boolean number (to produce a true or false result).

A number field can hold up to 255 characters. However, for calculation 
purposes FileMaker Pro uses only the first 15 numeric characters. 
Adjust the length of the line by changing the width of the field on the 
layout, if needed.

1. In Layout mode, select a number field, and then choose Number from 
the Format menu.

To format more than one number field at a time, Shift-click each field 
to format, and then choose Number from the Format menu.

2. In the Number Format dialog box, select options, and then click OK.

  

To display numbers Do this

Exactly as typed or 
entered

Click Leave data formatted as entered.

As Boolean numbers Click Format as Boolean. To change the default values, type 
up to seven characters for Show non-zeroes as and Show 
zeroes as (such as True and False).

As decimals Click Format as decimal, and then select options. See the 
table in the next section to change default decimal options.

With different text 
attributes

Click Text Format, and then select options. (See “Formatting 
text attributes in individual fields” on page 3-60.)

Define the symbols
for thousands and

decimal separators
Specify font, style, 
size, line spacing, 
alignment, and color

Choose options for Boolean
or decimal numbers

Set options for 
negative values
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Keep these points in mind:

1 Numbers with decimal digits that exceed the specified number are 
rounded. If you specify 0, no decimal digits are displayed. If you 
specify a negative value, numbers are rounded to the number of 
positions left of the decimal separator. (For example, for the field 
value 789.78, 2 fixed decimal places displays 789.78; 0 fixed places 
displays 790; and –2 fixed places displays 800.) For calculations and 
summaries, FileMaker Pro uses the original, unrounded, number.

1 Only numbers are displayed and printed in a number field formatted 
as Boolean or decimal (except for symbols set in the Number Format 
dialog box). To display text and symbols (as in @1.98 per pound) in a 
number field, don’t define a number format.

1 When you work with a file created with different system formats and 
you want to use the formats set on your computer, choose Use System 
Formats from the Format menu. See appendix B, “Working with 
international files.”

Changing options for numerical data
You can change the default symbols used as the thousands separator and 
decimal separator. Unless you changed them previously, the default 
settings are taken from the Numbers control panel. You can also change 
the default format for negative numbers.

1. In Layout mode, select a number field, and then choose Number from 
the Format menu.

2. In the Number Format dialog box, click Format as decimal, select 
options, and then click OK.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E numbers, formatting

To change the 
default Do this

Number of decimal 
digits

Select Fixed number of decimal digits, and type a new value.

Notation symbol and 
position

Select Use notation, and then choose Percent (to display a percent 
symbol after the value, Currency (leading) (to display a currency 
symbol before the value) or Currency (trailing) (to display a 
currency symbol after the value.)

Currency symbol For Currency symbol, select the current default, and type a new 
one.
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Formatting date values in individual fields
Format dates in date fields, or calculation, summary, or global fields that 
have a date result. You can also leave a date unformatted, so it will 
display and print as typed. A date field can hold values from 
1 January 0001 to 31 December 3000.

1. In Layout mode, select a date field, and then choose Date from the 
Format menu.

To format more than one date field at a time, Shift-click each field to 
format, and then choose Date from the Format menu.

2. In the Date Format dialog box, select options, and then click OK.

Display of zero values Select Do not display number if zero.

Decimal separator For Decimal separator, double-click the current default, and then 
type a new one.

Thousands separator Select Use thousands separator, double-click the current default, 
and then type a new one.

Format for negative 
numbers

For Format as, choose an option. To display negative numbers in 
color, select Use color, and then choose a color.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E numbers, formatting

To display dates Do this

Exactly as typed or 
entered

Click Leave data formatted as entered.

In a particular format Click Format as, and then choose a format. To change the 
default separator between parts of numeric dates, for Numeric 
separator, type another character.

In a custom format Click Custom, and then choose options and separator characters 
for day of week, month, date of month, and year.

With leading zeroes (as 
in 01/02/98) or leading 
spaces in numeric parts 
of dates

Choose options for For day numbers, For month numbers, or both.

With different text 
attributes

Click Text Format, and then select options. (See “Formatting 
text attributes in individual fields” on page 3-60.)

To change the 
default Do this
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Keep these points in mind:

1 Be sure to size the date field on the layout according to the length of 
the date. For example, the date Wednesday, May 5, 1999 needs more 
room than 5/5/99.

1 You can also set the format for the system date symbol (//). Select the 
symbol first. See “Displaying special information” on page 3-83.

1 When you work with a file created with different system formats and 
you want to use the formats set on your computer, choose Use System 
Formats from the Format menu. See appendix B, “Working with 
international files.”

Formatting time values in individual fields
Format times in time fields, or calculation, summary, or global fields 
that have a time result.

1. In Layout mode, select a time field, and then choose Time from the 
Format menu.

To format more than one time field at a time, Shift-click each field to 
format, and then choose Time from the Format menu.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E date fields

Choose options for day, 
month, date, year, and 
separator characters

Set font, style, size, color,
line spacing, and alignment
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2. In the Time Format dialog box, select options, and then click OK.

  

Keep these points in mind:

1 You can also set the format for the system time symbol (::) on the 
layout. Select the symbol first. See “Displaying special information” 
on page 3-83.

1 When you work with a file created with different system formats and 
you want to use the formats set on your computer, choose Use System 
Formats from the Format menu. See appendix B, “Working with 
international files.”

To display times Do this

Exactly as typed or 
entered

Click Leave data formatted as entered.

In a particular format Click Format as, and then choose a format. You can set a 
different unit separator (like : or –), 24-hour or 12-hour time, 
and a trailing or leading suffix (like AM or PM).

With leading characters For Leading Characters, choose options for Hours, Minutes and 
seconds, or both.

With different text 
attributes

Click Text Format, and then select options. (See “Formatting 
text attributes in individual fields” on page 3-60.)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E time fields

Choose a time format

Set font, size, style, color,
line spacing, and alignment
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Formatting graphics in individual container fields
When you define a container field, FileMaker Pro displays the 
boundaries of the field in Layout mode, as it does for other fields. You 
can format the graphic in a particular way, to maintain the original 
proportions of the graphic as it’s entered in the field, or to align the 
graphic horizontally or vertically within the boundaries.

You can change the dimensions of container fields on a layout without 
affecting the original shape and size of the graphic.

1. In Layout mode, select a container field, and then choose Graphic 
from the Format menu.

To format more than one container field at a time, Shift-click each 
field to format, and then choose Graphic from the Format menu.

2. In the Graphic Format dialog box, select options, and then click OK.

  

   

To Do this

Determine how to fit the 
graphic in the frame

For <value> image to fit frame, choose an option.

Keep the graphic’s original 
proportions when it’s in the 
field

Select Maintain original proportions.

Set the horizontal and vertical 
alignments

For Alignment, choose options for a vertical and a 
horizontal alignment.

Choose how to fit the
graphic in the frame

Choose how to align the
graphic horizontally

Choose how to align 
the graphic vertically
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Keep these points in mind:

1 For information about adding a graphic to a container field, see 
“Working with container fields” on page 4-6.

1 You can also add graphics to a layout as objects. See “Adding 
graphics in a layout” on page 3-54. 

Determining data entry in fields
You can have the entire contents of a field selected when you select the 
field in Browse mode (otherwise, FileMaker Pro places the insertion 
point after the last character in the field). You can also allow or prevent 
entry into a field (preventing entry is useful when you want users to see 
the data in the field on a layout but not modify it).

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields, formatting

Display the same graphic
once on each page of a report

Enter a graphic in a
container field to

display a different
graphic in each record
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1. In Layout mode, select a field, and then choose Field Format from the 
Format menu.

2. In the Field Format dialog box, select options, and then click OK.

1 To select all the field’s contents when the field is selected, select 
Allow entry into field, and then click Select entire contents of field on 
entry.

1 To prevent entry into a field, deselect Allow entry into field. (To 
allow entry into the field, select this option.)

Setting the tab order for data entry
When you press Tab in Browse mode, fields are normally selected from 
left to right, top to bottom. You can change this preset tab order, set a 
custom tab order, omit fields from the tab order, and create a tab order 
specifically for repeating fields.

Note Setting a tab order has no effect on data entry when records are 
edited using FileMaker Pro Web Companion Instant Web Publishing.

1. Choose Set Tab Order from the Mode menu.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields, customizing

Each arrow indicates the field’s 
position in the tab order
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2. Select options.

3. Click OK.

4. If you omitted fields, click Omit in the alert message.

Keep these points in mind:

1 A blank arrow indicates a field omitted from the tab order.

1 You can tab into a field that’s formatted as radio buttons and 
checkboxes, and use the keyboard to make a selection. See “Entering 
data from a value list” on page 4-9.

1 You can tab into repetitions of repeating fields from left to right or top 
to bottom. (For example, create a tab order that selects the first 
repetition for all fields before it selects the second repetition.) Start 
setting the tab order with the topmost or leftmost repeating field. When 
you create a tab order, the arrow blinks as you select the rest of the 
fields for the tab order and stops when you return to the first repeating 
field selected. FileMaker Pro completes the tab order for the repeating 
fields based on your previous selections.

To Do this

Renumber individual 
arrows

In the Set Tab Order dialog box, click Edit tab order. In the 
layout, click an arrow whose order you want to change, and 
then type a new number.

Remove numbers from all 
arrows and set a new tab 
order 

In the Set Tab Order dialog box, click Create new tab order. 
In the layout, click the arrows in the order you want.

Omit fields from the tab 
order

As you set a new tab order, don’t click arrows for the fields 
to omit. For fields that already display a number, select the 
number, and then press Delete.

Set a tab order for values in 
repeating fields

See the information following these steps.

Restore the default tab 
order (left to right, top to 
bottom)

Click Revert to Default.

Second 
click Third click

Horizontal tab order for 
repeating fields (left to right) First click

Fourth click
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To enter all the values in a single repeating field before you tab into any 
other field, double-click the field’s arrow.

Adding scroll bars to fields
Add a vertical scroll bar to any field on your layout (except a container, 
summary, or repeating field), to see more data than fits in the field.

1. In Layout mode, select a field, and then choose Field Format from the 
Format menu.

2. In the Field Format dialog box, click Standard field.

3. Select Include vertical scroll bar, and then click OK.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields, entering data

First 
double-click

Second 
double-click

Third 
double-click

Vertical tab order for repeating 
fields (top to bottom)

Browse mode

Layout mode
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Scroll bars are always displayed if you set the field borders option for 
the right side of the field. Otherwise, they display only when you tab into 
the field. See “Adding borders, fill, and baselines to fields” on page 
3-73.

Formatting repeating fields
To fine-tune a repeating field, you can choose the number of repetitions 
visible in the current layout, and the orientation of the repetitions.

Note Before you begin, you need to define a repeating field. See 
“Defining database fields” on page 2-3 and “Defining repeating fields” 
on page 2-11.

1. In Layout mode, select the repeating field to format, and then choose 
Field Format from the Format menu.

2. In the Field Format dialog box, select options, and then click OK.

   

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scroll bars

To Do this

Set the number of visible 
repetitions in the repeating 
field

For Show <value> of field’s <value> repetitions, type a 
number.

Choose an orientation for 
displaying repetitions

For Use <value> orientation, choose vertical to display 
repetitions stacked (as in a column); choose horizontal to 
display them side by side (as in a row).

Set the number of repetitions
visible in a repeating field, and

their orientation
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Note Data added to a repeating or calculation field with a formula that 
uses repeating fields is always maintained and can be used, even if you 
change the layout to display fewer repetitions or change the field to 
nonrepeating.

Adding borders, fill, and baselines to fields
You can add or change the borders, fill pattern, and baselines (a 
horizontal line in a field to help you align data) for fields, before or after 
you add fields to a layout.

1. In Layout mode, to set attributes for new fields, start with no fields 
selected. To change the attributes of existing fields, select the fields 
to change. 

2. Choose Field Borders from the Format menu.

3. In the Field Borders dialog box, select options, and then click OK.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E repeating fields

To Do this

Set attributes for field 
borders

Select any combination of Top, Bottom, Left, and Right. For 
<value> format, choose Borders from the pop-up menu, and 
then choose a color, pattern, and width.

Add baselines for field data 
and set attributes for the 
baselines

Select Text baselines. For <value> format, choose Baselines 
from the pop-up menu, and then choose a color, pattern, 
and width.

Set a fill pattern for fields For <value> format, choose Fill from the pop-up menu, and 
then choose a color and pattern from the palettes.

Add borders between 
repetitions in repeating 
fields

Select Between repeating values. For <value> format, choose 
Borders from the pop-up menu, and then choose a color, 
pattern, and width from the palettes. (See the examples 
following these steps).

Choose which
portion of the field to

assign attributes to

Choose a color,
pattern, and width
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Keep these points in mind:

1 Changes made in the status area to the preset pattern, color, and line 
width settings replace settings in the Field Borders dialog box, and 
vice versa. See “Changing lines, colors, and patterns” on page 3-51.

1 You can also use the fill controls in the status area to fill a field with 
a color and pattern. See “Changing lines, colors, and patterns” on 
page 3-51.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields, customizing

Select Top, Bottom, 
Right, and choose a width

Select Top, Bottom, 
and choose a width

Lines between the repeating values

One box around all data in three 
repeating fields

For each field, select the Between
repeating values option, and then

choose a line width

For the middle field, select Left and
Right, and then choose a width

Left and right borders for the middle field

Select Top, Bottom, Left, 
and choose a width
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Defining value lists
To save time and ensure accuracy during data entry, define frequently 
used text, number, date, or time values to display in a pop-up menu or 
pop-up list, or as checkboxes or radio buttons. When you enter data, 
choose from the list of defined values.

Value lists aren’t attached to any field definition but can be shared by 
several fields. The values in a value list can be user-defined or based on 
the values in a field in the same file or in a different file.

After you define a value list, you can use it to validate any field. (See 
“Choosing data entry options” on page 2-6.)

To define a value list:

1. Select a field on the layout for which you want to use a value list, and 
then choose Field Format from the Format menu.

2. In the Field Format dialog box, for Style, select Pop-up list using value 
list <value>, and then choose Define Value Lists from the pop-up menu. 

3. In the Define Value Lists dialog box, for Name, type a name for the 
list, and then click Create.

Choose from this list of 
values during data entry
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4. Define the value list.

To Do this

Create a list of values Select Use custom values, and then type each value on a separate 
line, in the order you want them to appear. Press Return to 
separate each value.

Choose from existing 
values in a different 
field

Select Use values from a field, and then click Specify Field. In the 
Specify Field for Value List dialog box, to choose from a field 
in a different file, click Specify File, and then choose a filename. 
For Use values from this field, click the name of a field, and then 
click OK.

Choose from existing 
values in a second 
field

In the Specify Field for Value List dialog box, select Also display 
values from, click a field name, and then click OK.

Select this option to display the values from a corresponding 
field next to the values in your value list. For example, to help 
with data entry, you could display part names next to part 
numbers.

Produce a separator 
line between items in a 
pop-up menu or 
pop-up list, or produce 
spaces between radio 
buttons or checkboxes

In the list of custom values, type a hyphen on a separate line 
where you want the separator line or space to appear, and then 
press Return.

Delete a value list In the list of names, select the value list, and then click Delete.

Duplicate a value list In the list of names, select the value list, and then click Duplicate.

Names of value lists

Type a name for the current list

Determine which
values to display

in the list

Type 
custom 
values

Click to use field values
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5. Click Save, and then click Done.

Keep these points in mind:

1 You can open the Define Value Lists dialog box quickly by choosing 
Define from the File menu, and then Value Lists.

1 You format a value list as checkboxes, radio buttons, a pop-up menu, 
or a pop-up list in Layout mode. See the next section.

1 You can also define a value list or attach value lists to fields in the 
Validation dialog box (of Define Fields) or in the Sort dialog box.

1 You can edit a value list in Browse mode. See “Entering data from a 
value list” on page 4-9.

Formatting fields with value lists
After you define a value list, you can make the following changes:

1 Display values in a pop-up menu, a pop-up list, with radio buttons, or 
with checkboxes.

1 Add an Other item to checkboxes, radio buttons, pop-up menus, and 
pop-up lists so you can enter a value that’s not in the list.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E value lists

Select a field to
use its values

Select a second 
field to display 
values from

Select a file containing
the field values you want
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1 Add an Edit item to checkboxes, radio buttons, pop-up menus, and 
pop-up lists so you can edit the values in the list.

  

Note Before you begin, you need to define a value list. See “Defining 
database fields” on page 2-3 and “Defining value lists” on page 3-75.

1. In Layout mode, select the field to format, and then choose Field 
Format from the Format menu.

2. In the Field Format dialog box, select options.

1 To choose a format for a value list, for <value> using value list, 
choose a format, and then choose the name of a value list or define 
a new value list.

1 To add an Other item to a value list, for <value> using value list, 
choose a format, and then choose the name of a value list or define 
a new value list. Then select Include “Other...” item to allow entry of 
other values.

1 To add an Edit item to a value list, for <value> using value list, choose 
a format, and then choose the name of a value list or define a new 
value list. Then select Include “Edit...” item to allow editing of value list.

3. Click OK.

Note Pop-up lists, pop-up menus, checkboxes, and radio buttons appear 
when you publish a database on the Web using FileMaker Pro Web 
Companion Instant Web Publishing. However, Edit and Other items do 
not appear.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E value lists

Checkboxes Radio buttons Pop-up menu Pop-up list
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Working with text
Text makes a layout easier to use and understand. When you add text to 
the body of a layout, FileMaker Pro displays the text with every record. 
Add text for labels or column headings that identify fields, instructions 
on a form, report titles, page or record numbers, and so on. On some 
predefined layout types, FileMaker Pro displays the field name as text. 

Text typed or pasted on a layout is a text object (except when it’s part of 
a graphic), which you can select, group, move, shape, cut, or copy, as 
any other object.

Note Text objects do not appear when you publish a database on the 
Web using FileMaker Pro Web Companion Instant Web Publishing.

FileMaker Pro can use all the fonts installed in the System Folder of 
your current startup disk. If you have Helvetica on your system, 
FileMaker Pro uses it by default. Otherwise, it uses the Geneva 
computer font. To update your list of fonts, see the documentation that 
came with your computer.

You can set the font for text before you type it, or you can change the 
font of existing text or field objects.

  

   

Changing these field
labels doesn’t affect

the actual field names
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Keep these points in mind:

1 You can also use drag and drop and context menus to edit text. See 
“Using drag and drop to move information” on page 4-13 and 
“Editing objects and data quickly using the context menu” on page 
3-42.

1 Use standard editing conventions when working with text. For 
keyboard equivalents and other keyboard shortcuts, see 
FileMaker Pro Quick Reference on the back cover of this user’s 
guide.

1 To use the attributes of an existing field or text object to set the preset 
attributes for all text, hold down Command and click the field or text 
object.

1 To change text attributes, see “Changing the appearance of text” on 
page 3-88.

1 You can change attributes for the text in a field when you set the 
field’s format. See “Formatting text attributes in individual fields” on 
page 3-60.

1 To check the spelling of text, see “Checking your spelling” on page 
1-13.

Typing text
When you add text, you see a temporary border around the object, to 
indicate the object’s boundaries. The border doesn’t display or print 
when you browse, preview, or print records.

To type text:

1. In Layout mode, select the text tool in the tool panel.

2. With the I-beam pointer, click in the layout where you want to add 
text.

3. Type the text.

You can also type text with other tools selected. If you click on the 
layout and begin typing, FileMaker Pro creates a text object where 
you click.

Temporary border 

Text tool
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To control the size and position of the borders before typing:

1. In Layout mode, select the text tool, and then position the pointer 
where you want the text to begin.

2. Drag the pointer until the border is the size you want.

3. Type the text.

Keep these points in mind:

1 The text appears in the current font, style, line spacing, color, and 
alignment. To set or change text attributes, see “Changing the 
appearance of text” on page 3-88.

1 To set an option to keep layout tools selected until you select another 
tool, see “Setting layout preferences” on page 9-3.

1 FileMaker Pro adds text to a layout in different places, depending on 
what you select.

When you select Text appears

Nothing on the layout and start 
typing

In the last place you clicked.

A text object and start typing In place of the selected text object.

An object (such as an oval) and start 
typing

Within the boundaries of the selected object (the 
text isn’t actually inside the object but layered in 
front of it).

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text, entering
E text tool
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Selecting text
Before you select text, select the object (in Layout mode) or field (in 
Browse mode) by clicking it. Then:

Editing text
You can make changes to text after you type it on the layout.

To select Click the text tool and

Individual characters With the pointer, drag through the 
characters.

A word Double-click the word.

A line of text (the first character in the field or 
object to the last character in the field or 
object on the same line)

Triple-click anywhere in the line.

A paragraph of text Click the block of text four times.

All text in a field or text object Click the field or object five times.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text, entering

To Do this

Replace text Select the text, and then type the new text.

Paste a copy of text 
elsewhere

Select the text, and then choose Copy from the Edit menu. Click 
where you want the text to appear, and then choose Paste from the 
Edit menu.

Remove text and paste 
it elsewhere

Select the text, and then choose Cut from the Edit menu. To paste 
the cut text, click where you want the text to appear, and then 
choose Paste from the Edit menu.

Edit text quickly using 
commands in a pop-up 
menu

See “Editing objects and data quickly using the context menu” on 
page 3-42.

Delete text permanently Select the text, and then press Delete. FileMaker Pro doesn’t place 
your selection on the Clipboard, and you can’t paste it anywhere.

Paste text from a 
different application or 
desk accessory 

In the other application or desk accessory, select the text. Choose 
Copy or Cut from the Edit menu. Click where you want the text on 
the FileMaker Pro layout, and then choose Paste from the Edit 
menu.
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Keep these points in mind:

1 To restore text you deleted, choose Undo from the Edit menu before 
you do anything else in FileMaker Pro.

1 Text you cut or copy stays on the Clipboard until the next time you 
use Cut or Copy.

1 To change the appearance of text, see “Changing the appearance of 
text” on page 3-88.

1 To rearrange text on the layout, see “Arranging objects” on page 
3-44.

Displaying special information
You can display or print fixed information (like the date as it was when 
entered) or variable information (like today’s date) when you print or 
preview records. For example, display the current time in a report footer 
each time you print the report. You can also display the date, time, or 
user name as it is when you place it in the layout. This information stays 
the same whenever you display, print, or preview records.

1. In Layout mode, click where you want the variable information to 
display.

2. Choose Paste Special from the Edit menu, and then choose a 
command.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text, editing

To insert Choose You see this on the layout

A fixed date Current Date The current date (taken from your 
computer’s calendar)

A fixed time Current Time The current time (taken from your 
computer’s clock)

A fixed user name Current User Name The current user name

A variable date Date Symbol Two slashes (//)

A variable time Time Symbol Two colons (::)

A variable user 
name 

User Name Symbol Two vertical lines (||)

A page number Page Number Two number symbols (##)

A record number Record Number Two at symbols (@@)
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Note Before you print a layout that displays the current page number, 
you can specify the starting number in the Print dialog box. (See 
“Printing” on page 6-12.)

Formatting text paragraphs
You can format text, and the data in text fields, as paragraphs. For 
example, indent the first line of text, or insert tab stops in a text field. Set 
formatting options individually or all at once.

Using the text ruler
Format text on layouts and in text fields using the text ruler.

 

1. To display the text ruler in Layout mode, choose Text Ruler from the 
Show menu. In Browse mode, choose Text Ruler from the Format 
menu.

2. In Layout mode, select the objects to format. In Browse mode, select 
the text to format.

To set tabs, indents, or margins, select text first. If you click a text 
object without selecting text, you can only set font, size, style, 
alignment, and ruler units.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E variables

Choose a font

Choose a font size Set font styles

Align paragraphs Set tabs

Choose ruler units
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3. Select options.

Note After you set tab stops within a field, use the tab stops in Browse 
mode by clicking inside the field, then holding down the Option key 
while pressing Tab.

Setting tabs using the Tab dialog box
1. Display the text ruler, as explained in “Using the text ruler” on page 

3-84.

2. To display the Tabs dialog box, with text selected, double-click a tab 
marker in the text ruler.

You can also choose Text from the Format menu, click Paragraph in 
the Text Format dialog box, and then click Tabs.

To Do this

Indent the first line Drag the left indent marker . The first line indent 
marker automatically follows.

To move the left indent marker by itself, press Option 
and drag it.

Set the font Choose a font from the pop-up menu.

Set the font size Choose a size from the pop-up menu.

Set the font style Click one or more style controls (bold, italic, or 
underline).

Set a tab Click a set tab button, and then click the ruler where 
you want the tab. (Set up to 20 tabs for each text object 
or field.) Select a left-align, center-align, right-align, 
or decimal-align tab. Or double-click a tab marker to 
display the Tab dialog box. (See the next section.)

Align text Click an alignment control. Select left, center, right, or 
justified alignment.

Change the unit of measure Choose a unit from the pop-up menu.

Change the left or right margin Drag the left or right indent markers on the ruler.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text ruler
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3. In the Tabs dialog box, select options.

4. Click OK when you’re done setting options for all tabs.

To Do this

Set the tab alignment For Type, select an option.

Set a decimal tab Click Align On. To set a decimal tab on a separator other 
than a period (.), type a character in the text box.

Specify the tab’s position on the 
ruler

For Position, type a value.

Specify a fill character For Fill Character, type a character (for example, for a 
phone listing, you can fill the area between the name 
and the telephone number with periods).

Apply the current settings and 
set another tab

Click Apply.

Change the options for the 
currently selected tab

Select new options, and then click Set.

Set a new tab Select options, and then click New.

Clear the current settings, to 
start over

Click Clear.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text, formatting

Set alignment 
for a tab

Specify the tab’s 
position

Specify a fill 
character

Current tab settings
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Formatting paragraphs all at once
1. Display the text ruler, as explained in “Using the text ruler” on page 

3-84.

2. To display the Paragraph dialog box, with text selected, double-click 
a blank area of the text ruler.

You can also choose Text from the Format menu, and then click 
Paragraph in the Text Format dialog box.

3. In the Paragraph dialog box, select options, and then click OK.

To Do this

Set text alignment For Alignment, select an option.

Indent all the text For Indent, type a value for Left or Right.

Indent the first line only For Indent, type a value for First.

Set line spacing For Line Spacing, choose an option. To set the unit of 
measure, for Lines, choose an option.

Set tabs Click Tabs, and then see “Setting tabs using the Tab 
dialog box” on page 3-85.

Apply the current settings to the 
text without closing the dialog 
box

Click Apply.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E paragraph attributes

Align text

Indent text

Set line spacing 
and change the 
units of measure

Set tabs
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Changing the appearance of text
You can change text attributes, like font or line spacing, before or after 
you type text. If you change text attributes after typing text, the attributes 
you set become the preset attributes for new text.

To set attributes for new text, start with no text selected. To change the 
attributes of existing text, select the text, and then make your changes. 

You can display text in various alignments, as shown in the following 
examples.

To set Do this

Font Choose Font from the Format menu, and then choose a font.

Size Choose Size from the Format menu, and then choose a size.

Custom font size Choose Size from the Format menu, and then choose Custom. Type a 
value between 1 and 500, and then click OK. You see the new size 
below Custom in the Format/Size menu.

Style Choose Style from the Format menu, and then choose a style. You can 
apply more than one style to text. Use the Text Format dialog box to 
set several options at once. See the next section.

Text alignment Choose Align Text from the Format menu, and then choose Left, Center, 
Right, or Full. Then, you can also choose Top, Center, or Bottom. The 
setting applies to a whole field or paragraph, and not to individual 
characters. (See the next table.)

Line spacing Choose Line Spacing from the Format menu, and then choose a 
spacing.

Custom line spacing Choose Line Spacing from the Format menu, and then choose Custom. 
For Line Spacing, select options, and then click OK.

Text color Choose Text Color from the Format menu, and then choose a color.

For example, this 
alignment Aligns text like this

Left Mountaineering, Inc. sunglasses provide good looks and the 
maximum protection against the sun’s damaging ultraviolet rays. 
Mountaineering, Inc. sunglasses are endorsed by mountaineers and 
skiers

Center Mountaineering, Inc. sunglasses provide good looks and the 
maximum protection against the sun’s damaging ultraviolet rays. 

Mountaineering, Inc. sunglasses are endorsed by mountaineers and 
skiers
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Right Mountaineering, Inc. sunglasses provide good looks and the
maximum protection against the sun’s damaging ultraviolet rays.

Mountaineering, Inc. sunglasses are endorsed by mountaineers and
skiers.

Full Mountaineering, Inc. sunglasses provide good looks and the
maximum protection against the sun’s damaging ultraviolet rays.
Mountaineering, Inc. sunglasses are endorsed by mountaineers and
skiers.

Top 
(when Left is also 
selected)

Mountaineering, Inc. sunglasses provide good looks and the 
maximum protection against the sun’s damaging ultraviolet rays. 
Mountaineering, Inc. sunglasses are endorsed by mountaineers and 
skiers.

Center 
(when Left is also 
selected)

Mountaineering, Inc. sunglasses provide good looks and the 
maximum protection against the sun’s damaging ultraviolet rays. 
Mountaineering, Inc. sunglasses are endorsed by mountaineers and 
skiers.

Bottom 
(when Left is also 
selected)

Mountaineering, Inc. sunglasses provide good looks and the 
maximum protection against the sun’s damaging ultraviolet rays. 
Mountaineering, Inc. sunglasses are endorsed by mountaineers and 
skiers.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text, formatting

For example, this 
alignment Aligns text like this
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Changing several text attributes at once
You can set or change any combination of the text attributes at one time.

1. In Layout mode, to set text attributes for new text, start with no text 
selected. To change text attributes of existing text, start by selecting 
the text object.

2. Choose Text from the Format menu.

3. In the Text Format dialog box, select options, and then click OK.

For more information about the options, see “Formatting text 
attributes in individual fields” on page 3-60.

Keep these points in mind:

1 Changes to preset options affect the text format of text objects and 
fields you add later. See “Formatting text attributes in individual 
fields” on page 3-60.

1 You can set default paragraph styles for text and fields before typing 
text or creating new fields. To format text in paragraphs and fields, 
see “Formatting text paragraphs” on page 3-84.

1 Preset attributes apply to text objects that you create by selecting the 
text tool and dragging to make a bounding box on the layout. If you 
click on the layout and begin typing text, the preset attributes don’t 
apply.

1 Text attributes do not appear when you view data using Web browser 
software.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E text, formatting



Chapter 4:  Working with information in records

After you create a database and define fields, you can enter and work with data 
in the file. This chapter explains how to:

1 add and edit data in a database

1 view records in a database

1 find groups of records to work with

1 delete records

1 sort records

For information on adding, editing, viewing, searching for, deleting, and 
sorting records on the Web, see chapter 11, “Publishing files on the Web.”

Important Before you read this chapter, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.”

Working in Browse mode
When you finish defining fields for a new file, FileMaker Pro moves to 
Browse mode, where you enter data into the file. (You also work in Browse 
mode after you open a file or when you choose Browse from the Mode menu.) 
In Browse mode you work with the contents of a file rather than the 
appearance and layout. 

When you work with a new database in Browse mode, you start with a 
Standard layout. You can modify this layout and create additional layouts in 
Layout mode (see chapter 3, “Laying out and arranging information”). If the 
database you’re using has several layouts, you can choose a different layout 
from the layout pop-up menu at the top of the status area.

In Browse mode, you also view, change, find, omit, sort, copy, and delete 
records.

You can work with all the records in a file or a group of records, in sorted order 
or the order in which you added them to the file. When you choose a group of 
records to browse, you temporarily separate those records from the others in 
the file so you can work with them.
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Each file has one current record at a time, which is the record on the screen if 
you’re viewing individual records, or the record marked with a solid bar if 
you’re viewing records in a list.

Adding data to a file
Add data to a file by typing, pasting, or copying data into blank fields of a 
record. FileMaker Pro saves the file as you work. The following sections 
describe how to add data to a file.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E records, overview

Layout pop-up menu

Number of records in the file

Current sort status of
records

Zoom controls

Status area control
Mode pop-up menu

Status area

Book
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Selecting a field for data entry
To work with data in a field, you first select the field. The boundaries of 
a selected field are solid lines; boundaries of other fields are dotted lines.

Keep these points in mind:

1 You can’t press Tab to move to some fields (for example, calculation 
and summary fields and fields omitted from the tab order) in Browse 
mode. You must click in them to select them, as long as the fields 
have been formatted to allow entry (by selecting Allow entry into field 
in the Field Format dialog box in Layout mode). You can’t add data 
to calculation and summary fields, but you can copy their contents to 
other fields. 

1 To change the order in which pressing Tab or Shift-Tab moves you 
through the fields, see “Setting the tab order for data entry” on page 
3-69.

Adding and duplicating records
You add records to a database by using the New Record and Duplicate 
Record commands and then typing or pasting data into blank fields of the 
record. If you specified entry options to enter values automatically, you 
see those values entered in the record. 

To Do this

Select a field for data entry Click in the field. FileMaker Pro scrolls if necessary to 
display the field’s contents. FileMaker Pro extends a 
field that’s filled beyond the border, if the field has no 
scroll bar, until you move out of the field.

Move to the next field in the field 
order

Press Tab.

Move to the previous field in the 
field order

Press Shift-Tab.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E entering data
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Duplicate an existing record to quickly add a record with the same or 
similar data. When you add or duplicate records, each new record is 
placed at the end of the file. When you browse a group of records you 
found (called the found set), new records appear at the end of the group 
(until you sort them).

Note To return the current record to the way it was before you began 
adding or changing data, choose Revert Record from the Mode menu 
before you select a different record or leave the current one. 

Entering and changing data in fields
You can enter information up to the limit for the field type (for example, 
255 characters in a number field), but you can see and print only as much 
data as fits within the field boundaries. (You can change the boundaries 
in Layout mode. See “Resizing objects” on page 3-50.)

To Do this

Add a record Choose New Record from the Mode menu. (You see a blank 
record with one field selected.) Type data into the fields. (See 
the next section, “Entering and changing data in fields.”)

Duplicate a record Select the record to duplicate. Choose Duplicate Record from 
the Mode menu. You can change data as needed. (See the 
next section, “Entering and changing data in fields.”)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E entering data

To Select the field, and then

Type in a text field Type the text (up to 64,000 characters).

Type in a number field Type the data.

Type in a date field Type one date on one line in each field. Type the day, 
month, and year as numbers (for example, 2/3/98) in the 
format used when the file was created or the current 
system format for dates (if Use System Formats is set), 
separated by a nonnumeric character like – (minus) or / 
(forward slash). Type a two-, three-, or four-digit year. 
Don’t mix dates with other types of data.

For information about system formats, see appendix B, 
“Working with international files.”
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Keep these points in mind:

1 You can add a vertical scroll bar to a field. A scroll bar lets you see 
all the field’s contents without changing the field’s boundaries. See 
“Adding scroll bars to fields” on page 3-71.

1 In a date field, if you don’t type a year, FileMaker Pro enters the 
current year for you.

1 There are many other ways of entering data in a field, like inserting, 
or copying it from another source, using a lookup, or having 
FileMaker Pro automatically enter the data each time you create a 
record. See the appropriate sections in this chapter; chapter 8, 
“Importing and exporting data;” “Choosing data entry options” on 
page 2-6; and “Looking up and displaying data from other files” on 
page 10-1.

Type in a time field Type the time as hours and minutes or as hours, 
minutes, and seconds in the format used when the file 
was created or the current system format for time (if Use 
System Formats is set), separated by a nonnumeric 
character like : (colon). Use 24- or 12-hour format, with 
or without AM or PM. (AM is assumed for a time less 
than 12:00.) You can type a negative 24-hour time (like 
–08:40:00).

For information about system formats, see appendix B, 
“Working with international files.” 

Insert a tab character in a field Press Option-Tab.

Add data to a container field See “Working with container fields” on page 4-6.

Delete a character Place the insertion point to the right of the character, 
and then press Delete. Or place the insertion point to the 
left of the character, and then press Del.

Edit data quickly, using commands 
in a pop-up menu

See “Editing objects and data quickly using the context 
menu” on page 3-42.

Replace text Select the text, and then type the replacement. Click 
twice to select a word, three times to select a line, four 
times to select a paragraph, and five times to select the 
entire field contents.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E entering data

To Select the field, and then
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Working with container fields
A container field can store a graphic, a sound, or a QuickTime movie.

Note Sounds and QuickTime movies are not supported in FileMaker Pro 
Web Companion Instant Web Publishing.

Importing graphics
1. Select the container field to import into.

2. Choose Import/Export from the File menu, and then choose Import 
Picture.

3. In the Import Picture dialog box, choose options for the graphic, and 
then click Open.

Importing QuickTime movies
1. Select the container field to import into.

To Do this

Choose the file to import Select the name of the file (switch to a different 
folder if needed).

Store a reference to the graphic file 
in the field

Select Store file reference. (This keeps the file size 
down. However, if the file is moved or deleted, 
FileMaker Pro can’t display the graphic.) To store 
the graphic in the file, deselect Store file reference.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E importing data

Select a file

Choose a file type
Select to store a 
reference to the 
graphic file in the field 
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2. Choose Import/Export from the File menu, and then choose Import 
Movie.

3. In the Import Movie dialog box, double-click the filename (change 
folders, if needed).

To crop or scale the first frame of the movie, see “Defining display 
formats for fields” on page 3-59. 

Playing QuickTime movies
To control a QuickTime movie, click the field containing the movie, and 
then use the movie controls.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E importing data

Choose a QuickTime
movie file

Select to see a frame of
the movie displayed

Click the Play button to
start or stop the movie

Drag the scroll bar to go to a 
specific frame of the movie

Click the Backward or Forward 
button to step through the frames
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The movie in a container field is a reference to a QuickTime movie file. 
If you move the database to a different computer, move the movie file as 
well (unless you have access to it through an AppleShare network 
server). 

Pasting graphics, movies, and sounds from the Clipboard
Cut or copy a graphic, movie, or sound in a different application by 
putting it on the Clipboard. Then paste it into a FileMaker Pro container 
field. 

1. After you cut or copy the graphic, movie, or sound to the Clipboard, 
open the FileMaker Pro file to paste into. 

2. In Browse mode, display the record to paste into, or add a new record.

3. Select the container field, and then choose Paste from the Edit menu.

To delete graphics, movies, or sounds, select the container field and 
press Delete, or use drag and drop to move the item to the trash (see 
“Using drag and drop to move information” on page 4-13).

Note  You can also drag and drop graphics and sounds into container 
fields. See “Using drag and drop to move information” on page 4-13.

Recording and playing sounds
With Sound Control Panel and a microphone, you can play and record 
sound.  

 Choose FileMaker Help Index from the  or Help menu, and then type:

E playing

To Do this

Record a sound Double-click a blank container field. In the Sound Record 
dialog box, click Record.

Play a sound Double-click the field where the sound is stored.

Stop or pause recording In the Sound Record dialog box, click Stop or Pause.

Play back a recording In the Sound Record dialog box, click Play.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E sounds
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Entering data from a value list
in Layout mode, you can define a list of values to enter or validate data 
in one or more fields and format the values to appear in a pop-up list, a 
pop-up menu, as radio buttons, or checkboxes. You can also include an 
Other item (to add a value not in the list) and an Edit item (to add or 
change values from Browse mode) in value lists. (See “Choosing data 
entry options” on page 2-6 and “Formatting repeating fields” on page 
3-72.)

To Do this

Choose from a pop-up list Select the field with the pop-up list, and then select a 
value by clicking the value.

Choose from a pop-up menu Select the field with the pop-up menu, and then choose 
a value.

Choose from radio buttons Select the field with the radio buttons, and then select a 
value.

Choose from checkboxes Select the field with the checkboxes, and then select a 
value or values.

Choose an Other item Select Other in the list of values. In the dialog box that 
appears, type a value, and then click OK.

Hide a value list Press Esc, or select the field again. Press Esc again to 
see it.

Type a value that’s not in a list Select the field again, and then type the value.

Deselect a checkbox Select the selected checkbox again.

Deselect a radio button Select a different value.

Deselect several radio buttons or 
pop-up menu items

Press Shift and select the values.

Deselect an Other item Click Other, and then delete the associated value (and its 
carriage returns) in the dialog box.

Edit a value list Click Edit, and then make any changes to the values in 
the Display Values for <value list> dialog box.

Add or change values
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Viewing and inserting data from another source
To maintain consistency across records, you can do the following:

1 View values in the index (when a field is indexed), which contains all 
the values in the currently selected field and insert them into the 
current field. 

1 Insert the current date, time, or user name.

Working with the index
When you have field values indexed (by selecting storage options in the 
Entry Options dialog box), FileMaker Pro indexes the values in each 
text, number, date, time, and calculation field. You can view the values 
in a field’s index, and insert them into the field to prevent typing 
duplicate values incorrectly. (To index fields, see “Indexing fields” on 
page 2-12.)

Note Inserting values from the index is useful in Find mode. In Browse 
mode, prevent errors by creating a value list and inserting values from 
the list into the currently selected field instead of pasting values from the 
index. (See “Defining value lists” on page 3-75.)

1. Select the field to hold a value from the index. 

To replace the current field value, select the data to replace. To select 
the entire contents of the field, choose Select All from the Edit menu.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E entering data

Type a value to
enter in the field
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2. Choose Paste Special from the Edit menu, and then choose From Index.

3. In the View Index dialog box, to view each word instead of each 
value, select Show individual words.

4. Double-click a value to paste.

  

Note In a text field, the first 60 characters of the text are pasted.

Inserting the current date, time, or user name
You can insert the current date, time, or user name into a field in Browse 
mode or into fields in a find request. Insert the current date into a date, 
number, or text field. Insert the current time into a time, number, or text 
field. Insert the current user name into a text or number field.

1. Select the field to insert information into.

2. Choose Paste Special from the Edit menu, and then choose Current 
Date, Current Time, or Current User Name.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E index

Indexed values in a field
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Keep these points in mind:

1 After you insert the current date or time into a field, that value doesn’t 
change. To display the current date or time, place a date or time 
symbol on the layout. See “Displaying special information” on page 
3-83.

1 You can use a script to insert information into a find request (for 
example, have a script enter the current user name to find all records 
specific to the current user). For more information, see “Displaying 
customized layouts” on page 5-32.

Copying and moving values and records
You can copy values from any field type, including fields that are 
formatted as radio buttons, checkboxes, pop-up lists, and pop-up menus.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E entering data

To Do this

Copy or move a value from 
one field to another

Select the field contents and choose Copy or Cut from the Edit 
menu. Select the field to hold the data, and then choose Paste 
from the Edit menu.

Copy or move a value from a 
field in one record to a field 
in another

Select the field contents and choose Copy or Cut from the Edit 
menu. Display the other record (see “Moving through 
records” on page 4-18). Select the field to hold the data, and 
then choose Paste from the Edit menu.

Copy a value from the last 
record you modified

Select the field to hold the data. Choose Paste Special from the 
Edit menu, and then choose From Last Record.

Copy values in a record to 
another application, like 
word processing

With no field selected, choose Copy from the Edit menu. In the 
other application, paste the record that’s in the Clipboard.

Copy the found set of 
records

See “Copying the found set” on page 4-29.

Duplicate data from another 
record in the current record

See “Adding and duplicating records” on page 4-3.
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Keep these points in mind:

1 You can also drag and drop information between fields, records, and 
applications. See the next section, “Using drag and drop to move 
information.”

1 When you paste data into a field formatted as radio buttons, 
checkboxes, or a pop-up list or menu, the appropriate value is 
selected, replacing the entire contents of the currently selected field. 
When you paste a value that’s not in the field’s value list, the Other 
value is selected, if applicable.

1 When you copy a record, everything is copied except data in 
container fields (including calculations with container results and 
global fields of container type). Text fields are copied in 
tab-delimited format, without styles, in the order they were created in 
the file. 

Using drag and drop to move information
You can use drag and drop to transfer information to or from 
FileMaker Pro and other applications that are drag-and-drop capable 
without using the Clipboard. 

To use drag and drop, you need System 7.5 or later, or System 7.0 with 
the Macintosh Drag and Drop extension.

You can use drag and drop in Browse mode, Layout mode, and Find 
mode. In Layout mode, use drag and drop to transfer graphics or text. In 
Browse mode, use drag and drop to transfer text, or the contents of a 
container field, to another field. You can use drag and drop between 
FileMaker Pro and other applications. Each application you’re using 
must support the type of data you’re transferring (for example, you can’t 
transfer a graphic into a text field).

1. Be sure both applications are open and visible on the screen in 
Browse, Layout, or Find mode.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E copying data
E deleting data
E pasting
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2. Drag an object from one application to the other. 

You see an outline of the object you’re dragging while you hold the 
mouse button down. If the other application can accept the object, the 
destination area (for example, a field) is highlighted.

Keep these points in mind:

1 To disable drag and drop for text in fields, deselect Enable drag and 
drop text selection in the General area of the Preferences dialog box. 
See “Setting general application preferences” on page 9-2.

1 You can’t use drag and drop with more than one object at a time into 
FileMaker Pro.

Replacing field values
You can replace the contents of a field in all or some records with a 
different value (for example, replace the value Production Artist with 
Production Specialist), a new series of serial numbers (when, for 
example, records have become disordered), or an expression. You can 
also modify a field’s existing values by using an expression that includes 
the field (for example, change the value Gross Pay to the expression 
Gross Pay + 1000).

Before you begin, keep these points in mind:

1 You can’t replace calculation, summary, or global fields.

1 You can’t reserialize calculation, summary, global, or container 
fields.

1 You may want to sort records before you reserialize them. For 
example, sort suppliers by how frequently you use them, and then 
reserialize the records. (See “Finding information” on page 4-19, 
“Omitting records” on page 4-26, and “Sorting records” on page 
4-30.)

1 To replace data in fields in only a few records, go to each record and 
change the value by selecting the contents of the field and then typing 
the information you want.

Important You can’t undo replacing field values. Before you begin, 
consider making a copy of the file.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E drag and drop
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To replace field values:

1. In Find mode, find the records whose data you want to replace.

2. If you want the data in a specific order, in Browse mode, sort the 
records.

3. In Browse mode, in the current record, select the contents of the field 
whose values you want to replace.

4. If you’re replacing data (not assigning serial numbers), type the value 
to replace the current data with.

5. Choose Replace from the Mode menu.

6. In the Replace dialog box, choose how to replace field values.

To replace each field 
with Select 

The value in the currently 
selected field

Replace with <value>. FileMaker Pro replaces the 
contents of the field for the entire found set.

A serial number Replace with serial numbers. Then type the starting value 
for the serial numbers and how much to increment each 
number by. (FileMaker Pro enters serial numbers 
starting with the first record in the found set).

If you chose to automatically enter a serial number 
when you defined the field, you can update the next 
serial number value in the Entry Options dialog box by 
selecting Update serial number in Entry Options? in the 
Replace dialog box.

An expression you specify Replace with calculated result, and then click Specify. In the 
Specify Calculation dialog box, define the expression. 
(See “Writing formulas for calculation fields” on page 
2-20.) The expression result must match the field type 
of the replaced field.

Select how to replace
field values
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7. Click Replace.

Note If the field that contains the replaced data is validated, FileMaker 
Pro doesn’t validate the new data. (See “Choosing data entry options” 
on page 2-6.)

Working with records
After you add data to records, you can work with them in various ways, 
as described in the following sections.

Browsing records
View records individually or as a list. When you’re browsing individual 
records, the current record is the one you’re viewing. When you’re 
browsing records in a list, you see as many records as fit on one screen. 
In a list, the current record is marked with a solid bar along the left 
side.

1 To browse individual records, choose Browse from the Mode menu. 
(Be sure View as Form in the Select menu is chosen.) 

1 To browse records in a list, choose Browse from the Mode menu, and 
then choose View as List from the Select menu. To work with a 
particular record, click anywhere in the record to make it the current 
record. 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E values
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Note You can also prepare a Columnar report layout to show records in 
a list. See “Using Columnar report and Extended columnar layouts” on 
page 3-9.

Opening a URL
If you have a valid URL (Web address) in a field, you can click on the 
address, automatically open your Web browser, and go to the URL.

To open a URL from a field:

1. Press and hold the Command key, and then click any part of the URL.

2. Choose Open <URL> from the context menu.

Note This feature requires the Internet Config 1.1 (or later) tool. For 
information on installing this extension, see your Mac OS 
documentation.

When you view records in a
list, you see any header or

footer in the layout

Current record bar
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Moving through records
To move from one record to another, use keyboard commands or the 
book in the status area. When you browse individual records, 
FileMaker Pro displays the number of the current record in the 
lower-right corner of the book. When you browse records in a list, the 
current record is also identified by a solid bar to its left.

 

To move Do this

One record at a time forward Click the bottom page of the book.

One record at a time backward Click the top page of the book.

Quickly to a specific record Click the record number at the bottom of the book, type 
the record number you want, and then press Return. (Or 
press Esc, type the record number, and then press 
Return).

Quickly through records Drag the bookmark down or up to move forward or 
backward to a specific record.

Record by record through the list Use the scroll bar to view records, and then select the 
record you want to work with.

To a record with a unique value 
that you know

See the next section, “Finding information.”

 Choose FileMaker Help Index from the  or Help menu, and then type:

E records, overview

Click to move to previous record Bookmark

Current record number
Click to move to next record
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Finding information
You find specific records using Find mode. In Find mode, you can get a 
subset of the records in a file (called the found set) to do the following:

1 Get specific information based on the data in text, number, date, time, 
and calculation fields.

1 View, edit, perform functions on, calculate summaries for, sort, print, 
delete, export, or copy the found set to a different file.

1 Find records that contain errors like empty fields, duplicate values, 
invalid dates or times, or mistakes you might notice (like 
misspellings) while viewing the index.

1 Further reduce the found set by omitting records from it. 

To find records, you type criteria (the value or values to find) into fields 
in a find request, which looks like a blank record. FileMaker Pro 
searches through all the records to compare the criteria with the data in 
the file. Records whose fields match the criteria are added to the found 
set, and the found set becomes the records being browsed.

Find requests can be as simple or complex as required, from a single 
request for a name in a field to multiple requests using operators and 
omissions.

Defining find requests
1. Choose the layout to use for finding records.

The layout must include each field you plan to enter criteria into.

2. Choose Find from the Mode menu.

3. In the find request, select the field to use for finding, and then type 
values in the field.

You can combine values you type with operators from the Symbols 
pop-up menu.
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You can’t enter search criteria in container fields, summary fields, or 
global fields.

To find values that are
Use this 
operator

For example, enter this 
in the field

Less than the value to the right of the 
symbol

< <40
<9/7/1998

Less than or equal to the value to the 
right of the symbol

≤
or
<=

≤95129
≤05:00:00

Greater than the value to the right of 
the symbol

> >95129
>9/7/1998

Greater than or equal to the value to 
the right of the symbol

≥
or
>=

≥100
≥8:00

Exactly as you specify, although the 
field may contain other values 
(additional words, for example)

= =John

Exactly as you specify, in the order 
you specify, and the field contains no 
other values

== ==John

Within the range you specify.

A range is first to last character in the 
alphabet for text; least to greatest for 
numeric; and earliest to latest for date 
and time.

... (three periods)
or
… (ellipsis)

or
.. (two periods)

12:30...17:30
1/1/98..6/6/98

Duplicate values (for example, to 
examine duplicate records in a 
mailing list) 

! ! 

Today’s date // // 

Invalid dates, times, or calculated 
results

? ? 

One unknown or variable text 
character

@ @on

Zero or more unknown or variable 
text characters

* J*n

In fields (to find fields that contain 
values)

* *

Literal text (text exactly as it appears, 
but regardless of uppercase or 
lowercase) in a text field 

" " "   "
", Ltd."

Empty fields (for example, to find 
records of unfilled orders)

= = 
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See the following sections for more information about search criteria.

4. Click Find in the status area, or choose Perform Find from the Select 
menu.

To cancel before searching is finished, press Command-period.

Keep these points in mind:

1 To return the find request to the way it was before you began adding 
criteria, choose Revert Request from the Mode menu.

1 Use the “=” operator when you want to find a value that is exactly as 
you specify—although the field could contain additional values. 
(“=John” could return “John,” “John Smith,” and “John Q. Public.”) Use 
the “==” operator when you want to find exactly what you specify, in 
the order you specify (“==John” returns “John” only; “==John 
Smith” returns “John Smith” only, not “Smith John.”)

1 You can use the index (if the field’s values are indexed) to insert 
values into a find request. See “Working with the index” on page 
4-10.

Click a page of the book to
see another find request

Number of the current request

Number of existing requests

Click to exclude records
that match the request

Choose operators from the
Symbols pop-up menu to

paste into the request

Click to begin searching
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1 You cannot find duplicate values in unindexed fields. For more 
information, see “Indexing fields” on page 2-12.

1 You can perform finds on related fields. See “Finding and omitting 
related records” on page 10-34.

Finding information in different field types
In specific field types, you can find:

1 text that matches a word, phrase, or a string of characters in a text 
field or in a calculation field that produces a text result

1 text characters that aren’t indexed (literal text)

1 numbers in a number field or in a calculation field that produces a 
numeric result

1 dates in a date field or in a calculation field that produces a date result

1 times in a time field or in a calculation field that produces a time 
result

Note To find data in a container field, create a text or number field that 
describes or identifies the contents of the container field. Then find the 
value in the text or number field.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E find requests, defining
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Finding text

Keep these points in mind:

1 Searching for literal text takes longer than word searches. (See 
“Indexing fields” on page 2-12.)

1 You can omit records when you define one or multiple requests. See 
“Omitting records” on page 4-26.

To find this in a text field Type this in the field Example

Words that start with specific 
characters

The specific characters Chris Smith finds Chris 
Smith, Chris Smithson, and 
Smith Christenson

A word that is part of a field’s 
contents

An equal sign (=) before the 
word

=John finds John and John 
Smith (but not Johnson)

An exact word and nothing 
else

Two equal signs (==) before 
the word

==John finds John only
==John Smith finds 
John Smith (but not 
Smith John)

Exact matches on several 
words in the same text field

An equal sign (=) before each 
word in the search criterion in 
that field

=Chris =Smith finds 
Chris Smith or Smith Chris
(but not Christopher 
Smithwick)

Words that vary by one or 
more characters 

One wildcard character (@) 
for each unknown character

Gr@y finds Gray and Grey

Words that vary by more than 
one character 

The wildcard character (*) 
for all unknown characters

McK*ie finds McKechnie and 
McKenzie

Whole words of literal text 
(text exactly as it appears, but 
regardless of uppercase or 
lowercase)

Choose Literal text from the 
Symbols list. Type the text, 
including spaces and 
punctuation, surrounded by 
double quotation marks ("). 

"Marten and Jones 
Interiors" finds Marten 
and Jones Interiors but not 
Jones and Marten Interiors

Partial words of literal text 
(text exactly as it appears, but 
regardless of uppercase or 
lowercase)

Choose Literal text from the 
Symbols list. Type 
characters, punctuation, and 
spaces exactly as they appear 
in the file, surrounded by 
double-quotation marks ("). 
Type the wildcard character 
(*) to find text in the middle 
of the literal text string.

*"son & Phillips" finds 
Johnson & Phillips and 
Paulson & Phillips

", " finds Boston, MA and 
Markley Insurance, Inc.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E symbols
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Finding numbers, dates, and times

Note For information about system formats, see appendix B, “Working 
with international files.”

To find Type this in the field Example

A number in a number field 
or calculation field that 
produces a numeric result

The number, in the format 
used when the file was 
created (unless Use System 
Formats is chosen)

.50 finds .50, $.50, and 50%

A Boolean number in a 
number field or calculation 
field that produces a Boolean 
result

The value you’re using for 
the field

Y, y, t, and T find Yes

1 finds 1

F, f, n, and N find False

A date in a date field or 
calculation field that 
produces a date result

The date as digits, separated 
by a nonnumeric character, in 
the format used when the file 
was created (unless Use 
System Formats is chosen)

3/3/98 finds 3/3/98, 
March 3, 1998, and 
3/3/1998

Today’s date in a date field or 
calculation field that 
produces a date result

// // finds April 4, 1998 (when 
the current date is 
4/4/98)

A time in a time field or 
calculation field that 
produces a time result

The time as digits, separated 
by colons, in the format used 
when the file was created 
(unless Use System Formats is 
chosen)

12:53:09 finds 12:53:09

 Choose FileMaker Help Index from the  or Help menu, and then type:

E data, finding
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Finding different sets of criteria
You can find all the records in a file (for example, after you’ve created 
a found set), find records that match more than one set of criteria (logical 
AND search), or find records that match either one set of criteria or 
another (logical OR search).

Repeating, editing, and deleting find requests
You can repeat the most recent find request to find records that match 
the same criteria. If you add or delete records after defining the first 
request, the result is a different set of found records. You may also edit 
your requests before finding records again.

To find Do this

All the records in a file Choose Find All from the Select menu.

A group of records that match a 
specific set of criteria

In one request, enter criteria into as many fields as 
needed to make your request specific (creating a logical 
AND search), and then click Find (or choose Perform 
Find from the Select menu). For example, type Johnson 
and Personnel to find all people named Johnson who 
work in Personnel.

Records that match one criterion or 
another 

Choose New Request from the Mode menu. (Or use the 
bookmark to display the request to duplicate, and then 
choose Duplicate Request from the Mode menu.) Enter or 
edit the criteria, continue adding new or modified 
requests for each set of criteria (creating a logical OR 
search), and then click Find (or choose Perform Find from 
the Select menu). For example, type New York in the 
first request and Paris in the second request to find all 
records that contain either New York or Paris.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E records, finding
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You can delete requests as long as you keep at least one.

Note Performing a find retrieves records from all the records in the file, 
not just from those previously found.

Omitting records
When you don’t want to include all records in a particular group, you 
can omit the records to exclude, to make them temporarily unavailable. 
Omitting a record doesn’t remove it from the file; the record is removed 
only from the current found set. Omitted records aren’t included in 
summaries, and they aren’t sorted, printed, or exported to another file.

You can also mix requests to find some records and omit others. 
FileMaker Pro works through multiple requests in order, so you first 
define the criteria for finding records and then the criteria for omitting 
records.

In addition, you can find records that don’t match the request. For 
example, to work with all the sales records except those for the city of 
London, you can specify London in the find request and then omit those 
records. It’s often easier to omit the records you don’t want than to 
search for all the records you do want. 

To Do this

Repeat a request Switch to the layout you want. Choose Modify Last Find 
from the Select menu, and then click Find.

Edit a request Switch to the layout you want. Chose Modify Last Find 
from the Select menu, make changes to the request as 
needed, and then click Find (or choose Perform Find from 
the Select menu).

Delete a request Choose Modify Last Find from the Select menu. Use the 
bookmark to display the request to delete, and then 
choose Delete Request from the Mode menu.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E copying records
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Note FileMaker Pro works through multiple requests in the order you 
specify, so define the omit requests last. Otherwise, subsequent find 
requests might include records that should be omitted.

The following example shows three find requests where one request 
omits a group of consecutive records. Together, these three find requests 
find all records of employees in Marketing and Operations and omit 
those whose title is Director.

To Do this

Omit a specific record Display or select the record to omit, and then choose 
Omit from the Select menu.

Omit groups of records Display or select the first record in a number of 
consecutive records to omit, and then choose Omit 
Multiple from the Select menu. In the Omit Multiple 
dialog box, type the number of records to omit, and then 
click Omit.

Bring back all the records in the file Choose Find All from the Select menu.

Switch the found set with the 
omitted set

Choose Find Omitted from the Select menu.

Find some records and omit others In one request, type the criteria for finding the records. 
In a second request, click Omit, and then type the criteria 
to remove records from those found. Then click Find (or 
choose Perform Find from the Select menu).

Find records that don’t match the 
request

In one request, type criteria for the records to omit. 
Click Omit, and then click Find (or choose Perform Find 
from the Select menu).

The first request finds all
records where Department

is Marketing, that is, all
employees in Marketing
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 Choose FileMaker Help Index from the  or Help menu, and then type:

E omitting records

The second request finds all
records where Department

is Operations, that is, all
employees in Operations

The third request omits
records of employees
whose title is Director

The found set
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Copying the found set
You can copy the found set to the Clipboard to paste the records into a 
different application, like a spreadsheet. Container fields aren’t copied.

In Browse mode with no fields selected, press Option-Command-C. 
FileMaker Pro copies the data to the Clipboard in tab-delimited format 
(in fields, separated by tab characters), without text styles, in the order 
they were added to the file.

Deleting records
You can delete an entire file of records, delete groups of records, or 
delete single records. When you delete a record, you permanently 
discard the data in all the fields in that record. 

Important You can’t retrieve deleted data, and you can’t undo deleting 
records. Before you delete records, it’s a good idea to make a backup 
copy of your file. 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E copying records

To delete Do this

One record Select the record to delete and choose Delete Record from the 
Mode menu. In the alert message, click Delete.

A group of records Use Find or Omit Multiple to select a subset of records to delete, 
and then choose Delete All from the Mode menu. In the alert 
message, click Delete.

All records in a database Choose Find All from the Select menu, and then choose Delete 
All from the Mode menu. (Or create a clone of the database 
with no records. See “Saving a copy of a file” on page 1-11.)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E records, overview
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Sorting records
FileMaker Pro stores records in the order they were added to the file. 
However, you often want to work with records in sorted order. Sorting 
temporarily rearranges all or a group of records (the found set) based on 
the entries in a field or set of fields, so you can browse, update, or print 
the records in a different sequence. 

You sort records by selecting fields whose contents you want to sort by. 
The first sort field arranges the records based on the field’s contents. The 
second sort field arranges records when two or more records have the 
same value in the first sort field, and so on. You can sort records in 
ascending order, descending order, or in a custom order based on a value 
list.

FileMaker Pro keeps the records in the sorted order until you perform a 
find or sort the records again. 

1. To sort some but not all of the records, find the records to sort.

See “Finding information” on page 4-19.

2. Choose Sort from the Mode menu.

3. In the Sort Records dialog box, choose fields for sorting, in the order 
you want them sorted.

To Do this

Choose a sort field and sort it 
according to the selected order

In the fields list, double-click a field.

Assign different sort orders to 
fields as you add them to the 
Sort Order list

For each sort field, in the fields list, select a field, select 
a sort order, and then click Move.

Ascending order is first to last character in the alphabet 
for text, lowest to highest for numbers, and earliest to 
latest for dates and times. Descending order is last to 
first character in the alphabet for text, highest to lowest 
for numbers, and latest to earliest for dates and times.

Change the sort order for fields 
in the Sort Order list

For Sort Order, select a field, and then select a sort order.

Sort according to the order of 
values in a value list (for 
example, in the order months 
are arranged)

In the fields list, select a field, select Custom order based 
on value list, and then choose or define a value list. (See 
“Defining value lists” on page 3-75 and “Entering data 
from a value list” on page 4-9.)

Change the order of fields in 
the Sort Order list

For Sort Order, use the double-arrow (to the left of the 
field name) to drag the field to a new position.
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4. Click Sort.

To cancel before sorting is finished, press Command-period. 

Keep these points in mind:

1 To sort records that have container fields that you want in order, 
create a text or number field that describes or identifies the contents 
of the container field. Then sort by the text or number field.

1 To restore records to the order in which they were added to the file, 
choose Sort from the Mode menu, and then click Unsort in the Sort 
Records dialog box.

Remove a field from the Sort 
Order list

For Sort Order, double-click the field.

Remove all fields from the Sort 
Order list

Click Clear All.

Sort by summary fields Select Include summary fields. (See “Sorting by summary 
fields” on page 4-32.)

Use a language for the order in 
which fields are sorted that’s 
different from the one used for 
indexing

Select Override field’s language for sort, and then choose a 
language.

Close the Sort Records dialog 
box without sorting

Click Done.

To Do this

Select fields to sort

Select the sorting order
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1 When you sort repeating fields, or related fields in portals, FileMaker 
Pro uses only the first value in the repeating or related fields to sort 
records. To sort records based on values other than the first value, 
make separate records for each repeating value.

1 You can specify a sort order for related fields. If the match field in 
one record in a file relates to the match field in more than one record 
in a related file, you can specify that the related field in the first file 
display a sorted value (or several sorted values if the related field is 
in a portal displaying more than one row). For more information, 
“Sorting related data” on page 10-43.

1 When you add a record to sorted records, FileMaker Pro tries to 
maintain the sort order. It adds new records to the end of the group 
the current record is in. For example, if you sort records by month and 
add a record where the month is June, FileMaker Pro adds the record 
to the end of the group of June records. The message in the status area 
changes to Semi-sorted to indicate the approximate order. When you 
finish adding records, resort them.

1 To create a script with a sort order, define the sort order, and then 
click Done. Then define the script.

Sorting by summary fields
You can include a summary field in the sort order. For example, sort on 
a summary field named Monthly Sales Totals and on a field named Sales 
Region to show monthly sales totals for different sales regions. (To sort 
a summary field like Monthly Sales Totals, you must include a second 
nonsummary field like Sales Region or Salesperson.)

Keep these points in mind:

1 Sorting by summary fields affects the order of printed or previewed 
records but doesn’t change the order of records in Browse mode.

1 A summary field selected for sorting is placed at the bottom of the 
Sort Order list. Summary fields can’t be sorted in a custom sort order.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E sorting records
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1 If data is already sorted appropriately for the summary report, you 
don’t have to re-sort when you add or remove summary fields in the 
sort order. Add the summary field as described in the previous 
section, and then click Done (not Sort).

 Choose FileMaker Help Index from the  or Help menu, and then type:

E summary fields



Chapter 5:  Using ScriptMaker and buttons

FileMaker Pro includes ScriptMaker software, which you can use to 
automate tasks like:

1 switching to another layout or mode

1 finding, sorting, and printing records

1 dialing phone numbers

This chapter tells you how to use ScriptMaker and how to define buttons 
to perform script commands.

Note FileMaker Pro scripts are not available when you publish a 
database on the Web using FileMaker Pro Web Companion Instant Web 
Publishing.

Important Before you read this chapter, be sure you know how to work 
with FileMaker Pro, as explained in the rest of this guide. You should 
also know how to use FileMaker Pro Help, as explained in the preface, 
“Getting help.”
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Understanding scripts
A script is a command that tells FileMaker Pro to carry out one action 
or a sequence of actions. You perform a script to carry out its actions.

For example, when you click the Letter button on the Client Entry 
layout, a script displays the Letter layout. Then the script switches to 
Preview mode and pauses so you can see what the letter looks like when 
it prints.

 

Click to continue the
script—FileMaker Pro prints
the letter, and then returns to

the Client Entry layout in
Browse mode

When you click the Letter button, 
FileMaker Pro performs the Print 
Letter script

Buttons on a layout 
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Scripts help you do a job the same way every time. They carry out 
simple steps, like changing the printing orientation for envelopes, or 
complex tasks, like preparing a large mailing. 

You can perform additional scripts, called subscripts, within a script. 
Subscripts make it easy to break a complex task into small tasks. For 
example, you can find customers with a balance due with one script, and 
then print form letters requesting payment with another script. The first 
script contains a command that performs the second script (the 
subscript). If a subscript is in a different file, it’s called an external 
script. 

With FileMaker Pro, you can:

1 define a script that pauses to let you do unscripted tasks, like entering 
data. When you resume the script, FileMaker Pro performs the 
remaining script commands.

1 save settings, like find requests and sort orders, in a script. 

1 print the commands and settings that make up a script. (See chapter 6, 
“Previewing and printing information.”)

1 define passwords that prevent other users from defining or changing 
scripts. (See “Protecting your files” on page 7-9.)

1 perform a startup script, a script that runs when you open a 
FileMaker Pro file. For example, a startup script can switch to a data 
entry layout whenever you open a customer order database. 
FileMaker Pro can also perform a shutdown script every time you 
close a file. (See “Setting document preferences” on page 9-7.)

1 send Internet mail using a separate email client (this requires an email 
account).

1 launch Web browser software and have it display a specified URL 
(Web address—this requires an account with an Internet service 
provider).

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scripts, overview
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Understanding ScriptMaker steps 
A step is a FileMaker Pro command that you use in a script. Steps are 
similar to the commands you access through FileMaker Pro menus. For 
example, you can create a record by choosing New Record from the Mode 
menu, or you can perform a script that contains the New Record/Request 
step.

Keep these points in mind:

1 Many steps have options that you specify when you define a script. 
For example, you can specify a field name in the Go to Field step. 
FileMaker Pro Help contains detailed information about steps and 
options.

1 Some steps, like Paste, can only be performed in certain modes or 
when a specified field is on the current layout.

1 Some steps can display a dialog box when you perform a script. For 
example, a script with the Sort step can display the Sort dialog box so 
you can enter a sort order.

1 You can use status functions in steps to monitor the state of your 
database. For example, a script can check whether a file is sorted. Or 
it can display a customized message that tells users what to do when 
a found set is empty.

For a list of status functions, see “Status functions” on page C-16. For 
examples using status functions, see “Displaying customized 
layouts” on page 5-32 and FileMaker Pro Help.

1 For information about using script steps with related fields, see 
“Working with related fields” on page 10-30.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E script steps
E status functions
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Control steps 

Use this step To

Perform Script Perform another script

Pause/Resume Script Pause a script, or resume a paused script

Exit Script Exit the current script

Halt Script Stop performing all scripts

If Perform steps if a calculation is True (not zero)

Else Perform another set of steps if a calculation is False (zero)

End If Mark the end of an If statement

Loop Repeatedly perform a set of steps

Exit Loop If Exit a loop if a calculation is True (not zero)

End Loop Mark the end of a loop

Allow User Abort Allow or prevent users from stopping a script

Set Error Capture Allow or prevent error messages from displaying. Use this step to 
change the way FileMaker Pro handles error messages.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E control script steps
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Navigation steps

Sort, find, and print steps

Use this step To

Go to Layout View the specified layout

Go to Record/Request/Page Move to a record in the found set in Browse mode, a find 
request in Find mode, or a page in Preview mode

Go to Related Record Move to the current related record in a related file

Go to Portal Row Move to a portal row, or to a specified field in a portal row 

Go to Field Move to a field on the current layout

Go to Next Field Move to the next field on the current layout

Go to Previous Field Move to the previous field on the current layout

Enter Browse Mode Switch to Browse mode

 Choose FileMaker Help Index from the  or Help menu, and then type:

E navigation script steps

Use this step To

Sort Order records in the found set 

Unsort Restore records to the order in which they were created

Find All Find all records in the file

Find Omitted Find records that aren’t in the found set

Omit Leave the current record out of the found set

Omit Multiple Leave a number of records, starting from the current record, out of the 
found set 

Perform Find Find records that match the current find request(s)

Modify Last Find Change the last find request(s)

Page Setup Set Page Setup options for printing, like horizontal or vertical 
orientation

Print Print information from the current file

 Choose FileMaker Help Index from the  or Help menu, and then type:

E sort/find/print script steps
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Editing steps

Fields steps

Use this step To

Undo Undo the last action 

Cut Delete the contents of a field and put them in the Clipboard

Copy Copy the contents of a field, or a page in Preview mode, to the 
Clipboard

Paste Paste the contents of the Clipboard into a field

Clear Delete the contents of a field without copying the contents to the 
Clipboard

Select All Select the entire contents of a field

 Choose FileMaker Help Index from the  or Help menu, and then type:

E editing script steps

Use this step To

Set Field Replace the contents of a field with the result of a calculation. 
The field doesn’t have to be on the current layout.

Paste Literal Paste a text string into a field

Paste Result Paste the results of a calculation into another field on the 
current layout

Paste from Index Paste a value from the index into a field

Paste from Last Record Paste data from a field in the last active record into the same 
field in the current record or find request. (The last record to 
contain an insertion point in a field is the active record.)

Paste Current Date Paste the current system date into a field

Paste Current Time Paste the current system time into a field

Paste Current User Name Paste the name of the current user into a field. (The current 
user name is specified in the general preferences.)

 Choose FileMaker Help Index from the  or Help menu, and then type:

E fields script steps
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Records steps

Import and export steps

Use this step To

New Record/Request Add a record or find request

Duplicate Record/Request Duplicate a record or find request

Delete Record/Request Permanently delete the current record or find request

Delete Portal Row Permanently delete the current portal row. Use Go to Portal 
Row to specify which is the current row.

Revert Record/Request Return the current record or find request to the way it was 
before you added or changed its data

Exit Record/Request Exit the current record or find request to update the field data 
and make no field active

Copy Record Copy the contents of the current record to the Clipboard

Copy All Records Copy the contents of the found set to the Clipboard

Delete All Records Permanently delete all records in the current found set

Replace Change the contents of a field in all records in the found set 

Relookup Update a lookup value in records in the found set

 Choose FileMaker Help Index from the  or Help menu, and then type:

E records script steps

Use this step To

Import Picture Import a graphic into the current field

Import Movie Import a QuickTime movie into the current field

Import Records Bring data from another file into the current file

Export Records Save data in a format you can open in another application

 Choose FileMaker Help Index from the  or Help menu, and then type:

E import and export script steps
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Windows steps

Files steps

Use this step To

Freeze Window Stop updating the window (hide actions from users)

Refresh Window Redraw the screen, or resume updating after Freeze Window

Scroll Window Scroll the window up, down, or to the current selection

Toggle Window Hide or change the size of the window 

Toggle Status Area Show, hide, or lock the status area

Toggle Text Ruler Show or hide the text ruler

Set Zoom Level Reduce, enlarge, or lock the contents of a window

View As View records individually or in a list

 Choose FileMaker Help Index from the  or Help menu, and then type:

E windows script steps

Use this step To

New Create a file

Open Open a file. Subsequent steps operate in the file that contains 
the script, not the file just opened.

Close Close a file

Change Password Modify an existing password

Set Multi-User Turn network access On or Off for the current file

Set Use System Formats Use date, time, and number formats saved with the current 
file, or use the system formats

Save a Copy as Save a copy of the current file

Recover Recover a file

 Choose FileMaker Help Index from the  or Help menu, and then type:

E files script steps
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Spelling steps

Open Menu Item steps

Use this step To

Check Selection Check the spelling of text in the selected field

Check Record Check the spelling of text in the current record

Check Found Set Check the spelling of all fields in all records in the found set

Correct Word Display Spelling dialog box so you can correct a misspelled 
word. Spell check as you type (in the Spelling area of the 
Document preferences) must be on.

Spelling Options Display the Spelling Options dialog box

Select Dictionaries Display the Select Dictionaries dialog box

Edit User Dictionary Display the Edit User Dictionary dialog box

 Choose FileMaker Help Index from the  or Help menu, and then type:

E spelling script steps

Use this step To

Open Application 
Preferences

Display the Application Preferences dialog box

Open Document Preferences Display the Document Preferences dialog box

Open Define Fields Display the Define Fields dialog box

Open Define Relationships Display the Define Relationships dialog box

Open Define Value Lists Display the Define Value Lists dialog box

Open Help Display the FileMaker Pro Help system contents window

Open ScriptMaker Display the Define Scripts dialog box. FileMaker Pro stops 
performing a script after this step.

Open Sharing Display the File Sharing dialog box

 Choose FileMaker Help Index from the  or Help menu, and then type:

E open menu item script steps
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Miscellaneous steps

Planning scripts
Consider these points before defining a script:

1 What do you want to accomplish? Can you separate the job into 
smaller tasks? If so, define a subscript for each small task, and then 
define a script that performs the subscripts. It’s usually easier to 
design and test several small subscripts than one complex script.

1 Is all the data you need in one file, or will the script operate on more 
than one file? If you’re using multiple files, which ones should the 
script open? Where should you define the script?

1 How will users perform the script? (See “Performing, resuming, or 
stopping scripts” on page 5-19.)

1 Will the script contain steps for page setup, printing, importing, 
finding, sorting, or exporting? If so, what settings should you store 
before defining the script? (See “Storing settings for a script” on page 
5-15.)

Use this step To

Show Message Display an alert message

Beep Play the system beep sound

Speak Produce speech from text

Dial Phone Dial phone numbers

Open URL Open a URL

Send Mail Send email with the To, Cc, Subject, and Message fields as 
specified in script step options

Send Apple Event Send an Apple event to another application

Perform AppleScript Perform AppleScript commands

Comment Add notes to a script to describe a step

Flush Cache to Disk Save the FileMaker Pro internal cache to disk

Quit Application Close all files and quit FileMaker Pro

 Choose FileMaker Help Index from the  or Help menu, and then type:

E miscellaneous script steps
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1 Which fields and layouts will the script need? Some steps require a 
field to be on the current layout (like Go to Field, Paste Literal, Paste 
Result, and Replace), while others don’t (Set Field). Use Go to 
Layout to switch to a layout that has the fields your script requires.

1 Should the script switch among modes? For example, use Enter 
Browse Mode before modifying data in fields and records, and use 
Enter Find Mode before setting up a find request or finding data.

1 Should the script work on all records in the database, the current 
found set, or a specific set of records? What if no records are found? 
Use one of the find or omit steps to set up the correct records.

1 Which record should the script start with? For example, when using 
the Loop step, decide whether the loop starts at the first or last record, 
a specific record, or the current record in a found set. Use 
Go to Record/Request/Page to select a starting record.

1 How should the script advance through multiple fields and records? 
Use navigation steps to move through a found set.

1 Should the records be sorted before the script processes them? If you 
use the Loop step, use Sort or Unsort before the loop to order your 
records properly. 

1 When should the script finish? After all records have been processed? 
After a specified condition has been met? Use the If step to perform 
a task when the script reaches a specified condition.

1 How will you document your script design? Use the Comment step to 
make your scripts readable and understandable. 

1 How will you test your script? Use the Pause/Resume Script step to 
pause at specific points in your script.

Tip Save a clone (or copy) of your database, and then define and test 
your script in it to preserve the original data. After testing the script, 
import data from the original file into the clone.

Defining scripts
Define scripts in ScriptMaker by choosing steps and arranging them in 
the order you want FileMaker Pro to perform them. If you’re using a 
subscript, define it first, and then define the script that calls (uses) it.

1. If you’re defining a script to print, import, export, find, or sort, first 
store the settings for the script.

See “Storing settings for a script” on page 5-15.
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2. Choose ScriptMaker from the Script menu.

3. In the Define Scripts dialog box, type the name of the new script, and 
then click Create.

  

4. In the Script Definition dialog box, choose steps for the script.

Scripts defined in the file

Drag the double arrow to
reorder the script in the

Script menu

Type the name of a new script

Click to 
add a new 
script

Select to include the selected script in the Script menu

Scripts with checkmarks
appear in the Script menu
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FileMaker Pro includes preset steps when you create a script. You 
can change or delete the steps. 

  

5. Click OK.

6. To list the script in the Script menu, select Include in menu in the 
Define Scripts dialog box.

To Do this

Add a step Select the step in the Available Steps list, and then click Move. 
Select options for the step, if they’re available.

Delete a step Select a step in the script, and then click Clear.

Delete all steps Click Clear All.

Duplicate a step Select a step in the script, and then click Duplicate.

Change step options Select a step in the script, and then change the options.

Change the order of a 
step

Drag the double arrow to move the step.

Add a subscript Select Perform Script in the Available Steps list, and then click 
Move. Select the Perform sub-scripts option, and then choose the 
subscript from the pop-up menu. Choose External Script if the 
subscript is in a different file.

Add a pause in the 
script

Select Pause/Resume Script in the Available Steps list, click 
Move, and then specify the options. Or add a step with the Pause 
option and set the option.

Choose steps from
this list

Steps in the script

Options for a 
step appear 
inside 
brackets

Drag the 
double arrow 
to reorder the 
step

Set options 
for the 
selected step
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7. Click Done.

Storing settings for a script
When you define a script, FileMaker Pro saves the current settings for 
page setup, importing, finding, sorting, and exporting. FileMaker Pro 
can restore the settings when you perform the script.

To store settings for a script, specify them before adding Page Setup, 
Print, Import Records, Perform Find, Sort, or Export Records steps to a 
script.

Keep these points in mind:

1 To use the settings when you perform the script, select the Restore 
option for Page Setup, Import Records, Perform Find, Sort, or Export 
Records steps.

1 A script can store only one of each type of setting, for example, one 
set of find requests and one sort order. If you need more than one, 
define a subscript that stores different settings. See “Defining scripts” 
on page 5-12.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scripts, defining

To specify Do this

Page setup 
options

Choose Page Setup from the File menu. Select the settings you want, and 
then click OK. For information about the options, see the manual that 
came with your printer.

Print options Choose Print from the File menu. Select the settings you want, and then 
click Print. FileMaker Pro saves most print settings, including the 
number of copies and the type of information to print (like Records being 
browsed). See “Printing” on page 6-12.

Import order Import records using the field order you want to store. See “Importing 
data into an existing file” on page 8-4.

Find requests In Find mode, create the find requests. You don’t have to click Find to 
perform the requests. See “Defining find requests” on page 4-19.

Sort order In Browse mode, choose Sort from the Mode menu, and then choose the 
fields you want to sort by and the sort order. Click Done. See “Sorting 
records” on page 4-30.

Export order Export records using the field order you want to save. See “Exporting 
data from FileMaker Pro” on page 8-9.
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1 To see the settings you stored with a script, print the script definition. 
See chapter 6, “Previewing and printing information.”

1 You can enter settings when you perform a script instead of using 
stored settings. FileMaker Pro doesn’t save the settings you enter 
when you perform the script.

For example, if you add a Sort step and deselect the Restore sort order 
and Perform without dialog options, the Sort dialog box appears when 
you perform the script. If you select Restore sort order and deselect 
Perform without dialog, the dialog box displays default settings that the 
user can perform or modify.

Changing and duplicating scripts
1. Change the settings stored for the script, if necessary.

See “Storing settings for a script” on page 5-15.

2. Choose ScriptMaker from the Script menu.

3. In the Define Scripts dialog box, select a script name.

4. Click Done to finish, or click Edit to change the steps in the script.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scripts, managing

To Do this

Quickly create a similar script Click Duplicate.

Change the name of the script Edit the name in the Script Name box, and then 
click Rename.

Add the script to the Script menu Select Include in menu.

Remove the script from the Script 
menu

Deselect Include in menu.
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5. In the Script Definition dialog box, change the script steps, and then 
click OK.

Note If you’re changing a script that was created with FileMaker Pro 
for Windows, steps that work only in Windows are displayed in 
italics. You can’t change the options for these steps.

6. If you see the Script Settings dialog box, specify whether to keep or 
replace the settings you previously stored with the script, and then 
click OK.

 

7. Click Done.

To Do this

Add a step Select the step in the Available Steps list, and then click Move. 
Select options for the step, if they’re available.

Delete a step Select a step in the script, and then click Clear.

Change step options Select a step in the script, and then change the options.

Change the order of 
steps

Drag the double arrow to move a step.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scripts, changing
E scripts, defining

Dimmed options aren’t available 
in the current script

Select an option to keep or replace 
all occurrences of that setting type 
(for example, all sort orders) 
stored with the script
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Reordering scripts in the Script menu
FileMaker Pro lists scripts in the Script menu and assigns keyboard 
shortcuts (like Command-1) to the first ten.

1. Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box, drag the double arrow to the left of 
the script name to a new position.

3. To add or delete a script from the menu, select the script, and then 
select or deselect Include in menu.

Scripts with checkmarks appear in the Script menu. 

4. Click Done.

Deleting scripts
1. Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box, select the name of the script, and 
then click Delete.

3. Click Delete again, and then click Done.

Important When you delete a script, change scripts and buttons that refer 
to the deleted script.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scripts, managing

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scripts, managing
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Performing, resuming, or stopping scripts

Note You can’t stop a script that contains the Allow User Abort [Off] 
step.

To Do this

Perform a script from the Script 
menu

Choose the script name from the Script menu.

Perform a script from the 
Define Scripts dialog box

Choose ScriptMaker from the Script menu. Select the script 
name, and then click Perform.

Perform a script using a 
keyboard shortcut

Type the keyboard shortcut. (See “Reordering scripts in the 
Script menu” on page 5-18.)

Perform a script from a button Switch to a layout that contains a button for the script. In 
Browse or Find mode, click the button.

Perform a script when opening 
or closing a FileMaker Pro file

In the Preferences dialog box, set the option to perform a 
startup or shutdown script. See “Setting document 
preferences” on page 9-7.

Continue a script after it pauses Click Continue in the status area, or press Return. If you 
switch layouts while a script is paused and then continue the 
script, remaining script steps occur in the new layout.

Stop a paused script Click Cancel in the status area, switch to another mode, 
close the active window, or quit FileMaker Pro.

Stop a script (except when it is 
paused)

Press Command-period, hide or close the active window, or 
quit FileMaker Pro. If the script contains a Close or Toggle 
Window step that hides the active window, FileMaker Pro 
stops the current script and returns to the script that called 
it (if there is one).

 Choose FileMaker Help Index from the  or Help menu, and then type:

E scripts, performing
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Using buttons with scripts
A button is an object on a layout that you can click to perform one script 
step or an entire script.

    

Keep these points in mind:

1 To show borders around buttons in Layout mode, choose Buttons 
from the Show menu. See “Showing button, text, and field 
boundaries” on page 3-43.

1 To set buttons so they don’t print, see “Keeping objects from 
printing” on page 6-9.

1 FileMaker Pro doesn’t store settings (like find requests) with a 
button, but you can define a script that stores the settings and then 
define a button to perform it. See “Storing settings for a script” on 
page 5-15.

When you click the Letter
button, FileMaker Pro

performs the Print Letter script

Buttons
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Defining buttons
Use the following steps to create a button labeled with text. To specify 
a preference option for rounded or rectangular buttons, see “Setting 
layout preferences” on page 9-3.

Note To create another type of button (for example, a circle with a 
graphic), see FileMaker Pro Help.

1. If you’re defining a button that performs an entire script, create the 
script.

See “Defining scripts” on page 5-12.

2. In Layout mode, choose a layout, and then click the button tool.

See “Working with the drawing tools” on page 3-38.

  

3. Drag the crosshair pointer on the layout to draw the button.

Button tool

Button 
border

If tools don’t appear on the layout, 
click the status area control
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4. In the Specify Button dialog box, select a step, set step options (if 
they’re available), and then click OK.

See “Understanding ScriptMaker steps” on page 5-4.

  

5. At the insertion point, type a label for the button, and then press Enter.

6. Switch to Browse or Find mode to use the button.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E buttons

Select a step

Set options for the step
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Copying, changing, or deleting buttons 

Working with Apple events
Apple events are Mac OS commands that automate, customize, and 
control many Mac OS applications. FileMaker Pro can send Apple 
events to any application that supports them. The application that 
receives an Apple event is the target application.

FileMaker Pro uses ScriptMaker to send Apple events to other 
applications. (See “Defining a script to send Apple events” in the next 
section.) For example, a script can send Apple events to open a 
spreadsheet application, send it data, and then create a chart.

Apple events are grouped into suites. FileMaker Pro supports the 
Required suite, a special subset of the Core, Table, URL, and Database 
suites, and its own FileMaker suite. It also supports the object model, a 
standard way to refer to objects.

To Do this in Layout mode

Select a button Use the pointer tool. See “Selecting objects” on page 3-39.

Move a button Using the pointer tool, drag the button. See “Moving objects” on 
page 3-44.

Change the appearance 
of a button

See “Changing the appearance of objects” on page 3-50.

Change a button label See “Typing text” on page 3-80 and “Changing the appearance of 
text” on page 3-88.

Copy a button See “Cutting, copying, and pasting objects” on page 3-45. When 
you copy a button, you copy the object and the button definition. If 
you copy a button from another file, change the button definition if 
fields, layouts, or scripts don’t match.

Change a button 
definition

Double-click the button. In the Specify Button dialog box, select a 
step and options, and then click OK. To modify a script that the 
button performs, see “Changing and duplicating scripts” on page 
5-16.

Delete a button Select the button, and then press Delete.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E buttons
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FileMaker Pro can receive Apple events from scripting applications that 
are designed to send Apple events, like the AppleScript Script Editor. 
Applications can send events to FileMaker Pro to perform many tasks, 
including:

1 requesting data from a record or list of records

1 requesting a list of scripts and performing scripts

1 requesting a list of fields and getting data from the fields

1 sorting or finding records

1 placing or modifying data in any record, field, or list of records or 
fields

1 switching layouts

1 creating and choosing menu items

1 opening and closing databases

FileMaker Pro can also send commands written in the AppleScript 
scripting language. Scripting languages use terms like “open” and 
“field” instead of the four-character codes in Apple events. (See 
“Defining a script to perform AppleScript commands” on page 5-28.)

Support for Apple events is a technical feature for FileMaker Pro 
developers. To learn more about Apple events:

1 open the Apple Events Reference database (included when you install 
FileMaker Pro using the Easy Install option). The database contains 
a complete description of all FileMaker Pro events and objects, 
including examples and usage tips. 

1 contact the Apple Programmers and Developers Association 
(APDA).

1 read third-party books about Apple events and scripting applications.

1 log into the scripting forums available on many online services.

Keep these points in mind:

1 To determine if an application supports Apple events, refer to the 
documentation or the application’s scripting dictionary (called an 
AETE resource). You can view the dictionary using the AppleScript 
Script Editor.
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1 You can use the Perform Applescript step to communicate directly 
with FileMaker Pro. For more information, see the Apple Events 
Reference database. You can also use an applet, droplet, or scripting 
application that communicates with FileMaker Pro.

1 FileMaker Pro can’t receive Apple events while performing a 
ScriptMaker script.

1 FileMaker Pro can send Apple events with text or AppleScript 
commands that are located in a related file. See chapter 10, “Using 
data from related files.”

1 To send Apple events to FileMaker Pro on a network, you need a 
local copy of FileMaker Pro. Any commands you send to a guest 
database are relayed to the host. See chapter 7, “Networking and 
access privileges.”

Defining a script to send Apple events
Before you send Apple events, consider the following:

1 Use the Send Apple Event step to send Apple events to other 
applications. Each Send Apple Event step sends one event. You can 
include more than one Send Apple Event in a script.

1 When specifying a field value or script text, FileMaker Pro sends text 
as a parameter with the Apple event. See the documentation that came 
with the target application to determine what information it expects 
to receive with an event.

1. Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box, create a script or select an existing 
script, and then click Edit.

3. In the Script Definition dialog box, double-click Send Apple Event in 
the Available Steps list, and then click Specify.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E Apple events
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4. In the Specify Apple Event dialog box, click Specify Application.

5. In the Open File dialog box, select the target application, and then 
click Open.

6. In the Specify Apple Event dialog box, choose the event you want to 
send from the pop-up menu.

See “Choosing an Apple event to send” on page 5-27.

7. Select options for the event, and then click OK.

8. In the Script Definition dialog box, finish defining or editing the 
script, and then click OK.

Select To

Bring target application to 
foreground

Display the target application when it performs the Apple 
event. Deselect this option to run the target application in the 
background or to perform scripts more quickly.

Wait for event completion 
before continuing

Wait for the Apple event to finish before returning control to 
ScriptMaker.

Wait for event completion 
before continuing and 
Copy event result to the 
clipboard. Deselect Bring 
target application to 
foreground.

Copy the result of an event performed in the target application. 
Use this option when sending events to an application that can 
send an Apple event reply, like the HyperCard application. In 
the next step, you can add ScriptMaker steps to paste the data 
into a FileMaker Pro field.

Choose an Apple 
event 

Choose options 
for the event
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9. If you are changing an existing script and the Script Settings dialog 
box appears, select options, and then click OK.

See step 6 on page 5-17.

10.Click Done.

Choosing an Apple event to send
When you add the Send Apple Event step to a script, you choose an 
event in the Specify Apple event dialog box. The following table 
explains the options.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E Apple events

To Do this

Open the target application Choose open application. In the Open File dialog box, confirm 
the target application you selected in step 5 in “Defining a 
script to send Apple events” on page 5-26, or select a different 
application. Click Open.

Open a file Choose open document.

1 To open the same file each time FileMaker Pro sends the 
event, click Document, and then click Specify File. In the 
Open File dialog box, select a file, and then click Open.

1 To open a file using a pathname that’s stored in a field in the 
current record, click Field value, and then click Specify Field. 
In the Specify Field dialog box, select a field on the current 
layout, and then click OK.

1 To open a file by specifying a path to the file, click Script text 
and type a path in the text box. (For example, HD:Database 
folder:Database file.) This option opens the same file each 
time FileMaker Pro sends the event.

Perform a script in the target 
application

Choose do script. The target application must support the do 
script event.

1 To specify the file that contains the script, click Document, 
and then click Specify File. In the Open File dialog box, select 
a file and then click Open.

1 To perform a script that’s stored in a field in the current 
record, click Field value, and then click Specify Field. In the 
Specify Field dialog box, select a field on the current layout. 
(The field can contain a complete script or a script name 
depending on how the target application supports the do 
script event.) Click OK.

1 To send a script with the event, click Script text and type 
script commands or a script name in the text box. The script 
must be written in the target application’s scripting 
language, not AppleScript. This option sends the same 
script each time FileMaker Pro sends the event.
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Defining a script to perform AppleScript commands
Use the Perform AppleScript step to perform AppleScript commands. 
The AppleScript extension, or the Apple Event Manager and QuickTime 
extensions must be installed on your system. (See the Apple Computer, 
Inc. Web site at http://www.apple.com for more information.)

1. Choose ScriptMaker from the Script menu.

2. In the Define Scripts dialog box, create a script, or select an existing 
script and click Edit.

3. In the Script Definition dialog box, double-click Perform AppleScript 
in the Available Steps list, and then click Specify.

4. In the Specify AppleScript dialog box, select options, and then click 
OK.

Perform other types of 
Apple events

Choose Other. In the Specify Event dialog box, type the Event 
Class and Event ID (four-character codes specified by the target 
application). Click OK.

1 To send an Apple event to the same file each time you 
perform the script, click Document, and then click Specify 
File. In the Open File dialog box, select a file, and then click 
Open.

1 To send text that’s stored in a field in the current record, 
click Field value, and then click Specify Field. (The event must 
accept a text parameter.) In the Specify Field dialog box, 
select a field on the current layout. Click OK.

1 To send a text parameter with the event, click Script text and 
type the parameter in the text box. (The event must accept a 
text parameter.) This option sends the same parameter each 
time FileMaker Pro sends the event.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E Apple events

To Do this

Perform AppleScript commands that 
are stored in a field

Click Field value. In the Specify Field dialog 
box, choose a field that contains AppleScript 
commands, and then click OK. The commands 
are compiled each time FileMaker Pro 
performs the script.

To Do this
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5. In the Script Definition dialog box, finish defining or editing the 
script, and then click OK.

6. If you are changing an existing script and the Script Settings dialog 
box appears, select options, and then click OK.

See step 6 on page 5-17.

7. Click Done.

See “Changing monitor settings” on page 5-37 for an example script.

Examples of ScriptMaker scripts
The following sections show scripts that you can use as starting points 
for your work. Before reading the examples, you should understand how 
to use ScriptMaker. For information about script steps or more 
examples, see FileMaker Pro Help.

Entering and printing data
This example illustrates a simple way to automate data entry. When you 
perform the New Entry script, it creates a record, and then pauses so you 
can enter data. When the script pauses, you can:

1 resume the script by clicking Continue or pressing Enter. The script 
loops (repeats steps) to create a record.

1 print the current record by clicking the Print button on the layout. 
FileMaker Pro performs the Print Record script, and then returns to 
the paused New Entry script.

1 stop the script by clicking Cancel.

Perform AppleScript commands
(up to 32K)

Click Script text, and then type AppleScript 
commands in the text box. The commands are 
compiled when you click OK, and then 
FileMaker Pro stores the source.

 Choose FileMaker Help Index from the  or Help menu, and then type:

E AppleScript 

 Choose FileMaker Help Index from the  or Help menu, and then type:

E script examples
E script steps

To Do this
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. 

The following sections describe how to define the example scripts and 
button. 

Example step 1: Define the New Entry script
In ScriptMaker, define the New Entry script with the steps shown in the 
previous figure.

Example step 2: Store page setup and print settings
Store page setup and print settings for the Print Record script so you 
don’t have to select them each time you perform the script.

1. Choose Page Setup from the File menu, choose the paper size and 
orientation, and then click OK.

2. Choose Print from the File menu, select Current record, and then click 
Print.

Steps between 
Loop and End 
Loop repeat until 
you stop the script

Click to resume
the script

Click to stop
the script

Click to perform 
the Print Record 
script
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Example step 3: Define the Print Record script
In ScriptMaker, define the Print Record script with the steps shown in 
the previous figure. Choose the following options to use the stored 
settings when you perform the script.

Example step 4: Define the Print button
On the Client Entry layout, define a button to perform the Print Record 
script. (See “Defining buttons” on page 5-21.)

  

Finding data
This example illustrates a simple way to automate finding information. 
When you use this Find Information script, it repeats the last find that 
was performed before the script was created. You can set up additional 
scripts to automate other finds you want to do.

Example step 1: Perform the Find you want scripted
Choose Find from the Mode menu. Type the data you want to find, then 
click the Find button. (For more information on performing finds, see 
“Finding information” on page 4-19.)

For this step Select these options

Page Setup Restore setup options

Perform without dialog

Print Perform without dialog

Select this step

Choose the Print 
Record script
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Example step 2: Create the new script
Choose ScriptMaker from the Script menu. In the Script Name box, type 
Find Information. Click Create.

Example step 3: Define the Find Information script
In the Script Definition box, you see that ScriptMaker has automatically 
specified six script steps for you.

1. Delete the Enter Browse Mode, Go to Layout, Page Setup, Unsort, 
and Print script steps. You can delete these script steps by clicking to 
select them, then pressing Delete.

2. For Options, be sure Restore find requests is selected. Click OK.

3. Click Done.

Displaying customized layouts
In this example, a travel agency has a database that stores information 
about its clients. One agent likes to view the information in a simple 
layout that shows only the agent’s name, and the client’s name and 
telephone number. Another agent prefers a more complex layout that 
displays the agent’s name, and the client’s name, address, phone 
number, and travel preferences.

Delete

Select the Perform Find script step, then be sure 
Restore find requests is selected
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The following sections explain how to define a startup script that uses 
the current user name to display the correct layout and client records.

Note For this example, you should know how to specify a user name 
(see “Setting general application preferences” on page 9-2) and a startup 
script (see “Setting document preferences” on page 9-7.)

Example step 1: Define the startup script
In ScriptMaker, define the Custom Layout script with the steps shown 
below.

Example step 2: Set the startup option
In Document Preferences, set the option to perform the Custom Layout 
script each time the file is opened.

Displays a welcome layout for all users

Depending on the agent’s user name, the script
shows the appropriate layout

In Find mode, the script pastes the agent’s user
name into the Name field, and then finds the agent’s

records

Choose the Custom 
Layout script
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Finding duplicate records
In this example, a travel agency uses a registration database to track 
clients who sign up for a cruise seminar. The database contains duplicate 
records because some clients called the travel agency to sign up and also 
mailed in a registration form for the same seminar. 

The following sections explain how to set up a database and define a 
script to find duplicate records.

Note For this example, you should understand global fields (see 
“Defining global fields” on page 2-9) and know how to define fields (see 
“Defining database fields” on page 2-3.)

Example step 1: Create a unique value for each record
The Seminar file contains records of clients who register for a seminar. 
Each client has a unique identification number, the Client ID field. Some 
records contain the same identification number—these are the duplicate 
records you want to find.

Tip If your database doesn’t have a unique identification field, define a 
calculation field to create one from existing fields. For example, 
combine first name, last name, and birthday to create a unique 
identification for each client.

Example step 2: Add two fields
Define these fields in the Seminar file:

1 A text field, called Mark. When the script finds a duplicate record, it 
places an x in this field to mark the record.

1 A global field, called Global, to store the unique identification while 
comparing records. Global should be the same data type as the Client 
ID field.

Example step 3: Display the Mark field
Create a layout that displays the Mark field, or add the field to an 
existing layout. You’ll use this layout to store Find settings in the 
following step.
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Example step 4: Store settings
Store Sort and Find settings for the script.

Example step 5: Define the script
In ScriptMaker, define the Find Duplicates script.

When you perform the Find Duplicates script:

1. It finds all records, and then sorts them by the ClientID field so that 
records with the same ClientID are grouped together.

To store this setting Do this

Sort In Browse mode, choose Sort from the Mode menu. If fields 
appear in the Sort Order list, click Clear All. Click ClientID, 
choose Ascending order, click Move, and then click Done.

Find Choose a layout that displays the Mark field. In Find mode, 
type x into the Mark field, and then switch to Browse mode. 
(You don’t have to perform the find request.)
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2. Starting with the first record, the script copies the value from the 
ClientID field into the Global field.

3. The script goes to the next record and compares the value in ClientID 
with the value in Global. 

1 If the values match, the record is a duplicate and the script puts an 
x in the Mark field.
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1 If the values don’t match, FileMaker Pro copies the ClientID value 
into Global. It doesn’t change the Mark field. 

4. The script repeats step 3 until it reaches the last record in the file.

5. The script finds all records with an x in the Mark field, and then 
displays the found set of duplicate records.

Changing monitor settings
In this example, the Set Monitor Depth script uses AppleScript 
commands to set your primary monitor to a minimum bit depth. For 
example, it sets a monitor that supports 256 colors to a bit depth of black 
and white.

Note To use this script, you must have a scriptable version of the Finder 
(included in System 7.5 or later). 
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For information about Apple events and AppleScript, see “Working 
with Apple events” on page 5-23.

Specify this AppleScript command when you
add the Perform AppleScript step

Define this script



Chapter 6:  Previewing and printing information

This chapter describes how to print the information in your 
FileMaker Pro files, including records, forms, and definitions of fields 
and scripts.

Note The information in this chapter does not apply to users working 
with databases on the Web. When users work with databases on the 
Web, the Web browser software governs printing.

Important Before you read this chapter, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.” You 
should also understand layouts and parts. (See chapter 3, “Laying out 
and arranging information.”)

Preparing to print
With FileMaker Pro, you can print:

1 records you’re browsing (the found set) or a record you select in 
Browse mode, including data from related files. 

FileMaker Pro formats the records using the current layout. For 
example, use a Labels layout to print mailing labels. 

If a layout contains a header, footer, and body, FileMaker Pro prints 
as many records on each page as can fit between the header and 
footer. If a record at the end of the page doesn’t fit, FileMaker Pro 
prints it on the next page. (See “Paginating a layout” on page 3-32 and 
“Changing part types and options” on page 3-36.)

1 blank records to create a form using the current layout.

1 definitions of fields or scripts to see the structure of your database.
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The margins, current layout, and printer and page setup options affect 
how FileMaker Pro prints records.

Contact List
Company Name       Name               Contact Title             Phone

Contact List
Company Name       Name               Contact Title             Phone

Smith's More Corp. Jeremy Smith President 503-555-4655

Contact List
Company Name       Name               Contact Title             Phone

ACME Accessories
Norris Corporation
PrinTCo.
The Framery
West End Corp.
Smith's More Corp.

Dennis Smith
Sonia Long
Jennifer Norriz
John Winford
Pamela Day
Jeremy Smith

Marketing Associate
Buyer
Sales Manager
Personnel Adm.
Promotions Asst.
President

617-555-9876
601-555-2348
717-555-6840
715-555-6829
712-555-2846
503-555-4655

Field Name           Field Type              Fomula/Entry Option

Company Name
Cantact First
Contact Last
Contact Title
Phone
Enter Date
HolidayCard

Priority

Name
Dial Phone
Date

Text
Text
Text
Text
Text
Date
Text

Text

Calculation (Text)
Calculation (Text)
Date

Auto-enter the: "Creation Date"
Value List:
Yes
No
Value List:
High
Med
Low
=Contact First & • • Contact Last
="dial" & ••••& TextTo Num (Phone) & ••••

Go to Layout

Sort

   Restore sort order
   No dialog

Script Step/Options            Script Parameters   

Go to Layout

Sort

   Restore sort order
   No dialog

Contact List

Sort Order:

   Company Name (Ascending)
   Contact Last (Ascending)
   Contact First (Ascending)

FileMaker Pro uses the current 
layout to print records

Blank record

Current record

Found set

Field definitions

Script definition



Previewing and printing information 6-3
Displaying margins
In Layout mode, choose Page Margins from the Show menu to see where 
a layout will print on a page. 

Most printers can’t print to the edge of the paper. If you place objects in 
the margins or outside the area the selected printer can print to, you see 
them in Browse and Find modes. You don’t see the objects when you 
preview or print.

  

Choose FileMaker Help Index from the  or Help menu, and then type:

E page margins

Margins—objects 
in this area won’t 
print

Page break

Layout showing margins

Layout not showing 
margins

The selected printer 
can’t print objects 
outside this line

Page break
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Setting margins
You can set different margins for each layout.

1. Choose Page Setup from the File menu, confirm the printer and paper 
settings, and then click OK.

To switch printers, see “Specifying a printer” on page 6-14. For 
information about other settings, see the manual that came with your 
printer.

2. In Layout mode, choose a layout, and then choose Layout Setup from 
the Mode menu.

3. In the Layout Setup dialog box, select Fixed page margins, type values 
for the margins, and then click OK.

  

4. Switch to Preview mode to check the margins.

Keep these points in mind:

1 If you don’t select Fixed Page Margins, FileMaker Pro uses the 
printer’s default margins.

1 In Layout mode, choose Set Rulers from the Mode menu to change the 
unit of measure for margins. See “Positioning and sizing objects” on 
page 3-40.

Select to alternate margins—the
inside margin prints on the left

side for the first page, on the right
for the second page, and so on

Type margin 
sizes

Select to specify sizes



Previewing and printing information 6-5
1 If you select the Print in <value> columns option for a layout and 
change the size of the columns, the columns resize to fit the new page 
width when you change the left or right margins. See “Arranging 
records in columns” on page 3-20.

Removing spaces at the end of fields and parts
FileMaker Pro can move information vertically or horizontally to close 
gaps at the end of fields and parts when you print. This movement is 
called sliding. For example, you can create a letter layout so the comma 
in the greeting prints right after the last name, even though some names 
are longer than others. 

When objects slide:

1 fields shrink to eliminate empty space within the field boundaries. 
Sliding does not remove empty space between fields.

1 objects (including fields) slide left or up corresponding to the amount 
of space the fields to the left or above the objects shrink.

Choose FileMaker Help Index from the  or Help menu, and then type:

E page margins
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You can set parts to shrink when the fields in them slide up. When parts 
shrink, FileMaker Pro can print more records on a page. 

In Layout mode, choose Sliding Objects from the Show menu to see which 
objects slide and in which directions. The following layout illustrates 
how fields are set to slide for the previous figure.

  

Printing without sliding objects

Slide objects left to
remove space at the

right edge of fields

Slide objects up to
keep extra space

from printing

Slide parts up to get
different sized

bodies for different
amounts of data

Printing with sliding objects

Slide objects and 
parts up to fit more 
records on a page

Arrows show how objects 
are set to slide

The body, Notes 
field, and 
horizontal line 
slide up

These fields slide 
left 
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Keep these points in mind:

1 You can slide any object. Non-field objects, like the horizontal line in 
the previous example, can slide if you place a sliding field above or 
to the left of the objects. When a non-field object slides, it moves to 
another place on the layout but doesn’t shrink. When a field slides, it 
moves to another place on the layout and shrinks if the data doesn’t 
fill the field boundaries.

1 When you slide objects or parts, FileMaker Pro prints the objects 
relative to each other, not precisely as you placed them on your 
layout. 

1 If you leave blank space on a layout, FileMaker Pro keeps that space. 
For example, if you create a body with one inch of space below the 
lowest object, FileMaker Pro leaves one inch below the lowest object 
when it shrinks the body.

1 You can also use merge fields to align text in form letters, envelopes, 
or labels. (See “Adding merge fields” on page 3-58.) Use sliding 
instead of merge fields to:

1 align non-text objects, like graphics

1 move the enclosing part up

1 align formatted fields, like value lists and repeating fields

1 enter data into the layout. If you use merge fields, you must use a 
different layout for data entry.

1 Don’t slide parts up on layouts that require a fixed vertical spacing, 
like labels.

1 Headers, footers, title headers, and title footers never slide up.

1 For information about sliding related fields and portals, see 
“Changing the appearance of related fields and portals” on page 
10-28.

Sliding objects and parts
1. To slide objects left, align their top edges and align data in text fields 

to the left.

See “Aligning objects to each other” on page 3-48 and “Formatting 
text paragraphs” on page 3-84.

Choose FileMaker Help Index from the  or Help menu, and then type:

E sliding objects
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2. In Layout mode, select the objects to slide, and then choose
Sliding/Printing from the Format menu.

To slide an object left, you must also select the field to the left of it. 
To slide an object up, also select the field above it.

3. In the Set Sliding/Printing dialog box, select the sliding options you 
want, and then click OK.  

  

4. Switch to Preview mode to see objects and parts slide. 

See “Previewing before printing” on page 6-11.

Select this option To

Sliding left Close up blank space to the right of the object, allowing objects 
to slide left into the unused space. This option keeps punctuation 
with data, moves the contents of fields closer to each other, and 
so on.

Sliding up based on Close up blank space above an object.

1 Select All above to close up blank space above an object based 
on the position of all objects above it. This option maintains 
consistent vertical spacing among columns.

1 Select Only directly above to close up blank space above an 
object based on the position of the objects directly above it. 
This option allows the spacing in a column to adjust 
independently of the other columns.

1 Select Also reduce the size of the enclosing part to close up the 
space in the part that contains the fields. To slide the part up 
relative to all objects, set this option for all the objects that are 
sliding up. To slide the part up relative to a single object, set 
this option for that object only.

Choose FileMaker Help Index from the  or Help menu, and then type:

E sliding objects
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Sliding repeating fields
If you set sliding options for repeating fields, be sure not to change the 
way the information is aligned.

Keeping objects from printing
To keep objects, like buttons, from appearing when you print records:

1. In Layout mode, select the objects you don’t want to print.

2. Choose Sliding/Printing from the Format menu.

3. In the Set Sliding/Printing dialog box, select Do not print the selected 
objects, and then click OK.

Keep these points in mind:

1 You can slide nonprinting objects to close up blank space. See 
“Sliding objects and parts” on page 6-7.

To keep values in repeating fields Do this

From sliding left independently of the other 
values

Fill the field with a color (like white) or add a 
field border to the repeating field.

From sliding up independently of the values 
in adjacent repeating fields

Select Sliding up based on All above in the
Set Sliding/Printing dialog box. See the 
previous section.

Repeating fields sliding up with “Only directly 
above” option

Repeating fields in Layout mode Repeating fields with no sliding options set

Repeating fields sliding left
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1 You see nonprinting objects in Browse and Layout modes, but not 
when you preview or print. Choose Non-Printing Objects from the 
Show menu to display nonprinting objects with a gray border in 
Layout mode.

Printing Extended columnar layouts
For Extended columnar layouts, select the horizontal (landscape) page 
setup option so that more columns print on a page. See “Printing” on 
page 6-12.

Tip If you can’t print all columns on one horizontal page (or you want to 
print a vertical page), create several layouts that show fewer columns, 
and then print all the layouts.

Choose FileMaker Help Index from the  or Help menu, and then type:

E printing, data

Choose FileMaker Help Index from the  or Help menu, and then type:

E Extended columnar layout

Horizontal option in
Page Setup

All columns print

Information to the 
right of this line 
won’t print

Vertical option in
Page Setup
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Printing layouts with subsummaries
Before printing a layout with subsummary parts, sort the records by the 
break field (the field that groups the records). See “Adding a summary 
part” on page 3-31 and “Sorting records” on page 4-30.

Keep these points in mind:

1 Switch to Preview mode after you sort to see how your records will 
print. See “Previewing before printing” below.

1 You can start a new page for each subsummary part. If you print 
records in columns down the page, FileMaker Pro starts a new 
column, not a new page. See “Arranging records in columns” on page 
3-20.

Printing labels and envelopes
To print labels, set up a Labels layout (see “Setting up to print on labels” 
on page 3-12). For information about printing envelopes, see “Setting up 
to print on envelopes” on page 3-18.

Previewing before printing
In Preview mode, you see how records will look when they’re printed, 
but you can’t change records or layouts. To switch to Preview mode, 
choose Preview from the Mode menu.

Choose FileMaker Help Index from the  or Help menu, and then type:

E subsummary layout parts

Choose FileMaker Help Index from the  or Help menu, and then type:

E labels layout
E printing, envelopes
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Note You cannot use the preview feature to see how your database looks 
when published on the Web. You must use Web browser software.

  

Printing 
You can print all or part of a database. See “Preparing to print” on page 
6-1.

1. If you’re printing records, switch to the layout you want to use.

2. If you have more than one printer, specify which one you want to use.

See the next section, “Specifying a printer.”

3. Choose Page Setup from the File menu, confirm the options, and then 
click OK.

For information about Page Setup options, see the manual that came 
with your computer or printer.

Choose FileMaker Help Index from the  or Help menu, and then type:

E preview mode

Choose a different layout

Number of pages to
preview

Click zoom controls to
see objects in detail, or

to get an overview

Click to hide or show the status area

Click a page of the
book to see the next or

previous page

MarginMove to view a different page

Current page number



Previewing and printing information 6-13
4. If you’re printing records, browse the ones you want to print, and then 
switch to Preview mode to check them.

Use Find, Omit, Find All, and Sort, if needed. If your layout has a 
subsummary, sort on the break field. (See “Printing layouts with 
subsummaries” on page 6-11.)

5. Choose Print from the File menu, and then select options in the Print 
dialog box. 

 

6. Click Print.

To stop printing, press Command-Period.

In the Print area, select To print

Records being browsed All records in the found set.

Current record The record currently selected in Browse mode.

Blank record, showing fields, and 
then choose an option from the
pop-up menu

A blank record using the current layout. Use this option 
to create a form that represents your database. Choose 
as formatted to print the fields as specified in the Field 
Borders dialog box. (See “Adding borders, fill, and 
baselines to fields” on page 3-73.)

Script, and then choose a script 
from the pop-up menu

Script definitions. Choose All scripts to print every 
script definition in the file.

Field definitions A list of all the fields defined for the file, including 
formulas and entry options.

Choose the data
to print
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Specifying a printer
1. Choose Chooser from the Apple menu.

2. In the Chooser dialog box, select a printer, respond to any messages, 
and then click the close box.

For information about printer options, see the manual that came with 
your printer.

Choose FileMaker Help Index from the  or Help menu, and then type:

E print options



Chapter 7:  Networking and access privileges

You can share FileMaker Pro files with other users on a network. By 
sharing files, you can work simultaneously with others in your work 
group, and save disk space by keeping files in a central location.

You can also share your FileMaker Pro files on the Web using 
FileMaker Pro Web Companion. For more information, see chapter 11, 
“Publishing files on the Web.”

To be sure that the right people see the right information in your files, 
you can set FileMaker Pro access privileges. This chapter explains how 
to protect files using passwords and groups. You can use these same 
passwords to protect files shared over the Web. For even more complete 
protection, you can use FileMaker Pro Web Companion Web Security 
databases. For more information, see “Database security” on page 
11-18.

Important Before you read this chapter, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.”

Sharing files
To share your FileMaker Pro files with other users, you need:

1 a computer running the Mac OS

1 a connection to a network

1 FileMaker Pro installed on your computer with the correct network 
options selected

See the FileMaker Pro Installation and New Features Guide for 
more information.

Important Your FileMaker Pro licensing agreement requires that you 
own the same number of copies of the FileMaker Pro application as the 
number of people using FileMaker Pro at the same time.
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The first person to open a shared file is the host. Any user who opens a 
shared file after the host is a guest.

Keep these points in mind:

1 You can share FileMaker Pro files between a computer running 
Windows and a computer running the Mac OS just as you share files 
among networked computers on the same platform. For example, you 
can host a file on a Mac OS–based computer, and then guests on 
Windows computers or Mac OS–based computers can connect to the 
same file.

When you share files between platforms, you may see differences in 
font mapping, alignment of layout objects, and character set mapping.

1 For enhanced file sharing capabilities, use the FileMaker Pro Server 
application to host files.

1 You don’t have to turn on File Sharing (in the Sharing Setup control 
panel) to share FileMaker Pro files on a network.

1 To change network connections, see “Setting general application 
preferences” on page 9-2.

Choose FileMaker Help Index from the  or Help menu, and then type:

E sharing files

The host opens the file

Guests open connections to the file
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Opening files as the host
To host a file, you must be the first user to open it.

1. Choose Open from the File menu.

2. In the Open File dialog box, select a file, and then click Open.

3. Choose Sharing from the File menu.

In the File Sharing dialog box, select Multi-User.

Note If Multi-User is dimmed in the File Sharing dialog box, 
FileMaker Pro is unable to access the network. An explanation 
appears below the Multi-User button. You can also get an explanation 
by choosing Open from the File menu, then clicking Hosts.

To open the File Sharing dialog box, you must open the file using a 
password that provides the Export records access privilege.

4. If the file uses information from other FileMaker Pro files (like 
related databases, external scripts, or value lists), repeat steps 1 
through 3 to open the files and set them to Multi-User.

Tip Group the files in a single folder to make it easy to locate them.

Adding an underscore character _ to the end of a database filename 
(before the .FP3 extension, if any) prevents that database from being 
listed in the Hosts dialog box. It also prevents the database from being 
listed on the default home page if you are using FileMaker Pro Web 
Companion Instant Web Publishing.

You can broadcast messages to guests who are using your database. In 
the File Sharing dialog box, click Send Message. Type the message, then 
click OK. Your guest(s) see the message in a dialog box. They can 
dismiss the dialog box by clicking Cancel—or the dialog box dismisses 
itself 30 seconds after appearing.

Keep the file open to make it available to guests. For the best 
performance:

1 When you host a file, open it first on the computer that is directly 
connected to the hard disk on which the file is stored, rather than on 
another computer using Mac OS personal file sharing.

1 If you use a file sharing system (like AppleShare or the Mac OS 
personal file sharing), host the file from your hard disk instead of 
hosting it from a file server.
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Warning Anyone who opens a database file with the Export records 
access privilege, including FileMaker Pro guests, can then publish the 
database on the Web by enabling FileMaker Pro Web Companion. In 
this case, your database is protected over the Web by any FileMaker Pro 
access privileges that you have set. However, you should exercise 
caution when granting access privileges. For more information, see 
chapter 11, “Publishing files on the Web.”

Opening files as a guest
After the host opens a shared file, guests can connect to the file.

1. Choose Open from the File menu.

2. In the Open File dialog box, click Hosts.

3. In the Hosts dialog box, do the following.

  

Choose FileMaker Help Index from the  or Help menu, and then type:

E hosting files

For this protocol Do this

AppleTalk with zones Select the host’s zone in the lower list.

AppleTalk without zones Continue with step 4.

MacIPX Continue with step 4.

TCP/IP To specify a local TCP/IP host, click Local Hosts in the lower 
list. FileMaker Pro displays local hosts on the network in 
the upper list.

To specify a host outside your local TCP/IP area, click 
Specify Host in the lower list. In the Specify Host dialog box, 
type a host name or IP address. (To add this host to the list, 
click Permanently add entry to Hosts list.) Click OK.

Zones

Select from the list of shared 
files available on the hostMac OS computer host

Windows computer host

FileMaker Pro Server host

Hosts dialog box for an 
AppleTalk network with 
zones. If you’re using 
another network, the dialog 
box may look different.
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4. Select a file, and then click Open.

If the network is very busy, the file might not be listed. Use one of the 
following procedures to check the network for a longer period of 
time. 

If you select a FileMaker Pro Server host (instead of a shared file), 
you see the remote administer dialog box. See the FileMaker Pro 
Server documentation for information.

Keep these points in mind:

1 Close your connection to a shared file if the host asks, or if you aren’t 
using the file. 

1 If some menu commands, layouts, or fields are dimmed, you may 
have limited access to the file. See “Protecting your files” on page 
7-9.

1 For information on sharing your file over the Web, see chapter 11, 
“Publishing files on the Web.”

For this type of network Do this

AppleTalk with zones

1 TCP/IP

Hold down the Option key as you click an item in the 
lower list.

AppleTalk without zones 

1 MacIPX

Click Cancel to return to the Open File dialog box. Hold 
down the Option key as you click the Hosts button.

Choose FileMaker Help Index from the  or Help menu, and then type:

E sharing files
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Working with shared files
When a shared file is open, the host and guests have access to the same 
information. FileMaker Pro saves a shared file on the disk where the file 
resides. It saves changes that the host and guests made to the file, 
including changes to records, layouts, and scripts.

FileMaker Pro limits access to some commands and records to keep 
users from interfering with each other. 

While you are working with a shared file, you might see the 
pointer change.

This user Can perform these tasks

Host and all guests 
(every user)

1 Find, sort, or browse records
1 Specify a page setup and print
1 Switch layouts or modes
1 Import or export data
1 Check the spelling of a found set
1 Perform a script by choosing it from the Script menu or clicking 

a button defined for the script
1 Change global values. Only the host’s changes are saved with the 

file. When guests open a file with global fields, they see the 
current values. If the host changes a global value, guests don’t see 
the change until they close the file and then reopen it. 

Host or one guest 
(only one user at 
a time)

1 Open the ScriptMaker dialog box
1 Define or change relationships
1 Define or change passwords
1 Define or change value lists
1 Edit a record or layout. Others can view the record, but no one can 

modify it until the current user moves to another record or presses 
Enter in Browse mode. In Layout mode, the current user must 
move to another layout or switch to another mode.

Host only (all guests 
must close their 
connections to 
the file)

1 Define fields or change field definitions
1 Reorder layouts
1 Define, delete, or change groups and access privileges
1 Save copies of a file with the Save a Copy As command
1 Switch the file status between multi-user and single user 
1 Close a shared file

This pointer Means FileMaker Pro is

Waiting to receive data from the network

Waiting for the host to finish processing a request from another user
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Keep these points in mind:

1 Sorting, replacing data, viewing and printing summary report layouts, 
and other calculation-intensive tasks performed on many records 
affect the performance of the host and guest computers. Perform 
these tasks on a small found set, or schedule tasks so they’re 
performed during low usage periods.

1 FileMaker Pro saves the host’s sort order, find requests, and page 
setup. If you’re a guest, you can save your settings by defining a 
script. See “Storing settings for a script” on page 5-15.

1 With FileMaker Pro for Windows, you can combine information 
from other applications using Object Linking and Embedding (OLE). 
When you share FileMaker Pro for Windows files, users of 
computers running the Mac OS can cut, copy, and paste OLE objects 
as graphics, but can’t edit them. The following table explains how 
OLE works with cross-platform networking in FileMaker Pro.

1 When you share a file with system formats that are different from the 
settings on your computer, you can choose which formats to use. See 
appendix B, “Working with international files.”

With this configuration You can do this

A computer running Windows is the 
host and a computer running the 
Mac OS is the guest.

On a computer running the Mac OS, you can 
view embedded and linked objects as graphics.

A Mac OS–based computer is the 
host and a computer running 
Windows is the guest.

On a computer running Windows, you can 
embed, link, and edit objects. On a Mac OS–
based computer, you view the objects 
as graphics.

Mac OS–based computers are host 
and guest.

When you use FileMaker Pro to open a database 
that has OLE objects, you view the objects 
as graphics.

Computers running Windows are 
host and guest.

Host and guests can embed, link, and edit objects.

Choose FileMaker Help Index from the  or Help menu, and then type:

E sharing files
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Closing shared files
If you’re a host, you can close the files you’re hosting. If you’re a guest, 
you can close your connections to shared files. 

Important Leave FileMaker Pro by choosing Quit from the File menu. If 
you turn off your computer without quitting the program, you can 
damage open files and lose your changes.

1. Choose Close or Quit from the File menu.

2. If you’re a host and guests are connected, click Ask in the Ask 
dialog box.

Note You see this dialog box whenever you perform a task that 
requires all guests to close their connections to the file. See “Working 
with shared files” on page 7-6.

   

Guests see a message asking them to close the file. If guests click 
Close Now, FileMaker Pro closes the file. If the guests don’t respond 
to the message and the file can be closed safely, FileMaker Pro closes 
it in 30 seconds.

To Do this

Close a shared file Choose Close.

Quit FileMaker Pro Choose Quit.

Guests currently 
using the file
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Protecting your files
When you share databases, you need a security system so that 
confidential data is protected and unauthorized changes aren’t made. 
With FileMaker Pro, you protect files by defining passwords and 
groups. Passwords limit what users can do and groups limit the layouts 
and fields they can see. Both passwords and groups have access 
privileges:

1 For passwords, access privileges limit a user’s activities with a file. 
For example, one password might let users create and edit records, 
but another might only let them browse records. 

Passwords can also limit access to an entire file—if you don’t know 
a password, you can’t open the file.

1 For groups, access privileges limit access to specific layouts and 
fields. For example, you can give the Sales group access to one set of 
layouts and fields and the Marketing group access to a different set, 
keeping each group’s information private within the same database.

Choose FileMaker Help Index from the  or Help menu, and then type:

E files, closing

If a guest clicks Cancel, 
FileMaker Pro doesn’t close 
the connection to the file
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Passwords and groups are related. You can define a password for each 
employee in your company, and then associate passwords with groups 
to limit access to each department’s data. For example, in a file 
containing employee information, only passwords in the Human 
Resources group can see salary information.

When you open a file with a password, FileMaker Pro knows: 

1 activities you’re authorized to do with the file

1 groups associated with your password

1 layouts and fields you can see

Important FileMaker Pro passwords work independently of operating 
system access privileges. Shared FileMaker Pro files are available on 
your network even if you haven’t shared them with your operating 
system’s file sharing features. To restrict access to shared FileMaker Pro 
files, use FileMaker Pro passwords.

Note When you assign passwords to a database, those same passwords 
are required when opening the database over the Web, unless Web 
Security database passwords are in effect. For more Web-related 
password and access privilege options, see “Database security” on page 
11-18.

The following example shows two layouts for an Employees database. 
The Salary List layout displays data that is confidential (like salary) and 
data that everyone can see (like phone number). The Network List 
layout displays network addresses that only network administrators can 
access. The file has two groups, Human Resources and Network 
Administration.

Passwords in this group Can do this

Human Resources See and change any field on the Salary List layout. They 
can’t see the Network List layout.

Network Administration See (but not change) the names and phone numbers on the 
Salary List layout. They can’t see the salaries. They can see 
and change any field in the Network List layout. 
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Define passwords or groups only if you need to protect information. If 
you only want to limit the tasks users can do and don’t mind if they can 
see all fields and layouts, define passwords but don’t define groups.

Defining passwords
When you define passwords for a file, you specify who can open the file 
and what tasks they can perform. When a user opens the file with a 
password, FileMaker Pro dims commands that aren’t available for that 
password.

Keep these points in mind:

1 If you define passwords, you must set at least one master password 
that gives access to the entire file.

1 Make passwords easy to remember, but not so easy that someone can 
guess them. If you write down passwords, store them in a secure place 
away from your computer.

Choose FileMaker Help Index from the  or Help menu, and then type:

E protecting database files

Human Resources can’t
see this layout

Network Administration 
can’t see this field
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1 You can define a blank password that gives all users limited access to 
a file. When users open the file, they can press Return at the password 
prompt to access the file.

1 When you open a file, FileMaker Pro can try a password without 
prompting you. Define the password, and then see “Setting document 
preferences” on page 9-7 to set the option.

1 If you create a script that opens a second file when your primary file 
opens, and both files have the same password, FileMaker Pro enters 
the password for the second file and opens it automatically—it does 
not prompt you for the second file’s password. If you don’t want this, 
specify a different password for the second file.

1 You can protect all FileMaker Pro files, not just shared files on a 
network. For example, you can define a password so other users can’t 
open a file on your computer. 

To define passwords:

1. Open the file.

2. Choose Access Privileges from the File menu, and then choose Define 
Passwords.

3. In the Define Passwords dialog box, specify the password.

To Do this

Define a password Type up to 31 characters in the Password box. Passwords 
aren’t case sensitive. If you type spaces, users must type them 
to open the file. 

Define a blank password Leave the Password box blank, and then select a limited set of 
privileges in the next step.



Networking and access privileges 7-13
  

4. Select the activities that users with this password can perform.

Select To let users with this password

Access the entire file Perform any task with records, layouts, and scripts. This 
privilege creates a master password. It’s the only privilege that 
can define or delete passwords, or change field definitions, 
document preferences, groups, or other users’ passwords.

Browse records See data in records. (Define groups to limit the fields and 
layouts that users can see.)

Print records Print one or more records

Export records Export one or more records, or copy the found set. This 
privilege also provides access to the File Sharing dialog box, 
allowing users to enable FileMaker Network Sharing and 
Companion Sharing (for example, Web Companion sharing).

Override data entry 
warnings

Enter data that doesn’t fit the entry options. (See “Choosing data 
entry options” on page 2-6.)

Design layouts Create or change layouts

Edit scripts Create or change scripts

Define value lists Create or change value lists

Create records Create records and enter data in them

Edit records Change the information in records

Delete records Delete one or more records

Select the access privileges 
for users of this password

Deselect to limit access

Click to define 
groups

Passwords defined
in the file

Blank password

Click to associate 
passwords with existing 
groups

Select the menu 
commands for users of this 
password
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5. Choose the menu commands that users with this password can access, 
and then click Create.

Note All options let users switch between database windows, 
perform scripts on the Script menu, click buttons on layouts, open 
FileMaker Pro Help, change preference options (except Document 
Preferences), and open, create, or close FileMaker Pro files.

6. Repeat steps 3 through 5 for additional passwords.

7. Define groups or close the Define Passwords dialog box.

Important After you define a master password, write it down and store it 
in a secure place. If you forget it, you can’t regain full access to the file.

Select To

Normal Enable all menu commands associated with the privileges you selected 
in the previous step

Editing Only Enable only basic data entry commands for the current file. (Available 
menu commands depend on the level of access you selected in the 
previous step.)

None Disable all commands that work on the current file

To Do this

Create groups Click Groups in the Define Passwords dialog box. At the 
prompt, type a master password, and then click OK to see the 
Define Groups dialog box. See step 3 in “Defining groups” on 
page 7-17.

Associate passwords 
with existing groups

Click Access in the Define Passwords dialog box to see the 
Access Privileges dialog box. See step 4 in “Defining groups” 
on page 7-18.

Close the Define 
Passwords dialog box

Click Done. At the prompt, type a master password, and then 
click OK.

Choose FileMaker Help Index from the  or Help menu, and then type:

E defining passwords
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Deleting or changing passwords

Keep these points in mind:

1 Notify users if you change their passwords.

1 If you change passwords while a file is shared, the changes don’t take 
effect until guests close and reopen the file. 

Defining groups
After you define passwords, define groups to restrict access to specific 
fields and layouts. You can:

1 associate a group with more than one password. For example, you can 
assign separate passwords for each person in an accounting group. 
All users have access to the same layouts and fields (determined by 
the group), but only the managers can make changes to the file 
(determined by their passwords).

1 associate the same password to more than one group. For example, to 
give an accountant access to the layouts and fields for the Sales and 
Inventory groups, associate the accountant’s password with both 
groups.

To Do this

Delete a password Choose Access Privileges from the File menu, and then choose 
Define Passwords. Select the password in the Define Passwords 
dialog box, and then click Delete. In the confirmation dialog box, 
click Delete, and then click Done. When prompted, type the master 
password, and then click OK.

Change a password if 
you know a master 
password

Choose Access Privileges from the File menu, and then choose 
Define Passwords. Select the password in the Define Passwords 
dialog box. Edit the password, revise the privileges, and then 
click Change. Click Done. When prompted, type the master 
password, and then click OK.

Change your own 
password if you don’t 
know a master password

Choose Change Password from the File menu. In the Change 
Password dialog box, type the old password. Type the new 
password, type it again to confirm it, and then click OK.

Choose FileMaker Help Index from the  or Help menu, and then type:

E deleting passwords
E passwords, changing
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The following illustration shows the access privileges for a file created 
by a Marketing department. The file has three groups: Marketing, 
Accounting, and Sales. When you select the Sales group, you see that the 
Advertising Costs layout is not available to Sales.

     

Tip To see the associations between layouts and fields, choose Access 
Privileges from the File menu, and then choose Overview. You must be the 
host and set the file to Single-User, or have all guests close the file. (See 
“Opening files as the host” on page 7-3.)

For example, if you want to delete a field but aren’t sure which layouts 
will be affected, select the field in the Access Privileges dialog box. 
Layouts with solid bullets contain the selected field.

Before you define groups, consider these points:

1 Groups give database administrators a way to manage user access to 
layouts or fields. Users don’t need to know about groups. If you don’t 
need to restrict access to layouts or fields, don’t define groups.

Password associated with the Sales group 

Sales can’t see these layouts

Sales can see 
but can’t 
change these 
fields

Master passwords
appear in bold text

Key

Sales can see and change these layouts
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1 Define passwords before defining groups. (See “Defining 
passwords” on page 7-11.) Master passwords can access the entire 
file and aren’t associated with specific groups.

1 You can limit what users can do with specific fields or layouts 
without changing the access privileges of their passwords. For 
example, if passwords associated with a group have Edit record 
privileges, you can prevent users from editing specific fields or 
layouts by setting the group access privileges to Not accessible.

To define groups:

1. Open the file.

You must use the master password. If the file is shared, you must be 
the host. (See “Opening files as the host” on page 7-3.)

2. Choose Access Privileges from the File menu, and then choose 
Define Groups.

If the file is shared and guests are connected, ask them to close the 
file. (See step 2 in “Closing shared files” on page 7-8.)

3. In the Define Groups dialog box, type the group name, click Create, 
and then click Access.

   

Groups defined in the file
Click to associate 
passwords with a group

Click to define or change 
passwords

Type a new group name
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4. In the Access Privileges dialog box, select a group.

   

5. Associate passwords for the group by clicking bullets next to 
the passwords.

Click the bullets, not the names of the passwords. A solid bullet 
indicates that the group can use the password.

6. Set the access privileges for layouts and fields by clicking the bullets 
next to them.

Click the bullets, not the layout or field names.

7. Click Save to save the current settings, or click Revert to return the 
settings to the way they were last saved.

8. Click Done, and then click Done again.

Choose FileMaker Help Index from the  or Help menu, and then type:

E groups

Selected group

Key

Master password
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Deleting or changing groups
To delete or change groups, you must have the master password, be the 
host, and set the file to Single-User (or have all guests close the file). See 
“Opening files as the host” on page 7-3 and “Closing shared files” on 
page 7-8.

To Do this

Delete a group Choose Access Privileges from the File menu, and then choose 
Define Groups. In the Define Groups dialog box, select the group 
name and then click Delete. In the confirmation dialog box, click 
Delete and then click Done.

Change password 
associations or access 
privileges for a group

Choose Access Privileges from the File menu, and then choose 
Overview. In the Access Privileges dialog box, select a group. Click 
the bullets next to the passwords, layouts, and fields you want to 
change. Click Save, and then click Done.

Choose FileMaker Help Index from the  or Help menu, and then type:

E groups



Chapter 8:  Importing and exporting data

You can exchange information with FileMaker Pro files or with files 
created in other applications. This chapter describes the import and 
export features of FileMaker Pro. 

Note You cannot import or export data from your database using a 
Web browser.

Important Before you read this chapter, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.” 

Understanding import and export
With FileMaker Pro, you can:

1 import — bring data from another file into a FileMaker Pro file

1 export — save FileMaker Pro data in a format you can open in 
another application

For example, suppose you have a FileMaker Pro database that contains 
temperature and rainfall data for many travel destinations. To create a 
chart for a travel seminar, you export the temperature data from 
FileMaker Pro, and then open the exported file using a charting or 
similar software application which supports the importing of data, such 
as ClarisImpact software or Microsoft Excel. Exporting the data is faster 
and more accurate than retyping it in another application.

   

File containing exported 
FileMaker Pro data

FileMaker Pro data you want to chart

Data displayed in ClarisImpact
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Keep these points in mind:

1 To exchange small amounts of data between files (for example, a few 
records), use Copy and Paste, or drag and drop. See “Copying and 
moving values and records” on page 4-12 and “Using drag and drop 
to move information” on page 4-13.

To quickly exchange larger amounts of data, import or export records.

1 You can define FileMaker Pro scripts to exchange information with 
other files. See chapter 5, “Using ScriptMaker and buttons.”

1 You can import data into (or export from) shared FileMaker Pro files. 
See chapter 7, “Networking and access privileges.”

When you exchange information between FileMaker Pro files on a 
Mac OS–based computer and a Windows–based computer, you may 
see differences in filenames and character set mapping.

1 You can’t import or export layouts from one FileMaker Pro file to 
another, but you can:

1 copy and paste objects from one layout to another

1 copy layouts and field definitions (but no data) to a new 
FileMaker Pro file by saving a clone of the file. See “Saving a 
copy of a file” on page 1-11.

1 copy fields to a layout in another file if the field names are 
identical in both files. See chapter 3, “Laying out and arranging 
information.”

1 For information about importing or exporting data in related files, see 
“Working with related records” on page 10-31.

Choose FileMaker Help Index from the  or Help menu, and then type:

E exporting, data
E importing data
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Understanding file formats
Every application uses a file format, the organization of information 
within a file. The following table describes the file formats that 
FileMaker Pro supports. For more information about the formats, see 
FileMaker Pro Help.

Keep these points in mind:

1 If you’re exchanging data with another application, check the 
documentation to determine the file formats it supports.

Format Use to

FileMaker Pro Import data from a FileMaker Pro 2.0, 2.1, 3.0 or 4.0 file, 
or export to another FileMaker Pro 3.0 or 4.0 file. (If you 
import a FileMaker Pro 2.0 or 2.1 file, the file is first 
converted to FileMaker Pro 4.0 format, then the data is 
imported. See the FileMaker Pro Installation and New 
Features Guide for more information.)

Tab-Separated Text Exchange data with most applications, including 
ClarisImpact. If you aren’t sure which format to use, try 
Tab-Separated Text.

Comma-Separated Text Exchange data with BASIC programs, and applications 
like ClarisImpact. This format is also called 
Comma-Separated Values (CSV).

SYLK Exchange data with many spreadsheet applications

DIF Exchange data with spreadsheet programs, like VisiCalc

WKS Exchange data with Lotus 1-2-3

BASIC Exchange data with Microsoft BASIC programs

Merge Create personalized documents like form letters. For 
example, in MacWrite Pro you can combine variable data 
(like names and addresses) in a Merge file with text in a 
main document. The FileMaker Pro Merge file is 
equivalent to a MacWrite Pro Merge data file.

HTML Table Save data as an HTML table for use on a Web page

Edition File Publish an Edition file, which users can subscribe to from 
any application that supports the Edition Manager. 
Whenever you export the file, subscribers are 
automatically updated.

ClarisWorks 2.0/3.0/4.0 Import data from ClarisWorks 2.0 through 4.0 
database files

DBF Exchange data with dBASE III and dBASE IV

Excel Import data from Microsoft Excel 4.0 through 5.0
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1 Most file formats don’t support importing or exporting text attributes 
(font, size, or style). In these cases, FileMaker Pro imports or exports 
the text but not the attributes.

1 Some formats don’t support repeating fields. See “Exporting 
repeating field data” on page 8-14.

Importing data into FileMaker Pro
You can import data into a new or existing FileMaker Pro file.

Keep these points in mind:

1 The file you’re importing from must be in one of the formats listed in 
“Understanding file formats” on page 8-3.

1 FileMaker Pro imports data in the order it appears in the file you’re 
importing from.

1 You can import data from any field type into any compatible field 
except container, calculation, summary, and global fields. You can 
import container fields if you’re importing from another 
FileMaker Pro file.

1 To insert graphics, sounds, or QuickTime movies into your file, see 
“Working with container fields” on page 4-6.

Importing data into an existing file
You can import data into an existing FileMaker Pro file from another 
FileMaker Pro file, or from another application. You choose whether 
FileMaker Pro adds or replaces records in the file you’re importing into:

1 The Add new records option copies all records to the end of the file 
you’re importing into.

Choose FileMaker Help Index from the  or Help menu, and then type:

E file formats

To Do this

Import data into an existing 
FileMaker Pro file

See the following section.

Import data from another application 
into a new FileMaker Pro file

See “Importing data into a new file” on page 8-9.
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1 The Replace data in current found set option replaces records in the file 
you’re importing into. The following figure illustrates this option.

To import data into an existing file:

1. If you’re replacing records, make a backup 
copy of the file you’re importing into.

2. If you’re importing records from a FileMaker Pro file, open the file, 
and then browse the records you want to import.

FileMaker Pro imports the records in the found set in the order 
they’re sorted. Use Find, Omit, Omit Multiple, or Sort, if needed.

3. Open the FileMaker Pro file you want to import records into.

If you’re replacing records in the file, use Find, Omit, or Omit Multiple 
to browse the records you want to replace. Sort the records in the 
same order as records in the file you want to import.

4. In Browse mode, choose Import/Export from the File menu, and then 
choose Import Records.

5. In the dialog box, select the name of the file to import, and then click 
Open.

For Show, choose a file type to narrow the choices, or choose All 
Available to see all the files you can import.

6. In the Import Field Mapping dialog box, match the fields you want 
to import.

When replacing data,
FileMaker Pro doesn’t import

these records because the
source file has more records

than the destination file

Destination fileSource file
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Important Check each arrow and field name to be sure the correct data 
moves into the correct fields.

To Do this

Change the order of 
fields in the Fields in list

Choose an option from the View By pop-up menu. (Options 
change the order by which you view fields in the dialog box, 
not the order of the fields in the file.) To list the fields by:

1 names that match, choose Matching Names
1 the order used the last time FileMaker Pro imported data into 

this file, choose Last Order
1 the order the fields were created, choose Creation Order
1 name in alphabetical order, choose Field Names
1 the types of fields, choose Field Types
1 a custom order (created by dragging field names), choose 

Import Order

Change the order of 
one field in the file 
you’re importing into

Move the pointer over a field name in the Fields in list. When the 
pointer changes to a double arrow, drag the name to a new 
location. This changes the order you view fields in the dialog 
box, not the order of the fields in the file.

Prevent data from 
being imported

Click the arrow between the field names. The arrow changes to 
a dotted line.

View the data in the file 
you’re importing from

Click the Scan Data arrows to see the data in each record.

Create a field in the file 
you’re importing into

Click Define Fields. In the Define Fields dialog box, create the 
field, and then click Done. (See “Defining database fields” on 
page 2-3.) If you’re importing into a shared file, only the host 
can create fields.

Change or delete a field 
in the file you’re 
importing into

Click Define Fields. In the Define Fields dialog box, make your 
changes, and then click Done. (See “Changing field definitions” 
on page 2-25.) If you’re importing into a shared file, only the 
host can change or delete fields.
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7. Select an option to add or replace records, and then click Import.

8. If you see the Import Options dialog box, select options, and then 
click OK.

FileMaker Pro displays this dialog box if your file has lookups or 
fields that automatically enter data, or if you’re importing data from 
a FileMaker Pro file with repeating fields and select the Add new 
records option.

To Do this

Add new records to the end of the 
file you’re importing into

Select Add new records.

Replace existing data in the file 
you’re importing into

Select Replace data in current found set. FileMaker Pro 
replaces field values in the found set of the file you’re 
importing into.

To Do this

Enter default data into 
fields that are defined with 
Auto Enter options or as 
lookups

Select Perform auto-enter options while importing.

After importing data, FileMaker Pro enters default data 
into fields with Auto Enter options. Some Auto Enter 
options (like modification date, time, and name, and 
lookups) overwrite the imported data. (See “Choosing data 
entry options” on page 2-6 and “Defining a lookup” on 
page 10-11.)

Fields in the 
destination fileFields in the source file

Arrows show how
FileMaker Pro imports data
from one file into the other

Dotted lines 
show data that 
won’t be 
imported
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Keep these points in mind:

1 The records you import become the found set. After importing, check 
the data in the found set.

1 If you select the Replace data in current found set option, be sure your 
records are correct before discarding the backup copy of the file.

1 FileMaker Pro doesn’t validate imported data.

To stop importing, press Command-period. To delete the records 
already imported, choose Delete All from the Mode menu.

Important If you delete the found set after using the Replace data in 
current found set option, you delete your original found set (which 
might be all your data).

Import data into 
repeating fields

1 Select Keeping them in the original record to import the 
records as repeating fields.

1 Select Splitting them into separate records to place each 
repeating value in a separate record. For example, 
choose this option to split line items on an invoice—if 
you have five repeating values, you get five separate 
records. Each separate record is identical except for the 
repeating field values. You can then sort the newly 
separated items, or total them using a summary field.

Choose FileMaker Help Index from the  or Help menu, and then type:

E importing data

To Do this



Importing and exporting data 8-9
Importing data into a new file
You can bring data from another application into a new FileMaker Pro 
file with one Standard layout and one columnar report. Every record is 
copied into the new file.

1. In FileMaker Pro, choose Open from the File menu.

2. In the dialog box, select from the pop-up menu the type of file you 
want to import, select the file from the list, and then click Open.

3. In the Name converted file dialog box, type a name for the new file, 
select a location, and then click Save.

FileMaker Pro creates a text field called fx for each field in the new 
file, where x is 1, 2, 3, and so on, until all fields are named.

Note If you’re importing from a format that contains the field names 
(like DIF), FileMaker Pro uses the names instead of fx.

Some formats (including ClarisWorks and DBF) create number, date, 
and time field types in addition to text.

If you are importing a Microsoft Excel file which contains more than 
one worksheet, FileMaker Pro displays the Select Worksheet dialog 
box from which you can select the worksheet that you want to import.

To stop the import, press Command-period. You can delete the records 
already imported by choosing Delete All from the Mode menu.

Exporting data from FileMaker Pro
You can export FileMaker Pro data to a new file, and then open it in 
another application.

Keep these points in mind:

1 To use an exported file, open an application that can read the file 
format, and then open the file. See “Understanding file formats” on 
page 8-3 for file formats you can export.

1 You can export data in container fields to FileMaker Pro format.

Choose FileMaker Help Index from the  or Help menu, and then type:

E importing data
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1 Use the procedure in this section to export summary data. To export 
subsummary data, see “Exporting subsummary data” on page 8-12.

1 To export repeating field values to SYLK, WKS, or DBF formats, see 
“Exporting repeating field data” on page 8-14.

1 For information about exporting data from related fields, see 
“Working with related files and fields” on page 10-30.

1 You can’t export data from a FileMaker Pro file to a remote database, 
like SQL Server.

To export data:

1. Open the FileMaker Pro file and browse the records you want 
to export.

Use Find, Omit, or Omit Multiple to create a found set. 

2. Sort the records in the order you want them exported.

3. In Browse mode, choose Import/Export from the File menu, and then 
choose Export Records.

In the dialog box, type a name, and then select a location for the file.

Important If another file with the same name already exists, 
FileMaker Pro replaces the file.

 

4. Choose a file type from the Type pop-up menu, and then click Save.

5. In the Export Field Order dialog box, change the field order as 
needed.

To Do this

Export fields Double-click a field to move it to the Field Order list. To 
export all fields, click Move All.

Choose a file type that 
the target application 
supports

Type a name for the
exported file
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6. Select a format option for the fields, and then click Export.

Suppose the current layout has a number field that’s formatted to 
display two decimal digits and a currency symbol ($). When you 
enter 3.7 into the field, FileMaker Pro displays $3.70 in Browse 
mode. You can export the value with or without the formatting.

Export fields from a 
related file

Choose a relationship from the Relationship pop-up menu, 
and then move fields to the Field Order list. (See 
“Understanding relationships” on page 10-9.)

Prevent data from 
being exported

Select a field in the Field Order list, and then click Clear. To 
move all fields out of the list, click Clear All.

Change the export order In the Field Order list, drag the double arrow for the field 
name.

To export Select this option

Unformatted values (for example, 3.7) Don’t format output

Values with the number, date, and time 
formats from the current layout (for 
example, $3.70) 

Format output using current layout. Symbols and 
other non-numeric values are exported as text. 
You can’t select this option for SYLK, DBF, or 
DIF formats.

Choose FileMaker Help Index from the  or Help menu, and then type:

E exporting, data

To Do this

FileMaker Pro 
exports these 
fields

Select fields from this list

Relationship pop-up menu

Choose a formatting option
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Exporting subsummary data
When you export subsummary data, you must specify how to sort and 
summarize the records.

Note To export summary data, see the previous section.

1. Open a FileMaker Pro file and browse the records you want to export.

Use Find, Omit, or Omit Multiple, if needed. 

2. Sort the records in the order you want them exported.

Sort on the break field (the field that groups the records), and then 
switch to Preview mode to verify the subsummary results. (See 
“Adding a summary part” on page 3-31 and “Sorting by summary 
fields” on page 4-32.)

3. In Browse mode, choose Import/Export from the File menu, and then 
choose Export Records.

4. In the dialog box, type a name, and then select a location for the file 
you’re exporting to.

Important If another file with the same name already exists, 
FileMaker Pro replaces the data in it.

5. Choose a file type from the Type pop-up menu, and then click Save.

6. In the Export Field Order dialog box, select the fields to export.

For information about the Export Field Order dialog box, see step 5 
in “Exporting data from FileMaker Pro” on page 8-10.

7. To export subsummary values, select a summary field in the Field 
Order list, and then click Summarize by.

8. In the Summarize by dialog box, choose one or more fields to 
summarize by.

Move the pointer to the left of the field name, and then click to 
choose it.
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9. Click OK.

  

10.Repeat steps 7 through 9 to export additional subsummary values that 
are sorted by the same break field.

Repeat steps 2 through 9 to export subsummary values that are sorted 
by other break fields. 

11.Select a format option for the fields, and then click Export.

See step 6 on page 8-11 in “Exporting data from FileMaker Pro.”

Choose FileMaker Help Index from the  or Help menu, and then type:

E subsummary layout parts

The file is sorted by 
these fields

Click the left side of the field

When you choose a field,
FileMaker Pro displays a

checkmark

If you don’t select a field to
summarize by, FileMaker Pro

exports a grand summary
(one summary value for

every record)

Select a format option

Relationship pop-up menu

This field is summarized by
Department—FileMaker Pro

exports the subsummary values
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Exporting repeating field data
Some file formats (like SYLK, WKS, and DBF) can only interpret one 
value per cell or field. When FileMaker Pro exports to these formats, it 
exports only the first value in a repeating field. To export all repeating 
field values, split the fields into separate records.

1. Make a clone of the file you want to export.

See “Saving a copy of a file” on page 1-11.

2. Open the clone, and then import the data from the original file. 

See “Importing data into an existing file” on page 8-4. 

3. When you see the Import Options dialog box, select Splitting them into 
separate records, and then click OK.

Choose FileMaker Help Index from the  or Help menu, and then type:

E repeating fields



Chapter 9:  Customizing FileMaker Pro

You can customize FileMaker Pro by setting preferences for the 
application, for individual files, or for working with files on the Web. 
This chapter explains the preference options. 

Important Before you read this chapter, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.”

Setting application preferences
Application preferences apply to any file you open. Preferences remain 
in effect until you change them.

To set application preferences:

1. Open a FileMaker Pro file.

2. Choose Preferences from the Edit menu, and then choose Application.

3. In the Application Preferences dialog box, choose a preference from 
the pop-up menu, and then set the options.

Choose FileMaker Help Index from the  or Help menu, and then type:

E application preferences

Set options to customize 
the way you work

Choose a preference type
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Setting general application preferences
In general application preferences, you set options for dragging and 
dropping text, displaying template files, and the number of previously 
opened files that are listed in the File menu. You can also specify your 
user name and network protocol.

Do this To

Select Enable drag and drop 
text selection

Use drag and drop to transfer text without using 
the Clipboard

Select Show templates in New File dialog Display a list of template files when you start 
FileMaker Pro or choose New from the File menu

Select Recently opened files Display recently opened files in the File menu. You 
can also select how many files appear in the menu, up 
to a maximum of nine files.

For User Name, select Custom, and 
then type a name in the text box

Specify a custom user name. If you don’t specify a 
custom name, FileMaker Pro uses the System user 
name from the Chooser or the Sharing Setup 
control panel.

Choose a network from the Network 
protocol pop-up menu

Select a network connection. Changes to this setting 
don’t take effect until you quit FileMaker Pro, and 
then start it again.

Choose FileMaker Help Index from the  or Help menu, and then type:

E general preferences



Customizing FileMaker Pro 9-3
Setting layout preferences
In layout preferences, you set options for the way you like to work in 
Layout mode.

Select To

Always lock layout tools Keep a layout tool selected until you select a different one 
or press Enter. If you don’t select this option, 
FileMaker Pro returns to the arrow pointer after you use a 
tool.

Add newly defined fields to 
current layout

Add new fields to the current layout when you define them

Create rounded buttons Create buttons with rounded corners  using the 
button tool 

Create rectangular buttons Create rectangular buttons  using the button tool 

Choose FileMaker Help Index from the  or Help menu, and then type:

E layout preferences



9-4 FileMaker Pro User’s Guide
Setting memory preferences
Changes you make to FileMaker Pro files are stored in an area of RAM 
called the cache, and are saved periodically to the hard disk. In memory 
preferences, you choose when FileMaker Pro saves your changes.

Setting preferences for dialing phone numbers
Modem and dialing preferences affect the way FileMaker Pro dials 
phone numbers. To dial phone numbers:

1. Define a script that includes the Dial Phone step.

Dial Phone specifies which phone numbers to dial. See chapter 5, 
“Using ScriptMaker and buttons.”

2. Specify modem and dialing preferences. 

See the following sections.

Do this To

Select during idle time Save changes when the system is idle or when the file cache 
is full. Don’t use this option with battery-powered portable 
computers—it can run down the power supply.

Select every <value> or when 
necessary, and then choose an 
interval from the drop-down list

Save changes at a specified time interval or when the file 
cache is full

Choose FileMaker Help Index from the  or Help menu, and then type:

E memory preferences
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3. Perform the script.

Setting modem preferences
For information about the settings you should use, see the 
documentation that came with your modem.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Dial Phone script step
E scripts, overview
E setting preferences

For Do this

Setup Type the command (all uppercase or all lowercase) to initialize your modem.

Prefix Type the command (all uppercase or all lowercase) for starting a call.

Hang up Type the command (all uppercase or all lowercase) for disconnecting a call.

Output Choose a port from the pop-up menu. If you choose Speaker, you don’t have 
to set the other modem preferences.

Speed Choose a baud rate (the speed for transmitting data between your computer 
and the modem) from the pop-up menu.

Choose FileMaker Help Index from the  or Help menu, and then type:

E modem preferences

Options are preset to standard
Hayes-compatible settings

AT is an attention command for 
Hayes-compatible modems—for 
example, +++ ATH instructs the 
modem to hang up

Click to restore preset 
modem preferences
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Setting dialing preferences
You can store a phone number in your database and set FileMaker Pro 
dialing preferences to dial it in different ways.

Note FileMaker Pro uses these preferences when you select the Use 
Dialing Preferences option in the Dial Phone script step.

The following example shows dialing preferences for an office. When 
dialing another extension in the same office, you might not want to dial 
the exchange. And when dialing a number outside the office, you might 
need to dial a prefix for a local area code, or several prefixes for a long-
distance call. 

FileMaker Pro matches the text in the left column of the Dialing 
Preferences dialog box with the phone number in your database. When 
it finds the longest matching entry in the left column, it dials the 
corresponding entry in the right column. In this example, if the number 
in your database is 408 555-3930, FileMaker Pro dials 3930.

For Do this

At location Choose a location from the pop-up menu.

If text begins with Type the digits that you don’t want FileMaker Pro to dial at the 
beginning of a phone number.

Replace with Type the digits that you want FileMaker Pro to dial before a 
phone number.

Always append Type the digits that you want FileMaker Pro to dial after a 
phone number.

With most modems, include a 
comma for a two-second delay

Set preferences for different 
locations

This is the longest entry
that matches the example

phone number
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Note Some modems won’t accept more than 32 characters, so be careful 
when inserting or appending long numbers.

Setting up plug-ins
A plug-in is a file that adds features to FileMaker Pro. In plug-ins 
preferences you can set options for these plug-ins. Select the checkbox 
next to the plug-in you want to work with, then click Configure. If the 
checkbox is already selected, click the plug-in name to highlight it, then 
click Configure.

See “Publishing files on the Web” on page 11-1 for more information on 
using the FileMaker Pro Web Companion plug-in.

Setting document preferences
Document preferences affect the current database file. You can set 
different document preferences for different files. 

Note A shared file has the same document preferences for every user. 
You can change the document preferences if you have the master 
password or if there isn’t password protection in the file. See “Defining 
passwords” on page 7-11.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Dial Phone script step
E phone dialing

Select the plug-in you
want to enable

Click to configure the plug-in
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To set document preferences:

1. Open a FileMaker Pro file.

2. Choose Preferences from the Edit menu, and then choose Document.

3. In the Document Preferences dialog box, choose a preference type 
from the pop-up menu, and then set the options.

 

Setting general document perferences

Select To

Use smart quotes Use curly apostrophes (’) and quotation marks (“ ”). If you 
use a font that doesn’t have smart quotes, FileMaker Pro 
substitutes plain marks (' "). When you change this option, 
FileMaker Pro uses the new setting when you type in the 
file (existing marks do not change). If you deselect this 
option, FileMaker Pro uses plain marks.

Store compatible graphics Store graphics in a cross-platform format. You can 
deselect this option to conserve disk space. Changing this 
option affects only the objects you create after the 
change.

Try default password, and then 
type a password

Automatically enter a password when you open the file. 
If the password isn’t valid, FileMaker Pro prompts you to 
type another password. To temporarily bypass the 
default password and enter a different one, press Option 
while opening the file.

Switch to layout, and then 
choose a layout from the 
pop-up menu

Display the specified layout when you open the file. If 
you don’t select this option, FileMaker Pro opens the 
layout you displayed when you closed the file, or opens 
a layout you specify in a startup script. (See the Perform 
script option below.)

Changes to document 
preferences affect only 
this file

Choose a script to run 
when the file is closed

Choose a script to run 
when the file is opened

Choose a preference type
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Setting document spelling preferences
You can choose to have FileMaker Pro check your spelling as you type. 
You can also define where the Spelling dialog box appears onscreen. For 
more information on setting spelling preferences, see “Checking your 
spelling as you type” on page 1-15.

Setting Web Companion preferences
In Web Companion preferences, you set options for FileMaker Pro 
records that are published on the Web. You can set options for Table 
View, Form View, searching, and sorting.

To set Web Companion preferences, choose Preferences from the Edit 
menu, and then choose Web Companion.

For more information on setting preferences for FileMaker Pro Web 
Companion, see “Setting up FileMaker Pro Web Companion” on page 
11-7.

Perform script, and then 
choose a name from the 
pop-up menu

Perform a startup or close script when you open or close 
the file. For example, you can define a startup script to 
hide the status area or set the window size. If another 
script opens the file, FileMaker Pro doesn’t perform the 
startup script.

Choose FileMaker Help Index from the  or Help menu, and then type:

E document preferences

Select To



Chapter 10:  Using data from related files

There are times when one database file doesn’t suit all your data 
management needs. Perhaps you have data in one file that you want to 
use in another file. Or you’ve tried to expand a file by adding several 
fields to it, and now the file’s subject has become unclear. Or you have 
the same values in several files, and you’re constantly updating them to 
keep them all the same. With FileMaker Pro, you can access data from 
other files to use in the current file, by either defining lookups or 
creating a relational database. This chapter explains how.

Important Before you read this chapter, be sure you understand how to 
create a FileMaker Pro file (see chapter 2, “Creating a database file”). You 
should also know how to create a layout and work with data (see chapter 3, 
“Laying out and arranging information,” and chapter 4, “Working with 
information in records”). In addition, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.”

Looking up and displaying data from other files
When you have data in one file that you want to use in the current file, 
you can access, display, and work with that data in two ways: 

1 A lookup copies data from another file into a field in the current file. 
After data is copied, it becomes part of the current file (as well as 
existing in the file it was copied from). Data copied to the current file 
doesn’t automatically change when the values in the other file change.

1 A relational database allows data from another file to be displayed, 
edited, and used in the current file, without having it copied to the 
current file. The data is always part of the other file only. Data 
displayed in the current file changes whenever the values in the other 
file change.
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To establish a connection between files for lookups and relational 
databases, you define a relationship, an expression that tells 
FileMaker Pro how to match records in one file with records in another. 
Then you choose the fields that contain the data you want to work with.

Note  All files involved with lookups and relational databases must be 
FileMaker Pro 3.0 or 4.0 files.

Understanding the terminology
Before you begin, you need to understand the following terms for 
lookups and relational databases. These terms are illustrated in the 
sections that follow.

Choose FileMaker Help Index from the  or Help menu, and then type:

E relationships, understanding

This term Means

Master file For lookups, the file that contains the copied data. It’s the file the 
lookup originates from and the file the data is copied to.

For relational databases, the file that accesses and displays data 
from another file.

Related file For lookups, the file that contains the data to copy. It’s the file the 
lookup goes to and the file the data is copied from.

For relational databases, the file that contains the data you want to 
access and work with in the master file.

A related file and the master file can be the same file.

A lookup copies data from another file into 
the current file, in a field that belongs to the 
current file

In a relational database, data from another file is 
displayed in the current file, in a field that belongs 
only to the other file

Client ID

Route

R20

Oak-Bos

Client ID

Route

R20

Oak-Bos

Client ID

Route

R42

Oak-Lon

Client ID

Route

R42

Oak-Lon
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Understanding lookups
You look up data by first setting up a relationship between matching 
data in the master file and a related file, and then defining a lookup to 
copy data from a field in the related file into a field in the master file.

Match fields A field in the master file and a field in the related file that contain 
values you want to use to find matching records. (A match field is 
sometimes called a key field.)

For lookups, the values in the match fields don’t have to be equal 
to each other. For example, you can set an option to copy the next 
lower value when the match fields aren’t equal.

For relational databases, the values in the match fields must be 
equal to each other.

Lookup source field 
(for lookups only)

A field in the related file that contains the data you want to copy. 
It’s the field the data is copied from.

Lookup destination field 
(for lookups only)

A field in the master file that you want to contain the copied data. 
It’s the field the data is copied to.

Relationship An expression you define that contains requirements which, when 
met, establish a relationship between values in the match fields. (A 
relationship is sometimes called a link or a join expression.)

Related record A record in the related file whose match field (according to the 
relationship used) contains a value that’s equal to the value in the 
match field of the master file.

Related field A field in the related file that contains data you want to access and 
work with in the master file. After a relationship has been 
established between data in the match fields, the data in a related 
field can then be used in the master file.

You place a related field in a layout of the master file, either by 
itself or in a portal. You can then work with the related data in all 
modes.

In the master file, a related field name appears as
Relationship name::Related field name or as
::Related field name

Portal An object in a layout of the master file in which you can place 
related fields. Use a portal when you want to access and work with 
data from more than one related record in records of the master file.

You only need to place related fields in a portal if you want to work 
with data from more than one related record.

Portals display data from related records in rows, one record in 
each row.

This term Means
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When you type a value in the match field of the master file, 
FileMaker Pro uses the relationship to find the first record in the related 
file whose match field contains a matching value. Next, it copies the 
value from the lookup source field into the lookup destination field, 
where the value is then stored. Data that’s copied into the master file 
doesn’t change when the value in the related file changes, unless the 
match field in the master file is changed. In that case, the lookup will be 
performed again.

After a value is copied into the lookup destination field, you can edit, 
replace, or delete it like any other value. You can also update data in the 
master file to match data that changed in the related file. (See “Updating 
lookup values” on page 10-14.)

Keep these points in mind:

1 When the same value exists in more than one match field in the related 
file, FileMaker Pro copies data from only the first related record.

1 When you type data in the match field of the master file, you might 
be asked to type a password for the related file. 

1 To copy data into a second field that uses the same match fields—for 
example, to copy a name and telephone number based on a matching 
client identification number—define a lookup for the second field, 
and use the same relationship as the first field.

Client ID

Name 

Phone 

City

C235

Durand

42.83.91.04

Paris

Client ID

Name 

Phone 

City

C100

Burke

408-555-3456

San Jose

Client ID

Name

C200

Turkoglu

Client ID

Name 

Phone 

City

C200

Turkoglu

123-45-67

Istanbul

Lookup destination field

Master file

Match fields for the relationship

Related file

Lookup source field
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Understanding relational databases
A relational database is a group of two or more discrete database files 
that, when used together, contain all the data you need to do your work. 
In a relational database, each occurrence of data is stored in only one file 
at a time, but you can access and work with that data from any file. 

For example, a travel agency might store trip information in a Trip file, 
and then use it with client information in a Client file and with billing 
information in an Invoice file.

Choose FileMaker Help Index from the  or Help menu, and then type:

E lookups, overview

Master file Related file

Lookup destination
field for second lookup

Match fields for 
the relationship

Lookup destination
field for first lookup

Lookup source field 
for first lookup

Lookup source field for 
second lookup
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You create a relational database by first defining a relationship in the 
master file. Then you add the fields to display the data from the related 
file in a layout of the master file. You can then work with the data in the 
related fields in all modes when you work with records in the master file.

When you type a value in the match field of a record in the master file, 
FileMaker Pro uses the relationship to find all the records in the related file 
whose match field contains the same value. Then it accesses data from the 
fields of the related file in the current record of the master file. When the 
related field is in a portal, values from all related records are accessed.

Note You do not need to place related fields in a portal unless you want 
to work with data from more than one related record.

Trip file
Client file

Invoice file
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.

When the related field isn’t in a portal, the value from the first related 
record is accessed.

Because data from a related file is displayed in—and not copied into—
the master file, you always see the data in its current state.

Choose FileMaker Help Index from the  or Help menu, and then type:

E relational databases

Master file

Related fields in a portal

Related file

Match field for 
the relationship

Both records in the 
related file are accessed

Related fields not in a
portal—the first record in
the related file is accessed

Master file

Match field for the relationship

Related file
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Lookups and relational databases: a comparison
Whether you define a lookup or create a relational database depends on 
how you plan to use the data from another file. Use the following 
information to help you decide.

Use lookups to:

1 Copy data from a different file (or the current file) and keep it as 
copied. For example, use a lookup to copy values from a Current 
Price field to a Price field in an invoice file. Even if the price in the 
original file changes, the value in the invoice file stays the same.

1 Maintain a file that already contains lookups, when you don’t want to 
change the files to a relational database.

Use a relational database to:

1 See and work with data in its most up-to-date state. This is important 
when you need current data, like values in a Days Past Due field from 
a related file. 

1 Set up and manage data efficiently and with flexibility. Instead of 
creating many database files that together store multiple occurrences 
of data, you store single occurrences of values in smaller files. You 
can then work with the data in many ways. You make any changes to 
data in only one place, which promotes data accuracy.

1 Save disk space, because data is stored in only one place.

Note A complex set of lookups or a complex relational database may 
require an administrator who understands the design and how to 
maintain it. The administrator might also train others to use the database.

 

Choose FileMaker Help Index from the  or Help menu, and then type:

E lookups, overview
E relational databases
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Understanding relationships
Whenever you want to use data from another file—either for a lookup or 
in a relational database—you must first define a relationship from the 
master file to the related file. A relationship is an expression that 
includes the name of the match field in the master file, the related 
filename, and the name of the match field in the related file.

After you define a relationship, you can choose its name from the 
relationship pop-up menu as you work in the master file. The 
relationship pop-up menu is in all dialog boxes where you can select 
field names in related files. The following example shows the dialog box 
used to export FileMaker Pro data.

 

Master file

Match field

Related file

Match field

Relationship

Relationship pop-up menu
with the Customers

relationship selected

Choose fields in the
related file

List of fields to export
Field from the current file
Fields from a related file
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Once a connection is established between two files, you then have 
access to data in the related file in any of the following ways:

1 Define a lookup, to copy data from one related record for each record 
in the master file (establishing a one-to-one correspondence between 
data in the master file and data in the related file).

1 Place one or more related fields in a layout of the master file, to 
display data from one related record for each record in the master file. 
This establishes a one-to-one correspondence between data in the 
master file and data in the related file.

1 Add a portal in a layout of the master file, and then place one or more 
related fields in the portal to display data from more than one related 
records for each record in the master file. This establishes a one-to-
many correspondence between data in the master file and data in the 
related file.

 Keep these points in mind:

1 To define a relationship for a lookup, see “Defining a relationship for 
a lookup” on page 10-13. To define a relationship for a relational 
database, see “Defining relationships for a relational database” on 
page 10-21.

1 Each relationship involves only one master file and one related file; 
however, you can define many relationships from a master file and 
many relationships to a related file. The related file of one 
relationship can be a master file for a different relationship.

1 You can define many relationships between the same two files. For 
example, the relationships can specify different match fields.

1 The match fields for a relationship can have different names; what 
determines that the relationship is established is that the fields have 
matching values. Be sure the fields are the same type and are indexed; 
otherwise, the relationship might not find the records you expect.

1 You can define a relationship from one file to the same file (a self-
join.) For example, use a self-join in a portal to display a subset of 
data in the current file, like all the employees of each manager.

1 If the master file is protected with passwords, you must have the 
master password to define relationships. (See “Defining passwords” 
on page 7-11.)

Choose FileMaker Help Index from the  or Help menu, and then type:

E relationships, understanding
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Defining lookups between files
Important Before you begin, be sure you understand the information in 
the previous sections that explains lookups and how they differ from 
relational databases.

Defining a lookup
1. In Browse mode or Layout mode in the master file, choose Define 

from the File menu, and then choose Fields.

2. In the Define Fields dialog box, double-click the lookup destination 
field (the field to copy data to). Or create a field, and then double-
click it. 

3. In the Entry Options dialog box, select Looked-up value.

4. In the Lookup dialog box, choose the relationship to use from the 
relationship pop-up menu.

Or define a relationship by choosing Define Relationships from the 
pop-up menu. See “Defining a relationship for a lookup” in the 
following section.

5. In the list of field names, select the lookup source field (the field to 
copy data from).

6. Select options for the lookup.

To Do this

Determine what to do when values in 
the match fields are not equal

For If no exact match, then, select an option to copy 
no value, copy the next lower or next higher value 
that’s in the lookup source field, or display the 
message or data you type in the text box (up to 
255 characters).

Prevent null (empty) data in the 
lookup source field from being 
copied to the lookup destination field 

Select Don’t copy contents if empty. (Deselect this 
option to allow empty data to be copied.)
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7. Click OK, click OK again, and then click Done.

Keep these points in mind:

1 Be sure the lookup source field and lookup destination field are the 
same field type; otherwise, you might get unexpected results. 

1 To change a lookup, in the Entry Options dialog box, be sure Looked-
up value is selected, click Specify, and then make your changes. To 
stop using a lookup, deselect Looked-up value in the Entry Options 
dialog box.

1 When data in the related file changes and you want the master file to 
contain the new values, you can look up the data again. See 
“Updating lookup values” on page 10-14.

Choose FileMaker Help Index from the  or Help menu, and then type:

E lookups, defining

Select an option for 
lookups with unequal data 
in match fields

Select the lookup
source field

Choose the relationship to 
use, or define a new one



Using data from related files 10-13
Defining a relationship for a lookup 
1. In the Define Relationships dialog box, click New.

  

2. In the Open dialog box, double-click the name of the related file.

3. In the Edit Relationship dialog box, for Relationship Name, you can 
type a unique name for the relationship (otherwise, FileMaker Pro 
uses the name of the related file).

Don’t include colons (:) in the name. FileMaker Pro ignores spaces at 
the end of the name.

4. Select a match field in the master file and a match field in the 
related file.

  

5. Click OK, and then click Done.

Relationships currently
defined for the master file

Type a 
relationship 
name

Select a 
match 
field in the 
related file

Select a match field
in the master file
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Keep these points in mind:

1 You can define a relationship for a lookup when you define the 
lookup. See the previous section.

1 To change a relationship, see “Changing relationships” on page 
10-29.

Updating lookup values
If you change data in the match field of the related file or in the lookup 
source field, FileMaker Pro doesn’t automatically update the data in the 
lookup destination field. To update the data, you need to look it up again.

Important You can’t undo your actions when you update lookup values.

1. In the master file, locate the records that contain the values to update.

If necessary, find or omit records first. (See “Finding information” on 
page 4-19 and “Omitting records” on page 4-26.)

2. Select the match field in the current file, and then choose Relookup 
from the Mode menu.

3. When you see an alert message, click OK. 

To define a script to update lookup values automatically, see chapter 5, 
“Using ScriptMaker and buttons.”

Working with relational databases
The rest of this chapter explains how to plan, create, and work with 
relational databases.

Important Before you begin, be sure you understand the information in 
the previous sections that explain relational databases and how they 
differ from lookups.

Choose FileMaker Help Index from the  or Help menu, and then type:

E lookups, defining

Choose FileMaker Help Index from the  or Help menu, and then type:

E lookups, updating
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Planning a relational database
An efficient relational database organizes and stores information that 
you can retrieve and use to suit your needs. Related database files work 
together to ensure that the correct data is available when you need it. 

It’s a good idea to plan a database on paper first. Follow these general 
steps to plan a relational database:

1. Begin by asking questions, like these:

1 What information will the database hold?

1 What database files are needed?

1 What fields will each database file contain?

1 What common data exists among the database files?

2. Determine the database files and the data they will include. 

When you understand what you want the database to accomplish, 
you’re ready to list all the database files it will include. For example, 
for a travel agency, you might want a group of files that holds all the 
information about your clients, the trips your company offers, and 
accounting data.

As you design the files, think about the fields you want to include and 
which fields will contain common data. 



10-16 FileMaker Pro User’s Guide
Keep each file simple. For example, a Route file might have fields for 
a route identification number, the departure city, and the destination 
city. A Trip file might have fields for a trip identification number and 
trip name. You can combine data from the Route file in records of the 
Trip file.

3. Determine the match field or fields for each file.

Each database file has at least one field that can be used to determine 
whether or not a new record should be added to the file. This field is 
a match field. Often this field contains a value unique to each record. 

Client file

Route file Trip file
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For example, in a Client file you might want to assign each client a 
unique, identifying number. You wouldn’t enter a client number into 
the file unless you had a new client to add, so the existence of a client 
number determines the existence of a record.

4. For each file, decide which fields will store data and which ones will 
use data from other files.

The fields in each database file all store a single occurrence of the 
subject of the database file. For example, the fields in the Client file 
(client identification number, name, address, and phone number) 
together store all the information about one client. Other data can be 
combined as needed from other database files.

Client file

Route file Trip file
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Based on the file’s subject, you can see where it makes sense to store 
the data and where to use stored data from a different file. For 
example, you might want to use trip information in a Client file (to 
see which clients took which trips), so you could use the Trip fields 
in the Client file.

5. Determine the relationships between the files.

Each database file is related in some way to all the other database 
files. What defines a relationship between files is that their fields 
contain common data. Between match fields that have common data, 
draw a line from one file to another.

Client file

Route file Trip file
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Determining relationships between database files lets you see where 
you can use data stored in one file in another file. Establishing these 
relationships promotes consistent data entry and retrieval and reduces 
the existence of duplicate data among the database files.

6. Consider who will use the database and whether you want to restrict 
access to some files or fields.

For information about setting up passwords and access privileges, see 
“Protecting your files” on page 7-9.

Choose FileMaker Help Index from the  or Help menu, and then type:

E relational databases

Client file

Route file Trip file
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Creating a relational database
After you’ve planned your relational database, follow these general 
steps to create it (detailed instructions follow):

1. Define the relationships to use.

2. Depending on whether you want to work with data from one related 
record or more than one in each record in the master file, add related 
fields directly in the layout or in a portal in the layout.

1 For a related field by itself, add the related field directly in the 
layout.

1 For related fields in a portal, create the portal in the layout, and 
then add the related fields in the portal. 

You add related fields and portals in Layout mode and then work with 
data from the related records in all modes.

Deciding where to place related fields
You can display related fields directly in a layout or inside a portal.

1 Place related fields directly in the layout to display data from the first 
related record in the related file, even when the match field in the related 
file contains more than one occurrence of the same value. (A related field 
directly in a layout establishes a one-to-one correspondence between 
data in the master file and data in the related file.) 

1 Place related fields in a portal in the layout to display data from all 
found related records in the related file. (A portal establishes a one-
to-many correspondence between data in the master file and data in 
the related file.)
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Defining relationships for a relational database
1. In Browse mode or Layout mode in the master file, choose Define 

from the File menu, and then choose Relationships.

2. In the Define Relationships dialog box, click New.

Choose FileMaker Help Index from the  or Help menu, and then type:

E related fields

Related fields in a layout

Related fields in a portal

Related fields in
Layout mode

Related fields in
Browse mode Data from one 

related record

Data from all 
related records in
the related file
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3. In the Open dialog box, double-click the name of the related file.

4. In the Edit Relationship dialog box, for Relationship Name, you can 
type a unique name for the relationship (otherwise, FileMaker Pro 
uses the name of the related file).

Don’t include colons (:) in the name. FileMaker Pro ignores spaces at 
the end of the name.

5. Select a match field in the master file and a match field in the 
related file.

   

Relationships currently
defined for the master file

Type a 
relationship 
name

Select a 
match field 
in the 
related file

Select a match field in the
master file

Option for records in the
master file

Options for 
related 
records
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6. Select options for the relationship.

7. Click OK, and then click Done.

Keep these points in mind:

1 A match can be defined only on fields that can have an index.

1 You can define a relationship when you add a related field or create 
a portal in a layout. See the following sections.

1 To change a relationship, see “Changing relationships” on page 
10-29.

Creating a portal to hold related fields
Important Before you begin, be sure you want to create a portal to hold 
related fields. (See “Deciding where to place related fields” on page 
10-20.) 

1. In Layout mode in the master file, select the Portal tool.

To do this while browsing 
records in the master file Select

When you delete a record in the master 
file, delete related records (in the 
related file)

When deleting a record in this file, also delete related 
records. (See “Deleting related records” on page 
10-34.) Related records may not be visible on the 
current layout.

Add records to the related file Allow creation of related records. (See “Creating 
related records” on page 10-32.)

Sort related records before displaying 
them in the master file

Sort related records, then specify how you want 
related records sorted. (See “Sorting records 
with related fields” on page 10-35.)

Choose FileMaker Help Index from the  or Help menu, and then type:

E relational databases
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2. Click in the layout where you want the portal to start and drag the 
pointer diagonally until the portal is the size you want.

3. In the Portal Setup dialog box, choose the relationship to use from the 
Show records from pop-up menu.

Or define a relationship by choosing Define Relationships from the 
Show records from pop-up menu. See “Defining relationships for a 
relational database” on page 10-21.

Portal tool

 If you don’t see layout
tools, click the status

area control
Drag the pointer to

draw the portal

Select options for the portal

Select the relationship to use, 
or define a new one
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4. Select options for the portal, and then click OK.

  

5. Place related fields in the portal (see the next section).

Keep these points in mind:

1 You can display objects other than fields in a portal. An object is in a 
portal if its upper-left corner is inside the portal. An object placed in 
the first row of a portal is displayed once for each related record. 

1 A portal can’t contain another portal. If you place a portal in a portal, 
they overlap. 

1 You can place a portal in any layout part. See “Working with layout 
parts” on page 3-24.

To Select

Delete records in the related file by selecting 
a portal row in Browse mode, and then 
choosing Delete Record from the Mode menu

Allow deletion of portal records

Specify the number of rows to display in 
the portal

For Show <value> rows, type a number

Display a scroll bar on the right side of 
the portal

Show vertical scroll bar

Display a background color and pattern for 
every other row of the portal

Alternate background with, and then choose a 
fill color and pattern from the palettes

Relationship for the portal

 Portal 

 First portal row
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1 To number rows in a portal, use Paste Special to paste the record 
number into the first portal row.

Placing related fields in a layout or portal
Use the following steps for adding related fields directly in a layout or 
in a portal. 

Important Before you begin, determine where to place related fields (see 
“Deciding where to place related fields” on page 10-20). If you’re 
placing related fields in a portal, create the portal first (see “Creating a 
portal to hold related fields” on page 10-23).

1. In Layout mode in the master file, hold down the Field tool and drag 
the new field onto the layout or in the first row of a portal.

.  

2. In the Specify Field dialog box, choose a relationship from the 
relationship pop-up menu.

You can define a relationship by choosing Define Relationships from 
the pop-up menu. See “Defining relationships for a relational 
database” on page 10-21.

Choose FileMaker Help Index from the  or Help menu, and then type:

E portals, creating

Related 
fields in a 
layout

Field tool

Related 
fields in 
the first 
row of a 
portal

Portal
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3. Double-click the name of a related field.

   

Note To prevent users from changing data in a related field, deselect 
Allow entry into field in the Field Format dialog box (in Layout mode) for 
the related file. (See “Determining data entry in fields” on page 3-68.)

Changing related fields and portals
In Layout mode, related fields and portals are layout objects that you can 
change like any other FileMaker Pro object.

Selecting, moving, or deleting related fields and portals

Choose FileMaker Help Index from the  or Help menu, and then type:

E related fields

Choose FileMaker Help Index from the  or Help menu, and then type:

E related fields

To Do this in Layout mode

Select a related field Click the field.

Select a portal Click the portal area outside any fields.

Change the tab order of 
related fields

See “Setting the tab order for data entry” on page 3-69.

Move or delete the field label of 
a related field

Select the label, and then move or delete it.

Move related fields or portals See “Moving objects” on page 3-44. To move related fields 
with a portal, select the fields and the portal.

Choose the relationship to 
use, or define a new one

Fields in the related file (based on 
the current relationship)
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Changing the appearance of related fields and portals

Copying and pasting related fields and portals

Delete related fields or portals 
from a layout

In Layout mode, select the field or portal, and then press 
Delete. FileMaker Pro deletes the objects, not the 
relationships, field definitions, or data.

To Do this in Layout mode

Change the fill color or pattern, 
pen color or pattern, or line width 
of a related field or portal

See “Changing lines, colors, and patterns” on page 3-51.

Change the color or pattern of 
alternating rows in a portal

Double-click the portal. In the Portal Setup dialog box, 
select Alternate background with, and then choose a fill color 
and pattern from the palettes. Click OK.

Resize related fields or 
portal rows

See “Resizing objects” on page 3-50. Resizing the first row 
of a portal resizes all rows.

Change the number of rows 
displayed in a portal

Double-click the portal. In the Portal Setup dialog box, type 
a new value for Show <value> rows. Click OK.

Show or hide a portal scroll bar Double-click the portal. In the Portal Setup dialog box, 
select Show vertical scroll bar. Click OK.

Change the data format of 
related fields

See “Defining display formats for fields” on page 3-59. 
The changes only affect the format on the current layout.

Change the appearance of a 
related field in the current layout

See “Working with fields in a layout” on page 3-55. The 
changes only affect the appearance on the current layout.

Slide related fields and portals to 
remove blank space between 
layout objects

See “Removing spaces at the end of fields and parts” on 
page 6-5. Objects in a portal don’t slide or shrink, but when 
a portal slides, objects within the portal slide with it.

To Do this in Layout mode

Cut, copy, and paste 
related fields

See “Cutting, copying, and pasting objects” on page 3-45. 
If you paste a related field into another file, FileMaker Pro 
looks for a matching related field name in the new file. If 
the matching name exists, FileMaker Pro pastes the field in 
the layout with that same name. Otherwise, a template field 
(a field with no association to any field in the database file) 
is pasted.

Copy and paste portals See “Cutting, copying, and pasting objects” on page 3-45. 
To copy and paste related fields with a portal, select the 
fields and the portal. If you paste a portal into another file, 
FileMaker Pro looks for a matching relationship name in 
the new file.

To Do this in Layout mode
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Choosing a different relationship for a portal
1. In Layout mode, double-click the portal.

2. In the Portal Setup dialog box, choose a relationship from the pop-up 
menu, and then click OK. 

If you change the relationship after adding related fields to the portal, the 
fields don’t change, but FileMaker Pro matches records based on the 
new relationship. Remove the fields from the portal, and then add related 
fields based on the new relationship, if needed.

Changing relationships
When you change a relationship, your changes affect which records are 
found in the related file and displayed in records of the master file.

When you delete or change a relationship, all records involved in that 
relationship are affected by your changes.

1. Choose Define from the File menu, and then choose Relationships.

2. In the Define Relationships dialog box, select a relationship, and then 
select an option.

3. To edit the relationship, make your changes in the Edit Relationship 
dialog box, click OK, and then click Done.

To Click

Delete the relationship Delete, and then click Delete in the confirmation 
message. Be sure to delete all references to the 
relationship in the master file.

Quickly create a 
similar relationship

Duplicate. To make changes, with the duplicate selected, 
click Edit. Then see the next step.

Change the relationship Edit, and then see the next step.

To Do this

Rename a relationship For Relationship Name, type a new name.

Change options for a relationship Select or deselect options.

Choose a different related file Click Specify File. In the Open File dialog box, 
double-click the name of a related file. Then, in the 
Edit Relationship dialog box, select the match fields 
you want.
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Working with related files and fields
The following sections explain how to work with data in related files 
and fields.

Working with related files

Working with related fields

Change match fields Select a new match field in the master file, the 
related file, or both.

Choose FileMaker Help Index from the  or Help menu, and then type:

E relationships, changing

To do this with 
related files Keep these points in mind

Work with passwords 
and access privileges

You must have the appropriate access privileges to a related file or 
field. For example, to add data to a related field, you must have the 
privilege to edit records for the related file. (See “Protecting your 
files” on page 7-9.)

Check spelling Check spelling of data in related fields just as you do with data and 
text in the master file. (See “Checking your spelling” on page 1-13.)

Copy data When no fields and no records in a portal are selected, Copy copies 
data in the master record and in all records in portals. When a record 
in a portal is selected, Copy copies the data in the record in the portal. 
(See “Copying and moving values and records” on page 4-12.)

Choose FileMaker Help Index from the  or Help menu, and then type:

E related files

To do this with 
related fields Keep these points in mind

Change field definitions Change data entry options and validations directly in the 
related file only, because the data is defined in the related file. 
(See “Changing field definitions” on page 2-25.)

Change field formats Change the way data is displayed and formatted in the 
appropriate layout of the master file. (See “Defining display 
formats for fields” on page 3-59.)

To Do this
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Working with related records
The following table explains how to work with related records in some 
areas of FileMaker Pro. For other areas, see the following sections.

Define a calculation formula 
in the master file that refers 
to a related field

In the Specify Calculation dialog box, choose a relationship 
from the relationship pop-up menu. Then select a related field. 
(See “Understanding formulas” on page 2-13.)

References to related fields can become invalid when you create 
or delete a field, change the field type or number of repetitions, 
or have a missing field definition or mismatched field types (for 
example, when a field is deleted in the related file). When a field 
reference is invalid, FileMaker Pro alerts you.

Set the order for related 
fields (for columnar reports, 
exporting, and so on) 

You can place a related field anywhere in the field order—
before, after, or between fields in the master file.

In the Specify Field Order dialog box, choose a relationship 
from the relationship pop-up menu. Then select related fields 
in the field list, in the order you want.

Insert a merge field from a 
related file

In the Specify Field dialog box, choose a relationship from the 
relationship pop-up menu. Then select a related field. (See 
“Adding merge fields” on page 3-58.)

Summarize data that’s in a 
portal

Make the field a calculation field, and then define a formula 
that includes an aggregate function. For example, for a field 
that calculates the total of values in the related field Price 
(which is in a portal and uses the relationship Line Items), 
define the formula: Sum(Line Items::Price) for the 
Total field. (See “Functions” on page 2-20 and “Aggregate 
functions” on page C-6.)

Define a script step to work 
with related fields

In the Specify Field dialog box for the step, choose a 
relationship from the relationship pop-up menu. Then select a 
related field.

Choose FileMaker Help Index from the  or Help menu, and then type:

E related fields

To do this with 
related records Keep these points in mind

Duplicate related records 
(in Browse mode)

1 To duplicate a master record (and display related data), be 
sure no records in a portal are selected, and then choose 
Duplicate from the Edit menu. (See “Adding and duplicating 
records” on page 4-3.)

1 To duplicate a related record that’s in a portal, select the 
record, and then choose Duplicate from the Edit menu. The 
Allow creation of related records option must be selected for the 
portal relationship.

To do this with 
related fields Keep these points in mind
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Creating related records
You can add records to the related file as you enter data in a record in 
the master file.

To add related records from the master file, the Allow creation of related 
records option must be selected for the relationship. (See “Defining 
relationships for a relational database” on page 10-21.) When this option 
is selected, typing in a related field that has no corresponding related 
record creates a related record based on the match field in the master file. 

Import and export 
related records

1 You can’t import related fields, but you can import directly 
from a related file. (See “Importing data into FileMaker Pro” 
on page 8-4.)

1 To export related fields, use the relationship pop-up menu to 
choose the fields in the Export Field Order dialog box. (See 
“Exporting data from FileMaker Pro” on page 8-9.) 

Replace related records See “Replacing field values” on page 4-14.

Preview and print 
related records

1 FileMaker Pro prints related records and portals you see in 
Preview mode. (See chapter 6, “Previewing and printing 
information.”)

1 To prevent related fields and portals from printing, see 
“Keeping objects from printing” on page 6-9.

1 When you print a portal that displays a scroll bar, 
FileMaker Pro prints only the records displayed in the portal 
when the portal isn’t scrolled.

Work with records in 
shared files

FileMaker Pro limits access to some commands and records to 
keep users from interfering with each other. (See “Working 
with shared files” on page 7-6.)

1 When you make changes to a master record, FileMaker Pro 
prevents other users from changing the same record.

1 When you make changes to a related field, FileMaker Pro 
prevents other users from changing the associated related 
record and master record.

1 Other users can access the record after you select a field in a 
different record, select a different record in the same file, or 
leave the master record.

Choose FileMaker Help Index from the  or Help menu, and then type:

E related records

To do this with 
related records Keep these points in mind
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Note If a related file is locked or write-protected, or the user doesn’t 
have access privileges to create records, FileMaker Pro doesn’t add new 
records. See “Working with related records” on page 10-31 and 
“Defining passwords” on page 7-11.

To Do this

Create a record in the master file In Browse mode, choose New Record from the 
Mode menu.

Add a record in a related file 1 If the related field is in a portal, type data into the 
field in the last row of the portal, and then press Tab.

1 If the related field isn’t in a portal, type data into the 
field, and then press Tab.

Choose FileMaker Help Index from the  or Help menu, and then type:

E related records

Related records from the Line Items file

Match field

 Master file

Related file

Type in the last row of the portal to add a
related record to the Line Items file
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Deleting related records
While browsing through records in a master file, you can delete records 
from a related file when one or both of the options for deleting records 
are selected.

Important You can’t undo deleting data or records. Before deleting, 
consider making a backup copy of your files.

To delete records, in Browse mode, choose Delete Record from the Mode 
menu. (See “Deleting records” on page 4-29.) FileMaker Pro deletes 
information based on the following:

1 When a portal row is selected (by clicking inside the row but outside 
any fields in the row) and Allow deletion of portal records is selected in 
the Portal Setup dialog box, FileMaker Pro deletes the associated 
related record. (See “Creating a portal to hold related fields” on page 
10-23.)

1 When anything other than a portal row is selected, FileMaker Pro 
deletes the master record. If When deleting records in this file, also delete 
related records is selected in the Edit Relationship dialog box, all 
related records are also deleted. (See “Defining relationships for a 
relational database” on page 10-21.)

Note Delete All deletes the records in the found set of the master file. If 
When deleting records in this file, also delete related records is selected for the 
relationship, FileMaker Pro also deletes the related records.

Finding and omitting related records
You can include related fields in find criteria when you find records in a 
master file. (For more information, see “Finding information” on page 
4-19 and “Omitting records” on page 4-26.)

When you find records using related fields in a portal, FileMaker Pro 
displays all records related to the found set of records in the master file, 
not just related records that satisfy the find criteria. For example, 
suppose you search for records whose Item field (which is in a portal) 
contains Computer. The found set includes all records in the master file 
that contain Computer in any row of the portal.

Choose FileMaker Help Index from the  or Help menu, and then type:

E related records
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You can omit master records that include related fields, but you can’t 
omit related records.

Sorting records with related fields
(For general information on sorting records, see “Sorting records” on 
page 4-30.)

You can sort on related fields when you sort records in the master file. 
When you sort on a related field, the value from the first related record 
FileMaker Pro finds in the related database is used for sorting unless you 
specify otherwise. (See “Sorting related records” below.)

Choose FileMaker Help Index from the  or Help menu, and then type:

E related records

Employee ID

Name

Computer
Desk
Lamp
Bookcase
Chair

Item ID          Item

Employee ID

Name

Desk
Long table
Lamp
Round table
Computer

Item ID          Item

Employee ID

Name

               Computer
Item ID          Item

Employee ID

Name

Swivel chair
Panels
Round table
Computer
Chair

Item ID          Item

l100
l202
l153
l229
l448

l202
l443
l153
l288
l100

l384
l554
l288
l100
l448

E152

Stewart

Amber

Burke

Find request

Records in master file
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1. In the Sort Records dialog box, choose a relationship from the 
relationship pop-up menu.

2. Select related fields in the order you want them sorted, and then 
click Sort.

Note You can place a related field anywhere in the field order—before, 
after, or between fields in the master file.

Sorting related records
You can sort related records before displaying their values in the master 
file. Normally, FileMaker Pro looks in the related file, finds the first 
record that matches according to the specified relationship, and displays 
the related values in the master file. However, you can have 
FileMaker Pro sort related records first, and then display values from 
those sorted records in the master file. Instead of displaying the first 
related record, FileMaker Pro displays the first value encountered after 
sorting. The displayed value could be a highest value, a lowest value, or 
a value sorted using a custom order based on a value list.

Sorting related records is especially useful if you are using a portal to 
display multiple related records. You can use this feature to have related 
records appear in the portal in the sorted order you specify.

1. Choose Define from the File menu, and then choose Relationships.

2. Select the relationship you want to work with.

3. Click Edit.

4. In the Edit Relationship dialog box, select Sort related records.

5. In the Specify Sort dialog box, define how you want fields in the 
related file to be sorted before they are displayed in the master file.

Invoicing example
The following sections contain a step-by-step example for setting up a 
relational invoicing system, using a sample travel agency named 
EveryWhere Travel.

Choose FileMaker Help Index from the  or Help menu, and then type:

E related fields
E sorting records
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Example step 1: Plan the system
In addition to booking cruises, EveryWhere Travel sells souvenirs, like 
shirts and ship photographs. The company followed the procedure in 
“Planning a relational database” on page 10-15 to design the following 
database files for tracking and billing the souvenir sales.

1 A Customers file stores information for each customer, including a 
unique identification number. When a new customer calls to place an 
order, an agent creates a record in the Customers file.

   

1 A Products file stores information about available products.

One record 
per customer



10-38 FileMaker Pro User’s Guide
1 A Line Items file stores the order number, product identification 
number, price, and quantity of each item in every invoice. For every 
line item in the Invoice, there’s one record in the Line Items file.

1 An Invoices file is used for order entry and billing. When a customer 
places an order, an agent enters a customer identification number to 
display the customer’s name and address. The agent enters data in the 
Product ID field for each item ordered. FileMaker Pro enters data in 
the Invoice Number and the Order Date fields.

One record per product
Current price 
of the 
product—if 
you change 
this value, 
FileMaker Pro 
doesn’t save 
the old price

This record describes one
item ordered in Invoice 1

Price when the 
customer 
places the 
order— the 
price might be 
different from 
the current 
price in the 
Products file

Another item ordered
in Invoice 1

Quantity 
ordered by 
the customer
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The following figure shows how the database files are related.

One record per order

Agents type the Customer ID and data 
from the Customers file displays

Agents type the Product ID
and quantity, and

information from the
Products file displays

Data from 
Customers 
file

Line Items relationship

Customers relationship

Products relationship

Lookup
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Tip If you use fields that contain identification numbers, plan the field 
formats when you plan the database files. For example, customer 
identification numbers can be telephone numbers, serial numbers, or a 
combination of a telephone number and first name.

You can enhance this simple invoicing system in many ways. 
For example:

1 Place a button in the Order Entry layout in the Invoices file that 
agents click when a new customer calls. The button performs a script 
that switches to the Customers file, pauses for the agent to enter 
information, and then switches back to the Invoices file.

1 Use the Line Items file to create reports, like how many items were 
sold in February.

1 In the Products file, include fields for product information, like 
weight, color, and so on.

1 Create a Vendors file with information about companies that supply 
products. Define a Vendor ID field in the Products file, and then 
define a relationship to a Vendor ID field in the Vendors file.

Example step 2: Define fields
After you plan the invoicing system, create the database files and define 
the fields. (See “Defining database fields” on page 2-3.) Create the files 
that contain lookup source fields first.

1. Define these fields in the Customers file:

Field names Field type Select this Auto Enter entry option

Customer ID Number Serial number

First Name, Last Name, 
Address, City, State

Text
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2. Define these fields in the Products file: 

3. Define these fields in the Line Items file:

4. Define these fields in the Invoices file:

Example step 3: Define relationships
After you define the fields, define the relationships from the master files.

Field name Field type Select this Auto Enter entry option

Product ID Number Serial number

Product Name Text

Unit Price Number

Field name Field type

Invoice ID Number

Product ID Text

Qty Number

Field name Field type Select this Auto Enter entry option

Customer ID Number

Agent Name Text

Invoice ID Number Serial number

Order Date Date Creation Date

Master file Related file
Relationship 
name Match fields

Select these options 
for the relationship

Line Items Products Products Product ID

Invoices Customers Customers Customer ID

Invoices Line Items Line Items Invoice ID 1 When deleting a record 
in this file, also delete 
related records

1 Allow creation of related 
records
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Example step 4: Define fields that use relationships
When the relationships are defined, you can create the lookup 
and calculations.

1. Define these fields in the Line Items file:

2. Define the Total field in the Invoices file.

The Total field is an unstored calculation that adds the extended price 
of all line items. Use the Line Items relationship to define Total as:

Sum(Line Items::Extended Price)

Example step 5: Create layouts
Create layouts in the master files for data entry and reports. (See 
chapter 3, “Laying out and arranging information.”)

Field name Field type Comments

Unit Price Number A lookup to Unit Price in the Products file. Use the 
Products relationship.

Extended Price Calculation Enter the calculation Unit Price * Qty. Use fields 
from the current file (not the Products relationship).

Product Name Calculation Use the related field Products::Product Name. For 
Calculation result is, choose Text.h

File Layout names Description

Invoices Order Entry Standard layout with a portal.

1 Place these fields from the Customers file 
directly in the layout: First Name, Last 
Name, Address, City, and State.

1 In the Portal Setup dialog box, choose the 
Line Items relationship and Allow deletion of 
portal records. Place these fields from the 
Line Items file in the first row of the portal: 
Product ID, Product Name, Unit Price, Qty, 
and Extended Price.

Customers Data Entry Standard layout

Mailing labels Labels layout

Line Items Sales Report by Product Standard layout with subsummary by product

Sales Report by Month Standard layout with subsummary by month

Products Data Entry Standard layout
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Example step 6: Enter data
Enter data in the Products and Customers files, and then test your 
database by creating records in the Invoices file. (See “Adding data to a 
file” on page 4-2.)



Chapter 11:  Publishing files on the Web

With FileMaker Pro 4.0, you can publish your database on the World 
Wide Web—without any additional software—using FileMaker Pro 
Web Companion and your Internet access. Your file can be viewed, 
edited, sorted, and searched by anyone who has Web browser software 
and access to the Internet. You can also choose how much or how little 
access users have to your files.

This chapter explains what you need to do to publish your databases on 
the Web.

About the World Wide Web
The Internet is a network of computers joined by data lines that 
communicate using common software standards. The World Wide Web 
is part of the Internet. 

In the most basic sense, the World Wide Web is a very large collection 
of documents, or pages, stored on computers around the world called 
World Wide Web servers. Each computer connecting to the Internet has 
a unique address, called an IP (Internet protocol) address. Web pages 
travel from one IP address to another—first a Web browser requests 
specific Web pages, then the Web server delivers the requested page to 
the Web browser.
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About FileMaker Pro Web Companion
There are two ways you can publish your database on the Web: 
FileMaker Pro Instant Web Publishing and FileMaker Pro Custom 
Web Publishing.

Instant Web Publishing lets you publish your database on the Web 
quickly and easily. You do not need to change your database, use any 
additional software, or design Web pages. You can control database 
privileges such as viewing, adding, editing, deleting, searching, and 
sorting records. Users see clear, consistent Web pages which let them 
open your file and work with it easily.

Custom Web Publishing allows you to customize the appearance of your 
FileMaker Pro data on the Web. You need to create format files, which 
are Hypertext Markup Language (HTML) pages that contain Claris 
Dynamic Markup Language (CDML) tags, or commands. The CDML 
tags enable HTML pages to interact with FileMaker Pro. For an 
overview, see “Custom Web Publishing” on page 11-25. For 
step-by-step instructions on Custom Web Publishing, see the CDML 
Reference database inside the Web Tools folder.

Important  Regardless of the publishing method you choose, it is strongly 
recommended that you publish your database by running it on a 
computer with a full-time Internet connection.

Publishing a database on the Web
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What the Web Companion does
FileMaker Pro Web Companion functions as a Web server by 
communicating with Web browsers that request data from, or submit 
data to, a FileMaker Pro database. Similar to other Web server 
applications, the Web Companion delivers HTML Web pages and 
image files to the Web browser. The Web Companion supports the 
HTTP-Put and HTTP-Get commands. For more information about these 
HTTP commands, refer to an HTTP reference.

The Web Companion also acts as a Common Gateway Interface (CGI) 
application, by handling the interaction between FileMaker Pro and 
Web browser software.

Note You can also publish databases using other common gateway 
interface (CGI) applications, which you must purchase from third-party 
vendors.

Why publish a database on the Web?
When you host a database on the Web, the number of people who can 
use your file is potentially large: the only requirements are Web browser 
software and access to the Internet (or an intranet). Your file is available 
to anyone, using virtually any kind of computer, virtually anywhere in 
the world. You can, however, limit access using passwords.

You can also publish your database on the Web so that you can access it 
anywhere—on the road, at another office, or at home.

Publishing your database on the Web—an overview
The following section provides an overview of the steps required to 
publish your database on the Web using Instant or Custom Web 
Publishing.

Instant Web Publishing
1. Create a database, or select an existing database to publish.

Perform the following steps on a computer connected to the 
Internet or an intranet via TCP/IP.

2. Make sure that the Web Companion plug-in is enabled in Application 
Preferences.

3. Make sure that Instant Web Publishing is enabled in the Web 
Companion Configuration dialog box.
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4. (Optional) Change the default configuration of the Web Companion 
in the Web Companion Configuration dialog box.

5. (Optional) If you have created a custom home page, move it to the 
Web folder and specify it as your FileMaker Pro home page in the 
Web Companion Configuration dialog box.

6. Open the database in FileMaker Pro 4.0.

7. Enable Web Companion Sharing in the File Sharing dialog box.

8. (Optional) Choose the layouts that specify which fields will appear 
in Table View, Form View, and Search View, and select sort options.

9. Give your users information about accessing your database.

These steps are described in detail in the rest of this chapter.

Custom Web Publishing
1. Create a database, or select an existing database to publish.

2. Create format files, which contain HTML and CDML tags. Format 
files determine how Web users interact with your FileMaker Pro 
databases.

Perform the following steps on a computer connected to the 
Internet or an intranet via TCP/IP.

3. Move the HTML pages and format files to the Web folder, in the 
FileMaker Pro 4.0 folder. 

4. Make sure that the Web Companion plug-in is enabled in Application 
Preferences.

5. (Optional) Disable Instant Web Publishing in the Web Companion 
Configuration dialog box.

6. Choose the home page and change any other settings in the Web 
Companion Configuration dialog box.

7. Open the database in FileMaker Pro 4.0.

8. Enable Web Companion Sharing in the File Sharing dialog box.

9. Give your users information about accessing your database.

For step-by-step instructions on Custom Web Publishing, see the CDML 
Reference database inside the Web Tools folder.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Web, publishing databases on
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Getting ready to publish your files on the Web
To publish a file on the Web you need:

1 a FileMaker Pro database

1 a Mac OS-based computer, or an Intel-compatible 486/33 or higher 
personal computer, with access to the Internet (or an intranet)

1 FileMaker Pro 4.0 (for Mac OS or Windows), with the Web 
Companion installed. (The Web Companion is automatically 
installed when you do an Easy Install.)

1 optional: a custom home page, or HTML files containing CDML 
tags, for use with FileMaker Pro Custom Web Publishing

Internet access
It is best if the machine running your FileMaker Pro database has a 
full-time dial-up, ISDN, T1, T2, or T3 connection to the Internet (or 
similar capabilities). If you want to publish your database within your 
company or workgroup, you can use an intranet.

Without continuous Internet access, you can publish a database on the 
Web—but your database is only available while your machine is 
connected to the Internet. For more information, see “Helping Web 
users find your database” on page 11-23.

If you are not sure of the type of Internet access available to you, consult 
your Internet service provider or network administrator.

Preparing files for the Web
If you are using FileMaker Pro Instant Web Publishing, you can publish 
all the fields in your database, or you can designate layouts for use with 
the Web Companion that don’t show all fields. If you designate a layout, 
the Web Companion publishes only the fields contained in the layout 
you have specified. See “Setting options for Web display” on page 
11-12 for more information on how these layouts will be available to 
you when you’re ready to set up browser views.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Web, publishing databases on
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If you want, you can create a new layout for use with the Web 
Companion. A simple, Standard layout is sufficient, as text styles, 
special backgrounds, and colors do not appear on the Web using 
FileMaker Pro Instant Web Publishing. Date and number formats, as 
well as repeating fields, do appear over the Web. For information on 
working with layouts, see chapter 3, “Laying out and arranging 
information.”

If you have specified one or more passwords using FileMaker Pro access 
privileges to limit access to your database, users are required to enter a 
password when viewing your database on the Web.

If you are using FileMaker Pro Custom Web Publishing, you will need 
to move any HTML pages and format files you have created into the 
Web folder, which is inside the FileMaker Pro 4.0 folder.

Security considerations before you publish a database
There are some important security considerations to keep in mind before 
sharing a FileMaker Pro 4.0 database on the Web:

1 If you have chosen a layout with related fields in the Web Companion 
View Setup dialog box, those related fields appear when a Web user 
opens the master database—even if the related databases are 
protected with FileMaker Pro access privileges. Keep this in mind 
when designating layouts for use with published databases.

1 If your database uses related fields, and you are using Instant Web 
Publishing with the built-in home page (available in the Web 
Configuration dialog box), the related database(s) are also made 
available on the Web because they appear in the list of open databases 
on the built-in home page. For information about hiding databases 
from the built-in home page, see “Helping Web users find your 
database” on page 11-23.

Warning Anyone who opens a database file with the Export records 
access privilege, including FileMaker Pro guests, can then publish the 
database on the Web by enabling FileMaker Pro Web Companion on his 
or her computer. In this case, your database is protected over the Web 
by any FileMaker Pro access privileges you have created. However, you 
should exercise caution when granting access privileges to guests. For 
more information, see chapter 7, “Networking and access privileges.”
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Setting up FileMaker Pro Web Companion
Once you have prepared your files for the Web, set up FileMaker Pro 
Web Companion:

1. Choose Preferences from the Edit menu, and then choose Application.

2. Choose Plug-Ins from the pop-up menu.

3. Select the Web Companion checkbox.

For information on configuring FileMaker Pro Web Companion, see 
“Configuring FileMaker Pro Web Companion” on page 11-8. In most 
cases, you will not need to change the configuration default settings.

4. Click Done.

You only need to set up this preference once.

For each database you want to publish on the Web:

1. Open the database.

2. Choose Sharing from the File menu.

Note If you see an alert informing you that your password does not 
enable you to open the File Sharing dialog box, you must reopen the file 
using a password that provides the Export records access privilege.

Select Web Companion
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3. Select Web Companion in the Companion Sharing area.

4. Click OK.

Note These settings apply only to the database that is currently open. 
You need to set up other databases separately if you want to host them 
on the Web.

Configuring FileMaker Pro Web Companion
The Web Companion Configuration dialog box contains options you 
can change as needed. Since the default values are appropriate for most 
uses, you may not need to change these settings.

These are the default settings:

1 Instant Web Publishing is enabled

1 a built-in HTML file for your home page is available

1 English is set as the default language

1 the TCP/IP port number is set to 80

Choose FileMaker Help Index from the  or Help menu, and then type:

E Web Companion

Select Web Companion
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To change the configuration settings for FileMaker Pro Web 
Companion:

1. Choose Preferences from the Edit menu, and then choose Web 
Companion.

You see the Web Companion View Setup dialog box. For 
information on setting up views, see “Setting up Instant Web 
Publishing” on page 11-12.

2. Click Configure.

You see the Web Companion Configuration dialog box.

3. Choose the configuration options you want (see below).

Enabling Instant Web Publishing
If you want to publish your database using FileMaker Pro Instant Web 
Publishing, be sure Enable Instant Web Publishing is selected. If you are 
exclusively using FileMaker Pro Custom Web Publishing, you can 
deselect this option.

Specifying a home page for your database
If you are familiar with HTML editing, you can create a personalized 
Web page that can be used instead of the FileMaker Pro Web 
Companion Built-in home page.

If you want to use a home page other than the one that’s built into 
FileMaker Pro Web Companion, create the home page and move it into 
the top level of the Web folder in the FileMaker Pro 4.0 folder. Then 
choose the home page file from the Home Page pop-up menu. 



11-10 FileMaker Pro User’s Guide
By default, the Built-in Web page is used. This page automatically 
updates to include links to all databases being shared using the Web 
Companion.

Here are suggestions for items to include on your custom home page:

1 a link that contains the IP address of your published FileMaker Pro 
database

1 a description of what your database contains

1 your email address, or an automated email link, so users can contact 
you if they have questions

1 your logo, or other graphics

For more information, see “Helping Web users find your database” on 
page 11-23.

Choosing a language
You can specify the language used in both the FileMaker Pro Instant 
Web Publishing interface and in the Instant Web Publishing Help. 
Choose a language from the Language pop-up menu.

Note Choosing a language affects the FileMaker Pro Instant Web 
Publishing interface only. It has no effect on your data.

Creating a Web activity log
You can have FileMaker Pro Web Companion keep a log of the activity 
your database receives from Web users. This Web activity log is a text 
file named Web.log, located in the same folder as the FileMaker Pro 
application.

1 For no activity log, or to stop keeping an activity log if one already 
exists, select None.

1 For an abbreviated activity log, select Brief.

1 For a detailed activity log, select Extended.

Remote password administration
You can specify a password to control several remote administration 
activities:

1 remote administration of the Web Security databases

1 remote uploading of files to the Web folder and remote downloading 
of database files from the Web folder, in the FileMaker Pro 4.0 folder
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You can specify whether you want to require a password before 
allowing remote administration:

1 To require a password before allowing remote administration, select 
Requires password.

1 To allow remote administration without a password, select Requires 
no password.

1 To prevent remote administration, select Disabled.

Note When creating a password, use only the characters A through Z, 
numerals, or a combination of the two. Do not include spaces in your 
password. This minimizes the possibility that you will choose characters 
that may be interpreted incorrectly over the Web.

Web security
You can set up FileMaker Pro access privileges before publishing your 
database on the Web, or you can control access to your databases with 
even greater precision by using the Web Security database.

To use FileMaker Pro access privileges for access control, select 
FileMaker Pro access privileges. To use the Web Security database, select 
Web Security Database. For more information, see “Database security” on 
page 11-18.

Specifying a port number
The port number specifies the number of the TCP/IP port where Web 
browsers can find FileMaker Pro databases. If port number 80 is already 
in use (for example, in running a Web server), consider changing TCP/IP 
Port to 591. Port number 591 has been registered with the Internet 
Assigned Numbers Authority (IANA) for use with FileMaker Pro Web 
Companion.

Note If you use a port number other than 80, users cannot access your 
database unless they append a colon, and the new port number, to your 
IP address (12.34.56.78:591).

Choose FileMaker Help Index from the  or Help menu, and then type:

E Web Companion
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Setting up Instant Web Publishing
In a browser, users can see different pages, or views, of your database:

1 a Table View, for working with several records at a time

1 a Form View, for working with one record at a time

1 a search page, for finding information

1 a sort page, for sorting information (if enabled)

Setting options for Web display
You can choose which fields display in Table View, Form View, and the 
Search page. You can also set options for the Sort page.

Users see only the pages and features that you have given them access 
to. For example, if sorting is disabled, Web users do not see the Sort 
page. By default, all fields are shown in each view, and sorting is 
disabled.

To set options for each type of Web page:

1. Choose Preferences from the Edit menu, and then choose Web 
Companion.

2. Choose an option from the pop-up menu for the type of page you 
want to work with.

Choose an option

Select a layout

List of fields for 
the selected layout
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3. From the Layout pop-up menu, select the layout that contains the 
fields you want displayed for Table View, Form View, and Search. 
(For information on the Sort view, see below.)

A list of that layout’s fields appears below the pop-up menu.

4. Click Done.

Note Selecting a layout does not display that layout over the Web—it 
only indicates which fields you want the Web Companion to publish on 
the Web. If the layout you select has special date or number formats, or 
repeating fields, these do appear over the Web.

Related fields do not appear if you have chosen All Fields (no layout) in the 
pop-up menu. Instead, choose a layout which contains the related field 
or fields you want to publish on the Web.

Warning If you choose a layout for use on the Web and it uses related 
fields, those related fields appear when a Web user opens the master 
database—even if the related databases are protected with 
FileMaker Pro access privileges. Keep this in mind when choosing 
layouts for use with published databases.

Setting sort options
You can specify the order in which data is sorted, or you can allow users 
to define how the records are sorted. You can also specify that records 
not be sorted at all (they appear in the order they were added to the 
database).
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In the Web Companion View Setup dialog box, choose Sort from the 
pop-up menu and then choose the options you want.

Do not sort records
If you do not want users to sort data in the Web browser, select Do not 
sort records. This can help speed up access for those who are using your 
database. Data is not sorted when it appears on the Web, and the Sort 
button does not appear.

User defines sorting
If you want to let the user define how data is sorted, select User defines 
sorting by specified fields in the browser. You specify the fields (including 
fields from related files) on which the user can sort.

For information on specifying sort fields, see “Sorting records” on page 
4-30.

Note If a user sorts the data in a particular order, it does not affect the 
record order for other users on the Web.

Predefine sorting by specified fields before downloading
If you would like to automatically sort records before the user sees them, 
select Predefined sorting by specified fields before downloading to the 
browser. Then specify the sort order. (You can include related fields in 
this sort order.)

Choose Sort
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The Web user sees the data sorted in the order the fields appear in the 
Sort Order list, and the Sort button does not appear.

You can choose either ascending or descending order. You can also 
choose to have data sorted by a custom order based on a value list. The 
data are sorted in the same order they appear in a predefined value list.

For information on specifying a sort order, see “Sorting records” on 
page 4-30.

About the browser views
Note The record range and book icons do not appear unless you are 
using a Java-enabled Web browser. 

Detailed help is available to Web users by clicking the question mark (?) 
button on the Web page.

Table View
Table View is the view the user sees when the database opens. It lists 
multiple records in tabular form. Each record appears as a row, while 
each field appears in a column.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Instant Web Publishing

View a single record

Table View in the browser

Add a record
Find all records after a search

or creation of a new record

Click for Help
Click to return to the database home page

Sort records

Click to see this record
in form view

Record range icon: move
slider to view a different range

of records

Change the size of the record
range by typing a range, then

clicking the arrow
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Note These screens change to reflect features you have enabled or 
disabled. For example, the New record button does not appear if a user is 
not permitted to add records.

Form View
The Form View displays one record at a time, making it easy to see the 
detail of each record. From this view, Web users can edit information in 
a record.

Note These screens change to reflect features you have enabled or 
disabled. For example, the New record button does not appear if a user is 
not permitted to add records.

View a list of records

Form View in the browser

Book icon: view the previous record
View the next record

Edit this record
Add a record

Delete this record

Find all records after a search
or creation of a new record

Sort records

To see a record, type its number
and click the arrow
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Search page
The search page displays fields that can be used to find specific 
information in your database. The results of the search are displayed in 
Table View.

Searching in the browser

Begin searching
Set new search criteria

Type find criteria, then
click Start search

Click for search tips

Choose a search type

Choose a search operator
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Sort page
When records are displayed to users, those records can appear in a 
particular sorted order. See “Setting sort options” on page 11-13 for 
more information.

Database security
You can control access to your database. This limits who can use your 
file, as well as what they can do. There are two types of database security 
available using FileMaker Pro Web Companion:

1 FileMaker Pro access privileges

1 Web security databases

Important For a list of security considerations see “Security 
considerations before you publish a database” on page 11-6.

FileMaker Pro access privileges
If you have specified FileMaker Pro access privileges for your file, those 
same access privileges are in effect when you publish your database on 
the Web.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Web browsers

Sorting records in the browser

Perform sort

Use pop-up menus to select field names for the 
first, second, third, and fourth sorts

Return to the
previous view

Undo the sort

Use pop-up menus to select ascending or 
descending sort order, or a custom sort order 
based on a value list
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When users open your database on the Web, they enter the same 
password as if they were opening your file on the host machine (or over 
a FileMaker Pro network). The Web browser’s password dialog box has 
two fields: Name and Password. FileMaker Pro access privilege security 
ignores anything entered in the Name field.

FileMaker Pro access privileges are convenient, easy to use, and the best 
choice for most database security needs. For more information on 
FileMaker Pro access privileges, see chapter 7, “Networking and access 
privileges.”

Web Security database
If you want to establish access privileges that are more specific than 
FileMaker Pro access privileges, you can use the FileMaker Pro Web 
Security database.

With the Web security database, you can control whether users can 
search, update, add, or delete records; whether they can use scripts; and 
which fields they can work with. If you choose, you can also administer 
access privileges remotely over the Web. If you do not require this level 
of security, use FileMaker Pro access privileges.

To use the FileMaker Pro Web Security database:

1. Be sure that Web Security Database is selected under Security in the 
Web Companion Configuration dialog box. For more information see 
“Web security” on page 11-11.

2. Choose Open from the File menu.

3. Navigate to the FileMaker Pro 4.0 folder, then open the Web Security 
folder.

4. Open the Databases folder, and then double-click Web Security.

5. Select New Record from the Mode menu.

Choose FileMaker Help Index from the  or Help menu, and then type:

E access privileges
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6. For Database Name, type the name of the database you are establishing 
security for.

7. Enter information for the access privileges you want to grant.

8. If the FileMaker Pro database has a password set up with 
FileMaker Pro access privileges, type that password in the Database 
Password field.

Note The Database Password overrides the Web Security database. 
Web access privileges are never greater than the privileges provided 
by the Database Password, regardless of the settings in the Web 
Security database.

The Security folder contains HTML files that enable you to remotely 
administer the Web Security database.

See the following sections for more information.



Publishing files on the Web 11-21
User permissions
To set user access privileges, type the user’s name in the User Name 
field, and if desired, type a password for that user in the User Password 
field. Then select the access privileges for that user. Press Return to set 
access privileges for another user.

Field restrictions
To place field restrictions on all users specified in this record, in Field 
Name type the name of the field in the database you want to restrict. Then 
select the Field Restrictions for that field.

Important If you are using Instant Web Publishing, ExactSearch, 
ExactUpdate, and ExactDelete must be deselected.

To provide these access privileges Select this User Permission

Browsing records Browse

Adding new records Create

Editing data in records Edit

Deleting records Delete

Using scripts defined in the FileMaker Pro database Scripts

To place these restrictions Type the field name, then 
select this Field Restriction

Do not show a field DontShow

Do not allow a field to be used for searching DontSearch

Do not allow a field to be edited ReadOnly

When a field is used for searching, do not retrieve any 
records unless the data in the field with the ExactUpdate 
restriction exactly matches the value that is stored in that 
field in the database.

ExactSearch

Do not allow the record to be edited unless data in the field 
with the ExactUpdate restriction exactly matches the value 
that is stored in that field in the database

ExactUpdate

Do not allow the record to be deleted unless data in the 
field with the ExactUpdate restriction exactly matches the 
value that is stored in that field in the database

ExactDelete
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Keep these points in mind:

1 Create a separate record for every database you want to assign Web 
Security database access privileges.

1 You can type All Users in the User Name field to create privileges 
that apply to any Web user. These privileges override more restrictive 
privileges you may set later. To prevent this, carefully decide which 
privileges you want to grant to all users.

1 When creating a password, use only the characters A through Z, 
numerals, or a combination of the two. Do not include spaces in your 
password. This minimizes the possibility that you will choose 
characters that may be interpreted incorrectly over the Web.

Web Security database remote password administration
To remotely administer the Web Security database:

1. In the Web Companion Configuration dialog box, be sure to select 
Web Security Database and to enable Remote Administration. 

See “Configuring FileMaker Pro Web Companion” on page 11-8 for 
more information.

2. Open the Web Security database, located in the Databases folder in 
the Web Security folder.

3. Copy the Security folder from the Web Security folder to the Web 
folder.

4. In your Web browser, type the IP address for the computer where the 
Web Security database is open, and /Security/default.htm

For example, 12.34.56.78/Security/default.htm

5. On the resulting Web page, for Database Name, type the name of the 
database whose privileges you want to change and click OK.

Click the Add Database link to add a new database record to the Web 
Security database.

6. If you specified Requires password in the Web Companion 
Configuration dialog box, you’re prompted for a User Name and the 
password. Type Admin in the User Name field, type the password, and 
click OK.

Choose FileMaker Help Index from the  or Help menu, and then type:

E Web Security database
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7. On the resulting Web page, make changes to the privileges as you 
would in the Web Security database.

Helping Web users find your database
Browsing a database set up in FileMaker Pro Web Companion requires 
only Web browsing software and access to the Internet (or an intranet). 
The Web browser must also have the Internet Protocol (IP) address (and 
port number if it is other than 80, which is the default) of the machine 
that hosts your database file. You can supply this address for the user to 
type directly in the Web browser software, or you can provide a link to 
this IP address on a Web page you set up.

Example The IP address of the machine that hosts your database file is 
similar to 12.34.56.78. To see your data, the user launches Web 
browser software and types this IP address.

If you have specified a port number other than 80, that port number must 
be appended, using a colon, to your IP address:

12.34.56.78:591

For more information see “Specifying a port number” on page 11-11. 
For more information on using a custom home page, see “Specifying a 
home page for your database” on page 11-9.

Note If you connect to the Internet using a modem connection to an 
Internet service provider, your IP address could be dynamically 
allocated, meaning it is different each time you connect. This makes it 
much more difficult to create links from a Web page to your database, 
since your IP address is constantly changing.

Choose FileMaker Help Index from the  or Help menu, and then type:

E remote administration

Type IP address in browser window
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Once Web browser software is pointed to the IP address of the machine 
hosting your database files, the Web user sees your database home 
page—a background screen and the list of the files you have currently 
running on your host machine. Clicking a filename opens the file. If you 
have specified a password for the file, the user is prompted for it.

Note You can publish a file on the Web, but keep it from displaying on 
the Built-in home page, by typing an underscore character at the end of 
the filename, before any filename extension.

Example:  “Orders_” or “Orders_.fp3”

Choose FileMaker Help Index from the  or Help menu, and then type:

E Web, publishing databases on

Click the filename to
open the file

Instant Web Publishing built-in 
home page

Click here for help on working in the browser
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Custom Web Publishing
Custom Web Publishing allows you to customize the appearance of your 
FileMaker Pro data on the Web. To use Custom Web Publishing, you 
must create format files, HTML pages that contain Claris Dynamic 
Markup Language (CDML) tags. CDML is Claris Corporation’s 
proprietary add-on to HTML that allows Web users to dynamically 
interact with FileMaker Pro databases. 

If you do not want to learn HTML and CDML, you can use the 
FileMaker Pro Assistant feature in Claris Home Page 3.0 to create 
format files. Otherwise, you must have an HTML editing application 
and an understanding of HTML and CDML.

FileMaker Pro 4.0 includes several resources to help you learn and use 
CDML:

1 the CDML Reference database (Web Tools folder)

1 the CDML Tool (Web Tools folder)

1 CDML template files (Web Tools folder)

1 example Web solutions (Web folder)

The CDML Reference database
The CDML Reference, located in the Web Tools folder, provides:

1 the Developer’s Guide, to get you started with Custom Web 
Publishing

1 a CDML Tag Index, which shows CDML tag syntax and provides 
examples

Choose FileMaker Help Index from the  or Help menu, and then type:

E Custom Web Publishing
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The Developer’s Guide in the CDML Reference database provides 
general information about Custom Web Publishing and step-by-step 
instructions on using the CDML Tool to create format files. 

You can start a new format file by:

1 using one of the templates in the CDML Tool (see “Using the CDML 
templates” in the Developer’s Guide)

1 copying and pasting CDML tags from the CDML Tool to existing 
HTML pages (see “Adding CDML tags to format files”)

1 modifying one of the format files in the Web folder (see “Working 
with the sample solutions”)

1 customizing one of the template files in the Web Tools folder

Note The CDML Reference focuses primarily on the CDML syntax. For 
information about working with HTML, see an HTML reference book.
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The CDML Tool
The CDML Tool, located in the Web Tools folder, interacts between 
open FileMaker Pro databases and HTML editing applications to help 
you construct format files quickly and accurately.

Use the CDML Tool to:

1 start a format file using basic templates that contain step-by-step 
instructions (Templates tab)

1 copy and paste CDML tags to format files (Tags tab)

The CDML Tool links open FileMaker Pro databases with HTML 
editing applications.

Follow these general steps to create a format file using the CDML Tool:

1. Open and share your FileMaker Pro database using Web Companion 
sharing.

2. From the Web Tools folder, open the CDML Tool.

3. Click the Templates tab and choose the database and layout names.

4. Open an HTML editing application.

5. From the Templates tab of the CDML Tool, copy a template from the 
Format File (Action) list.

6. Paste the template text into a blank HTML editing document.

7. From the Tags tab of the CDML Tool, copy and paste additional 
CDML tags into the appropriate location in the format file.

Create one format file to handle each database activity.
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For more information on the CDML Tool, see the Developer’s Guide in 
the CDML Reference database.

Sample Web solutions
Three sample Web solutions are provided for you to use as a model for 
database Custom Web Publishing. The sample Web solutions include 
helpful comments to assist you in creating format files.

The following sample Web solutions are located in the Web folder in the 
FileMaker Pro 4.0 Folder:

1 The Guest Book solution allows Web users to add records in the 
Guest Book.fp3 database.

1 The Shopping Cart solution allows Web users to browse through and 
purchase items from a catalog.

1 The Employee Database solution is designed to demonstrate the most 
widely used CDML tags.

Choose FileMaker Help Index from the  or Help menu, and then type:

E CDML Reference database

Select a database

Select a CDML tag category
Select a tag

CDML tag syntax

Opens the CDML
Reference database



Appendix A:  Recovering damaged files

Power failures, hardware problems, and other factors can damage a 
FileMaker Pro file. If a file is damaged, you can use the FileMaker Pro 
recovery feature. FileMaker Pro attempts to repair and salvage as much 
of the information in the file as possible, and then creates a recovered 
file. You can open and use a recovered file just like any other 
FileMaker Pro file.

Important Before you begin, be sure you have enough disk space for the 
recovered file. If there isn’t enough space, the recovered file won’t 
be usable.

To recover a damaged file:

1. Be sure the damaged file is closed.

2. Choose Recover from the File menu.

3. In the Open Damaged File dialog box, select the damaged file, and 
then click Open.

In the Name New Recovered File dialog box, FileMaker Pro adds 
Recovered to the filename (which might be truncated). 

4. If you want to rename the file, for Name new recovered file, type a 
name.

5. Click Save.

A status message tells you about the recovery process. A second 
message reports the success of the recovery—how many bytes were 
salvaged, the number of records and values skipped, and the number 
of lost field definitions that were rebuilt.

6. Click OK.
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Keep these points in mind:

1 To ensure you always have a file that’s up to date, make frequent 
backup copies of your files, and don’t write over the most recent 
copies.

1 If a file is severely damaged, you might not be able to recover it.

A file can grow or shrink in size. A file can grow if the indexes are 
damaged and repaired. A file can shrink when data deleted by the user, 
like a paragraph, has finally been deleted from the file.

Choose FileMaker Help Index from the  or Help menu, and then type:

E recovering files



Appendix B:  Working with international files

When you create or clone a database file, FileMaker Pro uses the current 
settings in the Numbers and Date & Time control panels as the default 
date, time, and number formats and stores them internally with the file. 
These system formats control how FileMaker Pro enters and indexes 
data in these field types.

The internal default formats saved with a file may be different from the 
system formats currently set on your computer when:

1 you receive or share a file with different internal default formats

1 you changed the system formats on your computer after creating or 
cloning the file

For example, a file created on a U.S. system has different formats from 
a file created on a German system, as shown in the following example.

For this 
field type

A U.S. system format 
may look like this

A German system format 
may look like this

Number 1.23 
(Decimal separator is a period (.))

1,23 
(Decimal separator is a comma (,))

Date 12/31/98 31.12.1998

Time 2:15:58 PM 14:15:58
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Using the current system formats
When you open or work with a file with formats different from the 
current system formats, you can continue to use the formats saved with 
the file, or you can use the current system formats. (When you use the 
current system formats, you don’t change the formats saved with the 
file—you simply enter and view data in a format that’s familiar to you.) 

1 When you open a file with different internal default formats, 
FileMaker Pro displays a message alerting you to the situation. To 
use the current system formats, click Yes. To use the formats saved 
with the file, click No. 

1 As you work with a file with different internal default formats, you 
can use the current system formats by choosing Use System Formats 
from the Format menu. You see this command only when the current 
file was saved with internal default formats different from the current 
system formats. 

Keep these points in mind:

1 You see the alert message only if the setting of Use System Formats 
when the file is closed is different from the setting when the file 
was open.

1 To change the formats saved with a file, you must change the system 
formats, and then clone the file. You can then change the system 
formats to their original settings. (For information about cloning a 
file, see “Saving a copy of a file” on page 1-11.)
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1 Using system formats doesn’t affect the formatting of dates, numbers, 
and times that you set in FileMaker Pro for displaying data in fields. 
However, you must enter data precisely according to the system 
format. For example, when date parts in a system format are in order as 
year, month, and day, separated by a period (.), you must enter dates in 
that format, as in 98.12.31. (For information about display formats 
for fields, see “Defining display formats for fields” on page 3-59.)

Defining scripts for system formats
You can have FileMaker Pro open a file using the current system 
formats by including the Set Use System Formats script step in a startup 
script. In the Script Definition dialog box, choose the Set Use System 
Formats script step, and then select On to use the current system formats. 
(To use the formats saved with the file, select Off.)

For more information about defining scripts, see chapter 5, “Using 
ScriptMaker and buttons.”

Choose FileMaker Help Index from the  or Help menu, and then type:

E system formats

Choose FileMaker Help Index from the  or Help menu, and then type:

E system formats



Appendix C:  Summary of functions

A function is a predefined, named formula that performs a specific 
calculation and returns a single, specific value. You use functions when 
you are defining calculation fields. You can use functions by themselves 
or combine them with other functions or expressions.

This appendix summarizes the FileMaker Pro functions by category. For 
detailed information about functions, see FileMaker Pro Help.

Important In the United States, commas act as list separators in 
functions, formulas, and calculations. In other countries, semicolons 
might be used as list separators. The separator being used depends on the 
operating system your computer uses, as well as the one used when the 
file was created.

Important Before you read this appendix, be sure you understand 
formulas and how to define calculations, as explained in “Understanding 
formulas” on page 2-13. In addition, be sure you know how to use 
FileMaker Pro Help, as explained in the preface, “Getting help.”

Understanding functions
With a few exceptions, all FileMaker Pro functions use the following 
syntax:

Function name(parameter)

This part Represents

Function name The calculation to perform

parameter The value or expression on which the calculation is performed. Most 
functions require one or more parameters. A parameter can be a 
constant, a field name, or another function.

( ) The beginning and end of the parameter
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Here are some examples of functions:

Some functions require two or more parameters, as in this example:

Position(LastName,"Mc",1, 1)

You can nest one function within another to perform more powerful 
calculations on your data, as in this example:

Left(Name,Position(Name," ",1, 1))

The result of a function can be used as a constant. The following 
example shows how FileMaker Pro evaluates a complex formula by 
simplifying each function into a constant. In the example, the Right 
function returns every character of text that is to the right of the first 
space in the Name field. (This example shows how Right returns the last 
name of a field that contains a first name and last name, when the value 
doesn’t include a title like Dr. or middle initials.)

This function Returns

Length("John") 4 (the number of characters in the text "John")

Round(SalesTax,2) The amount of sales tax rounded to two decimal places

Position(Name,"Mc",1,1) The position of the first occurrence of "Mc" in the Name 
field

Contents of Name

Formula walk-through
Indicate a space in 
your calculation 
by typing quote, 
space, quote
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Keep these points in mind:

1 The following sections summarize FileMaker Pro functions. Values 
in quotation marks ("") are text values. To include a space in a text 
expression, type a quote, then a space, then a quote (" "). For 
complete information about each function, including examples, see 
FileMaker Pro Help. 

1 A function can return the following data types: text, number, date, 
time, or container. However, you determine the data type of the 
calculated field when you define its calculation.

Text functions
The parameter text can be a text expression (in quotes) or a field name.

Choose FileMaker Help Index from the  or Help menu, and then type:

E functions, using

Syntax Definition

Exact (original text, comparison 
text)

Exact (original container, 
comparison container)

Compares original text and comparison text for exact 
match, including case when comparing text. Returns "1" 
for a match, "0" for no match.

Compares original container and comparison container 
for exact match. Returns "1" for a match, "0" for no 
match.

Left (text, number) Returns the specified number of characters in text, 
counting from the left

LeftWords (text, number of 
words)

Returns the specified number of words in text, counting 
from the left

Length (text) Returns number of characters in text

Lower (text) Converts text to lowercase

Middle (text, start, size) Returns characters in text, counting from the position of 
start, through the number of characters in size

MiddleWords (text, starting 
word, number of words)

Returns the middle words in text, beginning with the 
number of the starting word and continuing through the 
number of words

PatternCount (text, search string) Returns the number of occurrences of search string in 
text

Position (text, search string, 
start, occurrence)

Returns the position of the specified occurrence of 
search string in text, from start; otherwise returns 0. 
Position is case insensitive.
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Number functions

Proper (text) Converts the first letter in each word of text to uppercase 
and the remainder to lowercase

Replace (text, start, size, 
replacement text)

Replaces characters in text with replacement text, from 
the position of start and containing the number of 
characters in size

Right (text, number) Returns the specified number of characters in text, 
counting from the right

RightWords (text, number of 
words)

Returns the specified number of words in text, counting 
from the right

Substitute (text, search string, 
replace string)

In text, substitutes each occurrence of search string with 
replace string. Substitute is case sensitive.

TextToDate (text) Converts text to a date. Type text in the format MM/DD/
YYYY.

TextToNum (text) Converts text to a number

TextToTime (text) Converts text to a time. Type text in the format 
HH:MM:SS, with or without seconds and AM or PM.

Trim (text) Returns text without leading and trailing spaces

Upper (text) Converts text to uppercase

WordCount (text) Returns the number of words in text

Choose FileMaker Help Index from the  or Help menu, and then type:

E text functions

Syntax Definition

Abs (number) Returns the absolute value of number

Exp (number) Returns the value of e raised to the power of number

Int (number) Returns the integer (whole) portion of number

Mod (number, divisor) Returns the remainder after number is divided by 
divisor

NumToText (number) Converts number to text

Random For each record, returns a random number between 0.0 
and 1.0

Syntax Definition
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Date functions

Round (number, precision) Returns number rounded to the number of decimal 
places in precision. When precision is negative, all 
digits right of the decimal separator are dropped and 
number is rounded to the nearest ten for a precision
of –1, the nearest hundred for –2, and so on.

Sign (number) Returns –1 when number is negative; returns 0 when 
number is zero; returns 1 when number is positive.

Sqrt (number) Returns the square root of number

Truncate (number, precision) Returns number truncated to the number of decimal 
places in precision

Choose FileMaker Help Index from the  or Help menu, and then type:

E number functions

Syntax Definition

Date (month, day, year) Returns the calendar date of month, day, year (in digits), 
from January 1, 0001, in the date field format you’ve set 
in your computer system software. Year must be four 
digits.

DateToText (date) Converts date to text 

Day (date) Returns a number representing the day portion of date

DayName (date) Returns the weekday name of date

DayofWeek (date) Returns the weekday position of date, from Sunday (1) 
through Saturday (7)

DayofYear (date) Returns the number of days elapsed since January 1 of 
the year in date

Month (date) Returns a number representing the month portion of 
date

MonthName (date) Returns the month name based on the date provided

Today Returns the current date

WeekofYear (date) Returns the number of weeks elapsed since January 1 of 
the year in date, counting fractions of weeks as whole 
weeks

Syntax Definition
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Time functions

Aggregate functions

WeekofYearFiscal 
(date, starting day)

Returns the number of weeks elapsed since the first 
week of the year of date, using starting day (a number 
from 1-7, where 1 is Sunday) as the first day of the 
week. The first week of the year is a week that contains 
four or more days of that year.

Year (date) Returns a number representing the year portion of date

Choose FileMaker Help Index from the  or Help menu, and then type:

E date functions

Syntax Definition

Hour (time) Returns the hour portion of time

Minute (time) Returns the minutes portion of time

Seconds (time) Returns the seconds portion of time

Time (hours, minutes, seconds) Returns hours, minutes, seconds (as digits) as a time, in 
the current time field format

TimeToText (time) Converts time to text

Choose FileMaker Help Index from the  or Help menu, and then type:

E time functions

Syntax Definition

Average (field)
Average (relationship::field)

Average (field1, field2,...)
Average (relationship::field1, 
relationship::field2...)

Returns the average of nonblank values in a single 
repeating field (field) or (relationship::field)

Returns the average of nonblank values in each 
corresponding repetition of one or more repeating or 
non-repeating fields (field1, field2,...) or 
(relationship::field1, relationship::field2...)

Count (field)
Count (relationship::field)

Count (field1, field2,...)
Count (relationship::field1, 
relationship::field2...)

Returns the number of nonblank values in a repeating 
field (field) or (relationship::field)

Returns the number of nonblank values in each 
corresponding repetition of one or more repeating or 
non-repeating fields (field1, field2,...) or 
(relationship::field1, relationship::field2...)

Syntax Definition
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When you use aggregate functions, keep these points in mind:

1 You can specify fields in the current database (field) or in a related 
database (relationship::field).

1 If you specify a single parameter (field) or (relationship::field), it 
must be either a related field, or a repeating field. If you specify 
multiple parameters (field1, field2,...) or (relationship::field1, 
relationship::field2), they can be field references, a constant, or any 
valid expression. If you specify related fields, you can name a 
different relationship for each related field if you want 
(relationship1::field 1, relationship2::field 2...)

Max (field)
Max (relationship::field)

Max (field1, field2,...)
Max (relationship::field1, 
relationship::field2...)

Returns the highest nonblank value in a repeating field 
(field) or (relationship::field)

Returns the highest nonblank value in each 
corresponding repetition of one or more repeating or 
non-repeating fields (field1, field2,...) or 
(relationship::field1, relationship::field2...)

Min (field)
Min (relationship::field)

Min (field1, field2,...)
Min (relationship::field1, 
relationship::field2...)

Returns the lowest nonblank value in a repeating field 
(field) or (relationship::field)

Returns the lowest nonblank value in each 
corresponding repetition of one or more repeating or 
non-repeating fields (field1, field2,...) or 
(relationship::field1, relationship::field2...)

StDev (field)
StDev (relationship::field)

StDev (field1, field2,...)
StDev (relationship::field1, 
relationship::field2...)

Returns the standard deviation of the sample 
represented by a series of nonblank values in a repeating 
field (field) or (relationship::field)

Returns the standard deviation of the sample 
represented by a series of nonblank values in each 
corresponding repetition of one or more repeating or 
non-repeating fields (field1, field2,...) or 
(relationship::field1, relationship::field2...)

StDevP (field)
StDevP (relationship::field)

StDevP (field1, field2,...)
StDevP (relationship::field1, 
relationship::field2...)

Returns the standard deviation of a population 
represented by a series of nonblank values in a repeating 
field (field) or (relationship::field)

Returns the standard deviation of a population 
represented by a series of nonblank values in each 
corresponding repetition of one or more repeating or 
non-repeating fields (field1, field2,...) or 
(relationship::field1, relationship::field2...)

Sum (field)
Sum (relationship::field)

Sum (field1, field2,...)
Sum (relationship::field1, 
relationship::field2...)

Returns the sum of nonblank values in a single repeating 
field (field) or (relationship::field)

Returns the sum of nonblank values in each 
corresponding repetition of one or more repeating or 
non-repeating fields (field1, field2,...) or 
(relationship::field1, relationship::field2...)

Syntax Definition
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1 The parameters field1, field2,... can include a numeric constant (for 
example, 10). A constant in a formula for a repeating field affects the 
result for every repetition.

1 When field1, field2,... includes a nonrepeating field, that value is used 
in the result for only the first repetition unless you use the Extend 
function. For information about the Extend function, see “Repeating 
functions” on page C-12.

1 Empty (null) values are ignored.

1 If you specify a single parameter (field) or (relationship::field), the 
result includes all nonblank values in all repetitions. When the 
calculation is also repeating, the result is returned in the first 
repetition.

1 When field1, field2,... are repeating and the calculation result is not 
repeating, only the values from the first repetition of the repeating 
fields are used to calculate the result. If the calculation result field is 
also repeating, FileMaker Pro uses the corresponding repetitions of 
the fields to calculate the result.

1 Values in repetitions that exceed the number of repetitions in the 
calculated field are ignored. For example, a calculated field with three 
repetitions holds only three results, even when one field in the 
calculation has five repetitions.

The following examples show how aggregate functions produce results 
based on the number of parameters and whether the calculations involve 
repeating or nonrepeating fields.
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Summary functions
Use a summary function with summary fields.

When a database file is sorted, you can place a summary field in a 
subsummary part to get subtotal values. (See “Adding a summary part” 
on page 3-31.) Because sorting has the effect of grouping similar values, 
the field you sort by is called a break field. FileMaker Pro calculates a 
subtotal for each group of records with a common value in the break 
field, letting you “break out” that range from the rest of the database.

Choose FileMaker Help Index from the  or Help menu, and then type:

E aggregate (statistical) functions

Syntax Definition

GetSummary (summary field, 
break field)

GetSummary (summary field, 
summary field)

Returns the value of summary field for the current 
range of records when records are sorted by break 
field; otherwise, returns an empty result. This is 
equivalent to calculating a subsummary.

Returns the value of summary field for the current 
found set of records. This is equivalent to calculating 
a grand summary.

A calculation using GetSummary is unstored.

Example 1
Single input parameter

Example 2
Single input parameter

Repeating Field Sum(Repeating Field) Sum(Repeating Field)

1
2
3
4

10 10

Field Sum(Field) Sum(Field)

5 5 5

Field1 Field2 Field3 Sum(Field1, Field2, Field3)

1
2
3
4

15
2
6

4

3

10
Example 3
Multiple input parameters
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The GetSummary function has the effect of a summary field in a 
subsummary or grand summary part, performed from within a 
calculation. To calculate a subsummary value, you must sort by the 
break field to get appropriate results in a GetSummary function. 

Use GetSummary to:

1 create subsummary or grand summary values without using 
subsummary or grand summary parts on a layout—you can see the 
resulting values in the body part 

1 perform mathematical calculations on a summary field

The following examples show the result of the GetSummary function. In 
the first example, the file is sorted by the Department field first, and then 
by the Last Name field. Department Subtotal is a calculation field:

GetSummary(Total Number, Department)

Break field
Summary field for subsummary

Summary field for grand 
summary

Summary field for subsummary
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In the second example, the file is sorted by the Last Name field first, and 
then by the Department field. Employee Subtotal is a calculation field:

GetSummary(Total Number, Last Name)

  

Choose FileMaker Help Index from the  or Help menu, and then type:

E summary functions

Total number of employees 
in Direct Sales

Total number of 
employees in Finance

This column displays the 
Department Subtotal field

Total number of employees 
named Chen
Total number of employees named 
Danon

This column displays the 
Employee Subtotal field
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Repeating functions
Use repeating functions with repeating fields.

This example shows how the Extend function ensures accurate results 
when used in calculations involving nonrepeating fields.

Syntax Definition

Extend (nonrepeating field) Allows the value of non-repeating field to be 
used in a calculation involving repeating fields. 
(See the following example.)

GetRepetition (repeating field, number) Returns the contents of the repetition number of 
repeating field 

Last (repeating field) Returns the last valid, nonblank value in 
repeating field

Choose FileMaker Help Index from the  or Help menu, and then type:

E repeating functions

Without Extend, a calculation 
includes a nonrepeating value in the 
result for only the first repetition of 
the calculated field

Using Extend, a calculation includes 
a nonrepeating value in the result for 
all repetitions of the calculated field
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Financial functions

Keep these points in mind:

1 Term is expressed in months

1 Interest rate is a value from 0.0 to 1.0, divided by 12 (months).

Trigonometric functions

Syntax Definition

FV (payment, interest rate, periods) Returns the future value of an investment based on 
interest rate and payment for periods

NPV (payment, interest rate) Returns net present value of a series of unequal 
payments (in a repeating field) made at regular 
intervals using a fixed interest rate (in a number 
field) per interval. (When payments contains equal 
values, use the PV function.)

PMT (principal, interest rate, term) Returns the payment needed to meet the 
requirements of principal, interest rate, term

PV (payment, interest rate, periods) Returns the present value of equal payments made 
at regular periods, assuming a fixed interest rate 
per payment

Choose FileMaker Help Index from the  or Help menu, and then type:

E financial functions

Syntax Definition

Atan (number) Returns the trigonometric arc (inverse) tangent of 
number. The arc tangent is the angle, in radians, 
whose tangent equals number.

Cos (number) Returns the cosine of the angle (in radians) of 
number

Degrees (number) Converts number from radians to degrees
(π/180 radians)

Ln (number) Returns the base-e (natural) logarithm of number

Log (number) Returns the common logarithm (base 10) of number, 
which is any positive value

PI Returns the value of pi (π), approximately 3.14159
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Logical functions

Radians (number) Converts degrees (π/180 radians) in number to 
radians. Parameters for trigonometric functions 
must be in radians—use this function to convert 
values from degrees to radians within a formula.

Sin (number) Returns the sine of an angle expressed in radians

Tan (number) Returns the tangent of the angle (in radians) in 
number. Tangents for values of 90 degrees (π/2 
radians) or multiples are undefined (infinite).

Choose FileMaker Help Index from the  or Help menu, and then type:

E trigonometric functions

Syntax Definition

Case (test1, result1 [, test2, result2, 
default result]...)

Evaluates test1 to produce a result. When test1 is 
true (a nonzero value), returns result1; when test2 is 
true, returns result 2, and so on. When no test is true, 
returns an empty (null) value, or the default result 
you supply.

Choose (test, result0 [, result1, 
result2]...)

Evaluates test to produce an index number used to 
choose a result. When index is 0, returns result0; 
when index is 1, returns result1, and so on. When 
there’s no corresponding result, returns an empty 
(null) result.

If (test, result one, result two) Evaluates test to return a true or false result. When 
test is true (1), returns result one; when test is false 
(0), returns result two. Test must return either a 
numeric or Boolean result. (See the example below.)

IsEmpty (field) Returns true (1) when field is empty (null); 
otherwise returns false (0)

IsValid (field) Returns false (0) when field is missing from the file 
or when field contains an invalid value; otherwise 
returns true (1). For example, if a field in a related 
file is deleted, references to that field in the master 
file are invalid. See chapter 10, “Using data from 
related files.”

Syntax Definition
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The following example shows how the If function returns a different 
result based on a true or false condition.

Choose FileMaker Help Index from the  or Help menu, and then type:

E logical functions

SYNTAX:

If (Test,ResultIfTrue,ResultIfFalse)

BASIC EXAMPLE (Not Nested):

If(Signal="Green",Go,Stop)

When test is True When test is False

If(Signal="Green",Go,Stop) If(Signal="Green",Go,Stop)

ADVANCED EXAMPLE (Nested If’s):

If (Signal="Green",Go, If(Signal="Yellow",Slow down,Stop))

When first test is True

If (Signal="Green",Go, If(Signal="Yellow",Slow down,Stop))

When first test is False

If (Signal="Green",Go, If(Signal="Yellow",Slow down,Stop))

When second test is True

If (Signal="Green",Go, If(Signal="Yellow",Slow down,Stop))

When second test is False

If (Signal="Green",Go, If(Signal="Yellow",Slow down,Stop))
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Status functions
You can use status functions in ScriptMaker scripts to monitor the state 
of your database. When creating a calculation using a status function, 
choose Status functions from the pop-up menu above the function list, 
then double click the status function you want from the function list. For 
examples of scripts that use status functions, see “Displaying 
customized layouts” on page 5-32 and FileMaker Pro Help.

Syntax Definition

Status (CurrentAppVersion) Returns the FileMaker Pro version currently in use 

Status (CurrentDate) Returns the current date

Status (CurrentError) Returns a number for the current error value. Use 
Status (CurrentError) to check error results when 
FileMaker Pro performs a script. (See “Control 
steps” on page 5-5.)

Status (CurrentFieldName) Returns the name of the current field

Status (CurrentFileName) Returns the name of the current file

Status (CurrentFileSize) Returns the size (in bytes) of the current file

Status (CurrentFoundCount) Returns the number of records in the current 
found set

Status (CurrentGroup) Returns the group (or groups) that the current user 
is a member of, based on the current password

Status (CurrentHostName) Returns the host name FileMaker Pro registers on 
the network

Status (CurrentLanguage) Returns the current language set on the 
current system

Status (CurrentLayoutCount) Returns the number of layouts in the database

Status (CurrentLayoutName) Returns the name of the current layout

Status (CurrentLayoutNumber) Returns the number of the current layout

Status (CurrentMessageChoice) Returns a number corresponding to the button 
clicked in an alert message displayed using the 
Show Message step in a script. Returns 1 for OK, 2 
for Cancel, and 3 for the third defined button. (See 
“Open Menu Item steps” on page 5-10.)

Status (CurrentMode) Returns a number for the FileMaker Pro mode in 
use when the calculation is performed. Returns 0 
for Browse mode, 1 for Find mode, or 2 for 
Preview mode.
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Status (CurrentModifierKeys) Returns a number representing which keyboard 
modifier keys (for example, Shift) are being pressed 
by the user). For more information, see 
FileMaker Pro Help.

Status (CurrentMultiUserStatus) Returns 0 for a single user file, 1 for a multiuser file 
and the computer is the host, or 2 for a multiuser file 
and the computer is a guest

Status (CurrentNetworkChoice) Returns the name of the network protocol

Status (CurrentPageNumber) Returns the page number currently printing or being 
previewed. When no page is printing or being 
previewed, returns 0.

Status (CurrentPlatform) Returns a number for the platform currently in use. 
Returns 1 for Mac OS, 2 for Windows.

Status (CurrentPortalRow) Returns the number of the current row in a selected 
portal. When no portal is selected, returns 0.

Status (CurrentPrinterName) Returns the identification of the current printer

Status (CurrentRecordCount) Returns the number of records in a file

Status (CurrentRecordID) Returns the unique ID of the current record. (For 
more information, see FileMaker Pro Help.)

Status (CurrentRecordNumber) Returns the number of the current record in the 
found set

Status (CurrentRepetitionNumber) Returns the current repetition number (counting the 
first repetition as 1) of the current repeating field. 
When the current field is nonrepeating, returns 1.

Status (CurrentRequestCount) Returns the number of find requests defined in the 
database

Status (CurrentScreenDepth) Returns the number of bits needed to represent the 
color of a pixel on the main computer screen

Status (CurrentScreenHeight) Returns the number of pixels displayed vertically 
on the screen on which the current file is open. 
When the window spans more than one screen, uses 
the screen that contains the largest percentage of the 
FileMaker Pro window.

Status (CurrentScreenWidth) Returns the number of pixels displayed horizontally 
on the screen on which the current file is open. 
When the window spans more than one screen, uses 
the screen that contains the largest percentage of the 
FileMaker Pro window.

Status (CurrentScriptName) Returns the name of the script currently running or 
paused

Status (CurrentSortStatus) Returns a number representing the current sort 
status. Returns 0 for unsorted, 1 for sorted, or 2 for 
semisorted.

Syntax Definition
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Design functions
Design functions return information about the structure of any specified 
database that is currently open on your computer. For example, you could 
determine the names of all the layouts or fields in an open database.

Note  If you enclose the field name parameter in quotes (""), the design 
function returns information about the field itself. If you do not enclose 
the field name parameter in quotes, the design function returns 
information based on the entry in the field.

Status (CurrentSystemVersion) Returns the system version currently in use

Status (CurrentTime) Returns the current time

Status (CurrentUserCount) Returns the number of users accessing the file. 
Returns 1 for a single user, or 1 plus the number of 
guests for multiple users using FileMaker Pro 
networking. (Web users are not counted.)

Status (CurrentUserName) Returns the identification of the current 
FileMaker Pro user, as specified by the general 
preference

Choose FileMaker Help Index from the  or Help menu, and then type:

E status functions

Syntax Definition

FieldRepetitions (database name, 
layout name, field name)

Returns the number of repetitions of a specified 
repeating field

FieldNames (database name, 
layout name)

Returns the names of fields in the database and 
layout you specify. You can also type two quotes 
("") in place of a layout name to return the names of 
all fields in the specified database.

FieldBounds (database name, layout 
name, field name)

Returns the location and size of a specified field

FieldStyle (database name, layout 
name, field name)

Returns how a specified field is formatted on a 
layout (for example, radio button), and whether a 
value list is associated with the field

FieldType (database name, field 
name)

Returns the field definition for a specified field

LayoutNames (database name) Returns the names of layouts in a specified 
database file

DatabaseNames Returns the names of the currently opened databases

Syntax Definition
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FileMaker Pro Web Companion external functions
FileMaker Pro Web Companion and other FileMaker Pro plug-ins can 
add new functions to the standard functions that are available in 
FileMaker Pro. Functions added by FileMaker Pro plug-ins are called 
external functions.

You use special syntax with external functions:

External ("function name", parameter)

where function name is in quotes and is the name of an external 
function supported by an installed and configured plug-in. The 
parameter is required, even if it is only 0.

Note The following functions are only available if FileMaker Pro plug-
ins, such as the FileMaker Pro Web Companion, are installed on your 
computer (see the FileMaker Pro Installation and New Features Guide 
for more information on Web Companion installation). If there are no 
FileMaker Pro plug-ins installed, or the ones installed do not support 
external functions, you see only the generic external function definition 
in the Specify Calculation dialog box:

External (name, parameter)

RelationInfo (database name, 
relationship name)

Returns the name of the related file for a specified 
relationship

RelationNames (database name) Returns the relationships defined in a specified 
database file

ScriptNames (database name) Returns the scripts defined in a specified 
database file

ValueListItems (database name, 
value list name)

Returns the values defined for a specified value list

ValueListNames (database name) Returns the value lists defined in a specified 
database file

Syntax Definition

External ("Web-Version", 0) Returns the version of FileMaker Pro Web 
Companion that loads when you open 
FileMaker Pro

Syntax Definition
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External ("Web-ClientAddress", 0) Returns the domain name (for example, 
www.claris.com) of a Web user whose HTTP 
request is currently being processed by 
FileMaker Pro Web Companion. Returns the Web 
user’s IP address if the domain name is not available.

External ("Web-ClientIP", 0) Returns the IP (Internet protocol) address of the 
Web user whose HTTP request is currently being 
processed by FileMaker Pro Web Companion

External ("Web-ClientName", 0) Returns the value that the Web user types for user 
name in the Web browser password dialog box

External ("Web-ClientType", 0) Returns the name and version of the Web browser 
being used by the Web user

External ("Web-ToHTML", field 
name)
External ("Web-ToHTML", text value)

Returns the contents of the specified field or of the 
text value encoded in HTML

External ("Web-ToHTTP", field name)
External ("Web-ToHTTP", text value)

Returns the contents of the specified field or of the 
text value encoded in HTTP

Syntax Definition



I-1
Index

Symbols

! 4-20
- 2-3
– 2-17
" 2-3
" " 2-19, C-3
"" 2-15, 2-19, 4-20, 4-23, C-3
## 3-83
& 2-3, 2-19
( 2-3
) 2-3
* 2-3, 2-17, 4-20, 4-23
+ 2-3, 2-17
, 2-3
... 4-20
/ 2-3, 2-17
// 3-65, 3-83, 4-20, 4-24
: 2-3
:: 2-3, 3-66, 3-83
< 2-3, 2-17, 4-20
= 2-3, 2-17, 4-20, 4-23
== 4-20
> 2-3, 2-17, 4-20
? 4-20
@ 4-20, 4-23
@@ 3-83
^ 2-3, 2-17
_ 7-3, 11-24
|| 3-83
¶ 2-19
≠ 2-3, 2-17
≤ 2-3, 2-18, 4-20
≥ 2-3, 2-18

A
Access privileges

See also Networks
associating passwords with 
groups 7-15, 7-17
changing 7-15, 7-19
described 1-6, 7-9
examples 7-10, 7-16
fields 7-9, 7-18
groups 7-9, 7-15, 7-17
layouts 7-9, 7-16, 7-18
passwords 7-9, 7-13, 7-17
record locking 7-6
related files

planning 10-19
working with 10-10, 10-30

selecting 7-12, 7-17
Web 7-4, 11-6, 11-10, 11-18 to 
11-22

Access rights. See Access privileges
Accounts. See Access privileges
Actions. See Scripts
Adding

See also Defining
comments to scripts 5-11
dictionary terms 1-18
fields 2-3
graphics to layouts 3-54
layout parts 3-27
merge fields 3-58
objects to layouts 3-29
records 4-4
related records 10-23
repeating fields 3-72
Script menu items 5-14, 5-16
scroll bars to fields 3-71
text 3-80

Aggregate functions C-6
Aligning

objects 3-48
tabs 3-86
text 3-85, 3-88

AND operator 2-18
Apple events

described 5-23
examples 5-24, 5-37
exchanging files 5-23
receiving 5-23
scripts 5-23, 5-25, 5-28
sending 5-23, 5-25
supported suites 5-23

AppleScript commands 5-24, 5-28, 
5-37

Application preferences 9-1 to 9-7
Associating files. See OLE objects; 
Relational databases

Attaching files. See Relational 
databases; OLE objects

Attributes
fill 3-51, 3-52
paragraph 3-87
pen 3-51
tab 3-86
text 3-60, 3-90, 8-4

Authorized users. See Access 
privileges

Auto Enter 2-6
on the Web 2-9

AutoGrid
described 3-40
reshaping objects to 3-51
setting units 3-42
turning on/off 3-41

Automatic phone dialing 9-4
Automating tasks. See Scripts
Average for summary fields 2-23

B
Background color 3-51
Balloon Help XII, XVII
Baselines, field borders 3-73
BASIC format 8-3
Batteries, preferences for saving 9-4
Blank

layout 3-7
passwords 7-12
records, printing 6-1, 6-12

Blank spaces, closing up. See Sliding 
objects

Body 3-25
Book icon

Browse mode 4-2, 4-18
Find mode 4-21
Layout mode 3-4
Preview mode 6-12
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Boolean expressions 2-17
Boolean numbers

finding 4-24
formatting 3-62

Borders 3-53
button 3-43
field 3-73

Boundaries
field 3-43
text 3-43

Break fields 3-31
Browse mode 1-7
Browser, Web

home page 11-23
opening URL 4-17, 5-11, 11-23
protecting files 11-6
setting up views for 11-12 to 
11-18

starting 5-11
viewing databases in 11-15 to 
11-18

Browsing records
access privileges 7-13
described 4-1
groups of 4-1
in a list 4-16
individually 4-16
on Web 11-15 to 11-18
sorted 4-30

Built-in home page 11-6, 11-9, 11-23
hiding databases on 11-24

Buttons
borders 3-43
changing 5-23
copying 5-23
creating 5-21
defining 5-21, 9-3
deleting 5-23
described 5-20
examples 5-29, 5-31
non-printing 6-9
performing scripts 5-19, 5-20
shapes 9-3
showing 5-20

Buttons, radio. See Radio buttons

C
Calculation fields

See also Calculations; Formulas
changing 2-25

defining 2-20
described 2-5
formulas 2-13, 2-20
functions C-1
importing 8-4
moving to 4-3
stored results 2-20
unstored results 2-20

Calculations
See also Calculation fields
formatting 3-62
functions C-1
importing 8-4
related fields 10-31

Canceling, scripts 5-19
CDML Reference 11-25
CDML tags 11-2
CDML Tool 11-27
CGI applications 11-3
Changing

See also Editing
access privileges 7-15
calculation fields 2-25
dictionary terms 1-18
field definitions 2-25
field values 4-14
formulas 2-25
layout parts 3-35, 3-36
layouts 3-4, 3-23
passwords 7-15
portals 10-27
preferences 9-1
related fields 10-27
relationships 10-29
scripts 5-16
serial numbers 4-14
stacking order 3-46
units 3-85
value lists 4-9

Character sets, cross-platform 8-2
Characters, deleting 4-5
Charts, with FileMaker Pro data 8-1
Checkboxes

See also Value lists
choosing from 4-9
displaying field values 3-75
editing 4-9
tab order 3-70

Claris Dynamic Markup Language. 
See CDML tags

Claris Home Page 11-25
ClarisImpact

See also Exporting; Importing
file formats 8-3

ClarisWorks
See also Importing
file formats 8-3

Clients. See Guests
Clones 1-11
Closing FileMaker Pro 1-13, 7-8
Closing files 1-11, 7-8
Coffee cup icon 7-6
Color

fill 3-51
palette 3-51
pen 3-51
text 3-88

Columnar report layout
See also Extended columnar 
layout; Layouts

described 3-9
setting number of columns 3-20

Columns
page breaks 3-33
previewing 3-22
printing 6-10
resizing 6-5
setup 3-21

Commands. See Script steps
Comma-Separated Text format 8-3
Comments, in scripts 5-11
Comparison operators 2-17
Compressed copies of files 1-11
Confidential information. See Access 
privileges

Connecting files. See OLE objects; 
Relational databases

Constants 2-15
Container fields

See also Fields
deleting 4-8
described 2-5, 4-6
exporting 8-9
formatting 3-67
importing 8-4
searching by 4-22
sorting by 4-31

Context menu 3-42
Converting files 1-11
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Copying
buttons 5-23
field definitions 8-2
fields

between fields 4-12, 8-4
between files 3-57, 8-2
from previous record 4-12

files 1-11
found set 4-29
graphics and sounds 4-13
layouts 3-23, 8-2
non-standard fields 4-13
objects 3-45
OLE objects 7-7
records 4-4, 4-12
related records 10-31
scripts 5-16
text attributes 8-4
text using drag and drop 9-2
value lists 3-76
values 4-12
versus importing or exporting 8-2

Count for summary fields 2-23
Cover page for report 3-29
Creating. See Adding; Defining
Cross-platform

considerations 7-2
exporting 8-2
file sharing 7-1
importing 8-2

Currency, exporting formats 8-11
Current

date
formatting 3-65
pasting into fields 4-11

field 4-3
record 4-2
system formats B-2
time, pasting into fields 4-11
user name

in scripts 4-12
pasting into fields 4-11

Current file. See Files; Master file
Custom

field values 3-76
labels 3-16
line spacing 3-88
order, sort by value list 4-30

Custom Web pages
CDML tags 11-25
Claris Home Page Assistant 11-25

Custom Web Publishing

See also Instant Web Publishing, 
Web Companion 11-1

described 11-2
Customer support XI
Customizing FileMaker Pro. See 
Preferences

Cutting
layout text 3-82
objects 3-45

D
Data

described 1-1
entering automatically 2-7
from other files 10-1
relationships 1-2

Data entry
access privileges 7-13
exporting 8-1
importing 8-1
tab order 3-69

Database files. See Files
Database locks. See Access privileges
Database system 1-1
Databases

See also Files; Relational databases
described 1-1
planning 2-1
publishing on Web 11-1
single file 1-6

Databases, relational. See Relational 
databases

Date
See also Dates; Fields
fields 2-5
finding today’s 4-24
functions C-5
symbol, formatting 3-65

Date fields
See also Dates
described 2-5
formatting 3-64
typing values in 4-4

Dates
See also Date; Date fields
current

formatting 3-65
pasting into fields 4-11

entering data 4-4
finding 4-24

invalid 4-20
typing in 4-4

dBASE, exchanging data 8-3
DBF format 8-3, 8-14
Decimal tabs 3-86
Default

formats 3-60
passwords 9-8

Defining
See also Adding
calculation fields 2-20
fields 2-3
global fields 2-9
lookups 10-3
merge fields 3-58
passwords 7-11
portals 10-20
related records 10-32
relational databases 10-20
relationships 10-9
repeating fields 2-11
scripts 5-12
summary fields 2-23
value lists 3-75

Deleting
buttons 5-23
characters 4-5
dictionary terms 1-18
duplicate records 4-20
fields 1-12, 2-25, 3-59, 7-16
find requests 4-26
graphics 4-8
groups 7-19
imported records 8-8, 8-9
layout parts 3-36
layouts 3-23
master records 10-23, 10-34
movies 4-8
objects 3-45
passwords 7-15
records 4-29
related fields 10-28
related records 10-23, 10-34
Script menu items 5-16
script steps 5-16
scripts 5-18
sounds 4-8
text 3-82
value lists 3-76

Delimiters. See File formats
Design functions C-18
Designing databases
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planning 2-1
relational 10-15

Detail databases. See Related files
Detail tables. See Related files
Dialing phone numbers

procedures 9-4
script steps 5-11

Dictionaries
See also Spelling
adding words 1-14, 1-18
changing words 1-18
deleting words 1-18
described 1-13
editing 1-17
installing 1-16
main 1-13
options 1-17
selecting 1-16
user

adding words 1-14
described 1-13
exporting 1-18
importing 1-18
installing 1-16

DIF format 8-3
Display formats 3-60
Displays. See Layouts
Document preferences 9-7
Documentation

overview XVII
using with Help XI

Double arrow icon 7-6
Drag and drop

described 4-13
disabling 4-14
enabling for text 9-2
multiple objects 4-14
requirements 4-13
text 9-2

Dragging information 4-13
Duplicate records, finding with 
scripts 5-34

Duplicating. See Copying

E
Edit items 3-78
Editing

See also Changing
find requests 4-26

objects quickly 3-42
value lists 4-9

Edition File format 8-3
Edition Manager 8-3
Elements. See Objects
Email, sending 5-11
Embedded groups 3-47
Empty fields 4-20
Enabling plug-ins 9-7
Encryption. See Access privileges
Entering data

automatically 2-7
typing in fields 4-4

Entry options
always selected 3-68
changing 2-25
tab order 3-69

Envelope layout
See also Layouts
described 3-18
headers 3-20
using 3-18

Error messages, displaying in 
scripts 5-5

Errors, finding 4-19
Excel format 8-3
Exchanging files

See also Exporting; Files; 
Importing

Apple events 5-23, 5-37
AppleScript commands 5-37
cross-platform considerations 8-2
exporting 8-1, 8-9
importing 8-1, 8-4
lookups 10-1, 10-3
relational databases 10-1
remote data 8-10
sharing files 7-1
with other applications 8-1

Exchanging information.  See 
Exchanging files

Exporting
See also Exchanging files
access privileges for 7-13
described 8-1, 8-9
dictionaries 1-18
field order 8-10
file formats 8-3
formatting 8-11
grand summaries 8-13

opening exported files 8-9
related records 10-32
repeating fields 8-14
requirements 8-4
shared files 8-2
summary fields 8-10, 8-12
versus copying and pasting 8-2

Expressions
Boolean 2-17
described 2-15

Extended columnar layout
See also Layouts
described 3-9
printing 6-10
setting number of columns 3-20

External files. See Exchanging files; 
Exporting

External functions C-19
External scripts 5-3

F
False. See also Boolean 
expressions 3-62

Field definitions
changing 2-25
described 1-4
duplicating 2-25
importing 8-2
printing 6-1, 6-12
related fields 10-30
reordering 2-25

Field labels, layout 3-56
Field references in formulas 2-16
Field rights. See Access privileges
Field types

changing 2-25
described 2-5

Field values
described 1-4
replacing 4-14

Fields
See also Calculation fields; 
Container fields; Date fields; 
Global fields; Match fields; 
Number fields; Related fields; 
Summary fields; Text; Time 
fields

access privileges 7-9, 7-16, 7-18
adding to current layout 9-3
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borders 3-73
boundaries, showing/hiding 3-43
changing

calculations 2-25
definitions 2-25
entry options 2-25
formulas 2-25
names 2-25
sort order of 4-30
types 2-25

copying
between fields 4-12
between files 3-57
from previous record 4-12

current 4-3
custom values 3-76
defining 2-3
definitions 1-4
deleting 1-12, 2-25, 3-59, 7-16
described 1-3, 1-4
displaying 3-1
duplicating definitions 2-25
Edit items 4-9
editing 2-25
empty, finding 4-20
entry options 2-6
formatting

as selected 3-68
sample data 3-57
scroll bars 3-71
text 3-60

identifying records 5-34
indexing 2-12
lookups

defining 10-3
updating 10-14

maximum text entry 4-4
merge 3-58
modifying in multiple 
records 4-14

moving between files 3-57
naming 2-3
opening URL from 4-17
options 2-4
Other items 4-9
pasting into 4-10, 4-11
patterns 3-73
planning 2-3
positioning 3-44
removing 1-12, 3-59
reordering definitions 2-25
repeating

adding 3-72

described 2-11
formatting 3-72
sliding 6-9
sorting 4-32
tab order 3-70

rotating 3-49
scroll bars 3-71
selecting 3-39, 3-68
stored results 2-20
tab order 3-69
types 2-5
typing in 4-4
unstored results 2-20
validation options 2-7
value lists 3-75
values 1-4
Web display 11-12, 11-21

Fields functions. See Aggregate 
functions

File formats
See also Files; Formats
BASIC 8-3
ClarisWorks 8-3
Comma-Separated text 8-3
DBF 8-3
described 8-3
DIF 8-3
Edition File 8-3
Excel 8-3
exporting 8-3
FileMaker Pro 8-3
graphics 4-6
HTML table 8-3
importing 8-3
list of 8-3
Merge 8-3
repeating fields 8-14
requirements 8-4
SYLK 8-3
Tab-Separated Text 8-3
WKS 8-3

File types. See File formats
FileMaker Pro

customer support XI
file format 8-3
registration XI

FileMaker Pro Web Companion. See 
Web Companion

FileMaker Pro Server 7-2, 7-4, 7-5
Files

See also Exchanging files; File 
formats; Related files

access privileges 7-9
as host 7-3
closing 1-11
converting 1-11
copying 1-11
creating 1-9, 8-9
described 1-1
exporting 8-9
importing 8-4
internal default formats B-1
international B-1
lookup 10-3
multiuser 7-3
opening

as host 7-3
overview 1-10

planning 2-1
protecting 7-9
recovering A-1
related 1-6, 10-1
saving 1-11
security 7-9
shared

access privileges 7-9
closing 7-8
described 7-1
guests 7-2, 7-4
host 7-2, 7-3
on remote volumes 7-3
on Web 7-3, 11-1, 11-6, 11-7
preferences 9-7
requirements 7-1
saving 7-6, 7-8
System 7 File Sharing 7-2

system formats B-1
templates

creating files 1-9
described 1-9
displaying 9-2

updating to current version 1-11
Files, external. See Exchanging files
Files, master. See Master file
Fill attributes

color 3-51
described 3-53
pattern 3-73
setting 3-51, 3-52

Financial functions C-13
Find criteria 4-19
Find mode 1-7
Find requests

See also Finding
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defining 4-19
deleting 4-26
described 4-19
editing 4-25, 4-26
mixing find and omit 4-27
multiple 4-25
operators in 4-20
order of 4-27
repeating 4-25, 4-26
reverting 4-21
summary fields in 4-20

Finding
See also Find requests
all records 4-25
Boolean numbers 4-24
dates 4-24
described 4-19
duplicate records 5-34
duplicate values 4-20
empty fields 4-20
errors 4-19
exact values 4-20, 4-21
graphics 4-22
invalid dates and times 4-20
numbers 4-24
operators 4-20
order of requests 4-27
ranges 4-20
records 4-19
records using related fields 10-34
text 4-23
times 4-24
today’s date 4-24

Flat-file databases 1-6
Fonts

text ruler 3-85
Footers

described 3-25
printing 6-1

Form letters 3-58
Form View, Web

setting up 11-12 to 11-18
viewing in browser 11-16

Format files
and Claris Home Page 11-25
CDML tags 11-25

Formats
See also File formats; System 
formats

default 3-60
display 3-60

internal default B-1
international 3-60, B-1
system B-1

Formatting
calculations 3-62
custom line spacing 3-88
export data 8-4, 8-11
fields

as selected 3-68
defaults 3-60
sample data 3-57
text 3-60

graphics 3-67
import data 8-4
merge fields 3-58
paragraphs 3-84
repeating fields 3-72
scroll bars 3-71
text 3-88
times 3-65

Forms
See also Layouts
printing 6-1, 6-12

Formulas
See also Calculation fields; 
Summary fields

calculation fields 2-20
changing 2-25
constants 2-15
described 2-13
expressions 2-15
field references 2-16
functions C-1
operators 2-16
results 2-14
syntax 2-14

Found set
copying 4-29
deleting 8-8
described 4-4, 4-19
import data 8-8
switching with omitted set 4-27

Fraction of Total for summary 
fields 2-23

Functions
aggregate C-6
date C-5
described 2-20
design C-18
external C-19
financial C-13
logical C-14

number C-4
parameters C-1
repeating C-12
status 5-33, C-16
summary C-9
text C-3
time C-6
trigonometric C-13
Web Companion C-19

G
Getting help. See Help
Global fields

See also Fields
defining 2-9
described 2-5, 2-9
examples 5-34
importing 8-4
shared files 7-6

Glossary
in Help XII

Grand summaries
described 3-29
exporting 8-13

Graphic
objects

adding to layouts 3-54
described 3-52

rulers
described 3-40
showing/hiding 3-41

Graphics
copying 4-13
deleting 4-8
finding 4-22
importing 4-6
pasting 4-8
positioning 3-44
rotating 3-49
storing methods 4-6
viewing on the Web 3-3

Graphs, with FileMaker Pro data 8-1
Grouping objects 3-47
Groups

access privileges 7-9, 7-15, 7-17
associating with passwords 7-18
changing 7-19
defining 7-15
deleting 7-19
embedded 3-47
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examples 7-10
limiting access 7-9
master passwords 7-17
versus passwords 7-9

Guests
closing files 7-8
described 7-2
opening files 7-4
performing tasks 7-6
related files 10-32
saving files 7-6, 7-8
sending messages to 7-3

Guides. See AutoGrid; Ruler lines; 
T-square

H
Headers

described 3-25
Envelope layout 3-20
Labels layout 3-15
printing 6-1
title 3-25

Help
for databases in browser 11-23
using XIV

Hiding objects
See also Showing/hiding
during printing 6-3, 6-9

Home page
directing Web users to 11-23 to 
11-24

logging activity 11-10
replacing built-in 11-10
specifying default 11-9

Horizontal pitch, custom labels 3-16
Host

closing files 7-8
database on Web 7-3, 11-1, 11-6
described 7-2
FileMaker Pro Server 7-2, 7-4
opening files 7-3
performing tasks 7-6
related files 10-32
saving files 7-6, 7-8
sending messages to guests 7-3
System 7 File Sharing 7-2

HTML files
and Custom Web 
Publishing 11-25

described 11-2

exporting to HTML table 8-3
HTTP commands 11-3
HyperText Markup Language. See 
HTML

I
Identification fields 5-34
Importing

See also ClarisWorks; Exchanging 
files; Exporting

appending new records 8-4, 8-7
canceling 8-8
cross-platform considerations 8-2
data order 8-4
described 8-1, 8-4
destination files 8-5
dictionaries 1-18
exception fields 8-4
field definitions 8-2
field order 8-5
file formats 8-3
found set 8-8
graphics 4-6
into existing files 8-4
layouts 8-2
movies 4-6
new files 8-9
options 8-4
record order 8-4
related records 10-32
repeating fields 8-7
requirements 8-4
shared files 8-2
source files 8-5
updating existing records 8-8
validating data 8-8
versus copying and pasting 8-2

Index
Help XII
pasting from 4-10

Indexing fields 2-12
Instant Web Publishing

See also Custom Web Publishing, 
Web Companion

and layout objects 3-3
built-in home page 11-9, 11-23
described 11-2
disabling or enabling 11-9
language in interface 11-10
setting up pages 11-12 to 11-18

showing value lists 3-78
using Scripts with 5-1
viewing browser pages 11-15 to 
11-18

International files. See System formats
Internet

See also Web
access 11-2, 11-5
described 11-1
service provider 11-5

Intranet 11-1
IP address 11-1, 11-11, 11-23

J
Join expressions. See Relationships
Join fields. See Match fields
Joins. See Relationships
Justification. See Text, alignment

K
Key fields. See Match fields
Keywords. See Help

L
Labels

custom 3-16
dimensions 3-16
field 3-56
margins 3-16
print area 3-17
printing

dot matrix printer 3-13
entire sheet 3-17

Labels layout
See also Layouts
customizing 3-11
described 3-6
headers 3-15
page setup 3-13
preset sizes 3-11
printing 3-13
sizing 3-17
using 3-13

Layout mode 1-7
Layout objects. See Objects
Layout parts
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adding 3-27
adding objects to 3-29
body 3-25
changing 3-35, 3-36
deleting 3-36
described 3-24
field labels 3-56
footer 3-25
grand summaries 3-29
header 3-25
modifying 3-36
page breaks 3-32
page numbers 3-32
reordering 3-35
resizing 3-36
restoring 3-60
subsummaries 3-35
summaries 3-29
title footer 3-25
title header 3-25

Layout pop-up menu 3-4, 3-23
Layout text. See Text
Layouts

See also Columnar report layout; 
Envelope layout; Extended 
columnar layout; Labels layout

access privileges 7-9, 7-13, 7-16, 
7-18

adding graphics 3-54
Blank 3-7
blank space, removing 6-5
buttons 3-43, 5-20
changing 3-4, 3-23
checking 3-7
choosing 3-23
columns

page breaks 3-33
resizing 6-5
setup 3-21

cover page 3-29
custom line spacing 3-88
customizing for users 5-33
deleting 3-23
described 3-1
displaying related records 10-26
duplicating 3-23
field boundaries 3-43
fields

deleting 3-59
displaying 3-1
removing 3-59
selecting 3-39

importing 8-2
margins 6-3, 6-4
modifying 3-23
naming 3-8, 3-10, 3-13, 3-23
objects

deleting 3-45
graphic 3-52
locking 3-52
non-printing 6-9

on Web 11-5, 11-12
page breaks 6-3
predefined 3-5, 3-6
previewing 3-7
print area 6-3
printing

Extended columnar 6-10
overview 6-1
procedures 6-12
subsummaries 6-11

related fields
deleting 10-28
displaying 10-26
field definitions 10-30

removing 3-23
renaming 3-23
reordering the menu list 3-23
setting preferences 9-3, 9-8
Single-page form 3-7
Standard 3-7
switching 3-23
tools

described 3-4
locking 3-38, 9-3

viewing on the Web 3-3
Leading summaries 3-29
Leading. See Line spacing, custom
Leaving FileMaker Pro 1-13
Line spacing, custom 3-88
Lines 3-53
Links. See Linked objects; 
Relationships

List separators C-1
Lists, pop-up. See Pop-up lists
Locking

objects 3-52
shared records 7-6
tools 3-38

Log, of Web activity 11-10
Logical

AND search 4-25
functions C-14

operators 2-18
OR search 4-25

Lookups
and Relational databases 10-1
defining 10-3
defining relationships 10-9
updating 10-14

Lotus 1-2-3, exchanging data 8-3

M
Macros. See Scripts
MacWrite Pro data file. See Merge 
format

Mail merging. See Merge format
Mail, sending 5-11
Main database. See Master file
Main dictionary. See Dictionaries; 
Spelling

Main forms. See Master records
Margins

alternating 6-4
changing, text ruler 3-85
displaying

in Layout mode 6-3
in Preview mode 6-11

labels 3-16
setting 6-4

Master file
described 10-2
planning 10-15

Master password
defining 7-13
described 7-11
groups 7-17

Master records
deleting 10-23, 10-34
duplicating 10-31
finding with related fields 10-34
sorting with related fields 10-35

Master table. See Master file
Match fields

See also Fields
described 10-3
planning 10-16

Mathematical operators 2-17
Maximizing window size 9-9
Maximum for summary fields 2-23
Memory preferences 9-4



Index I-9
Menu commands, access 
privileges 7-14

Menus
context, described 3-42
layout pop-up 3-23
Script

adding items 5-14, 5-16
deleting items 5-16
reordering items 5-18

Menus, pop-up. See Pop-up menus
Merge fields

adding 3-58
described 3-58
formatting 3-58

Merge format 8-3
Messages, sending 7-3
Minimum for summary fields 2-23
Modems, configuring 9-5
Modes 1-7
Modifying. See Changing
Movies

deleting 4-8
importing 4-6
importing with scripts 5-8
moving 4-8
pasting 4-8
playing 4-7

Moving
fields between files 3-57
movies 4-8
objects

between applications 3-45
between layouts 3-45
overview 3-44

part labels 3-35
record to record 4-18
to calculation fields 4-3
to summary fields 4-3

Multiple platforms. See 
Cross-platform

Multi-table databases. See Relational 
databases

Multiuser files 7-3

N
Naming

fields 2-3, 2-25
layouts 3-8, 3-10, 3-13
scripts 5-13

value lists 3-75
Networks

See also Access privileges; Shared 
files

changing connections 9-2
cross-platform 7-2
FileMaker Pro Server 7-2, 7-4, 7-5
protecting files 7-9
sharing files 7-1

Web 7-4, 11-6
No password 7-12
No. See also Boolean 
expressions 3-62

Non-printing objects 6-9
NOT operator 2-18
Number fields

See also Fields
Boolean 3-62
described 2-5
entering data 4-4
finding 4-24
formatting 3-62
typing values in 4-4

Number functions C-4

O
Objects

adding to layouts 3-29
aligning 3-48
copying 3-45
cutting 3-45
deleting 3-45
described 3-37
editing quickly 3-42
fill 3-53
graphic 3-52
grouping 3-47
locking 3-52
moving

between applications 3-45
between layouts 3-45
overview 3-44

non-printing 6-9
pasting 3-45
positioning 3-40
resizing 3-50
rotating 3-49
selecting 3-39
sliding

described 6-5

displaying 6-6, 6-8
repeating fields 6-9
setting 6-7

stacking order 3-46
text

adding 3-80
deleting 3-82
described 3-79
pasting 3-82
replacing 3-82

ungrouping 3-47
OLE objects

working with 7-7
Omitting

fields
during printing 6-3, 6-9
from tab order 3-70

records
find requests 4-26
related 10-34

One-to-many relationship between 
data 10-20

One-to-one relationship between 
data 10-20

Onscreen help. See Help
Opening

files 1-10, 7-3
Help XII
URLs 5-11, 11-23

Operators
AND 2-18
comparison 2-17
in find requests 4-20
in formulas 2-16
logical 2-18
mathematical 2-17
NOT 2-18
OR 2-18
precedence 2-16
text 2-19
XOR 2-18

OR operator 2-18
Oval tool 3-53

P
Page breaks

changing 3-32
columns 3-22, 3-33
defining 3-32
layout parts 3-32
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printing records 6-1
subsummaries 3-32
viewing

in Preview mode 6-11
on layouts 6-3

Page guides. See Margins
Page margins. See Margins
Page numbering, layout parts 3-32
Page orientation for printing 6-10, 
6-12

Pages, Web
setting up 11-12 to 11-18
viewing databases in 11-12 to 
11-18

Palettes
color 3-51
pen 3-51
Size 3-40, 3-50
tools 3-53

Paragraphs
attributes 3-87
formatting 3-84

Parameters C-1
Part labels, displaying 3-35
Parts. See Layout parts
Passwords

access privileges 7-9, 7-13, 7-17
associating with groups 7-18
automatic 9-8
blank 7-12
case sensitivity 7-12
changing 7-15
default 7-12, 9-8
defining 7-11
deleting 7-15
described 1-6
examples 7-10
limiting activities 7-9
master 7-11, 7-13, 7-17
no password 7-12
related files

master file 10-10
planning 10-19
working with 10-30

versus groups 7-9
Web administration 11-6, 11-10, 
11-18

Pasting
current date, time, or user 
name 4-11

from the index 4-10

graphics 4-8
into non-standard fields 4-13
movies 4-8
objects 3-45
OLE objects 7-7
sounds 4-8
symbols 3-83
text 3-82

Patterns
field 3-73
fill 3-73
pen 3-51
selecting 3-51

Pausing scripts. See Scripts, pausing
Pen attributes 3-51
Performing scripts

described 5-2
on closing 5-3, 9-9
on opening 5-3, 5-33, 9-9
procedures 5-19

Permissions. See Access privileges
Phone numbers

dialing 9-4
script step for dialing 5-11

Picture/sound fields. See Container 
fields; OLE objects

Pictures. See Graphics; OLE objects
Pitch, custom labels 3-16
Planning

databases 2-1
fields 2-3
related fields 10-17
related files 10-15
relational databases 10-15
relationships 10-18
scripts 5-11

Playing
movies 4-7
scripts 5-19
sounds 4-8

Plug-ins
described 9-7
Web Companion, enabling 9-7, 
11-7

Pointer tool 3-39
Pointers to files. See Relationships
Pop-up lists

See also Value lists
choosing from 4-9
displaying field values 3-75, 3-77

editing 4-9
showing/hiding 4-9

Pop-up menus
See also Value lists
choosing from 4-9
displaying field values 3-75, 3-77
editing 4-9
layout 3-23

Port, TCP/IP 11-11, 11-23
Portals

See also Relational databases
changing 10-27
defining 10-20
deleting 10-27
described 10-3
displaying on layouts 10-26
displaying related records 10-26
one-to-many relationship 10-20
rotating 3-49
scroll bars 10-25
sorting 10-36

Precedence of formula operators 2-16
Predefined layouts

described 3-5
summary of types 3-6

Preferences
See also Settings
adding fields to current layout 9-3
button shapes 9-3
changing 9-1
configuring plug-ins 9-7
dialing phone numbers 9-4, 9-6
displaying template files 9-2
document 9-7
enabling drag and drop 9-2
general 9-2
layout 9-3
locking layout tools 9-3
maximizing window size 9-9
memory 9-4
modem 9-4, 9-5
network connections 9-2
opening to specific layout 9-8
opening with default password 9-8
performing scripts 9-9
saving files 9-4
shared files 9-7
showing/hiding status area 9-9
specifying user names 9-2
spelling 9-9
using smart quotes 9-8
Web Companion 11-7, 11-9



Index I-11
window size 9-9
Preset label sizes 3-11
Preview mode 1-7, 6-11
Previewing

See also Printing
columns 3-22
records 6-11
related records 10-32
subsummaries 3-31

Print area
labels 3-17
objects outside 6-3
viewing 6-3, 6-11

Print preview. See Preview mode
Printer, selecting 6-14
Printing

See also Previewing
access privileges for 7-13
blank records 6-1, 6-12
canceling 6-13
columns 3-22
Extended columnar layout 6-10
field definitions 6-1, 6-12
forms 6-1, 6-12
headers and footers 6-1
labels

dot matrix printer 3-13
setup 3-13
tips 3-13, 3-17

layouts 6-1, 6-12
overview 6-1
page orientation 6-10, 6-12
previewing 6-11
print area 3-17, 6-3, 6-11
procedures 6-12
records 6-1, 6-12
related records 10-32
reports 6-1, 6-12
script definitions 6-1, 6-12
setup 6-14
stopping 6-13
subsummaries 3-22, 6-11

Privileges. See Access privileges
Procedures. See Scripts
Protecting files. See Access privileges
Publish and Subscribe. See Edition 
Manager

Publishing, databases on the 
Web 11-1

overview 11-3

Pushbuttons. See Buttons

Q
QuickHelp application XII
QuickTime movies. See Movies
Quitting FileMaker Pro 1-13, 7-8
Quotation marks in searches 4-23
Quotes, smart 9-8

R
Radio buttons

See also Value lists
choosing from 4-9
displaying field values 3-75
editing 4-9
tab order 3-70

Ranges, finding 4-20
Read/write password. See Access 
privileges

Read-only password. See Access 
privileges

Record locking 7-6
Recording

scripts 5-12
sounds 4-8

Records
access privileges 7-13
adding 4-4
appending 8-4
browsing

groups of 4-1
in a list 4-16
individual 4-16
on Web 11-15 to 11-18
sorted records 4-30

copying 4-4, 4-12
deleting

duplicates 4-20
on Web 11-15 to 11-18
overview 4-29

described 1-2, 1-5
duplicating 4-4
exporting 8-9
finding

all 4-25
duplicates 5-34
on Web 11-15 to 11-18
overview 4-19

importing 8-4
locked 7-6
modifying field values 4-14
moving to 4-18
omitting 4-26
previewing 6-11
printing

blank 6-1, 6-12
large 6-1, 6-10
overview 6-1
procedures 6-12

reserializing 4-14
reverting 4-4
semi-sorted 4-32
sorting

on Web 11-13
overview 4-30
related records 10-36

Records, master. See Master records
Records, related. See Related records
Recovering files A-1
Rectangle tool 3-53
Registering FileMaker Pro XI
Related fields

See also Fields; Relational 
databases

calculations 10-31
changing 10-27
deleting 10-28
described 10-3
display on Web 11-6, 11-13
field definitions 10-30
finding 10-34
on layouts 10-26
one-to-one relationship between 
data 10-20

planning 10-17
script steps for 10-31
sorting 4-32, 10-35
summarizing data 10-31
syntax for field names 10-3

Related files
See also Files; Relational databases
access privileges 10-10, 10-19, 
10-30

described 1-6, 10-2
planning 10-15
shared 10-32

Related records
See also Records; Relational 
databases
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adding 10-23
defining 10-32
deleting 10-23, 10-34
described 10-3
displaying in portals 10-26
duplicating 10-31
finding and omitting 10-34
importing and exporting 10-32
previewing 10-32
printing 10-32
sorting 10-36

Relational databases
See also Portals; Related fields; 
Related files; Related records; 
Relationships

copying related records 10-31
defining 10-20
defining portals 10-20
deleting related records 10-34
described 1-2, 10-5
example 10-36
finding and omitting related 
records 10-34

master file
described 10-2
planning 10-15

match fields
described 10-3
planning 10-16

one-to-many relationship between 
data 10-20

one-to-one relationship between 
data 10-20

planning 10-15
portals 10-3
printing and previewing 10-32
related fields 10-3
related files 10-2
related records 10-3, 10-32
relationships 10-3
sorting 10-35
terminology 10-2

Relationships
See also Relational databases
changing 10-29
defining 10-9
described 10-3
planning 10-18
to and from same file 10-10

Relookups
automating 10-14
described 10-14

Remarks, in scripts 5-11
Remote files, sharing

local network 7-3
on Web 11-10, 11-18 to 11-22

Removing. See Deleting
Renaming layouts 3-23
Reordering

field definitions 2-25
layout parts 3-35
layouts 3-23
Script menu items 5-18
script steps 5-13, 5-17
scripts 5-18
sort fields 4-30

Repeating fields
adding 3-72
defining 2-11
described 2-11
exporting 8-14
formatting 3-72
importing 8-7
separating 8-14
sliding objects 6-9
sorting on 4-32
splitting 8-14
tab order 3-70

Repeating find requests 4-25, 4-26
Repeating functions C-12
Repeating panels. See Portals
Repetitions. See Repeating fields
Replacing

field values 4-14
text 4-5

Reports
See also Layouts
adding page numbers 3-83
adding printing date 3-83
adding printing time 3-83
Columnar 3-9, 3-20
cover page 3-29
previewing 6-11
printing 6-1, 6-12

Requests. See Find requests
Requirements

exporting 8-4
file sharing 7-1
importing 8-4
Web Companion 11-5

Reserializing records 4-14
Resizing

layout parts 3-36
several objects 3-50

Restoring
layout parts 3-60
script settings 5-15

Restricting access. See Access 
privileges

Retrieving data from other files. See  
Exchanging files

Reverting
find requests 4-21
records 4-4

Rights. See Access privileges
Rotating objects 3-49
Rounded rectangle tool 3-53
Ruler lines

described 3-40
setting units 3-41
showing/hiding 3-41

Rulers
graphic 3-40
lines 3-40
setting units 3-41
showing/hiding 3-41
text 3-40

Running scripts 5-19

S
Sample data in fields 3-57
Saving

files 1-11
setting preference for 9-4
shared files 7-6, 7-8

Script menu
adding items 5-14, 5-16
deleting items 5-16
reordering items 5-18

Script specifications. See Scripts, 
settings

Script steps
See also Scripts
adding 5-13, 5-16
Control 5-5
deleting 5-13, 5-16
described 5-4
Editing 5-7
Export 5-8
Fields 5-7
Files 5-9
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Find 5-6
for related fields 10-31
Import 5-8
italicized 5-17
Miscellaneous 5-10, 5-11
Navigation 5-6
options 5-4, 5-13, 5-16
Print 5-6
Records 5-8
reordering 5-13, 5-17
Sort 5-6
Spelling 5-10
Windows 5-9

ScriptMaker
See also Scripts
examples 5-29
steps 5-4
using 5-1

Scripts
See also Script steps; ScriptMaker
adding

comments 5-11
menu items 5-14, 5-16
remarks 5-11

Apple events 5-23
AppleScript commands 5-24, 5-28
automating relookups 10-14
buttons 5-20
canceling 5-19
changing 5-16
commands 5-4
conditional 5-5
current user name 4-12
defining 5-12
deleting 5-18
deleting menu items 5-16
described 5-2
designing 5-11
dialing phone numbers 5-11, 9-4
displaying error messages 5-5
duplicating 5-16
examples 5-29
external 5-3
keyboard shortcuts 5-18
looping 5-5
modifying 5-16
naming 5-13
passwords 7-13
pausing

adding to scripts 5-14
described 5-3
example 5-2
resuming 5-19

stopping 5-19
performing 5-2, 5-19
planning 5-11
playing 5-19
printing 6-1, 6-12
reordering in Script menu 5-18
resuming 5-19
running 5-19
sending Apple events 5-11, 5-25
setting preferences 9-9
settings

changing 5-16
examples 5-29, 5-31
keeping 5-17
replacing 5-17
restoring 5-15
storing 5-15

shutdown 5-3, 9-9
sort order 4-32
startup 5-3, 9-9
stopping 5-19
subscripts

adding to scripts 5-12
changing 5-16
described 5-3

system formats B-3
testing 5-12
with Instant Web Publishing 5-1

Scroll bars
adding to fields 3-71
in portals 10-25

Search page, Web
setting up 11-12 to 11-18
viewing in browser 11-17

Search requests. See Find requests
Searching. See Finding
Secondary files. See Relational 
databases

Security, file. See Access privileges
Selecting

checkboxes 4-9
Edit items 4-9
from pop-up lists 4-9
from pop-up menus 4-9
objects

all fields 3-39
by type 3-39
grouping 3-47
individually 3-39
multiple 3-39
ungrouping 3-47

Other items 4-9

patterns 3-51
printer 6-14
radio buttons 4-9
semi-sorted records 4-32
text 3-82

Selection handles 3-39, 3-50
Self-joins. See Relationships
Sending mail 5-11
Sending messages 5-11, 7-3
Separator line in value lists 3-76
Serial numbers, modifying 4-14
Server. See Host; FileMaker Pro 
Server

Settings
See also Preferences
alignment 3-49
tab order 3-69
Web Companion 11-7, 11-8

Shared files
See also Networks
access privileges 7-9
closing 7-8
coffee cup icon 7-6
described 7-1
double arrow icon 7-6
guests 7-2
host 7-2
on Web 11-1, 11-7

access privileges 11-10, 
11-18 to 11-22

opening 7-3, 7-4
quitting FileMaker Pro 7-8
related 10-32
saving 7-6, 7-8
System 7 File Sharing 7-2

Sharing information. See Exchanging 
files

Showing/hiding
See also Hiding objects
ruler lines 3-41
rulers 3-41
status area 4-2
T square 3-41

Shutdown
options 5-3
scripts 5-3, 9-9

Single file databases 1-6
Single-page form layout 3-7
Size

palette
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described 3-40
positioning objects 3-41
resizing objects 3-50

text 3-88
text ruler 3-85

Sliding objects
displaying 6-6, 6-8
parts 6-6
repeating fields 6-9
setting 6-7

Smart quotes 9-8
Sort order

See also Sorting
changing 4-30
creating 4-30
in scripts 4-32
records on Web 11-13
restoring original 4-31
summary fields 4-32

Sort page, Web
setting up 11-12 to 11-18
viewing in browser 11-18

Sorting
See also Sort order
ascending order 4-30
canceling 4-31
container fields 4-31
custom order 4-30
descending order 4-30
described 4-30
in scripts 4-32
master records with related 
fields 10-35

on subsummaries 3-31
records on Web 11-13
related fields 4-32
related records 10-36
repeating fields 4-32
summary fields 4-32

Sounds
copying 4-13
deleting 4-8
playing 4-8
recording 4-8

Space, removing blank 6-5
Speaking text 5-11
Speech 5-11
Spelling

See also Dictionaries
checking

as you type 1-15

automatically 1-15
options 1-13, 1-14
setting preferences 9-9

Splitting repeating fields 8-14
Spreadsheets

See also Exporting; Importing
file formats 8-3

Stacking objects 3-46
Standard Deviation for summary 
fields 2-23

Standard layout 3-7, 3-8
Startup

options 5-3
scripts

described 5-3
examples 5-33
performing 9-9

Statistical functions. See Aggregate 
functions

Status area
Browse mode 4-2
Find mode 4-21
showing/hiding 4-2, 9-9

Status functions
described C-16
using in scripts 5-4, 5-33

Steps. See Script steps
Stopping

See also Closing
printing 6-13
scripts 5-19

Stored results 2-20
Strings, text. See Text, literal
Subforms. See Portals
Subscripts. See Scripts, subscripts
Subsummaries

described 3-29
exporting 8-12
importing 8-4
leading 3-29
page breaks 3-32
previewing 3-31
printing 6-11, 6-12
sorting 3-31
trailing 3-30

Subtotals. See Subsummaries; 
Summary fields

Summaries. See Summary fields; 
Summary parts

Summarizing data in related 
fields 10-31

Summary fields
See also Fields; Formulas
Average for 2-23
Count for 2-23
defining 2-23
described 2-5, 2-23
exporting 8-12
find requests 4-20
formulas 2-13
Fraction of Total for 2-23
importing 8-4
Maximum for 2-23
Minimum for 2-23
moving to 4-3
on layouts 3-9
options for 2-24
sorting 4-32
Standard Deviation for 2-23
Total for 2-23

Summary functions C-9
Summary parts 3-29
Switching layouts 3-23
SYLK format 8-3, 8-14
Symbols

pasting 3-83
Syntax

formulas 2-14
related field names 10-3

System 7 File Sharing 7-2
System formats

See also Formats
changing B-2
current, using B-2
described B-1
scripts, defining B-3
working with B-1

T
Tab order

omitting fields 3-70
on the Web 3-69
repeating fields 3-70
setting 3-69

Table rights. See Access privileges
Table View, Web

setting up 11-12 to 11-18
viewing in browser 11-15
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Tables. See Files
Tabs

alignment 3-86
attributes 3-86
decimal 3-86
setting 3-85

Tab-Separated Text format 8-3
TCP/IP network protocol 9-2
TCP/IP port 11-11, 11-23
Technical support. See Customer 
support

Templates
creating files 1-9
described 1-9
displaying 9-2
suppress New Database dialog 
box 1-10

Web 11-26, 11-28
Text

See also Fields
adding 3-79, 3-80
alignment 3-88
attributes 3-60, 3-90, 8-4

on the Web 3-61
baselines 3-73
boundaries, showing/hiding 3-43
color 3-88
cutting 3-82
deleting 3-82
fields 2-5
finding 4-23
formatting 3-60, 3-88
line spacing 3-88
objects

viewing on the Web 3-3
objects, described 3-79
operators 2-19
paragraphs 3-84
pasting 3-82
removing 3-82
replacing 3-82, 4-5
rotating 3-49
selecting 3-82
sizes 3-88
speaking 5-11
styles 3-88
tool 3-80
typing values in fields 4-4
using drag and drop 9-2

Text fields. See Text
Text functions C-3

Text ruler
changing text attributes 3-85
described 3-40
formatting paragraphs 3-84
setting tabs 3-85
setting units 3-41
showing/hiding 3-41

Text tool 3-80
Time

See also Time fields
current 4-11
finding 4-24
formatting 3-65
functions C-6
invalid 4-20

Time fields
See also Fields; Time
described 2-5
entering data 4-5
international formats 4-5
typing values in 4-5

Title headers and footers
cover page 3-29
described 3-25

Today’s date, finding 4-24
Toolbars. See Tools
Tools

described 3-4
locking 3-38
switching between 3-38
text 3-81
tools palette

line tool 3-53
oval tool 3-53
pointer 3-39
rectangle tool 3-53
rounded rectangle tool 3-53
text tool 3-80

working with 3-38
Total for summary fields 2-23
Totals. See Summaries
Trailing summaries 3-30
Transactions, Web 11-10
Trigger fields. See Match fields
Trigonometric functions C-13
True. See also Boolean 
expressions 3-62

T-square
adjusting 3-41
described 3-40

showing/hiding 3-41
Typing in fields 4-4

U
Unauthorized users. See Access 
privileges

Ungrouping objects 3-47
Unstored results 2-20
Updating files. See Converting
Updating lookup values 10-14
Updating records. See Importing
URLs, opening 4-17, 5-11, 11-23
User dictionaries. See Dictionaries
User names

current
pasting into fields 4-11
scripts 4-12

examples 5-33
setting 9-2

Using data from other files. See 
Exchanging files

V
Validating fields 2-7
Value lists

See also Checkboxes; Pop-up lists; 
Pop-up menus; Radio buttons

access privileges 7-13
copying 3-76
custom sorting by 4-30
defining 3-75
deleting 3-76
described 3-75
Edit items 3-78
edit items 4-9
editing 4-9
naming 3-75
options 3-76
other items 4-9
separating line 3-76
showing/hiding 4-9

Values
copying 4-12
displaying 3-75
finding duplicates 4-20
finding exact 4-20, 4-21
inserting indexed 4-10
looking up automatically 10-3
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lookups, updating 10-14
modifying 4-14

Values, field. See Field values
Vertical pitch, custom labels 3-16
View as list

described 4-16
subsummaries 3-31

Views, Web
setting up 11-12 to 11-18

Views. See Layouts
Virtual results 2-20

W
Web

access 11-5
described 11-1
hosting databases on 11-1
servers 11-3

Web browser. See browser, Web
Web Companion

See also Custom Web Publishing, 
Instant Web Publishing

and tab order 3-69
and text formatting 3-61
CDML Reference 11-25
CDML Tool 11-27
configuring 11-8 to 11-11
default settings 11-8
enabling 9-7
functions C-19
home page 11-9, 11-23
Instant Web Publishing browser 
pages 11-15 to 11-18

port number 11-11, 11-23
remote administration 11-10
requirements 11-5
sample files 11-28
setting up 11-7 to 11-8
setting up layouts 11-5

Web security databases 11-11, 
11-18 to 11-22

Wildcards in searches 4-23
Windows, setting size 9-9
WKS format 8-3, 8-14
World Wide Web. See Web

X
XOR operator 2-18

Y
Yes. See also Boolean 
expressions 3-62

Z
Zoom controls 3-4, 4-2



 

Quick Reference

 

Keyboard and mouse shortcuts

 

Working with layout objects

 

Align objects using the current settings

 

2

 

-K

Align to grid off while resizing/moving an 
object

 

2

 

-resize/ 

 

2

 

-drag

Bring an object forward Shift-

 

2

 

-F

Constrain a line to 45

 

°

 

 increments Option-drag

Constrain a rectangle to a square Option-drag

Constrain an oval to a circle Option-drag

Constrain movement to vertical or horizontal Shift-drag

Constrain resizing to vertical or horizontal Shift-resize

Display an object’s format Option-double-click

Drag the selected layout part past an object Option-drag

Duplicate by dragging Option-drag

Group objects

 

2

 

-G

Lock an object

 

2

 

-H

Move the selected object one pixel at a time Arrow keys

Redefine a field on a layout Double-click

Reorder the selected part Shift-drag

Re-orient the part labels

 

2

 

-click

Reset the default format based on an object

 

2

 

-click

Rotate an object Option-

 

2

 

-R

Select items partially contained in the marquee

 

2

 

-drag

Select objects by type Option-

 

2

 

-A

Send an object backward Shift-

 

2

 

-J

Set Alignment dialog box Shift-

 

2

 

-K

Show/Hide T-Squares

 

2

 

-T

Square the object being resized Option-resize

Toggle the selected tool with the Pointer tool Enter

Ungroup objects Shift-

 

2

 

-G

Unlock an object Shift-

 

2

 

-H

 

Formatting text (Layout and Browse)

 

Align text center 

 

2

 

-\

Align text left Shift-

 

2

 

-L, 

 

2

 

-[

Align text right Shift-

 

2

 

-R, 

 

2

 

-]

Full text justification Shift-

 

2

 

-\

Insert a tab character in text Option-Tab

Next point size down Shift-

 

2

 

-<

Next point size up Shift-

 

2

 

->

Nonbreaking space Option-Space bar

One point larger Shift-Option-

 

2

 

->

One point smaller Shift-Option-

 

2

 

-<

 

Selecting text (Layout and Browse)

 

Extend selection to end of line Shift-

 

2

 

-

 

B

 

Extend selection to end of text Shift-

 

2

 

-

 

D

 

Extend selection to next end of word Shift-Option-

 

B

 

Extend selection to previous start of word Shift-Option-

 

A

 

Extend selection to start of line Shift-

 

2

 

-

 

A

 

Extend selection to start of text Shift-

 

2

 

-

 

C

 

Move insertion point to end of line

 

2

 

-

 

B

 

Move insertion point to end of text

 

2

 

-

 

D

 

Move insertion point to next word Option-

 

B

 

Move insertion point to previous word Option-

 

A

 

Move insertion point to start of line

 

2

 

-

 

A

 

Move insertion point to start of text

 

2

 

-

 

C

 

Select a word Double-click

Select a line Triple-click

Select a paragraph Four clicks

Select entire contents of a text area Five clicks or 

 

2

 

-A

 

Editing

 

Copy the found set (Browse) Option-

 

2

 

-C

Delete record, layout, or request

 

2

 

-E

Delete selection/next character Del

Delete selection/previous character Delete

Duplicate record, layout object, or request

 

2

 

-D

New record, layout, or request

 

2

 

-N

Next field (Browse and Find) Tab

 

Formatting text (Layout and Browse)



 

Editing

 

Next record, layout, or request

 

2

 

-Tab

Paste a merge field (Layout)

 

2

 

-M

Paste from the index (Browse and Find)

 

2

 

-I

Paste from the last record (Browse and Find)

 

2

 

-’

Paste from the last record and move to the 
next field

Shift-

 

2

 

-’

Paste the current date

 

2

 

-- (hyphen)

Paste the current time

 

2

 

-;

Paste the current user name Shift-

 

2

 

-N

Paste without style Option-

 

2

 

-V

Previous field (Browse and Find) Shift-Tab

Previous record, layout, or request Control-

 

C

 

, or 
Shift-

 

2

 

-Tab

Replace the contents of the current field in all 
records in the found set

 

2

 

-=

Spell the selected word correctly Shift-

 

2

 

-Y

 

Working with files

 

Close the database

 

2

 

-W

Network (Open) dialog box Option-

 

2

 

-O

Open dialog box

 

2

 

-O

Print

 

2

 

-P

Print without Print dialog box Option-

 

2

 

-P

Quit FileMaker Pro

 

2

 

-Q

Save FileMaker Pro saves 
automatically

 

Controlling windows

 

Scroll the document window down page down

Scroll the document window up page up

Show/Hide the status area Option-

 

2

 

-S

Toggle between full size and the previous size Shift-

 

2

 

-Z

 

Switching between modes

 

Go to Browse mode

 

2

 

-B

Go to Find mode

 

2

 

-F

Go to Layout mode

 

2

 

-L

Go to Preview mode

 

2

 

-U

 

Miscellaneous actions

 

Cancel a dialog box Esc

Cancel an operation

 

2

 

-.

Check/Uncheck the Omit checkbox in Find

 

2

 

-M

Define Fields dialog box Shift-

 

2

 

-D

Find all

 

2

 

-J

Help

 

2

 

-?

Modify the last find

 

2

 

-R

Move object up or down in list in dialog box

 

2

 

-

 

C

 

, or

 

 2

 

-

 

D

 

Play or record sound in a sound field Space bar

Select all

 

2

 

-A

 

Fill color palette

 

In Layout mode In Find modeIn Browse mode

 

Choose a different layout

Number of the current record (editable)

Shows whether records are unsorted, 
sorted, or semi-sorted

Click a page or drag the bookmark to 
move forward or backward in your records

Number of records in file 

Percent of magnification

Zooms window smaller or larger

Shows or hides the status area

Layout tools

Number of the current 
request (editable)

Click to omit the records found 
by the current request
Click to choose operators 
(like <, >, and =) to paste 
into a find request

Number of existing requests

Click to begin the search

Number of the current 
layout (editable)

 

Status area

 

Field tool
Part tool

Fill icon

Pen icon
Pen color palette

Button tool Portal tool

Fill pattern palette

Pen pattern palette

Current line properties

Line width palette

Current fill properties

U97600-081A
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